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Chapter 1 Software Installation & Hardware Setting

1.1 Installing the Win-GRAF Workbench

Before installing the Win-GRAF Workbench, check the installation environment on your PC.

System requirements:
® O0.S.: Windows XP, Windows Vista, Windows 7, Windows 8 (32-bits or 64-bits)
® Microsoft .Net Framework 3.5 (Download it on the Microsoft web site:
http://www.microsoft.com/zh-tw/download/details.aspx?id=22)
® RAM: 1 GB minimum (Recommended: 2 GB or more)
® Available hard-disk space: 200 MB minimum

Installation Steps:
1. Double-click the “Win-GRAF-setup-ver-x.xx.exe” file in the Win-GRAF installation CD (or download
the latest version of the Win-GRAF Workbench on the website: http://www.icpdas.com/root/
product/solutions/softplc_based on pac/win-graf/download/win-graf-driver.html) to begin the

process.
Win-GRAF-mtup-ver-1.01 exe
s Win-3EALF Betup
IR 1CF DAR CO,LTD.

2. Click “Next” to continue and then select “l accept the agreement”, then click “Next” to continue.

Setup - Win-GRAF

Welcome to the Win-GRAF Setup
Wizard

This will inskall win-GRAF version 1,01 on wour computer,

It is recommended that vou close all other applications before
conkinuing.

Click Mext ko continue, or Cancel to exit Setup.
Setnp - Win-GRAF
License Agreement

Please read the Follmwing important information before continuing.

Please read the Following License Agreement. You must accept the terms of this
agreement before continuing with the installation,

welcome bo the Win-GRAF setup program, LS

controllers) produced by ICP DAS.,

The win-GRAF is 4 ICP DAS software, Ik supports only hardwares (PAC, PLC, [ Mext > * [ Cancel
N\

W ARMING: This software is protected by copyright law and international treaties,

IUnautharized reproduction or distribution of this software, or any portion of i,
may result in severe civil and criminal penalties and will be prosecuted ko the
maximum exkent possible under law,

' 1 do not accept the agreement

[ <Back [ mext> *[ Cancel |
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http://www.microsoft.com/zh-tw/download/details.aspx?id=22
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/win-graf/download/win-graf-driver.html
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/win-graf/download/win-graf-driver.html

3. Recommend to use the default installation path (i.e., “C:\Win-GRAF”) and then click “Next” to

continue.

Setup - Win-GRAF

Select Destination Location
Where should Win-GRAF be installed?

.—.J Setup will install Win-GRAF into the Following folder,

To continue, click Mext, IF vou would like ko select a different Folder, click Browse,

| i GRAF

| [ Browse,..

AL least 77,4 MB of Free disk space is required,

| <Back || uext:»ﬂ[ Cancel |

4. Click “Next” to add a “Win-GRAF” folder shortcut in the “Start” menu, and then select “Create a
desktop icon” to add a desktop shortcut, then click “Next” to continue.

Setup - Win-GRAF

Select Additional Tasks
Wwhich additional tasks should be performedy

then click Mext,

Additional icons:

M&

Select the additional basks wou would like Setup to perform while installing Win-GRAF,

Setnp - Win-GRAF

Select Start Menu Folder
Where should Setup place the program's shortcuks?

- Setup will create the program's shortouts in the Following Start Menu folder,

To continug, click Next, IF vou would like to select a different Folder, click Browse,

| [ Browse. .,

< Back. ” Mext = *[ Zancel
N\

< Back “ Tk = k[ Zancel

N\
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5. Click “Install” to begin installing the Win-GRAF Workbench.

Setup - Win-GRAF

Ready to Install

change any settings,

Setup is now ready to begin installing Win-GRAF on vour computer,

Click Install ko continue with the installation, or click Back. if you want Eo review or

C:\Win-GRAF

Start Menu Folder:
‘Win-GRAF

Additional tasks:

Destination locakion:

Additional icons:
Create a deskkop icon

[ < Back ]| Install K[ Cancel ]

N

6. Before the end of the installation, you will see a pop up window and it displays:

a. The legal Win-GRAF Workbench is delivered with a legal Win-GRAF Dongle distributed by ICP DAS.

Please always plug the Win-GRAF Dongle in your PC while running it.
b. To run the Win-GRAF, require Microsoft “.Net FrameWork 3.5” installed in your PC.

Setnp - Win-GRAF

Installing

Extracting files. ..
C:Win-GRAFKSHelpGR . chim

Please wait while Setup installs Wwin-GRAF on wour computer, 'rh --'I

i) Setup - Win-GRAF

Information

Please read the Following important information before continuing.

\When waou are ready to continue with Setup, click Mexk,

Thank vou Far installing the Win-GRAF software,

The leqal Win-GRAF saftware is delivered with a legal Win-GRAF-Dangle distributed
by ICP DAS. Please abways plug the Win-GRAF-Dongle in your PC while running it.

T run the Win-GRAF, require MicraSaft ket Framewark 3.5" installed in voor PC,
Far technical suppart and sales service, contact service@icpdas.com |
ICP DAS CO,, LTD

v icpdas, com
service@icpdas, com
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7. By now, you have completed the Win-GRAF installation, then click “Finish” to exit this window.
(Select “Launch Win-GRAF” to auto-run the Win-GRAF after completing the setup. If there is no
Win-GRAF Dongle in your PC, the Win-GRAF Workbench will run in Demo mode.)

Setup - Win-GRAF 9= ]

Completing the Win-GRAF Setup
Wizard

Setup has finished installing Win-GRAF on vour computer, The
application may be launched by selecting the installed icons.

Click Finish ko exit Setup,

Launch W

< Back ” Einish Q

N

1.2 Run the Win-GRAF Workbench

Before running the Win-GRAF Workbench, make sure the Win-GRAF Dongle is plugged into your PC.
Without using a Win-GRAF Dongle, the Win-GRAF Workbench will runin Demo Mode. Open the
Windows Start menu, click on “Win-GRAF” folder and “Win-GRAF” to open this software.

/= N G Vi GRAF ) Librories  »
‘ ) Google Chrome vl & Handbook
/) ICPDAS v
ﬁj Ctlook Express

@ Mozilla Firefox

ARl ) Opers 16 Win-GRAF &

Description of the “Win-GRAF” folder:
Libraries: For users to create their own function or modify an exist function.
Handbook: The manual details the software interface, programming environment, programming
languages, and so on, provided by COPALP.
(Or click the [Help] > [Topics] from the Win-GRAF menu bar)
History:  The modification history and features added of the Win-GRAF Workbench.
Manual:  The Win-GRAF manual provided by ICP DAS.
(Or click the [Help] > [Tutorials] from the Win-GRAF menu bar, ? e—
®

the manual is located in the path “C:\Win-GRAF\Tutorials”)
ReadMe: The notice for the Win-GRAF Workbench.
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1.2.1 Win-GRAF Operating Mode
The Win-GRAF Workbench provides two operating modes:

“Demo Mode”: Without using a Win-GRAF Dongle. The compiled Win-GRAF project can run for 15
minutes on the PAC. Once the time limit has expired, users must Stop/Start this
project again and it only supports up to 40 1/0 tags.

“Large Mode”: Using a Win-GRAF Dongle. The project can run on the PAC without the time limit.

Demo Mode - Without using a Win-GRAF Dongle.
The start screen will show as below after running the Win-GRAF Workbench.

Win-GRAF Starter EER

No Win-GRAF-Dongle found. Demo mode !l i No Win-GRAF Dongle found. Demo mode!

Win-GRAF

Win-GEAF ¥Yersion 1.01 {(MAE 18,2014}

Coparright by ICP DAR CO, LTI since 2014,

Fhepbroeek [Demo mode] FEEEEEOO0

For [Large mode], pleass plug o the "Win-GRAF-Dongle' while mdng it.
For technical support and sales service, contact service @4icpd az oo

It describes the limitations in [ Limitations in demo mode:
- Applications are limited to 40 T0s
demo mode, you can also - The code generated b the compiler stops after 15 minutes

click the main menu [Help] > = i) AR T e o5 L i

H Limitaticns of controller type:
[About] to see this content. i Wi GIRAE st summeis oy Fadrarss (P00, FLC, eomtllbrs s byl o D08

Note: If you install the Win-GRAF Dongle in the Demo Mode, you must close Win-GRAF Workbench and
then start it again to make it become Large Mode.

Large Mode - Using a Win-GRAF Dongle.
The start screen will show as below after running the Win-GRAF Workbench.

Win-GRAF Starter

Win-GRAF
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1.2.2  Win-GRAF Operating Environment
Run the Win-GRAF and then the main screen will show as below:

Win-GRAF
(Fil: View [Lools Window Help .
e 1= = e >< i -

Work=space

Menu / Tool bar

X RO Alt+F4

-
ShowHide menu Pro gram Area

Workspace
3 >
Message Area
m Build‘ Cross references ] RunlimeJ Ca-ll stack ,l Breakpaints ,] Digital sampling trace ,l Prom-nt,l HEdAl
Ready Mo project 4 0,0 0x0 0,0 100% | B4

v

Note: Mouse right-click on the top of the Window to Show/Hide the menu bar.

A. The Workspace: It allows users to create project lists, and add/open the Win-GRAF program as
well as the related settings. Moreover, the new project can be created by using a
project template.

B. The Program Area: It used to show/edit the program and can be divided into more function area.
(Refer the Section 2.2.1)

C. The Message Area: It used to show compiler messages and provides more diagnostic tools.

Tips:

1. To resize a window, click and drag the side or corner of the window to change its size.
2. Press the “F1” key to open the user manual (i.e., HTML Help).

Hind or Show the window
If you carelessly closed the Variables pane or the Message Area during the programming, you can click

the menu bar "View" and select the following options to open this window again.

a'; L Local Defines

Cntpt Ctit A0
Tnfos Tabl
Tnfos Tab2

Output: It means the Message Area.
Infos Tab1: It means the Program Area — Variables pane (refer the Section 2.2.1).
Infos Tab2: It means the Program Area - Function Blocks pane (refer the Section 2.2.1).
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Switching the language

1. To switch the Ul language of the Win-GRAF, click “Help” and “Language” on the toolbar and then

choose a language in the “Select Language” dialog box, and click “OK”.

(Selectlonguage (o]

FrarfEiz -
Deutzch

EzpafEl !

k.orean =

Traditional Chinesze
Simplified Chinese

File View Tools Window [elp: —
ittt @ Torics- T
Workspace Q| Search... =
Tutorials » '8
@ | About...
| Language... w ‘
N :

DI(Q[ Arn.ﬂa‘r

2. The Ul language will be changed after restarting the Win-GRAF automatically.

File VWisualizza Strumenti  Finestra Guida
Gl g s X wl o o] AL Y £ A P e | 05 e A
Workspace Nessuna selezione!
4[+] Compila;" Lismincrosata | Runtme | CallStack | Breskpoint | Digitsl Sampiing Trece | Prompt | HMI| - Code Checker
Pronto Messun progetto 0,0 0x0 0,0
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1.2.3  Win-GRAF Library Manager
Win-GRAF Workbench provides a Library Manager that can be used to look up all descriptions for
Functions, Function Blocks and I/O Boards. The user can refer Section 11.1 to upgrade the Win-GRAF Lib.

1. To begin this, click the Start button and click "All Programs" > "Win-GRAF" > "Libraries" > “OEM”.

@ WinGRAF »| G Libaries
) Google Chrome »
™) ICPDAS >
(4 Outlook Express
@ Mozilla Firefox
9 € ) Opera 18

»| 78 OEM
Pistiller 2

mERA® »

Wi Win-GRAF

2. Inthe “Library Manager” window, click the menu bar “File” > “Open Library” and select “ICP DAS —
XP-WP-VP” then click “OK”.

3. Select any title in the “Function and FBs” tab and click the “Description” to view the usage of this
Function or Function Block; Select any title in the “I/Os” tab and click the “Description” to view the
usage of this I/O Boards.

Library Manager - zer

IZ1EN Wizard Help

I Open Library X
V. | e i
Exit [ICP DAS - XP-WP-/P [ o

[
(]
[v1}
=
Q
@

Embedded HMI
Ethemet Powerlink
Files

[CP DAS - XPWE-VP
Maths

Miscellaneous
FID
Plus!

S Retaim. Yor (% Kotam & Snzle veoable 7]
EiTime_Get (* Function Block: Get date and time of the PAC *) =

—T . Yok Sk Deerrrmiemgy TV Ve St veeiis Jode wied Aleeo do 2L VA, WA =%

m Description

Retain ¥ar : Retain a wariable . 25|

*#*% The "Retain Var()™ can work only in the lst PAC cycle or
in the cycle when on line change.
Call this function in other cycles will return FALSE . |

< |

B
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1.3 Setting the Win-GRAF PAC’s IP Address

For connecting with the PAC, the Win-GRAF Workbench needs to know the PAC IP. The following will
show you how to set up the PAC IP. Using the XPAC (XP-8xx8-CE6) and the WinPAC (WP-5xx8-CE7,
WP-8x48, WP-8x28-CE7) as the example:

Hardware Wiring Diagram

Power Supply
DP-665

Monitor

PC/Win-GRAF GND

1

IP: 192.168.1.20
Mask: 255.255.255.0 RS-408

Mask: 255.255.255.0

PAC Side

Using the USB mouse that connected to the PAC, and click “Start” > “Settings” > “Network and Dial-up
Connections” on the lower left corner of the monitor, then double-click the “LAN1” (or LAN2), then fill in
a proper IP address.

|EiIE Edit View Advaﬂced| )(I@l Iﬁ

Make Mew LAMNZ LARI

Connection 0\
ast Ethem_@
IP Address |Name Servers | e

A IP address can be () Obtain an IP address via DHCP
autornatically assigned to this :
computer, If your network (3) Specify an 1P address

does not autornatically assign .

IP addresses, ask your netwaor IP Address: |192'1E'8' 1 .10 |
administrator for an address, cubnet Mask: [255 255,255, 0 |
and then type it in the space -

provided, Default Gateway: | . . . |

@Erugrams »

% Favaorites  * 0 t paneﬂ

) Documents > EBs((1]2][3]4]5]6]7]8]9]0]- =]
[F] e[y uli[olplt

B~ Settings [+ Cantral Panel
@Help amet'-.ﬁ.-'curh: and Dial-up Connections g::t az sx dc fv gh hn :nk; I_ - T
RN, a Taskbar and Start Menu,., crlati] - T4 ] Ti]t]=ls

|| I ile v 1N=39 ﬁM%
Click to use the keyboard

".E||¢',NEtWka Conneclions
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Open the “WinPAC_Utility.exe” (or “XPAC_Utility.exe”) on the desktop (or \System Disk\tools\).Then,
click “File” > “Save and Reboot” to reboot the PAC.

Notice:
For connecting properly, the PC/Win-GRAF IP and the PAC IP must on the same network segment.

For example, set the PC’'s IP to “192.168.1.20” (Mask: 255.255.255.0).

= WP
LRF

-

L Ed

My Device  'Win_GRA. ..

g

WInPAC Utility [2.1.0.4]

=8 Help Configuration

Internet T
Save [
Explorer a' & and Reboot etfings2 IEﬂﬂernet Seftings I Metwork Settings ISystem Infor mation I Auto ML
E’@ Reboot without Save Welcome to use WinPAC Utility
wordPad Restore Default Settings This taal will help you to set up the WinPAC - 2000,

Exit

Display Resolution : IEIDIZI * poo hd
My WinPAC
Documents Frequency IES.EI bl

‘(-'D ~ Industrial Control Products

‘sb'.:' Data Acquisition System

Batteryl : 0K Task Bar Settings: [ | auto Hide flways On Tap
Batteryz Ok [ ]Blank Deskiop
Regiiew Configure synchronization with a time server ’ Canfigure ]
[ ]Enable Autorun when connecting a USE Disk
Ed ) .
Enable Autorun when connecting & Micro S0
TaskMagr D g
=
Ed 1'\
isghw 35

2L e b 10:56 AM ‘@ ‘%

..'jHurinpAc utility [2.1.0.4] |
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Chapter 2 A Simple Win-GRAF Program

2.1 Creating a New Win-GRAF Project

The following sections will introduce you to a simple template project that used to get/set (read/write)
the Win-GRAF PAC'’s system time. Follow the steps below to complete this demo program.

2.1.1 Creating a Template Project (Demo01)
1. Run the Win-GRAF Workbench (refer the Section 1.2), and click "File / Add New Project..." from the
menu bar.

I Win-GRAF

IZIEN View Tool: Window Help
Hml Mew Project Lizt...
Cpen Project List

_IJ Add Mew Froject... \
Add Emisting Project

2. Click “From template” to create a project from a template, enter a project name (e.g., "Demo01") in
the Name field and add a simple note in the Comment field, then click "Next". By default, it will
show a "ICPDAS_template" option provided by Win-GRAF Workbench, just click "Next" to continue.

B Project wizard [Z'
@ Project

ML Import
Q Library

'ﬁ: Autamation zcript

Creates a new project using a template

Recommend to use the default folder.

Mew project
Deztination folder ; | C:WwWin-GRAF\Projects w | Browse. ..
Marme: | Demaoll |
Comment: | Test Demo |

| Newt ‘{[ Cancel || Hep |

Template: ICPDAS_template 4 |

[ Previouz ] [ Ne:-:tkl [ Help ]
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3. Now, you have created the “Demo01” template project.

Win-GRAF - Demo01

File Edit View Inmrt Project Tools Window Help

ﬁ Exception programs

- [J Programs

; |_%'] PAC_Time [*Get / Set PAC Time®)
E| [ Watch [for debugging)

; - Soft Scope

-4 Initial values

g Binding Configuration

-3 Global defines

fal Wariables

Lo BB Types

Build

Ready

Sl g s AX R o 9 o LGN E GRS A
Workspace Ho selection!
- Ei Demo1

Build/ CrossrefelencesJ Runtime,l Callslack/I BreakDoinlsJ

Digital sampling trace /I Frampt

Hhdl

OFfLine 192,168,255,1:502

0,0

0x0

0,0 100% @&

Note: Inthe demo01, we use a “From template” way to create this project. If you select "Project" in the

step2, click the "Release" in the “Compiling options" setting. The others setting can be done in
the following sections, just click "Next" and then "OK" button to end the settings.

“PAC IP:502”,

See Section 2.3.5

Settings
Programs
Langvage: | LD: Ladder Diagram
Compiling options
() Debug
Communication options
|
Settings: 192.168.71.19:502 l'Y
Protocol: [ T5 Runtime )
Other
Edit initial valves with the Recipe editor

< F—#(B)

F—2w-] |

SERR

] [ A

]
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2.1.2 Important Project Settings
There are two important settings must be done after creating the project.

1. In the "Workspace", mouse right-click the project name (e.g., "Demo01") and then uncheck the
"Alphanumeric Sorting" option (the last one). If unchecked, means the programs are in execution
order ; If checked, means the programs are in alphanumeric order (e.g., FBD1, LD1, ST1).

Work=space

= | M Cucle...
L Communication Parameters. . Conbigaraton...
-G | #B1) On Line Libraries...
: e E Eumulate o . -
e 75 Buid Project
L~ Clean Froject
settings. .
Alphanumeric Sorting < v | Alphanumeric Sorting \

Workspace Workspace

5] FED1
Unchecked, Checked,
In execution order In alphanumeric order

Change the execution order of programs:

Note: If you want to change the execution order of programs, mouse right-click the project name
(e.g., "Demo01") and click "Cycle" (as the screenshot above) to open the settings window,
then click the "Move Up" or "Move Down" button to change the order.

| Enabled | Period | Phase |
1 0
1 0
1

2. If using the "Project" way to create a new project (in this example, we use the “From template” way,
refer the Section 2.1.1 - Step 2), click the"Project" > "Settings..." from the menu bar to open the
"Project settings" window. Click the "General" option and set the "Complex variables in a separate
segment" to "Yes" to allow the using of complex data structures, such as arrays. Finally, click "OK" to

exit the window.
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FEes Tool: Window Help
Enild 411 Projects Fi
Clean A1 Frojects

¥ LDownload All Projects...

Sethings...

(& 21 [ F

CWin-GRAFProjectsiDemo0 1

| M ame | Walue
Runtime # Commurication parameters 192.188.255.1:502
Compiler

Dehugging i E_I,II:|E t"TIE ]
Advanced [ Code Generation
(Al [H™ Comples variables in a separa

= 0On Line Change Disabled

EIE Yersion WE - 201402425 1217
o) Libraries Edit...

S Use external objects Edi...

Enables complex data such as arrays of struckures, This option is

Lirne consuming.
Zancel

(Note: The "Code Generation" must be set to "Release".)
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2.2 Introduction of the Project

2.2.1 DemoO1-LD Program
This program is used to read/write the Win-GRAF PAC's system time. In the Workspace, double-click the

LD program name (i.e., “PAC_Time") to open all relevant windows. As the screenshot below, the
Program Area has three main parts:

File Edit WView Insert Project Tools Window Help

Program Area

AN BE AN RN SE-Rh= T wHOI At € AR g Al
2l DemoD1 I : ! A °F Mame | Type | Dir
[ E=ception programs R cetour.. e ThE S L _] PAC Time (*Get f Set PAC Time #
e I - A = - ~ Inst_TIME_GET Time_Get
3| AL Time [“Get / Get PAC Time?) vaar|Pac vesr N Inst_TIME_SET Time_Set
o (SR e e il y B N 5 ¢ Global variables
W Soft Scope Marth | PAC_Morth Bl
= Iritial values I - FAC_Month DINT
%3 Binding Canfiguration 4| | Dy | PAC_Day PAC Day MINT b
jg Global defines b .
{2} Waiables | whiay | PAC_visekDay ] B. Variables
B Tupes [ [Used) Area
2 | Hour |-PAC_Hour 3 [Project)
-H 1 Advanced
| Minute | PAC_hirute 3 Aiithmetic
HeS w [ Araps
o) [ A. Program Editor | 43 meas s C. Function
Note: , means the Build Area (LD) BBl Area
program is locked and
cannot be deleted. ] : _ ——
4 ¥ | Build Cross references Runtirme Call stack EBreakpoints Digital sampling trace Frompt HbAl
Ready OffLine 192.168.255.1:502 £ 0,54 261 x 18 0,0 100% | gy

Tips: Mouse click the Program Editor Area, and press the "+“ or “-” key to zoom in or zoom out the

content.
Inst_TIME_GET R1: Gete.. HTIME_SET I

R1: et current .. fEn TIME_GET E... |

Current tim...
Year-PAC_rear

Current time of th...
Year |-PAC Y gar Mo, | FAC_Month

PAC Month Cray|-FAC_Day
Mertn| PAC Mo | (E.g., press "-” key twice to

] FAC_Wieek...
zoom out the content.) R M

PAC_Da
iy —DaY Hourf- FAC_Hour

wyDiay PAC \WeekDay q Mi.. .} FAC_Minute

Se. PAC_Second

Haour |-PAC_Hour Set_nem ti..
TIME_SET |

new time ...
new fear rear

Minute | PAC_Minute

A. Program Editor Area (LD):
This area allows to edit or display this LD program, you can click the object button (on the left of
Program Area) to add a program, and then drag-and-drop variables (in the Variables Area) onto the
function block one-by-one.

Win-GRAF User Manual, V 1.07, Apr. 2018 by ICP DAS 2-5



R1: Get current time of the PAC

Inst_TIME_ET
En TME_ET Eno

Year

honth

Dray

weliay

Hawr

Mlinute

Second

Current time of th...
PAC “ear

PAC_Moarth

PAC Day

PAC WeekDay

PAC_Haur

PAC_Minute

PAC _Second

R2:

Set “Set_new_time” to “True” to set the new time

Set_new_fime

o\

niesey time far the P
newy_Year

nesy_honith
neswy_Day
nesy_Hour
newy_Minute

newy_Second

Inst_TIME_SET
Set TME_ZET @ |

Year

fdarith

Day

Hiaur

Idinute

Secaond

R3: Reset it to “False”

B. Variables Area:

Note: You can press the SPACE bar
to change its type (/, S, R), and
press the F1 key for more details.

Set_new_time

R'\I

This area shows the function blocks and variables that used in this program. Mouse double-click the

“Name” or “Type” item to modify its name or data type, then click “Enter” to complete the setting.
(Refer the Section 2.3.1 for the details about variable declaration.)

M ame | Type

Dim. |

Attrib. Note: For the function block can work correctly, the

| FAL_Time ["bel 5 oel FAL

Inst_TIME_GET  Time_Get
Inst TIME_SET  Time_3Set
fat Global variables

PAC Year Dl

PAC _Muonth O | BOOL

PAC Day D |BrTE

PAC WeekDay D

PAC Hour b I[:;fDHD

PAC_Minute Ol unr

PAC_Second D LrEAL
< LwiaRD

C. Function Blocks Area:

Time™)

“*  “Inst_xxx..” FB instance variable will be automatically

added when using one function block. For the safety

reasons, this FB instance variable will not be automatically
= deleted even if the function block has been removed in the
editor area. So, users can right-click the unwanted variable
and select “Clear” to manually remove it.

Inst_TIME_: - .
&4 Glohal FB instance variable

LED L
o e & Cut

"u . Copy
TIME, =

TIME_

Cd Maths | % Clesr\

£

In the “Blocks” tab, it provides many types of the function block for users to drag and drop them to

the editor area.

- = - = =
’,/ \\\,__l BACHet
-~ N1 Booleans
En DAY_TME Eno | =3 GaMbus
(B | Eﬁ.ﬁqeen
Clock:
SEL at | Tips: —

Sl D2y TIME [*Get current day and time
DTAT [*Pulse at a datetime?]
T} DTCURDATE [*Get curent date stamg

BN CURDATETIME [FGet curent date
4 ’ Sow list [efine EM LI

After selecting the function
block, press “F1” key to open
the HTML Help.
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2.2.2

Demo01 - Variables

In the workspace, mouse double-click the “Variables” item to open the Variables window. The following
screenshot shows all the needed and defined variables in this “Demo01” project.

= H= 3 x — O & N e AR G & EA
2 DemoD1 l S Mame | Type | Dim. | Attrib. | Syb. | Init value | User Group | Tag | Description
[J Ewception programs PAC Year \ DIWT ] Current tirme of the PAC -
3 Pragrams PAC_ Maonth DIMT ]
“He] PAC_Time [*Get / 5... PAC Day . .
[ “watch [for debugging) PAC WeekDay Click it to sort by name.
& Scoft Scope PAC_Hour
= Initial values PAC_Minute DIMNT ]
%4 Binding Configuration PAC Second DIMT i
s g Global define new_Year DIMT ] new time for the PAC
Wariables fesws_Manth DINT [
new_Day DIMT [
new_Hour DIMT [
new_Minute DIMT ]
new_Second DIMT ]
Set_new _time BOOL | Set TRUE to set new time

=l RETAIN variables
_] PAC Time (*Get / Set PAC Time®)

L R e = P P Py

< ¥
4 ¥ | PAC 'I'|m

Tips: In the Variables window, users can click any title field (e.g., “Name”) for sorting.

If you want to go back to the original sort order, mouse right-click anywhere and select the

“Cancel Sorting” option.

Cancel Sorting \
Al Epshle Changes Space

Swap Flobal <= Eetain

Field description: (Press the “F1” key to look up the details)

Mouse double-click any field item to set or modify the data.

Name:

Type:
Dim.:

Attrib.:

Syb.:
Init value:

User Group:

Tag:

Description:

A valid variable name starts with a letter (e.g., "Ato Z" or "a to z") followed by any
number of letters, numbers (e.g., "0 to 9"), or an underscore (i.e., “_").

Data type. (Refer the Appendix A for the value range)

To specify the range of an array.

(E.g., enter “10”, means the use of the Counter [0] to [9]).

Double-click this field item to set it to “Read Olny” that means users can only read this
variable but cannot modify it.

If checked, the variable name will also be downloaded into the PAC.

To set the initial value of the variable.

All the variables can be divided into some groups (e.g., “Groupl”, “Group2”) and it is
convenient for users to look up or search these variables.

To enter a nickname for the variable.

To enter a simple note for the variable.
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2.3 GiveitaTry

As mentioned before, we have described the LD program (Section 2.2.1) and variables (Section 2.2.2) in
the "Demo01” project. The following sections will show you how to declare variables and add an LD

program with the blinking function in this project.
Note: All the Win-GRAF PAC does not support the “ULINT” and “LWORD” data type.

2.3.1 Declaring the Win-GRAF Project Variables
First, we will declare two boolean variables (i.e., "LED1" and "LED2") that used in the program.
1. In the “Variables” window, mouse right-click any item in the “Name” field and select “Add Variable”
1k

(or press the "Ins" key or click the tool button) to add a variable.

(S9N E AR S 5 eA

Variables

I Mame | Type | Cim. | atib. | Spb. | Initvalue | UserGroup | Tag | Description
o Global variahles ~
PALC Year &) | Undo Current time of the PAC
PAC Month
PAC Day
PAC WeekDay | ® =
PAC_ Hour 23 Comy
PAC_ Minute ]
PAC Second % | Clear
hew Y ear 3 Edi new time for the PAC
neswy_Month
new Day Cancel Sorting
new_Hour A Enable Changes Space
new Minute -
= Surap Global <= Retan
new _Second

1 Add Variable \ Lns Set TRUE to set new time
=l AN var £d4 Multi Variabl..

2. Double-click the new “NewVar” item and change its name to “LED1”, then click “Enter” to finish the
setting. In this case, the data type is "BOOL".

oet _new time BOOL ] et TRUE ta set new time
Pl eads e =Talal ]
LED1

Note: The settings will be done only after clicking the “Enter” key.

3. Follow the previous steps to add the “LED2” boolean variable.

Set new time BOOL ] Set TRUE to =et new time
LED1 BOOL ]
LED? BOOL L]

lml RETAIN variables

Tips: To set up multiple ordinal variables, enter the name “LED” (as the step2) and then press “Ctrl+C”
and “Ctrl+V” twice to create “LED1” and “LED2” (auto sequential numbering), finally, delete the
first variable (i.e., “LED").
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Tip #2:
1. If you need to add multiple variables (e.g., “Boo_01 to Boo_16"), simply right-click the “Global

variables” and select the “Add Multi Variables”.

Workspace I variables

=- d Test_01 P Name
i)~ [3 Exception programs a o
£ [ Programs il RETAIN variables | |
. ] Main ' _1 Main Mouse right-click |
= [ Watch (for debuggi... ? 2 pOnBadindex
- Soft Scope ? 8 pOnDivZero | | Eoste \
- 24 Initial values _1 pShutDown | 5| Clear \
-8 Binding Configuration _] pStartup | i Bt
.. 3g Global defines | =5
; Y Wariables Cancel Sorting
1o Add Variable Ins
¢ W Add Multi Variables... \ ‘
: | "% | 10 Drivers | Valiables./‘i Edit Variables as Text... I

2. Follow the settings like the figure below (Name: “Bool_%%"; Type: “BOOL”; From: 1; To: 16) to
create Boolean variables (i.e., “Bool_01" to “Boo_16") and then click “Create all” button to complete
the settings.

Creation of N variables

Name IBooI_ZZ I
Type BOOL VH__] I Cancel l\

Group Global variables v I [ Help ]

[(JRead only Dimn. 0 A []

[From 1 To |16 \]

Overview

Creation of 16 variables :

From wvariable Bool_01 to variable Bool_16

I Mame | Type | Dim. | Attrib. | Syb | Initwalue | User.. | Tag | Drescription

52 Global variables ~
Bool_01 BOOL O
Bool_02 BOOL O
Bool_03 BOOL O
Bool_04 BOOL O
Bool_05 BOOL O
Bool 06 BOOL O
Bool 07 BOOL O
Bool_08 BOOL O
Bool_09 BOOL O
Bool_10 BOOL O
Bool_11 BOOL O D
Bool_12 BOOL O
Bool_13 BOOL O
Bool_14 BOOL O
Bool_15 BOOL O
Bool_16 BOOL [l v

4 | )

m Wariables
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2.3.2 Declaring the 1/0 Variables

In this example, the [-8055W module that used to show the blinking feature must be plugged in the

PAC's slotl. So, we need to add an I/O link to correspond to the real I/O module.

1. Click the "Open 1/0s" tool button to add an 1/0 link.

File Edit View Insit FPooject Tool: Window Help

Sl 3 42X o 9c =2lghne dm s Ba

2. Mouse double-click on "Slot 1” and then double-click the "i_8055" to select this I/O board.

N

EEEE 140 Boands

Librany: Device:

i_B046_DI (*I-8046W (16-ch D) *

[ETI i 8046 _
ICP DAS - %PwP-H| |i_8050 (* [-8050% (16-ch configurable DIO) *)

Srandad 78051 _DI (*1-8051 W (16-ch D) %)
anear 78052 DI (*1-8052W (8-ch D/T) %)

i_8053_DI (*I-8053W (16-ch D) *

8054 (% 16054

ch DVT 4+ 8-ch Ditn %)

i 8056_DO (*1-8056 W (16-ch DAJ)

i_B057_DO (* 8057 W (16-ch D) *)

i_B058_DI (*I-8058W (5-ch D) *)

i_8060_D0O (*I-3060%W {B-ch Relaor outputs) *

[

I1E

[-B055w

8-Ch Digital Inputs + 8-Ch Digital Outputs

o 01,2013
ICP DAS | Taiwan

3. Click the “Close” button to exit the “I/O Boards” window.

Note: Click the “Virtual/Real” button to change to the Virtual I/O (for testing) or the Real I/0.

(The Real I/0 is used in this example).

EEEE /D Boards

Select

Fename

[

Properties

1 (i 8085 DO

Yirtual/Real
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After linking the “i_8055” 1/0 board, it will automatically add 8 input & output variables in the
“Variables” window.

T Mame | Type | Dir | Atk | Syb. | Initvalue | UserGroup | Tag | Description
LED1 BOOL O] »
LEDZ2 BOOL [l

[l RETAIN variables
B %0¢1.0-i 8055 D

Telr1.0.0 BOOL Input O]
%lx1.0.1 BOOL Input O]
%l¥1.0.2 BOOL Input O]
%1¥1.0.3 BOOL Input O]
%lx1.0.4 BOOL Input O]
%l1.0.5 BOOL Input O]
%lx1.0.6 BOOL Input ]
%lx1.0.7 BOOL Input L]
B %0x1.1-i 8085 DO
TCIA] 1.0 BOOL QOutput [
% K111 BOOL QOutput [
%0112 BOOL Output [
%113 BOOL Cutput [ |
%0114 BOOL Output [
%K1 1.5 BOOL Output [
%K1 16 BOOL Cutput [
%CIK1.1.7 BOOL Qutput [ v
< »
4 ¥ | PAD Tlm
%1X1.0 —i_8055_DI %QX1.1-i_8055 DO
“I” means “Input” “Q” means “Output”
“X” means “Boolean” “X” means “Boolean”
“1” means “Slot 1” “1” means “Slot 1”

%ID or %QD

“D” means “Integer/Real”

There are three output variables are used in this example, and you can modify the name for easy use.
Mouse double-click the item and fill in a name, then press “Enter” key to finish the setting.

B %011 - 8055 _DO B %011 - i 8055 DO

241 10 Slalal Output %@t 1.0400tputt |BOOL Output
Outputl \ Output |:> % 01,1, 19 0utput? |BOOL Output
11,2 BOOL Qutput %@t 1.2400tputd |BOOL Qutput
%QK1.1.3 BOOL Output %1 1.3 BOOL Output
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2.3.3  Creating an LD Program
In the “Demo01” project, we want to create a “LD1” program to show the blinking. To begin, follow
these steps:

1. Inthe workspace, mouse right-click the “Programs” folder and select “Insert New Program...”.

Workspace PAC _Time

B .1_|.| Demoll
l ----- [[3 Exception programs

D ij Eename... F2

e EE] PALC
5[ Watch [fo [ Dnzert New Folder

o ot 0 IgsertHewPngIﬂm..\
3

------- =4 Initial vl Shortouts
"""" % Binding Ci Tt Mew Ttem...
....... g Global del

2. Fillin a program name in the “Name” field and enter a simple note in the “Description” field, and
then select the “LD — Ladder Diagram” as the programming language and click the “OK” button.

New program [‘5—<|

Properties |Advamed | Descrintion |
Program
Name: LDI |

Description; |El]jnl<jng |

Programiming language

BFC - Sequential Function Chart - Grid edior

SFC - Bequential Function Chart - Free form editor
a.2073

aT - Sh'w:tu.red Text
IL - Instrocton List
PACEML - PACEML State Machine

Execution stle

(®) Main program
() Bub-program
() UDFE (User Defined Function Block)
Child 3FC program
Child of: | v |

ek~ | O | W

3. Double-click the “LD1” program to open the editor window.
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4. Clickthe “Insert FB..” button on the left of the “LD1” window to add a function block.

File Edit ¥iew Inset Project Tools Window Help

T (N2 (R IR E s 0 (o o &N E QR G A

Workspace
= .|_|l Demoll T A °F Mame | Type | Dim
----- 3 Exception programs L = 1 LD1 {*Blinking™) »~
£ [ Programs
558 PAC_Time [Get / Set PAC Time®] || ¥ Tips: B
5] LD (Blinking?) il y
- Watch (for debugging) You can also drag and drop
am Soft Scape the “BLINK” function block v
------- o Initial walues i . « ”oa |
------- %4 Binding Corfiguration into the “LD1” window. -
------- g Glabal defines ol =
------- it wariables “ ~ e e B
....... B Types » | ~ [ [Project)
y 3 ToPIp ~
IR [ Text buffers
= = [ Timers | v

<> t PAll: Time \f‘afiab'e BLIME [*Blink zignal ge...
BLIMNKA [*&symetric blin...

PLS [*Pulze signal gene...
SIG_GEM [*Signal gene...

click the “OK” button. e e - b
< Spulist | Define | ENUM

* | R ] S| =

!
[ K

- AN

5. Double-click this function block and select the “BLINK”, then

AVERAGEL [*Running average [LREALT *

9 | | TF BACHMETFMTDTYPES [*Set BAChet device types fomatting”]

i I} BACNETFMTMHAMES [*Set BACnet objects name formatting®)

I 1} BACHETMASMASTER [*Read/wfite Mas aster parameter®) 3
3 I BACMETOWERRIDE [*Set BAChet OVERRIDE flatl
3 B 1} BACHETSETFLAGS [*Set BAChet flags [obsolets M

| BACMETSLAVE [*Controls the BAChet MS_TF' Sl You can press the “BL” key

HiCH BACMETSTATE [*Current BAChet taken ring ztah i !
b {1} BCD_TO_BIN [BCD to binary canversion’] to quickly find out the name.

P | IF BIN_TO_BCD [*hinary ta BCD conversion®)
4 % | FAC Time | ‘ariables | LD [

BLIMKEA [“Asypmetric blink signal]
CANRCWMSE [*Recee CANbus meszage®)
IF CANSHNDMSEG [*Send CAMbuz message?]
TTF CHAR [*Build characker)

CHP [*3 output comparizon®)

ti CONCAT [*Concatenate strings™)

S S T EMITE O O O e leiLT L L L

Mb Inpuks: I:I [ o] 4 % Cancel

3 -
R1 |

o FIIECE \
JU1

CYCLE Tips: (Refer Section 2.2.1 - B)

Click the upper area, to change a FB instance variable.

Click the lower area, to change a function block.

y
.
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A Important Notice:

When programming, users may copy & paste an existing function block to create a new one. But,
this way will cause a function exception due to the same function instances. Therefore, users must
create a new name for the function instance.

1. Mouse double-click the function block and enter a new name (e.g., “Inst_BLINK1”), then click the

" button to complete the setting.

LD _test* B X
|

| 0 i)

- - AT Name | Type |
R1 -'”" .y || B LD test —
Inst_BLINK blink —
= fa} Global variables v
| S 2

R2 ENFT B
34 [Used] m
% Tft_l [ [Project) 5
#3 Varisbles: [all] Y i—" ;ltr-gl_‘?ﬁ'_‘._s ;S_D""'S'A 1 ;Dei'“_e’liﬁi“:l:'}i’;

=) Inst_BLIME =

=0
B LEDT v
Wariables: (all] v

[] Local varables only
[ Hide FB instances

2. In the “Inst_BLINK1” window, click “Yes” to create this function instance.

Inst BLINK1

This symbol does not exist. Do you want to:
Fenamsa the vanable

(3) Declare a new variable

Type:

° Where:
Yes

[ No ] [ Cancel ]

You can also use the same way to
double-click on the right-side of the
“Coil” to create or assign a variable.
(See Step7)

'@ Ca ~

@ 3 ([Used) —
¥l @ G (Projectl ¥
2 |4 %] Blocks  Sovlist | Define | ENUM
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6. Click the “Coil” on the right of the “BLINK” function block, and continuously click the “Insert Coil”
button to add four “Coil”.

k3 —

I In=t_BLIMK =l

| R RUM BLINK [=] &

lge! i
- | Jovele

'»
L Tips: Press the “+” key to zoom in the content.

0 Press the SPACE bar to change the Coil type (/, S, R).
LDJ | E
» | inst_BLINK~ §

R1 RUN BLIMK Qe
I “ﬂ
JoveLE

7. Mouse double-click the first “Coil” and double-click “LED1” to assign it. Follow the same way to
assign the “LED2” variable to the second “Coil”.

A 5F Mame

E3 —d
e LEDT v X
] R1 FLr BLIME o] - | |
4 Tt \ | #2 Variables: (2l ~
— | I [ Inst_BLINE.
| | & =
4 B LEDZ
I . = By new Day
By new Hour
i u By new_Minute
gl By new_Month
B new Second ¥
= —— )=
i Wariables: (all v
-
[] Local warisbles anly
HICH — []Hide FB instances

8. As the screenshot below, mouse drag-and-drop the “Outputl”, “Output2” and “Output3” variables
to the 3th, 4th and 5th “Coil”.

A 5P Mame | Dir

I & | Type
4 Leon =l LED1 BOOL &
L RUN  BLNK G LEDZ BOOL
=l RETAIM variables
: m LED? B %0x1.0 - i 8055 DI
e L dovLE =T T T~ |E %01 - 8085 DO
e 1.0=0utput! BOOL
i1 %11 1=0utput? BOOL
0 S QR1.1.2=0utputs BOOL .
g %01 1.3 BOOL
O ] 4 ™l I
I
3 | < | >
5 3 ) ~
I 3 [Used)
HiH ] . [ [Project]
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9. Mouse double-click on the left of the “CYCLE” and enter “T#2S” (to blink every two seconds), and
then click " to finish the setting.

— m LEDZ
| \CYCLE |
FaE1.1.0
! |T1¢25 v Ottt
1
O |4 Variables: [al] A !
= w0 Inst_BLINK = %O@;; o
By LEMM 1
¥ By LEDZ b
D FiRIsl nRII z %G}{1 1 2
=3 : Outputa
|'\-’ar|a|:||es: [all] W 1
HICH | X b
[] Local variables only
= []Hide FB instances

£

4 |
4 FAC Time “wariables LD1

| W

10. Finally, click the “Save” button to save the “LD1” program.

[ Win-GRAF - Demofl Q

File Edit ¥iew Insert Project Tools Window Help
T & 66X 090 & HaNEAE & RBA

WorkepaceX L 11 £

-2 Demo1 - A Mame | Type | Diirn.
5~ Ewception programs L Inst_BLINK e £ LEDZ . BOOL "~
[ Programs RUM. - BLIMK o 1 =l RETAIN variables
@ PAC_Time [“Get / Set.. Ll _ 1 P ETShE i_8055_D|
#5d] LD [*Blinking®] = nn LED? o B %011 - 6055 DO
- Watch [for debugging) T#25 | cyLE ] %x1.1.0=0utput!  BOOL
o Soft Scope WK1 A0 %G1 1 1=0utput2 BOOL B
o [ Initial walues o Output] %1 1. 2=0utput3  BOOL v
Wi Binding Configuration 0 — < | 3
sg Global defines Il FBEIRT 11 T_j 0 = A
5} Wariables Oulput2 A Used) m
B Types 4 el 1 2 3 (Project]
pe Output3 1 Advanced
. [ Avithmetic
_in v [ Arrays w
[ | > 4 % Blocks Sovlist | Define | ENUM
4 F FPAC Time '\f‘aliables
Build 3
4 ¥ | Build Cross references Furnitime Call stack Ereakpoints Cinital sampling trace Frompt HbAl
Ready OffLine 192.168.255.1:502 A 11 1,1

Note: “2” means this program is opened (locked, cannot be deleted). Click the “X” in upper-right

corner of window to close this program (un-locked, “ ] ”).
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If you want to add a program to the first line after completing the programming, follow these steps:

1. Click the upper-left corner of the Program Editor Area, and you will see the selectable items on the
Object bar. Select an object (4 to 7, as the screenshot below) to add a program to the first line.
Note: You can also select an object (1 to 3) to add it on the left of the current program.

3 ~
LEDH =
\\ R RUM  BLIMK i | |
= || Add a object on the left of the current program: LECZ
—{ | 1. Insert contact before (shift + F4) I
2. Insert horizontal line (shift + space) e
o . Outputt
— | 3. Insert FB before (shift + F8) I
| F@H1 11
i N Output2
55 || Add a object on the left of the program: |
a 4. Insert jump (shift + F9) FlR1.1.2
5. Insert Coil (F9) OutpLt3 I
u |}
HISS 6. Insert new rung
- 7. Insert commecnt line v
LS 2

4k FALC Time ‘JWariables LD 1

2. Inthis case, click “Insert new rung” to add it to the first line.

JE —
I _—
R1
bl —
= LED1
ol R2 RUM  BILINK Q@ |
o I LED2
4 T#2S |CWCLE |
@K1 1.0
! Outputd
l
% !
W@ 1.1
- Output2
l
HHCH '
W@ 1.2
B AN OutpLt3 v
(i) 2.

4k FAC Time ‘JWariables LD1
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2.3.4 Compiling the Program
In the previous section, we have added and saved the LD program. For the Win-GRAF project can
function properly on the PAC, we need to compile the programs. To begin, follow these steps:

1. Onthe menu bar, click “Project > Build All Projects” to compile all programs.

™ Win-GRAF - Demo01

File Edit View Insert B&ma® Tool: Window Help

TR = NE REE RS Euild 411 Projects F7
Workspace Clean A1l Prc:jects\

Diowndoad A1 Projects.

Settings. .

2. If a “No error detected” message is appear that means the project was successfully compiled.
Note: If you modify and save the program after compiling it, click the “Clean All Projects” to clean
the previous results and then do the step1 again.

[ Win-GRAF - DemoO1 =13
File Edit View Insert Project Tool: Window Help
SAR- BE AR= R WEEREND O AR O st e QR g A
Workspace PAC_Time L
=2 Demo0l [ | T Name | Type
----- [ Exception programs In=t TIME GET =l E ] PAC Time (*Get / Set F~
5 Programs _|R1: et currentt f|En TivE_GET Eno | Inst_TIME_GET Time
b B PAC_Time [Giet # Set... Inst_TIME_SET Time
) LD (Blinking? I Currert time of th... B {2} Global variables
. “ear | PAC_Year
I:—jll_j Wwiatch [for debugging] — PAC_Year DINT
8 Soft Scope PAC Manth DINT
o [ Initial values L | Marth | PAC_Morith {'_' = “l ~ .-....;— —
B4 Binding Configuration — m
sg Global defines 3 (& —
fay Wariables | | Day | PAC_Day ) [Llse_d] E
B Types 5 [ [Project]
3 [ Advanced
| wDay | PAC WizekDay £ Aithmetic
HICH [0 Amraps
o Hour | PAC_Hour v [ AS-interface A
50 > 4% Blocks  Soviist | Define | ENUM
Build x
Felocating code.... ~
< Code CRC=d1bdae33 - File CRC=cBebeatf - Size=2384> | Check to see if there is any
error message here. 3
4 ( Build >Cmss redgences Runtime Call stack -
Ready Offline 192,168,255, 1:502 é 0,0 1x1 0,0

Build in progres=... Pleaze \Wait...
C:wwiin-GRAFProjects\Demaoll

Compiler ¥14.3.31.0

»» Complex varables stored in a separate segment

If the Win-GRAF is running in Demo
Loading application symbals... L~ M9de' this me§sage means the

— Vi Win-GRAF project can run for up to
15 minutes on the PAC.

Demo Maode: rn time execution limited to 15 minutes!

4 ¥ Euild Cross references Funtime Call stack
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2.3.5 Download the Program to PAC

Before downloading the program, you need to set up the communication parameters. (By now, it only
supports the Ethernet TCP/IP).

1. Mouse right-click the project name (i.e., "Demo01") and select “Communication Parameters...” to
open the settings window.

File Edit View Insit Project Tools  Window
S R S % Gy X o

Workspace PAC_Tim

= .,_|l Demoll I —|—
..... CH ¢
B I‘jj Comrmnnication Parame ters.
........ #| Cn Line \

2. Enter the “PACIP:502"” (e.g., “192.168.255.1:502") to add an IP address and then click “OK”.

It can also click the D button to add/modify the IP address.
(Note: the default PAC IP is “192.168.255.1” and the fixed port number of Win-GRAF PAC is “502”)

Communication Sethngs &|

Tips: All the configured IP will be listed here. You
can select the unwanted IP and press “Del” key to
delete it (e.g., “192.168.78.8: 502").

Communication Setlings

|T5 Runtime Vl

How to Extend the Timeout ?

If typing “PAC IP:502", the

default timeout is 3 seconds, and

the user can type "PAC IP:502(n)"

to set the timeout as n seconds.

(E.g., "192.168.255.1:502(10)"
means the timeout is set to 10
seconds.)

|'IE!2.1 E2.255.1:502

|1E|2.1EE.?E=.E:5EIE

132.168.255.1:502
192.168.71.19:502

132168 78.58:502

(%) Ethernet TCPAP
A) |P adress: |192.1 £ 255 1 |

Part number: a0

) Serial link
PC port;

Baudrate:
Pariby:

Stop bits:

3. Before establishing a connection, make sure the PAC and the network are working properly.
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4. Click the menu bar “Project” and select “On Line”, or click the Al tool button to establish a
connection.

™ Win-GRAF - Demo01

File Edit View Insert B Tool: Window Help
= e Build AQ Projects Fr
Workspace Clean A1l Projects
=+l Demo01 ¥= | Download A1l Projects
----- [ Exception pro
i Settings. .

....... “Fe] PAC_Tim ¢8| On Line Chl+FS
“oo 3] LD Bl e Simulate\ F5

5. Asthe screenshot, if it shows “App: TEST”, different to the current project name (i.e., “Demo01”),
that means there is a project (name: “TEST”) running on the PAC. Click “Stop application” tool button
to stop the “TEST” project.

[ Win-GRAF - DemoOl
Filz Edit Wiew Insert Project Tools Window Help
SR N N WA NG N St o I & % € A B g (7 | App TEST @{

=t

6. Click the “Download” tool button to download the “Demo01” project. |EIPrgrat

Contme 7

#2| o application

[ %rﬁ‘{[ T |

Contime 7

[ RowR|[_Fw |
N

7. If RUN is displayed, it means that the "Demo 01" project has been successfully executed on the PAC.

- = A B3 i X =l o i & W e A B e (1 A RON G
Workspace Oooo [PAC_Time]
A °F Hame | % alue |
..... TR programs st TME GET E| ] PAC Time ("Get / Set Fa
[—:||_] Pragrams |R1: Getourrent t... HEn TE_GTEno | Inst_TIME_GET
-] PAC_Time Gt / Set... Inst_TIME _SET
) LD [Blinking®] fl Current time of th.. B fat Global variables
[ £ Watch (for debuaging] | Vesp | PAC_ Year = 2014 PAC_Year 2014
o R Sl Scope FPAC Month 4 [
B Iritial values marith |-G honth = 4 PAC Day 7
W& Binding Canfiguratian ] h PAC_ WeekDay 1
- g Global defines FAC_Hour 13
Y Vaiiables | D | PAC Day =7 PAC_ Minute 55
BBy Types PAC Second 23 e
| whap| FAceskb=y =1 | The current time on E —
the PAC is displayed. =
| Houg |-PAC_Hour =13 N
[ Advanced
| Minutg | PAC_Minute = 55 3 Aiithmetic
3 Arrays
[ AS-interface
] w:ﬂ.c_&econd =23 v £ BAChet v
0| Ed < »| Blocks  Sovist | Define | ENUM

4 *| PAC Time, ‘“ariables
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Note: |If there is any error message show up during the download process, refer the Appendix B to get
the solution.

Cycle time
When on-line with the PAC, move your mouse over the “RUN” position on the toolbar to view the

current cycle time of the program on the PAC. You can also view the cycle time in the bottom-right
corner of the message area.

Win-GRAF - Demo01

File Edit View Inmit Project Toole Window Help

7| =¥ By A X =l O A& %N e AR g (5 A RUN Pari| nd @
Workspace o000 [PAC_Ti = yole .
[* Demo01 [RUN ~ M = ' T
i e L e
L3 Exception programs R Gete. [TIME_GET | A Wesdimmmn = 36 A_[
[_J Programsz Bt Ins{ Ovedlow =0
= o I
.ﬂ F'AE_T@E [ Get ... | ‘Year| PAC_‘ear ... Ins Local spplisation:
] LD [*Blinking’] fd ‘(FZEP%C 0196924%?'10&{1?:? 085705
i hda, PAC_hant... =. s
[ :\-"atc:h [for debugging) | | - FA) Taraet application: [
&R Soft Scope N PAY w21 - 0904/2014 - 08:57.05] [
= | | ay _Dray = CRC=16#cifd3172
i :3”_'“;_' "a'E“ESf_ _ PAl REM = 75216 bytes [
J Inding I:.ln iguration | whay| PAC Wesk, . < Elapzed: 15ml3s >
.3g GIDPaI defines R 2
[ﬁj Wariables | | Haurf PAC_Hour ... [ [Used)
B Types _ _ 3 [Project)
| | Mi.. - FAC_Minut... Ca Advanced
| | Se. JPAC_Seco... L Arthmetic
v A o v
- P AC imbarfzrs
< » 4 *| Blocks " Soulist | Define | EMURM
4 ¥ | PAC Time ~ “ariables LC
Demoil - 192.168.71.19:502 »
# | Time | Event description RUM
1 2000/01/01 00:15:21.000  Board ermor in the slat No. 11 Gy e (msy
2 2000/01,/01 00:15:29.000  Board error in the slot Mo, 11 Allowed = 0
3 2000401/01 00:15:37.000  Board ermar in the slat Mo, 11 Maximum = 36

Overflowe =0

Local application:
4 ¥ Build Crasz reference @ all stack Breakpaints Diqital sampling trace Frompt HhAl

When doing the “On Line” ( Al ) operation, it will automatically switch to the “Runtime” tab and you
can see if there is any error message for the downloaded program. (E.g., in this example, we need to
plug the I-8055W module in the Slot1 of the PAC, and the message “Board error in the slot No. 1 !”
means there is no I/0 module in the Slot1 or an I/O exception.)

Shutting down the PAC, and plug one I-8055W module in the PAC’s Slot1 then reboots. Then, click
“On Line” ( Al ) button to connect to the PAC.

Demol - 192.168.71.19:502 »
# | Tirne | Event description RUM

Crycle time (ms):

Last=2

Allovwed = 0

Maximum = 36
Orverflove = 0

Local application:
4 F | Build Cross references Call stack Breakpoint= Digital sampling trace Frompt | HbI
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2.3.6 Testing the Program
In the previous section, you have successfully downloaded the “Demo01” project and the following will
describe how to test the program.

The “PAC_Time” Program:
1. Mouse double-click the variable name (e.g., “new_Year”) in the “TIME_SET” function block (or the

Variables Area) one-by-one to change the PAC’s system time (e.g., to change it as January 1, 2015
12:30:35).

oogoo [PAC_Time]

A F Mame | Walue |

PALZ_Manth 4 ~
| |R2: Set TRUEtD ... Set T T @ PALC_Day 7

PAC WeekDay 1

newy time for the ... PAC Hour 14
. new_ygar = 0| vear PAC_Minute 16
new_Yes PAC Second 41
new_Year 0
] |2':I14 | new_konth
new Day
g [ Force | new_Haur
new hinute
. |

[ (Al

[ [Used)
15 a7 0§34 [Praject] B
OOOOOEEE  EFROFEEFFD ey Advanced

1 24 33 15 |3 Arithmetic

setTRUEW s=tn.| OOO00000 OOOOO0O00 |23 A
[ AS-interface

| | R3 R B [ BAChet w

z 4 *| Blocks Sow list Crefine EMLIk4
4 @ ariablas

2. Set the “Set_new_time” variable to “TRUE” to write the new system time.

Set TRUEto =etn..

| W

3

oooO [PAC_Time]

#||"F Mame | Walue |

Set TRUEto =et n...

Inst_TIME _SET PAC WeekDay 1 -
_|RZ: Set TRUEto ... Zet TIME_SET  Qf— FAC_Hour 14
FPAC_Minute 30
newy time for the ... PAC Second 7
| | nevw _Year = 2015 vear new _Year 015
nea_hlanth 1
| nesw_Month = 1 karth nesw_Day 1
newy Hour 12
nesy_Minute 30
| nesw_Day =1 Day E new Secand 35
Set_new_time FALSE |«
| new_Hour =12 JHaur —‘ | »
Set_new_time X

|3

new_Minute = 30 Minute [ TRLUE ‘\ i1y =

[ FalsE (o))

newy_Second = 35| Second
Set TRUEto set ...

| R3 R —Kl ol
£ | EMUIbA

4 *»| PAC Time  ‘fariables
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3. Then, the new system time will show on the “TIME_GET” function block (or the Variables Area),
and the “Set_new_time” variable will be reset to “FALSE” automatically.

oogoo [PAC_Time]

# | ["F_Mame | Walue |
nesw_Year 2015 ~
nea_hlanth 1

nesw_Day 1
Current time of th... new_Hour 12

LPAC Y =2015 i
| Year _vear nesy_Minute 30

nesy Second 30

e .
Month |-PAC_hartth = 1 q_Set new time
LED1

\ LED2
Day |- PAC_Day =1 LLoeT Al variables

The new system time. |1.0-i_8055_D v
whay |-PAC_WeekDay = 4 — >
[ (&) J_\
[ [Used)

[ [Froject] B
1 Advanced

[ Arithmetic

[ Arrays

1 AS-interface

[ BAChet w
* | Blocks. Soviist [refine ENU;

R Get current t... FER no

Hour |-P&C_Hour =12

Minute |-PAC_Minute = 30

Second |-PAC_Second = 35

4l
4 ¥ | PAC Time  ‘fariablas

£
AEHEEREEHEERE

| %

The “LD1” program:
4. When the “Demo01” project is running, you can check to see if the DOO, DO1 and DO2 tags of the

[-8055W I/0 module that plugged in the slotl of the PAC is blinking every two seconds (like the
value "T#2S” we set before). You can also assign a “TIME” variable on the left side of the “CYCLE”
for easy to change the time setting. Refer the Section 2.3.1 for the setting way.

5. If the “%QX1.1.3” variable is set to “TURE” in the Variable Area, the LED4 (i.e., “DO3”, at the top of
the 1-8055W 1/0 module) will light up.

AN WEY RRET R W, - L & Y € G B e (5 " A RUN AR S n i &
= | DemoD1 [RUN] AT Mame | Walue | Tope
----- | Ewception prograns LED1 = TRUE B8 %01.0- I_BDEE_DI ﬁ
&1 [ Programs RUM. - BLINE B8 %0x1.1 -0 8055 DO
....... “HE] PAC_Time [*Get ... %=1.1.0=0utput! TRUE BOC
3] LD [*Blinking®) m LED?Z = TRLE Y11 1=0utput2  TRELE Bt
[=] 1 W atch [for debugging) | CYCLE 4
- Soft Scope G110
o ] Initial walues Output = TRUE
!!é Binding Configuration H
- 3q Global defines ZETH 0
]ﬁ Wariables OutputZ = TRUE
Lo s Sl 1 2
Outputs = TRUE

K4
| £

< |
4 b FAC Time “ariables L1

| »

6. Click the Al tool button again to cancel the PAC connection.
Note: Do NOT click the “Stop Application” button; it will stop the running project on the PAC.
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Chapter 3 Modbus Slave: Allow the SCADA/HMI Software to
Access Win-GRAF Variables

In Chapter2, we have described how to get/set the PAC system time (i.e., the “PAC_Time” program) and
create a blinking function (i.e., the “LD1” program) in the “Demo01” project. The following sections
describe how to allow the SCADA/HMI software (e.g., “InduSoft”) to access Win-GRAF variables that
defined in the "Demo01" project. The Win-GRAF Workbench provides two ways to open the PAC data,
one way is to enable the Win-GRAF PAC as a Modbus TCP Slave and the second way is to enable the
Win-GRAF PAC as a Modbus RTU Slave (you must first complete all the Modbus Slave settings in Section
3.1, and then refer the Section 3.2). To begin, follow these steps:

3.1 To Enable the Win-GRAF PAC as a Modbus TCP Slave

1. Click the “Open Fieldbus Configuration” tool button to open the “IO Drivers” window.

[ Win-GEAF - DemoD1
File Edit View Inseit Project Tools Window Help

g [N TR SRSy (8 e o ?JéﬁﬁE-ég & " A
Workspace 10 Drivers *
£ & Demodl E MName | value T Mame | Type
|_j Exception prog... || & Bl {2} Global variables #
£ 3 Programs i PAC Year DINT —
-Ma_e’] PaC_Time... B PAC Month  DINT
38 LD [Blirk. || PAC Day DINT
£ £ ‘watch [for de... [n R AT TP CRT
ﬂ Soft Scope E a8 3
o B8 Initial values Q Hame RS
- Big Binding Config.. || &,

-39 Glabal defines
5} Wariables o

BB Types
< | b3
4 FPALC Time “Wariables LDI

Build b4
C\win-GRAFProjects\Demallh
Mo eror detected

4 ¥ Build Crosz references Runtime Call stack Breakpaint= Diqital =ampling trace Frampt HkA|

lready Offline 192, 168,255,1:502 A 0,0 0x0 0,0

2. Click the “Insert Configuration” button on the left side of the “IO Drivers” window and then select the
“MODBUS Slave” and click “OK” to enable a Modbus TCP Slave.

10 Drivers *

= M arme | *alue
= |

Add Configuration

“E E
3 Chooze a configuration
g :

BT
EI MODELS Cancel

- MODEUS Master
3 W\ CDELS Slave

14

4 PAC Time ‘Jariables L1 | 1D Drivers
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3. Click the “Insert Master/Port” button on the left side to set the “Slave number” (In this case, the
value is “1”), and click the “OK” button.

10 Drivers *
S MODELS Slave

M arme | Walue

MODEDSE Slave Protocol

q
Slave number;
g

Bt

Slave numnber | Server D

4 * FALC Time “Wwariables L1 10 Drivers

4. Click the “Insert Slave/Data Block” button on the left side to open the “MODBUS Slave Request”
window.

0 Drive
[B Mg MODBLUS Slave Mame | Walue
& B Slave number 1

- \ Server 1D \
= \ Tips:

b

¥

1. Press the “F1” key to open the Help on this subject.
2. If you add two or more “Server - ...” settings, type a
“Server ID"” for easier use (a string, e.g., 'SVR1’)

FReguest | Address | Mhb Item | Description |

4 PAC Time ‘Wariables L1 | 10 Drivers

5. Enter a simple note in the “Description”  R.lunzliESd EUER g 120 E

4

field and then click the "Input Registers’ Request

option. Description; |Read _value |

\|
N

For Modbus Master to Read data:

Diata read by the master ]
Options Data types Enter a simple note.
- ) Input Bits
Input-bits BOOL o et
Input Registers BYTE, INT, DINT, 6% o
REAL, etc. Diata read or Forced by the master
For Modbus Master to Write data: © Coil Bits
o () Holding Registers

OPTT(:;_‘S 2ELE) 5 Recommend to set

CO| ‘. its BOOL Diata block, ”Base addressn to nln

HOI(.:Img BYTE' INT' DINT' Base address: and set the value of

Registers REAL, etc. N "

. . Nb items” is greater

(Refer the Appendix A to see more data type) Mb items: than “200”.
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6. As the screenshot above, it’s recommended to set the “Base address” to “1” and the “Nb items”
refers to how much variable data can be provided by one “data block”. If the data address requested
from the Modbus Master (e.g., the SCADA software) is greater than this value (in this example, the
value is “2000”), the Modbus Slave (i.e., Win-GRAF PAC) will not respond.

7. Mouse drags all the needed variables (e.g., “PAC_xxx", data type: “DINT”) one-by-one from the
Variables area and then drop it to the “Symbol” field.

IO Drivers *
=M@ MODBUS Slave Mame | Walle “F Mame | Type | Drimn.
El-ﬂ-; Server - Slave nurmber = 1 Fequest  Input Registers PAC Month DIMT ~
I ---“E Input Registers [1..2000] - Fead V4| Address 1 PAC Day DINT
B Nbltem 2000 PAC WeekDay DINT 1
ik Dezcripti... Read Value I—‘AL_Huﬂr LI
E L FAC Minute DINT
_ Symhbal | Offzet | hd azk, | Storage | f PAC Shcond DINT “
PAC_Year 0 FFFF Diefault | s
&5 PAC_Manth 1] FFFF Default Name// | Value |
PAC_Day 1 FFFF Default 7
B4 PAC Hour 0 FFFF Diefaul Plig
PAC_Minute n FFFF Default - -
PAC_Second 1] FFFF Defadt ~ -

-
-

N -
- -
-——
=

*" 4_ _——— -
£ [
4 ¥ FAC Time “Wariables L1 10 Drivers

| "

8. Mouse double-click the “Offset” field and fill in a value, then press “Enter” key to finish the setting.
Note: (1) The “Offset” value starts at “0” and the Modbus address of variable is equal to this value
plus 1 (Base address).
(2) If using a 32-bits (or more than 32-bits) data type (e.g., “DINT”, refer the Appendix A), it
requires two Modbus addresses, as the table below, the “Offset” values are 0, 2, 4, 6, etc.

Suernbol | Oiffset | Mask | Storage
PAC ear 0 FFFF Drefault
PALC_Manth 2 FFFF Drefault
FAC_Day 4 FFFF Default
PAC_Hour 5 FFFF Drefault
PAC_Minute EI FFFF Drefault
PAC_Second 0 FFFF Drefault
PAC ‘wWeekDay 0| Enter FFFF Defauilt

Tips:
Mouse click the “Offset” field and press the keyboard “Ctrl+A” to select all items, and then click the
“Iterate Property” button at the left-side to open the settings window.

5 Symbol | Drfset 4| Mask | Storage
] PAC_vear Drefault
&2 PAC_Marth Drefault
B+ PAC Dayp Default

PAC_Haour Drefault

PAC_kinute Ctrl+A Drefault
C_Second I} Drefault

Drefault

PAC WeekDay
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Keep the “Name” setting, enter “0” into “From” field and enter “2” into “By” field, then click “OK”.

(If the “Name” is set to “%%”, it will show “00, 22,

44, 66, 88, 1010, 1212” in this example. The user
iz * | can modify it depends on the needed settings and
Frorm B 2 2 then check the value in the “Results” area.)

Fiesults 1

Surnbial | Oiffget 4| Mask | Storage
PALC ear 1] FFFF Drefault
FALC_Month 2 FFFF Drefault
PAC_Day 4 FFFF Drefault
PAC_Haur G FFFF Drefault
PAC_Minute a FFFF Drefault
PAC_Second 10 FFFF Drefault

[ ok W[ ca PAC_ weskDay |12 FFFF Drefault

AN

% >

FAC Time ‘JWariables LC1 | 10 Drivers

9. Click “Storage” to select entire columns and then press “Enter” key to display a drop-down menu.
Then, select “DWORD (Low — High)” and press “Enter” key to complete the setting. (If using a 16-bits
or below, it’s no need to set the “Storage” item.)

Symbiol | Difset | Mask | Starage 4| Range [Low]
PAC “ear ] FFFF Default \

PAC_Maonth 2 FFFF Drefault

PAC_Dap 4 FFFF Drefault

PAC_Hour 5 FFFF Defaul

PAC_Minute 3 FFFF Defaul

PAC_Second 10 FFFF b=k

PAC weekDay 12 FFFF 0 | Default A

CwORD [High - Low
CwORD [Low - High)
STRINGIE]
STRINGIE]

FAC Time | “arizbles | LD | 1O Drivers STRIMG[10]

To expand this “Data Block” and you can see the Modbus addresses of all variables. It equals to the
“Offset” value plus 1 (Base address).

10 Drivers *

E 1 MName | Walue
2 \ = +0..1: PAC_Year A equest [nput Reqisters
I = +2..3 PAC_Month Address 1
E 2| +4.5: PAC_Day Mb Item 2000
= 3| +6..7: PAC_Hour Deszcrption  Fead_Walue
E =3 +3..9 PAC_Minute
Q = +10.17: PAC_Second W
. 2| +12.1:3% PAC “WeekDa ot
28 Syumbal | Dfset | Mazk | Storage | Range (Lo
g PALC “Wear 1] FFFF Liw/ORD [Low - High)
PaC_konth 2 FFFF LwfORD [Low - High)
PaC_Day 4 FFFF LwORD [Low - High)
PAC_Haour B FFFF LwORD [Low - High)
PAC_Minute a FFFF Liw/ORD [Low - High)
PaC_Second 10 FFFF LwORD [Low - High)
PaC_weekDay 12 FFFF LwORD [Low - High)
£ [ ¥
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10. Then, we need to add the second “Data Block” for the Modbus Master to read the Boolean data.
This configure way is similar to the step 4 to 8:
(1) Click the “Server - ..."” item and click the “Insert Slave/Data Block” button at the left side to open
the settings window.
(2) In the “MODBUS Slave Request” window, enter a simple note and select the “Input-bits” option,
then set “Base address” to “1” and set “Nb items” to “2000”.

10 Drivers *

E M@ MODBLS Slave
Egx e punmber = 1

5 :
@ -8 InpFegisters [1..2000] - Read_Walue

x

MODBUS Slave Request |

N |

Request

1= ¥

Description: |Read_E!cu3Iean ‘

Data read by the maske)

Enter a simple note

{*) Input. Bits
i) Input Reqgisters

For the Modbus Master to Read data:

[rata read or Forced by the master

Option Data Type
. () Coil Bits
Input Bits BOOL O oding Regist
Input Registers BYTE, INT, DWORD, e
put Reg REAL, LINT, etc. Data black
(Refer Appendix A to see more data type) B it

Mb items: 2000

(3) Mouse drags the Boolean variables (i.e., “LED1”, “LED2”; data type: BOOL) one-by-one and drop
them to the “Symbol” area, and then set the “Offset” to “0” and to “1”.

10 Drivers *
I Elﬂ-; Server - Slave number = 1 A || Name | Walue “F_Mame | Tupe
i Fequest  Input Bits LED BOOL |~
Address 1 0z BOOL | -
Mbltem 2000 /|l RETAIN variables 3
Descrption  Fead Boolean ,(l il ¥
7
| Storage | Rang M ame | Walue
Default P -
Default’ _- -
- S Ik

4k FAC Time ‘Wariables LC1 . 10 Drivers

You have completed the settings for the Modbus Slave. Finally, follow the way below to re-compile
the program and download it to the Win-GRAF PAC.
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11. Click “Project” > “Build All Projects” from the menu bar to compile this program again (refer the
Section 2.3.4). If a message informs you “No error detected” that means this process is successful.

On Line Chanhge iz dizabled ~
[MODBUS-5) [4): PAC Year: “Waming: 32 bit word ardenng not supported by ntime 7.4 and older

[< CT Seagment = 55 byte(z] » ]
<1610z

Relocating code...
< Code CRC=323797fc - File CRC=eb3d0c16 - Size=3672 »

This version information can be ignored.

CrozE references Runtime Call stack Breakpoint=s

Diigital sampling trace

12. Mouse right-click the project name (i.e., “Demo01”) and select the “Communication Parameters...”
to set the PACIP (e.g., “192.168.71.19:502”) and then click the menu bar “Project” > “On Line” (or

Al ) to establish a connection and download this project to the Win-GRAF PAC. (Refer the Section
2.3.5).

File Edit ¥iew Insert Project Tool: Window
AN B2 AN R TRECEECN

Worksnare
fin-GEAF - Demo01

Edit Wiew Insert B3 i Tool: Window Help

EI E]jl Commuication Parameters. A = = | ”l Euild 411 Projects | F?
A| OnLine kspace Clean A1 Projects
e _ E‘m Diowndoad A1 Projects.
o wCeption pro Settings
£ Programs -
"] PaC_Tin| @] OnLinewy | Ctrl+F5
o 2] LDV EBI b Simmlste N F5
SCADA / HMI Win-GRAF PAC
P, = . IP: 192.168.71.19
L&/ InduSoft & j Port: 502
InduSoft << >
O Slave number =1
IP: 192.168.71.xxx WP-5xx8-CE7 WP-8xx8

Mask: 255.255.255.0
Modbus TCP Master Modbus TCP Slave

(Refer the P1-1 to view all PAC models)

After completing all the steps, the HMI/SCADA software can access to all the Win-GRAF variables listed
above via Modbus TCP protocol.
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3.2 To Enable the Win-GRAF PAC as a Modbus RTU Slave

Before doing this, you must complete all the content that described in Section 3.1 to open the Modbus
Slave data. The way to enable the Win-GRAF PAC as the Modbus RTU Slave is to add the “MBSLAVERTU”
or the “MBSLAVERTUEX” function block in the program. To begin, follow these steps:

Add the “MBSLAVERTU” function block
1. Inthe “LD1” window, mouse click the place where you want to add this function block and then click

the “Insert FB..” button on the left side of the window.

1F /_\
3 LEDM -
R
m il |
- I LEDZ
| T#25 | CYCLE |
%EH1 1 0
Outputt
= |
a1 11
! Outputz
> I
el 1 2
= OutpLta

W

4 b PALC Time ‘u‘ariableﬂ Crrineers :

2. Double-click on this function block and select the name “MBSLAVERTU”, then click “OK”.

R2 M & Q |
] I K TF LML [*Matural logarithm [LREALJY) ~
N TTF LOADSTRIMG [*Get a sting from a table®)

TF LOBYTE ["Low part of a word®]

It LOG (*Logarithm [base 10)7)

LOGFILECSY [*Generate log file in C5W formnat®]

IF LOGL {*Logarithm [base 10 - LREALF)

T LOGMESSAGE [*zend a LOG message”)

T+ LOWWORD (*Low part of a double word®)

I+ MAKEDWORD [(*Pack words to double waord®) =
TT MAKEWORD [Pack bytes to ward)

TiES: T MAX (<M aximum*)
“ ” . MEMASTERRTU (MODBUS Master RTUY
Press “MBSL” key to quickly MBMASTERTCP (MODBUS Master TCP)
find out the function name. T} MBSHIFT [*Multibpte skift/rotate?]
11 hiPc] A EINE L =0 = b P

Nb Inputs: I:l I Ok, Q l Cancel
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3. Inthe “MBSLAVERTU” function block, mouse double-click the left side of the “PORT” and enter a
string 'COM2:9600,N,8,1' (it means using the Win-GRAF PAC’s COM2 to communication with the

Modbus Master) and then click

Rz

“ to complete the settings.

Inst_MWBSLAWERTL
.IN MESLAVERTI G I
\ Tips:
> Press the “F1” key on this
'COMZ:9600.8.2.1" v | x function block to show up
ﬁ UariablES: [EI"] e - the related Help.
#--[ Inst_BLINE
a7 Inst_MBSLAVERTL
Oy LEDT
G I FO7 b
W ariables: [all] W
[]Local variables anly
[ ]Hide FE instances

4. Double-click the left side of the “SLV” and then enter “1” (the value set in the Section 3.1 - Step 3),

then click " to finish the setting.

F2

In=t_MBESLANVERTL

'COM2:9500,H 5 1"

Ik WMESLAVERTU & I

R2

'COMZ:9600M 5,1°

PORT
1 Ll 4
#3 Yariables: [all) -~
Lo 4 [ Inst_BLINE
a0 Inst MBSLAVERTU
B, LED1
B FOo ¥
Yariables: [all] w
| N RPN [N N I (R 1t
Inst_MBSLAWERTL I

Ik MBESLAVERTU 2 I

PORT

Now, you have completed the setting of the “MBSLAVERTU” function block, and then re-compile the
program and download it to the Win-GRAF PAC. (Refer the Section 2.3.4, Section 2.3.5)

Note: Users can enable multiple Modbus RTU Slave ports for each PAC (recommend not over 16 Ports),
the way is to add multiple “MBSLAVERTU” function blocks and set the different “Port” value.
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SCADA / HMI Win-GRAF PAC

S = COM2: RS-232
é InduSoft = 9600,N,8,1

InduSoft h—] < >
.

Slave number =1

WP-5xx8-CE7 WP-8xx8
Modbus RTU Master Modbus RTU Slave

(Refer the P1-1 to view all PAC models)
Add the “MBSLAVERTUEX” function block

When using several “Server - ...” settings (recommend to set one) in the “IO Drivers” window, the user
needs to use the “MBSLAVERTUEX” function block.

10 Drivers *

Mare | Walue
a2 irf SErVE Slave number 1
I [+--"E Tnput Hegisters [T1..2000] - Read_Walue Server 1D Syl
E ----“E [nput Bitz [1..2000] - Read_Boolean
1__'-|
Request | Address | Mb Iterm | Description
E Input Registers 1 2000 Read_' alue

Input Bits 1 2000 Fiead_Boolean

=138
4 FAC Time “Wariables LD

1. Follow steps 1 to 4 above to add the “MBSLAVERTUEX" function block. If you want to change the
usage for existing function block, mouse double-click the “MBSLAVERTU” and change it to
the“MBSLAVERTUEX”, and then click the “OK” button.

Inzt RTL

R2 N MESLAYERTL @I |

"COMZ2: 3600 M8 1 JPORT T LOADSTRIMNG [*Get a string from a table®)

TF LOBEYTE [Low part of a ward”)

\ I} LOG [“Logarithm (base 10]%)
LOGFILECSY [*Generate lag file in CSY format)

I} LOGL ["Logarithm [base 10 - LREALF)

T LOGMESSAGE [*zend a LOG meszage”]

I} LOWORD [*Low part of a double word®)

=R MAKEDWORD [*Pack words to double word®)

Function ‘\Af-‘«KEWDHD [*Pack bytes to ward®] =t

[T MAX [*Maximum™]

MBMASTERRTU [*MODBUS Master RTU¥)

MBMASTERTCF [*MODEUS Master TCP¥|

TF MBSHIFT [*Multibpte shift/rotate®]

I+ MBSLAVEIDEMT [*Set MODBUS Slave Device |dentification®]

TZE MBSLAVERTL FMODRIS Slawe BT [zenialls]

Function Block MBSLAVERTUEX [MODEUS Slave RTL [seral]]

| >

1450y

LG g v o iy e gy ) ) ) e ) |

B oo ST Y1 I TR N _WHUT_1 XTI L Lire

b Inputs: I:I [ ok W ] [ Cancel
N\
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2. The “MBSLAVERTUEX” has a “SrvID” setting. Double click the left side of the “SrvID” and enter a
needed “Server ID” (using a string format, e.g., ‘Svrl’).
Note:
Using the “MBSLAVERTU” function block means the first Modbus Slave setting will be enabled.

Using the “MBSLAVERTUEX” function block means to enable the Modbus Slave setting depends on
the “Server ID”.

Inst_MP=1 8WERTL

Rz | MBSLAVERTUEX 2 I
I ——

'COMZ:9800,M 51" JpoRT Tips:

Press the “F1” on this
function block to show
up the related Help.

1450

Inzt_MBESLANVERTL
F2 | MBESLAWERTUER 2 I

CORZ2 9800 M G 1 PORT

1450

~—_

Now, you have finished the settings for the “MBSLAVERTUEX” function block, and then re-compile
the program and download it to the Win-GRAF PAC. (Refer the Section 2.3.4, Section 2.3.5)
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Chapter 4 Linking “I/O Boards”

This section lists the usage of the “I/O Boards” function in the Win-GRAF Workbench to link the Real I/O
modules or to enable other I/O functions. First, you need to know the slot numbering and supported 1/0
modules for each PAC:

Slot No. (from the
PAC Model left to the right) The supported PAC I/0 modules
WP-8xx8 Oto7
Supported:
WP-8xx8-CE7 Oto7 I-8K and I-87K series (High Profile) I/O modules.
XP-8x38-CE6 (*] 0107 (E.g., 1-8017HW and 1-87055W)
Not Supported:
XP-8x48-CE6 (*) 1to7 I-8K and |-87K series (Low Profile) I/0 modules.
(E.g., 1-8017H and 1-87055)
VP-x2x8-CE7 (*) Oto2
The Palm-size PAC which can support one XV board.
(E.g., XV107, XV116, XV308, etc.)
WP-5238-CE7 The XV board is a kind of the Modbus slave I/0 board.
(Refer the Section 5.1.6 to 5.1.12 for using XV-boards.)

(*) : The XP-8038-CE6, XP-8048-CE6, VP-x208, WP-5xx8-CE7 are the 0-slot PAC.
(Refer P1-1 for all PAC models)

Add the “1/0 board”
“I/0 board” refers to the 1/0 functionality in the Win-GRAF (e.g., “i_8037_DO“) and
“I/0 module” refers to the hardware device (e.g., “I-8037W*).

Notice:
Besides the software setting for the 1/0 board, there are some kinds of I/0 modules need to set the

hardware Jumper (e.g., Single-ended and Differential Jumper). So, go to the website to look up the
product information, or the description printed on the module cover, or the attached shipment
document.

I-8K and I-87K series product website:
http://www.icpdas.com/root/product/solutions/remote io/rs-485/i-8k i-87k/i-8k i-87k selection.html

1. In the Win-GRAF, click the "Open 1/0Os" button from the toolbar to open the “I/O Boards” window.

File Edit View Insit FProject Tools Window Help

EE EE IR R AR %@maﬁﬁs@gg'@sﬂl

2. Asthe figure below, mouse double click the slot number that corresponds to the real I/O module
and then select the proper I/O board (e.g., i_8037_DO).

Note: The Slot 0 to Slot 7 are reserved for real I/O modules that plugged into the PAC, and the slot
8 or above are for other usage.
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http://www.icpdas.com/root/product/solutions/remote_io/rs-485/i-8k_i-87k/i-8k_i-87k_selection.html

EEEE [/0 Boards

el o
ICP DAS - XP-WP-VI, |

Standard

1-8037w
16-Ch Digital Outputs

Nov.05,2013
ICP D&S |, Taiwan

§i_8042 (*1-8042W
11_8046_DI (*I-50
11 8050 (* [-5050

] (* Enable one sexial port to connect DCON [/0s ¥) ~
1 Bl]l'i‘I _08ch (*8-ch A/, differential (for [-B017HW, I-B017THCW & . —
11 _8017_16¢h (* 16- ~ch A , single-ended (for I- SUITHW [-8017HCW
I1 804 A * 024W 4 ch A

Select it and to see the
setting description.

Buttons Description: (Click the following buttons to modify the settings)

£EEE 170 Boards

——
i_:z:lilzz:.?_[:uj “
3 |
g | Delete |
? [_Rename ]
1% | Yirtual/Real |
:
z
i T
17 \—

“Properties”:

“Virtual/Real”:

“Move Up”:

“Move Down”:

IIHeIpII:

Look up the usage of this I/O board.

Swith the /0 board to a Virtual I/O (for testing) or a Real I/0O. (Hot Key — “

Move up this I/O board.

Move down this

I/O board.

To see the description on “1/0O devices”.

“Close”:
Close this window.

“Select”:

Open the I/0 selecting window.

( Hot Key - “Enter”
Hot Key - “ESC” : to exit)

“Delete”:
Delete this I/0 board.

“Rename”:
Rename this I/0 board.
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4.1 DI/DO Boards

Here use the "I-8055W" as an example, users can refer the Chapter 4 (P4-1) to add this I/O board.

1. Double-click the “i_8055_DI” (or the “i_8055_DQ”) to open the “Properties” window.

Note: A mouse-over showing the details on the “i_8055_DI” (or the “i_8055_DO”).

£EEE 170 Boards

Kéy=6

Ref=16#80554
Reserved0=0

Reserved1=0

Reserved2=0

Reserved 30

8055 - Pmpert-i;as 7

Key=
Ref = 16450554

Reserved0 =0
Reservedl =0
Reserved2 =0
Reserved3 =0

I-8055w/

Setting Description

8-Ch Digital Inputs + 8-Ch Digital Dutputs

MNow.01,2013
ICP DAS , Taiwan

2. After linking the “i_8055” I/0O board, it will auto add 8 Input and 8 output variables in the
“Variables” window that can be used in the program.

Variables BEX
“F MHame | Type | Dim. | &b | Spb. | Initvalue | User Group | Tag | Description
LED1 BOOL ] ~
LED2 BOOL ]
H_QET,MM e pimlle
= B8 %1.0-i 8055 D +—IZ|> %IX1.0—-i 8055 DI
Tl 0.0 BOOL Input . -
%161 0.1 BOOL pat [ %QX1.1-i_8055_DO
delbs) 0.2 o0l Ll “I” means “Input” “Q” means “Output”
%0¢1.0.3 BOOL
%0104 BOOL O “X” means “Boolean” “1” means “Slot 1”
%lx1.0.5 BOOL O
%IX1.0.6 BOOL O Note:
o,
= 21;;><1_1 - i_BDESBSI = Double-click this item to modify the variable
T T =TaI8] N Output [ name and click “Enter” to accept the setting.
SK1.1.1 BOOL Qutput [
Y1 1.2 BOOL Output [ B %0K1.1 -0 8055 DO
%0113 BOOL Output [ : =Talal Output
%0114 BOOL Cutput [ ( |Dutput1‘) || Olutput
20115 BOOL Output [ . <
%QX1.1.6 BOOL Output  [J Allal 1.2 BOOL Output
%QX1.1.7 BOOL Output [ Hllx1.1.3 BOOL Cutput
4 —
4 » FALC Time Wariables
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4.2 i_scale (Conversion Table)

The “i_scale” function can set up to 29 scaling functions to convert values for the Al or AO module that
plugged in the slot 0 to slot 7. See the Chapter4 (P4-1) to add this I/O board.

1. Mouse double click the "i_scale_0" (or "i_scale_1" or "i_scale_2") to open the “Properties” window,
and then to see the setting description.
Note: Using the slot 8 or above No. because the slot 0 to slot 7 are reserved for the real /O module.

§§6¢ 170 Boards
-

|Key=6

Ref = 16#24
ChO0_X0_reserved =00
ChO0_X1_reserved =00
ChO0_YO0_reserved = 22

)|

QO = |0 O (LD (D | O

9 scale ChO1_X1 Max Physical ¥al=00 Ch01_X0_Min_Physical Val
ChO1_YO0_Engineering ¥al For X0=00 0.0

Ch01_Y1_Engineering_¥al For X1=00

—_1 iscale ] ~Ch02—X0— M Physical—Val =11
— 2 i_scale 2 Ch02_X1 Max Physical ¥Yal=00
10 Ch02_YO0_Engineering ¥al For X0=00
11 Ch02_Y1_Engineering Yal For X1=00
12 Ch03_X0_Min_Physical ¥al=00
|Ch03_X1_Max_ Physical ¥al=00 . A ¥
13 : — — Setting Description ==
14 2

e scaling function No. 01 to 29 for scaling 1/0 variables .

ting both value of Ch_X0 and Ch_X1 to 0.0, it means the relative scaling function No. is disabled.
X0 is greater than or equal to Ch_X1, the setting is wrong. ,,

|2 2

Parameters: (“Ch” means the Ch01 to Ch29, "Ch00” is a reserved item)
Ch_X0_Min_Physical_Val: The min. value of Al (or AO) boards (X0).
Ch_X1_Max_Physical_Val: The max. value of Al (or AO) boards (X1).
Ch_YO_Engineering_Val_For_X0: The engineering value after scaling X0.
Ch_Y1_Engineering_Val_For_X1: The engineering value after scaling X1.

2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.
Notice:
1. If set both Ch_X0 and Ch_X1 values to "0.0", it means the relative scaling function No. is disabled.
2. If Ch_XO0 is greater than or equal to Ch_X1, the setting is wrong.
3. If Ch_YO is equal to Ch_Y1, the setting is wrong.

For example, if the Al board's value is 4 to 20 mA and wish to scale as 0 to 10000, then set Ch_XO0 as
"4.0", Ch_X1 as "20.0", Ch_Y0 as "0.0", Ch_Y1 as "10000.0".
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For example, if the AO board's value is -10 to +10 V and their respective engineering value is
-50 to 1200, then set Ch_X0 as "-10.0", Ch_X1 as "+10.0", Ch_YO0 as "-50.0", Ch_Y1 as

"+1200.0".
0.0: i_scale - Properties £
Key=0 -
Ref = 10#24 =

ChoD_X0_rxeserved =0.0

ChO0_X1 reserved =00

ChOD_Y0_reserved = gg

UChOO Y1 reserved =
Chil_X0_Min_FPhyzical ¥al=-100

Cho1 X1 Hax ' Physical_¥al=+10.0

Ch01_¥0 Engineering ¥al For X0=-500

Chil ?1 Enmeerm 1|i"al For X1 =+1.20010

111 B
Ch02 Il Hax Ph]rs;u:a.l "i"al on
Ch02_Y0 Engineering ¥al For Z0=00
Ch02_¥1 Engineering ¥al For X1=00
Ch03_X0_Min Physical ¥al=00
Ch03 X1 Max Physical ¥al=00 bl

3. After linking the “i_scale” in the “I/O Boards” window, it will auto add 30 Boolean variables in the
“Variables” window. When the Win-GRAF connects the PAC, it will display the state of each scaling
function.

True: scaling function is ok.
FALSE: scaling function is not enabled or setting error.

7 MName | Type | Dir. | Attrb., | Syb. | Initvalue | User... | Tag | Description
= B %IX9.0-i_scale D A
%0000  [Eelel Input O
%I1%3.0.1 BOOL Input O
%I%9.0.2 BOOL Input O
%I%9.0.3 BOOL Input O]

%I%9.0.4 BOOL Input O
%I¥3.0.5 BOOL Input O
%I%9.0.6 BOOL Input O
%I%9.0.7 BOOL Input O
%I%9.0.8 BOOL Input O
%I1%3.0.9 BOOL Input O
= B8 %IX8.1 - i _scale_1
%I%9.1.0 BOOL Input O]
%I%9.1.1 BOOL Input O
%I¥3.1.2 BOOL Input O
%I%9.1.3 BOOL Input O
%I%9.1.4 BOOL Input O L]
%I%9.1.5 BOOL Input O
%I¥3.1.6 BOOL Input O
%I%9.1.7 BOOL Input O
%I%9.1.8 BOOL Input O]
%I%9.1.9 BOOL Input O
C B %IK9.2 -0 scale 2
%I%9.2.0 BOOL Input O
%I%9.2.1 BOOL Input O
<°myn 79 =TaTal Inni it 1I'W . >4
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4.3

i_8017HW (8/16 channels Al)

The I-8017HW can be an 8-channel differential or a 16-channel single-ended analog input module (Data
type: "REAL"). The following will describe a 16-channel module, you can see the Chapter4 (P4-1) to add

this 1/0 board.

Note: Before using the 1-8017HW 1/0 module, it requires to set the Differential or Single-ended

Jumper in the hardware.

1. Mouse double click the "i_8017_16ch" to open the “Properties” window, and then to see the

setting description.

EEEE 170 Boards

e

OO0 |~ O O [ (LD D

1: i 8017 _16ch - Properties

Key=6
Ref = 16#801716
ChO_type = 16#08
Chl_type = 16#08
Ch2_type = 16408
Ch3_type = 16#08
Ch4_type = 16408
Ch5_type = 16#08
Ch6_type = 16408
Ch7_type = 16#08
Ch8_type = 16408
Ch9_type = 16#08
Ch10_type = 16808
Chll_type = 16#03
Chl2_type = 16808

Chl13_type = 16#03

Parameters:
Ch_type: 16#SSRR

1-8017HW | 1-8017HCW | 1-8017DW

16-Ch Analog lutputs [Value type is REAL), single-ended input.

Parameters :
Ch_type : 16HSSRR

S5 e Scaling function is defined by the virtual board "'i_scale"' ----
00 means "No scaling"
01 to 23 means “Appling a scaling function No. [01 ta 29"

3

Setting Description

132

SS : Scaling function is defined by the "i_scale" I/O board (see the Section 4.2).

means "No scaling".
01 to 29 means "Appling a scaling function No. (01 to 29)".
Setting “SS” as other value will use the default value 00.

RR : Range definition of signals.

05 means "physical input signal is -2.5 to +2.5 Volt".
06 means "physical input signal is -20 to +20 mA".

07 means "physical input signal is -1.25 to +1.25 Volt".
08 means "physical input signal is -10 to +10 Volt".

09 means "physical input signal is -5 to +5 Volt".
Setting “RR” as other value will use the default value 08.
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2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.

For example, 16#08 means the physical input signal is -10 to +10 V.
Channel value 5.67 means the input signal is 5.67 V.

For example, 16#209 means the physical input signal is -5 to +5 V with the scaling function 2.
Signal 5.67 V will be scaled to an engineering value by the scaling function 2.

For example, 16#1709 means the physical input signal is -5 to +5 V with the scaling function 17.
Signal 5.67 V will be scaled to an engineering value by the scaling function 17.

! ¥

'Chl_type = 16#08
'Ch2 type = 16#08
'Ch3 type = 16408
'Chd_type = 16#08
'Ch5_type = 16#08

Noise_Filter_Max: The max. of the physical value to be considered as noise.
The filter will filter out the signal value beyond it, default setting is "9999.9".
For example, set as “7.9”, signal larger than 7.9 V (or 7.9 mA) will be filtered out.

Noise_Filter_Min: The min. of the physical value to be considered as noise.
The filter will filter out the signal value beyond it, default setting is "-9999.9".
For example, set as “1.5”, signal smaller than 1.5 V (or 1.5 mA) will be filtered out.
Note:
If setting Noise_Filter_Min >= Noise_Filter_Max, filter is disabled.
If setting Noise_Filter_Min < -1000 and Noise_Filter_Max > 1000, the filter is disabled.

Sample_Number: The number of sampled data to be averaged as one data.
Default is “1” (range: 1 to 500). Set a bigger value will reduce the sampling rate,
however the signal curve is smoother than setting a small value.

3. After linking the “i_8017_16ch” in the “I/O Boards” window, it will auto add 16 "REAL” input
variables in the “Variables” window. These variables can be used in the program.

T Name | Type | Dir. | Attib. | Syb. | Initvalue | User... | Tag | Description

= B %ID1-i 8017 _16ch A

%ID1.0 g BEAL Input |

%ID1.1 REAL Input [1 | You can change the variable

:’6'01'2 REAL Ingut L & name by double clicking it.

%ID1.3 REAL Input O .

%ID1.4 REAL Input ] | (Seethe Section 4.1)

%ID1.5 REAL Input O

%ID1.6 REAL Input O

%ID1.7 REAL Input O

%ID1.8 REAL Input O

%ID1.9 REAL Input O

%ID1.10 REAL Input O

%ID1.11 REAL Input O

%ID1.12 REAL Input O

%ID1.13 REAL Input O

%ID1.14 REAL Input O

%ID1.15 REAL Input O v
< 1 >
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4.4 i_8024 (4-channel AO)

The 1-8024W is a 4-channel analog output module (Data type: "REAL") that can be used to output +/- 10
V or 0 to +20 mA signal. See the Chapter4 (P4-1) to add this I/O board.

1. Mouse double-click the "i_8024_AQ" to open the “Properties” window and then to see the setting
description.

5 170 Boards
i_8024_a0 :

e

1

5 1:i 8024 _AO - Propertie ®
3 N eyt i
4 Ref = 16#5024
5 ChO_type = 16#33
6 Chl_type = 16#33
Ch2_type = 16$33
7 Ch3_type = 16#33
8 Reserved0 =0
q Reservedl =0
10 Reserved2 =0
1 Reserved3 =0
12
13
14
15
16 : Setting Description 7
= |-8024w/ & P ~
4-Ch Analog Dutputs [Value type is REAL) 3
Parameters :
Ch_type: 16HSSRR
5§ : - Scaling function is defined by the virtual board "i_scale" ----
00 means "No scaling"”
01 to 29 means “Appling a scaling function No. [01 ta 29]" v
Parameters:

Ch_type: 16#SSRR

SS: Scaling function is defined by the "i_scale" I/O board (see the Section 4.2).
00 means "No scaling".
01 to 29 means "Appling a scaling function No. (01 to 29)".
Setting “SS” as other value will use the default value 00.

RR: Range definition of signals
30 means "physical output signal is 0 to 20 mA"
33 means "physical output signal is -10 to +10 Volt"

Setting “RR” as other value will use the default value 33.

2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.

For example, 16#33 means the physical output signal is -10 to +10 V.
Channel value 5.67 is to output 5.67 V ; value -3.752 is to output -3.752 V.

For example, 16#133 means the physical output signal is -10 to +10 V with the scaling function 1.
Channel value is a user-defined engineering value will be converted first by the scaling
function 1 (i.e., "Ch01") before output it as -10 to +10 V.
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3.

For example, 16#30 means the physical output signal is 0 to 20 mA.
Channel value 12.5 is to output 12.5 mA ; value 6.27 is to output 6.27 mA.

For example, 16#1730 means the physical output signal is 0 to 20 mA with the scaling function 17.
Channel value is a user-defined engineering value will be converted first by the scaling
function 17 (i.e., "Ch17") before output it as 0 to 20 mA.

Key=0
Ref = 16#5024

ype = 16#1730
Chl_type = 16833
Ch2_type = 16#33
Ch3_type = 16§33
Reserved0 =0
Reservedl =0
Reserved2 =10
Reserved3 =0

After linking the “i_8024_AQ” in the “I/O Boards” window, it will auto add 4 "REAL” Output variables
in the “Variables” window. These variables can be used in the program.

7 Mame | Type | Dim. | Attrib. | Syb. | Initvalue | User... | Tag | Description
o H %QD1-i 8024 AO Al
o,
o::gg}? < Egi 83;23: You can change thfa v.aria.ble _
%QD1 2 REAL Ot ® name by dou!ole clicking it.
%QD1.3 REAL Output (See the Section 4.1) |
< Il | >
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4.5 i_87018W (8-channel Al)

The I-87018W is an 8-channel analog input module (Data type: "REAL") that provides thermocouple
input, current input (-20 mA to +20 mA) and voltage input (+/- 15 mV, +/- 50 mV, +/- 100 mV, +/- 500
mV, +/- 1V, +/- 2.5 V). See the Chapter4 (P4-1) to add this I/O board.

Important Notice:
® |-87018ZW is better than I-87018W / I-87018RW / I-87018PW because

(A) Each channel can use different range type setting.

(B) Accuracy is better and total 10-Channels.

(C) Temperature input with sensor-broken-line detection.

Please visit http://www.icpdas.com/products/Remote 10/i-87k/i-87018z.htm
® |-87018W does not support sensor-broken line function.

1. Mouse double-click the "i_8018_08ch" to open the “Properties” window, and then to see the setting
description.

£EEE 1/0 Boards

e

2
3 Koy
4 Ref = 16#87018
5 Tmp_F = 16801
6 ChO_7_type = 16#05
ChO_scale = 16#0
i Chl scale = 16#0
8 Ch2_scale = 16#0
9 Ch3_scale = 16#0
10 Ch4 _scale = 16#0
1 Ch5_scale = 16#0
Ch6_scale = 16#0
12 Ch7_scale = 16#0
13 Reserved =0
14 Reserved =0
15 %eserveg = g
16 ‘_,_'.m“g,,__,__ S - Setting Description
17 F8701 8w A -87018RW / 1-87018Pw A
8-Ch Analog inputs [Value type is REAL)
Important:
1. 1-87018z is better than i-87018 / i-87018RW / i-87018PW because
[&] Each channel can use different range type setting.
(B] Accuracy is better & total 10-Channels
[C) Temperature input with sensor-broken-line detection v
4 1 ?
Parameters:
Tmp_F: 16#FF

FF: Temperature format, It only apply to the channel type is Thermocouple.
01 means the unit of the input value is Degree Celsius
02 means the unit of the input value is Degree Fahrenheit

ChO_7_type: 16#RR
RR: Range definition of signals.
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Normal Range: (For mA or Volt)

Thermocouple Range: (For temperature)

Type Code | Physical Input Signal Type Code Type | Physical Input Signal
00 -0.015to0 +0.015V OE J -210to +760 °C
01 -0.05to +0.05 V OF K -270to +1372 °C
02 0.1t0+0.1V 10 T -270 to +400 °C
03 -05t0+0.5V 11 E -270 to +1000 °C
04 -1to+lV 12 R 0to+1768 °C
05 '25 tO +25 V 13 S 0 tO +1768 oC
06 20 to +20 mA 14 B 0 to +1820 °C
When 1-87018 and I-87018R are connected 15 N 0to +2320 °C
to a current source and set to “06” type "
code, an optional external 125 Ohm resistor 17 - ~200 to +800 OC
is required. 18 M -200 to +100 °C
19 LDIN43710 -200 to +900 °C

Setting RR as other value will use the default value “05”

2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.

For example, 16#05 means the physical input signal is -2.5 to +2.5 V.

For example,

For example,

Note: If using a temperature module with a broken-line detection function (e.g., -87018ZW), and the

Channel value 1.28 means the input signal is 1.28 V.
Channel value -0.752 means the input signal is -0.752 V.

signal is -270 to +1372 degree Celsius.
Channel value 25.75 means 25.75 degree Celsius.

signal is -454 to +752 degree Fahrenheit.
Channel value 25.75 means 25.75 degree Fahrenheit.

Key=6
Ref = 16#87018

ChO_7_type = 16#1
Ch0 _scale = 1640
Chl _scale = 1640

Ch5 _scale = 16#0

temperature value is greater than "9000.0", it means,

1. The temperature sensor may be broken-line.

2. The temperature sensor may be damaged.

3. The DCON module is not configured well to fit the connected temperature sensors.

4. The ohm measured by the connected sensor is not correct.

Win-GRAF User Manual, V 1.07, Apr. 2018 by ICP DAS 4-11

If "ChO_7_type" set as 16#0F and "Tmp_F" set as 16#01 means the physical input

If "ChO_7_type" set as 16#10 and "Tmp_F" set as 16#01 means the physical input



ChO_scale to Ch7_scale: 16#SS
SS: Scaling function is defined by the "i_scale" I/O board (refer the Section 4.2).

00

means "No scaling".

01to 29 means "Appling a scaling function No. (01 to 29)"

Setting SS as other value will use the default value 00.

For example, 16#17 means the physical input signal is converted with the scaling function 17.

3. After linking the “i_87018_08ch” in the “I/O Boards” window, it will auto add 8 "REAL” input
variables in the “Variables” window that are available for programming.

¥ Name | Type | Dim. | Attrb, | Syb. | Initvalue | User... | Tag | Description
= B %ID1-i 87018 _08ch Al
HI00 4—REA Ingrt You can change the variable
o | BEAL Inpit @ name by double clicking it
%ID1 2 REAL ot y dou gt
%ID1.3 REAL Input (See the section 4.1)
%ID1.4 REAL Input L] 3
%ID1.5 REAL Input O
%ID1.6 REAL Input O
%ID1.7 REAL Input [ A\
£ \ >
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4.6 i_exist (Test if the I/0 module exists?)

The “i_exist” is used to check if the I-8K and 1-87K series I/0O modules exist in the PAC’s slot 0 to 7.
See the Chapter4 (P4-1) to add this I/O board.

1. Mouse double-click the "i_exist" to open the “Properties” window, and then to see the setting
description.
Note: Using the Slot 8 or above No. because the slot 0 to slot 7 are reserved for the real I/0 module.

iEEE 170 Boards

:i_exist - Properties

Reserved2

=0
Reservedl =g
Reserved3 =0

QO = D O (L0 10 | O

Setting Description
i_exist A

Test if |-8xxxi and |-87 =\ i0 boards in the slot D thru. 7 exist or nat.

8-ch boolean inputs represent the board state in the slot 0 thru. 7
True : exists
FALSE : board not found

2. After linking the “i_exist” in the “I/O Boards” window, it will auto add 8 "BOOL” input variables in
the “Variables” window and display the state of the I/0 module from slot 0 to slot 7 when
connecting the Win-GRAF PAC.

"TRUE" means the I/O module exists.
"FALSE" means cannot find this I/0 module.

T MName | Type | Dirn. | Attrb, | Syb. | Initvalue | User... | Tag | Description

Cl B %IX9 - i_exist fo
;’?:g? < ;88;_ :nput You can change the variable
olXH. nput C e
%1%5 2 BOOL T ® name by double clicking it.
o149 3 BOOL Input (See the Section 4.1)
%IX9.4 BOOL Input ] T
%I¥9.5 BOOL Input O
%IX9.6 BOOL Input O
%IX9.7 BOOL Input O ¥

N
v
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4.7 i_8084 (Frequency, UP/Down Counter, UP Counter)

The 1-8084W is a 4/8-channel high speed Frequency/Counter (Data type: “DINT”) that can be used to
measure frequency or as a UP/Down Counter or as a UP Counter. The following will describe these three
modes. See the Chapter4 (P4-1) to add this I/O board.

4.7.1 i_8084 freq (8-channel Frequency)
1. Mouse double-click the "i_8084_freq" to open the “Properties” window, and then to see the setting
description.

EEEE 170 Boards

-l=

1

i 8084 freq

2 ¢ 1:i_8084 freq - Properties
4 Ref = 16#5084F =1
5 ChO_1_Filter=0
g ChO_1_Freq_timeowut = 1800
7 ChO_1_Low_High Auto=2
Ch2_3_Filter=0
g Ch2_3_Freq_timeout = 1800
9 Ch2_3 Low_High Auto=2
10 Ch4_5_Filter=0
11 Ch4_5_Freq_timeout = 1800
Ch4_5 Low_High Auto=2
12 Ch6_7_Filter =0
13 Ch6_7_Freq_timeout = 1800
14 Ch6_7 Low_High Auto=2
15 ls{m_Ulidam_Ilawrgd =0
= . .. v
16 ‘,__%nfl:,nvem Setting Description —
17 |-8084%w A
8-Ch Frequency Inputs [Value type is DINT] =S
Parameters :
Ch_Filter : unit is 0.000001 second , can be 0~ 200 .
The default setting is 0 [without filter].
The "Ch_Filter" is for filtering out some noise sighals with samll signal width. v

Parameters:
Ch_Filter: The unit is 0.000001 second (us), the value can be 0 to 200.

The default setting is 0 (without filter). The "Ch_Filter" is for filtering out some noise
signals with smaller signal width. (Recommend O: if there is no noise consideration or
need a real-time measurement.) The following setting is recommended:

Max Input Signal (Hz) Recommend Filter Value

1K 200
2K 100
5K 40

10K 20

20K 10

100K 2

450K 1

450K 0 (without filter)
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Ch_Freq_Timeout:
The unit is 0.001 second (ms), the value can be 20 to 1800. Set as other value will use the

default value 1800. If there is no signal wave input to the I-8084W in the "Ch_Freq_Timeout"
interval, the frequency value of the related channel will be assigned as 0.

For example, if set it as 100 ms and the input is 500 Hz (that means, one signal wave takes
about 2 ms to happen), the frequency is updated normally. When the input frequency drop to 9
Hz (that means, one signal wave take about 111 ms to happen), this "111" exceeds the setting
"100" ms (Freq_Timeout). So the frequency value will be assigned as 0 because there is no
signal wave coming in this 100 ms interval.

When setting as 20 ms, the frequency value below 50 Hz is not detectable (become 0).
When setting as 100 ms, the frequency value below 10 Hz is not detectable (become 0).
When setting as 1800 ms, the frequency value of 0 Hz , 1 Hz to 450 KHz is detectable.

Ch_Low_High_Auto: (recommend setting as “2: Auto”.)
0 means a Low frequency mode.

1 means a High frequency mode.
2 means Auto switching between Low and High frequency mode.
Set as other value will use the default value “2: Auto”.

Mode 2 will auto change the frequency mode. It will auto change to High mode when the input
frequency is larger than 3500 Hz, while auto change to Low mode if input frequency is less than
1000 Hz.

DO NOT set as 1 (High frequency mode) if the input signal is normally less than 1000 Hz, or the
frequency value will be incorrect frequently. Recommended don't set as O (Low frequency
mode) if the input signal is normally larger than 3500 Hz.

Min_Update_Interval:
The unit is 0.001 second (ms), the value can be 0, or 20 to 1000.

Default value 0 means "Update frequency every PAC cycle".

Other means "Update frequency when each Interval time reached".

The frequency update time also depends on the Win-GRAF PAC cycle time. If the PAC cycle time
is big, for example 200 ms, then the real frequency update time will become 200 ms when
setting the "Min_Update_Interval" less than 200. Setting bigger "Min_Update_Interval" will get
smooth frequency curve value, however the frequency value is updated slowly.

Signal_Inverted:
0: input signal is normal (no inverted).

1: inputsignalis inverted (means voltage HIGH will be processed as LOW, and voltage LOW
will be processed as HIGH).
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2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.

1:i_8084_freq - Properties
Key=6

Ref = 16#8084F =
ChO_1_ Filter=0

ChO_1 Freq timeout=100
Ch0_1_Low_High_Auto =
Ch2_3_Filter=0
Ch2_3_Freq_timeout= 1800
Ch2_3 Low_High_Auto=2
Ch4_5_Filter=0
Ch4_5_Freq_timeout = 1800
Ch4_5 Low_High_Auto=2
Ch6_7_Filter=0
Ch6_7_Freq_timeout = 1800
Ch6_7 Low_High_Auto=2
Min_Update_Interval =200

‘ Chﬁ_l _Freq_timeount

Signal Inverted =0

3

After linking the “i_8084_freq” in the “I/O Boards” window, it will auto add 8 “DINT” input variables

in the “Variables” window. When the Win-GRAF connects the PAC, it will display the frequency value
for each channel.

Variables VX
T Name | Type | Dim. | Attrib, | Syb. | Initvalue | User... | Tag | Description
= B %ID1 - i 8084 freq A
:’Hm'g < QU Input You can change the variable
%lD1.1 DINT Input bv double clicking i
¢ name by double clicking it.
%ID1.2 DINT Input see the Section 4.1
%ID1 3 DINT Input (See the Section 4.1)
%ID1.4 DINT Input L] B,
%ID1.5 DINT Input O
%ID1.6 DINT Input O
%ID1.7 DINT Input O v
] | >
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4.7.2 i_8084 cnt_ch04 (4-channel UP/Down Counter)

Note: Using the "COUNTER_START", "COUNTER_STOP", "COUNTER _GET", "COUNTER_STATE" and
"COUNTER_RESET" functions in the Win-GRAF Workbench to operate counter channels in an
[-8084W.

1. Mouse double-click the "i_8084 cnt_ch04" to open the “Properties” window, and then to see the
setting description.

5 170 Boards

$ 5
2 U nt U Dpe S B
3 \ 'Xe = D o o o s ﬂ
4 Ref = 16#8084C4
5 Ch0_Mode =0
g ChO_Filter=10

Chl_Mode =0
£ Chl_Filter=0
8 Ch2_Mode =0
q Ch2_Filter=0
10 Ch3_Mode =0

Ch4_Filter=0
11 Signal_Inverted =0
12 Reserved0 =0
13 Reservedl =0
14 Reserved2 =0
15 Reserved3 =0
16 - Setting Description :
17 |-8084w/ : Setup 4-Ch Counter Inputs »

Mote: Please use the "i_8084_Start" , "i_8084_ Stop" , "i_B8084_Get",

" 8084_State" and "i_B0B4_Reset" functions to operate
counter channles in an |-8084% .
Parameters :
b

Parameters: - ——

Ch_Mode: Input mode, can be 0, 1 and 4. Set other value will use 0.
0: Pulse/DIR mode.
1: UP/DOWN mode.
4: A/B phase (Quard.) mode.
Ch_Filter: The unit is 0.000001 second (us), the value can be 0 to 200.
The default setting is O (without filter). The "Ch_Filter" is for filtering out some noise
signals with smaller signal width. (Recommend O: if there is no noise consideration or
need a real-time measurement.) The following setting is recommended:

Max Input Signal (Hz) Recommend Filter Value

1K 200
2K 100
5K 40

10K 20

20K 10

100K 2

450K 1

450K 0 (without filter)
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Signal_Inverted:
0: Input signal is normal (no inverted).

1: Input signal is inverted (means voltage HIGH will be processed as LOW, and voltage LOW
will be processed as HIGH).
For example:
If setting "Signal_Inverted" as 0 (no inverted) and Ch_Mode is 0 (Pulse/DIR),
the counter value will count up if "DIR" signal is High.
If setting "Signal_Inverted" as 1 (inverted) and Ch_Mode is 0 (Pulse/DIR),
the counter value will count down if "DIR" signal is High.

Double click the item and fill in a value, then press the “Enter” key to complete the setting.

Key =6

Ref = 16#8084C4
Ch0_Mode =0
ChO_Filter=0

Chl_Mode =0
Chl_Filter=0
Ch2_Mode =0
Ch2_Filter=0
Ch3_Mode =0

‘ Signal Inverted
1

0
Reserved2 =0
Reserved3 =0

After linking the “i_8084 _cnt_ch04” in the “I/O Boards” window, it will auto add one “BOOL” Input
variable (no meaning, always “FALSE”) in the “Variables” window.

T MName | Type | Dim. | Attrib, | Syb. | Initvalue | User... | Tag | Description
= B %IX1 - i B084_cnt_Ddch A
%IX1.0 BOOL Input O |

< I 1 >

After linking the “I/O board”, refer the Section 4.9 to use "COUNTER_START", "COUNTER_STOP",
"COUNTER _GET", "COUNTER_STATE" and “COUNTER_RESET” functions in the LD or ST program to
operate the Counter channel of the I1-8084W.
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4.7.3 i_8084 cnt_ch08 (8-channel UP Counter)
Note: Using the "COUNTER_START", "COUNTER_STOP", "COUNTER _GET", "COUNTER_STATE" and
"COUNTER_RESET" functions in the Win-GRAF Workbench to operate counter channels in an

[-8084W.

1. Mouse double-click the "i_8084 cnt_ch08" to open the “Properties” window, and then to see the

setting description.

£EEE 170 Boards

i 8084 _cnt_0D8ch — - s
2 1: 1 8084 cnt 08ch - Properties
3 A T RS,
4 Ref = 16#8084C8
5 ChO_1_Filter=0
g Ch2_3_Filter=0
Ch4_5_Filter=0
7 Ch6_7_Filter=0
g Signal Inverted =0
q Reserved0 =0
10 Reservedl =0
Reserved2 =0
11 Reserved3 =0
12
13
14
15 . .
16 _— Setting Description
17 |-8084w/ : Setup 8-Ch Counter Inputs »
Mote: Please use the "i_8084_Start" , "i_8084_ Stop" , "i_B8084_Get", -
" 8084_State" and "i_B0B4_Reset" functions to operate
counter channles in an |-8084% .
Parameters :
b
Parameters:

Ch_Filter: The unit is 0.000001 second (us), the value can be 0 to 200.
The default setting is 0 (without filter). The "Ch_Filter" is for filtering out some noise
signals with smaller signal width. (Recommend O: if there is no noise consideration or
need a real-time measurement.) The following setting is recommended:

Max Input Signal (Hz) | Recommend Filter Value

1K 200
2K 100
5K 40

10K 20

20K 10

100K 2

450K 1

450K 0 (without filter)

Signal_Inverted:
0: Input signal is normal (no inverted)

1: Input signal is inverted (means voltage HIGH will be processed as LOW, and voltage LOW will

be processed as HIGH).
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2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.

1:1 8084 cnt_08ch - Froperties

Key=0

Eef = 10#3054C3
ChO_1_Filter=0
Ch2_3_Filter=0
Ch4_5_ Filter=10
Cho_7 Filter=10
S1znal Inverted =10
Reservedd =0
Reservedl =0
Reserved? =0
Reserved3 =0 N

Signal Inverted

3. After linking the “i_8084_cnt_ch08” in the “I/O Boards” window, it will auto add one “BOOL” Input
variable (no meaning, always “FALSE”) in the “Variables” window.

7 Mame 4| Type | Dim. | Attrib. | Syb. | Initvalue | User.. | Tag | Description
= B %IX1 - i 8084 _cnt_08ch Al
%I%1.0 BOOL Input O v

4] I 1 §

[T.;J[ : 10 Drivers | Variables

4. After linking the “I/O board”, refer the Section 4.9 to use "COUNTER_START", "COUNTER_STOP",
"COUNTER _GET", "COUNTER_STATE" and “COUNTER_RESET” functions in the LD or ST program to
operate the Counter channel of the 1-8084W.
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4.8 i_8093 (3-axis High Speed Encoder Module)

The 1-8093W is a 3-axis high speed encoder module that can be independently configured as one of the
Quadrant, Pulse/Direction or CW/CCW input mode for each channel. If not familiar with the way to add
the this I/0O board, see the Chapter4 (P4-1).

1. Mouse double-click the "i_8093" to open the “Properties” window, and then to see the setting
description.

5 170 Boards

2 1: i;80é3 -A-l;roperti-es
3 \ R - e O |
1 Key=0

Ref = 16#8093
5 X Mode=1
6 Y_Mode=1
7 Z Mode =1
g Signal_Inverted =0

Reserved0 =0
3 Reservedl =0
10 Reserved2 =0
11 Reserved3 =0
12
13
14
15
16 - Setting Description =
17 |-8093w : Setup 3-Ch Encoder module »

Mote: Please use the "i_8093_Start" , "i_8093_Stop' , "i_B093_Get", =

"_8093 State" and "i_8033_Reset" functions to operate
encoder channles in an 1-8033w/ .
Parameters :
b4
Parameters:

X_Mode, Y_Mode, Z_Mode:

The input mode of X, Y, Z axis, can be 1, 2 and 3. Set other value will use 1.
1: CW/CCW counting mode.
2: Pulse/Directioncounting mode.
3: A/B phase (quadrant) counting mode.

Signal_Inverted:
0: Input signal is normal (no inverted)
1: Input signal is inverted (means voltage HIGH will be processed as LOW, and voltage LOW will
be processed as HIGH).

For example:
If setting "Signal_Inverted" as O (no inverted) and X_Mode is 2 (Pulse/Direction),
the encoder value will increase if "Dirextion" signal is High.
If setting "Signal_Inverted" as 1 (inverted) and X_Mode is 2 (Pulse/Direction),
the encoder value will decrease if "Dirextion" signal is High.
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2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.

Signal Inverted =0
Reserved0 =0
Reservedl =0
Reserved2 =0
Reserved3 =1

3. After linking the “i_8093” in the “I/O Boards” window, it will auto add 3 “BOOL” input variables in
the “Variables” window that are available for programming.
Ch0: Z-index of X axis.
Chl1: Z-index of Y axis.
Ch2: Z-index of Z axis.

7 MName | Type | Dim. | Attrib. | Syb. | Initvalue | User... | Tag | Description
= B %IX1 - i 8093 ~
%I%1.0 BOOL Input O
%111 BOOL Input O §
%Ix1.2 BOOL Input [ v
< | >

4. After linking the “I/O Boards”, refer the Section 4.9 to use "COUNTER_START", "COUNTER_STOP",
"COUNTER _GET", "COUNTER_STATE" and “COUNTER_RESET” functions in the LD or ST program to
operate the Encoder channel of the I-8093W.
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4.9 Using the Count Function for 1-8084W, 1-8093W, 1-87082W, 1-87084W,
I-7083 and 1-7080 Modules

This section lists the way to use the "COUNTER_START", "COUNTER_STOP", "COUNTER _GET",
"COUNTER_STATE" and “COUNTER_RESET” functions in the LD or ST program to operate the Counter
and Encoder modules. If not familiar with the way to create a program or a function block, see the
Section 2.3.3.

Note:

1. Inthe following content, we use I1-8084W and 1-8093W modaules as examples.

2. Before using these function blocks, first go to Section 4.7.2 (UP/Down Counter), Section 4.7.3
(UP Counter) and Section 4.8 (Encoder) to link 1/0 Boards.

49.1 COUNTER_START
For example: Using the I-8084W module in the PAC’s slot2 and start counting the channel 5.

ST program:

IF Startl =TRUE THEN

Note:
1 := FALSE;
Start SE; First, add two BOOL variables
TMP_BOOL := Counter_Start (0, 2, 8084, 5) ; ("Start1", "TMP_BOOL") in the

END_IF; Variables Area.

LD program:
(“Startl”: boolean, set it to “TRUE” to start counting and then reset “Start1” to “FALSE”.)

Start1
R1 E COUMTER_START I

*

Set it to “TRUE” to start counting | °|Fart Tips:
Press the [F1] key for
the details on settings.

ﬁ/!l{*#
]

2 Al

%1 Click to set
I:D.-I uCoiI” tO IIRII.

O 5034
] : I2_rame
Reset it to “FALSE”
-H
* S Channel
HEZH
= Start?
= | O F:2 R |
-
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Port: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as “0”. For a DCON module connected to a serial
COM port, can be “1 to 37” (depends on PAC, means COM1 to COM37).

Addr: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as the slot number (0 to 7).
For a module connected to a serial COM port, set it as the Net-ID address of the module (1 to 255).

I0_Name: (Data type: “DINT”)
The name of relative Counter/Encoder module, it can be set to "8084”, "8093", "87084", "87082",
"7083" and "7080".

Channel: (Data type: “DINT”)

The channel No. of the Counter/Encoder module, it can be set to "0", "1", and so on, depends on the
module. For example, when using the I-8093W module, "0" means the X-axis, "1" means the Y-axis
and "2" means the Z-axis.

Q: (Data type: “BOOL")
“TRUE”: OK ; “FALSE”: Error.
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4.9.2 COUNTER_STOP
For example: Using the I-8093W module in the PAC’s slot1 and stop counting the X-axis.

ST program:
IF Stopl =TRUE THEN
Note:
Stopl := FALSE; First, add two BOOL variables
TMP_BOOL := Counter Stop (0, 1, 8093, 0) ; ("Stop1", "TMP_BOOL") in the
Variables Area.
END_IF;
LD program:

(“Stop1”: Boolean, set it to “TRUE” to start counting and then reset “Stop1” to “FALSE”.)

s

£
I Stop
Iyl Fi En COUNTER_STOF @ |
. Set it to “TRUE” to stop counting 0-{port Tips:
K Press the [F1] key for
a 1 Lo the details on settings.
Il
LN G095 I _Mame
< Reset it to “FALSE”
D4 Channel
HKZH +
— Stop
o | Rz R |
—

Port: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as “0”. For a DCON module connected to a serial
COM port, can be “1 to 37” (depends on PAC, means COM1 to COM37).

Addr: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as the slot number (0 to 7).
For a module connected to a serial COM port, set it as the Net-ID address of the module (1 to 255).

I0_Name: (Data type: “DINT”)

The name of relative Counter/Encoder module, it can be set to "8084”, "8093", "87084", "87082",
"7083" and "7080".

Channel: (Data type: “DINT")

The channel No. of the Counter/Encoder module, it can be set to "0", "1", and so on, depends on the
module. For example, when using the I-8093W module, "0" means the X-axis, "1" means the Y-axis
and "2" means the Z-axis.

Q: (Data type: “BOOL")
“TRUE”: OK ; “FALSE”: Error.
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4.9.3 COUNTER_GET
For example: Using the I-8093W module in the PAC’s slot1 and get the Encoder value of the Z-axis.

ST program: Note: First, add variables in the
Variables Area (see section 2.2.1).

TMP_BOOL := Counter_Get (0, 1, 8093, 2, Encoder_1) ; "TMP_BOOL" (BOOL).
“Encoder_1" (DINT).

LD program:
(3
1E
bl R1 En COUNTER_GET @ |
| | 0-Part
Tips:
3 L Press the [F1] key for
i the details on settings.
I
5093
r i I2_PMame
-ZH
24 Channel
HHZH
o | Ecoder_1 @t alue
—=

Port: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as “0”. For a DCON module connected to a serial
COM port, can be “1 to 37” (depends on PAC, means COM1 to COM37).

Addr: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as the slot number (0 to 7).
For a module connected to a serial COM port, set it as the Net-ID address of the module (1 to 255).

I0_Name: (Data type: “DINT”)

The name of relative Counter/Encoder module, it can be set to "8084”, "8093", "87084", "87082",
"7083" and "7080".

Channel: (Data type: “DINT")

The channel No. of the Counter/Encoder module, it can be set to "0", "1", and so on, depends on the
module. For example, when using the I-8093W module, "0" means the X-axis, "1" means the Y-axis
and "2" means the Z-axis.

@Value: (The data type can be “DINT”, “UDINT”, “DWORD” and “LINT")
It returns the current counter or encoder value. (Refer the Appendix A for the range of values)

Q: (Data type: “BOOL")
Counting state. “TRUE”: Counting ; “FALSE”: Stopped.
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49.4 COUNTER_STATE
For example: Using the I-8084W module in the PAC’s slot2 and to get the counting status of the
channel 5.

ST program:

Note: First, adda "TMP_BOOL"

TMP_BOOL := Counter_State (0, 2, 8084, 5) ; . ) .
BOOL variable in the Variable Area.

LD program:

*

%

=il R EnCOUNTER_STATE G |

| | O4Part
Tips:

3 o L Press the [F1] key for

'l the details on settings.
!

a054
- 2 _Mame
o
S Channel

HIH —

Port: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as “0”. For a DCON module connected to a serial
COM port, can be “1 to 37” (depends on PAC, means COM1 to COM37).

Addr: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as the slot number (0 to 7).
For a module connected to a serial COM port, set it as the Net-ID address of the module (1 to 255).

10_Name: (Data type: “DINT”)
The name of relative Counter/Encoder module, it can be set to "8084”, "8093", "87084", "87082",
"7083" and "7080".

Channel: (Data type: “DINT”)

The channel No. of the Counter/Encoder module, it can be set to "0", "1", and so on, depends on the
module. For example, when using the [-8093W module, "0" means the X-axis, "1" means the Y-axis
and "2" means the Z-axis.

Q: (Data type: “BOOL")
“TRUE”: OK ; “FALSE”: Error.
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4.9.5 COUNTER_RESET
For example: Using the I-8093W module in the PAC’s slot5 and reset the Encoder value of the Y-axis
as IIOII.

STProgram: | | pesetl = TRUE THEN Note:

Resetl := FALSE ; First, add two BOOL variables

("Resetl", "TMP_BOOL") in the

END_IF;
LD program:
k3
I Resetl
b R1 EnCOUNTER_RESET G |
“ ” . 0{Part
B Reset1”: BOOL, set it to Tips:
o “TRUE” to reset the value. Press the [F1] key for
0 o [l the details on settings.
gl
i 09310 _Mame
-ZH
14 Channel
HHZH |
= Reset it to “FALSE”
—a + 0q%alue
—a
Resetl
| R2 R |

Port: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as “0”. For a DCON module connected to a serial
COM port, can be “1 to 37” (depends on PAC, means COM1 to COM37).

Addr: (Data type: “DINT”)
For a module in the slot 0 to 7 of the PAC, set it as the slot number (0 to 7).
For a module connected to a serial COM port, set it as the Net-ID address of the module (1 to 255).

I0_Name: (Data type: “DINT”)
The name of relative Counter/Encoder module, it can be set to "8084”, "8093", "87084", "87082",
"7083" and "7080".

Channel: (Data type: “DINT")
The channel No. of the Counter/Encoder module, it can be set to "0", "1", and so on, depends on the
module. For example, when using the I-8093W module, "0" means the X-axis, "1" means the Y-axis
and "2" means the Z-axis.

Value: (The data type can be “DINT”, “UDINT”, “DWORD”, and “LINT")
The new Counter or Encoder value wish to set.

Q: (Data type: “BOOL”) “TRUE”: OK ; “FALSE”: Error.
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4.10 Ping_ip (Test an Ethernet/Internet Connection)

The "Ping_ip" function is used to test if the connection of the remote Ethernet/ Internet device is
working properly. (It supports a max. of 50 IP settings.) If not familiar with the way to add this I/0 board,
see the Chapter4 (P4-1).

1. Mouse double-click the "Ping_ip" to open the “Properties” window, and then to see the setting

description.
Note: Using the slot 8 or above No. because the slot 0 to 7 are reserved for the real I/O module.

§EEE 170 Boards
E

9.0: Ping_1p - froperges

Ref = 16#04 —

IP_0=192.168.1.100

Interval 0=15

Timeout 0=3

IP_1=N/a

Interval 1=15

9 Ping_i il';m;m;}?hl =3 ==

sl Fing ip_00 09 4=
T Interval 2=15

—_1 Ping ip 1013 Timeout 2 =3

— 2 Ping_ip 2029 > ||/IP 3=N7

— 3 Ping_ip_30 39 !Ilgtervalt_33 = 135

T imeout_3 =
= 4 Ping_ip_40 49 IP_4 = N7
Interval 4=15 ] -
11 — . . Setting Description
12 Ping_ip : Test Ethemet / Interet connection ~

QO == | O O [ (L0 (P = D

3

Mote:
1. If wish ta test the connection between PAC and
Internet, please set proper "Gateway" settings.
2. If test only local Ethernet connection, then
"Gateway' may not be necessary.
3. One PAC can use only one "Ping_IP" . v

Note:
1. If wish to test the connection between PAC and Internet, please set proper "Gateway" settings.
If test only local Ethernet connection, then "Gateway" may not be necessary.
One PAC can use only one "Ping_IP". (Don't use two or more)
When Ping success, return Boolean channel as TRUE.
When Ping fails, it will try one more time. If still fail, then return Boolean channel as FALSE.

ik wnw

Parameters:

IP_01 to IP_49: (Data type: "STRING")

The IP address of targets. Set as 'N/A'if wish to disable it.
For example, 192.168.1.100 or 52.19.125.242 or N/A.

Interval_01 to Interval_49: (Data type: "DINT")

The unit is second. The interval to send one "ping" command. Value can be 6 to 86,400 seconds.
Setting smaller than 6 will use as 6. Setting greater than 86400 (24 hours) will use as 86400.
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Timeout_01 to Timeout_49: (Data type: "DINT")
The unit is second. The timeout settings of the "ping" command. Value can be 2 to 30 seconds.
Setting smaller than 2 will use as 2. Setting greater than 30 will use as 30.

Note: The "Interval_xx" value should be at least triple of the "Timeout_x" value. Or the PAC will
use the "Interval_x" value as a triple of the "Timeout_x" value.
For example, if "Timeout_00" is set as 10 however "Interval_00" is set as 20, then PAC will
use "Interval_00" as 30.

2. Double click the item and fill in a value, then press the “Enter” key to complete the setting.

E)[@

Key=0
Ref = 16#64
IP_0=192.168.1.100
Interval 0=15
Timeout 0 =23

Interval_1=10
Timeout_1=2
IP_2=N/a
Interval 2=15

Timeout_2 =3

IP_3=N/a

Interval 3 =15

Timeout_3=3

IP_4 =N/a

Interval 4 =15 v

192.168.78.88

3. After linking the "Ping_ip" in the “I/O Boards” window, it will auto add 50 “BOOL” input variables in
the “Variables” window. When the Win-GRAF connects the PAC, it will display the online status.
True:  The connection is ok.
FALSE: Connection failed or cable problem.

Variables BV X
7 Name | Type | Dim. | Attrib. | Syb. | Initvalue | User... | Tag | Description
= @ %I[X3.0 - Ping_ip_00_09 &

0,

;::gg? < :SSIL ::EEI You can change th‘e v‘aria‘ble

% [X9.0.2 BOOL T ¢ name by douPIe clicking it.

%I1¥9.0.3 BOOL Input (See the Section 4.1)

%I[x9.0.4 BOOL Input ]

%I¥9.0.5 BOOL Input O

%I%9.0.6 BOOL Input O

%IX9.0.7 BOOL Input O]

%Ix9.0.8 BOOL Input O

%I%9.0.9 BOOL Input O q

= & %I¥9.1 - Ping_ip_10_19
@ %IX3.2 - Ping_ip_20 29
W %I0X3.3 - Ping_ip_30_39
B %IX9.4 - Ping in 40 48

&)

154

HEE
v
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4.11 1-8088W (8-channel PWM Output Module)

The I-8088W is an 8-channel PWM (Pulse Width Modulation) output module. The duty range (Duty =
High / (High + Low) ) of the PWM output signal can be from 0.1% to 99.9%. Its output frequency in the
Win-GRAF PAC is from 1 Hz to 500 KHz. The [-8088W support two PWM output modes, one is the
“Continuous” mode. It outputs always. The other one is the “Burst” mode. It outputs the required pulse
count and then stop. Please visit http://www.icpdas.com/products/Remote 10/i-8ke/i-8088w.htm for
other specifications.

Hardware Connection Diagram:

This example uses the 1-8084W (Slot 2) to measure the frequency of the 1-8088W (Slot 1) PWM output
signal (the I-8084W is not necessary in the actual application). Then, connect the I-8088W’s PWM
output channel 0 (PWO) to the I-8084W'’s frequency input channel 0 (COA+).

Power Supply (DP-665) Monitor

PC/Win-GRAF GND — i
& .

RS-408

Win-GRAF PAC

VGA

GND

”

usse

PWR
1-8088W ' l 1-8084W

The demo project (demo_8088w.zip) that we will describe below is located in the shipment CD

(\Napdos\Win-GRAF\demo-project) , refer the Chapter 12 to restore/open this project and set up the
current PAC’s IP address.

[ Win-GRAF - demo_8088w ®[=3
File Edit View Insert Project Tools Window Help
A (2 AN TR T, e CE AN AR g 3 A
Workspace
&3 demo_BUBBVK A7 Name | Type | Dim.
[ Exception proj Ri i @ 2
e ight-click (set the IP = "
&3 Programs 8 ( ) E PRM_S088W Q — & &} Glabal variables
738 Main {8088 Stete0 iB088_FreqD DINT
-+ Watch (for def 1 4sict State S i8085_Duty0 REAL
- @R Soft Scol Communication Parameters. . i8088_Cnt0 DINT
; E Initial values A OnLine \ oJehan o !BDBB_RunD BOOL
o %d NewSpyl 8088 StateU BOOL ™
% Binding Configation |1 -0 TIMTSTIE T &5 .. | & ‘ 5
: 39 Global defines G 18088 _Freq0-{Freq ] u &) -
; ¥ Variables 0.001 ~0999 (0... B Cd Used)
LB Types » | i8085_Duty0 {Duty 3 (Project) g
g init as -1:Continu... ] [j Advanced
o i8088_Crt0 JCrit [F [ Arithmetic
F [ Arays
= i8085_Run0 PR ASinteif
e L Run B _] -interface
—_*'3‘ ¥l = BACnet ) ) 8
e [ _ >[4 3] Blocks " sovlist [ Dafine | ENUM /
|4 »| Main ‘arisbles | NewsSpyl
Build > %
[«® ’ Build /. “Cross references ‘ Runtime Call stack. _ Brezkpoints _ Diqital pling trace [ Frompt [ H1 )
Ready OffLine 192,168.71.19:502 é 0,0 132 x 18 0,0 118% &4
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1/0O Boards:
In this case, add the "i_8088" and the "i_8084 freq" to the corresponding 1/O slot No. in the "I/O

Boards" window (see the Chapter 4). Then, mouse double-click the Slot No. to open the "Properties"
window and you can see the setting description to set this /O board.

iEif 170 Boards

4 . || Delet |
5 Double-click it to set B =2
g— and to see the details. |
8
3 Key=6
10 Ref = 1643088
11 Hard_Trigger = 16400
12 Reserved0 =0 \
Reservedl =0
13 Reserved2 =0
1; Reserved3 =0 Double-click it to set up this item.
16 “00“ means the associate PWM output channel
is triggered by the "i_8088W" function block.
1-8088w _ — N
. Setting Description |
8-Ch P\wM outputs and 8-ch Diaital Inputs /
{Note:
1T0 control P'wM outputs of the I-8088W/, first connect the
"_B08E" in 170 board windows, then use the "PWwh_8088w"
function block to control each P\wM channel. v

After linking the "i_8088" and the "i_8084 freq" I/O boards, it will auto add related variables in the
"Variables" window (or Variables Area). And, you can also declare all the variables that will be used in
the program here (refer the Section 2.3.1).

Workspace Variables
-l demo_8088w T/ Name
-1 Exception programs

Attrib.

Init value WUser... | Tag | Description

-3 Programs i8088_Freq0 O unit is Hz, init as 100
L) Main i8088_DutyD REAL O o5 0.001 ~0.999 (0.1% ~ 99.9%),
£+ Watch (for debugging) i8088_Cnt0 DINT O - init as -1:Continuous mode, 1~
8 SoftScope i8088_Run0 BOOL O Set TRUE to start, Set FALSE
o B3] Initial values i5085_Statel BOOL O Current State
Lo Eg NewSpyl
- it e Lokt e . o | To declare all the variables that
(Y Variobles %I1x1.1=i8086_DI_1 BOOL Input 00 | will be used in the program.
= %IX1.2=i8088_DI_2 BOOL Input O

%I%1.3=i8088_DI_3 BOOL Input O

%I%1.4=i8088_DI_4 BOOL Input 1

%IX1.5=i8088_DI_5 oL L .

%IX1 B=iG0B8_DI_B BO Double-click it to change its name.

Smwnoiimg] | (Refer the Section 4.1)
- | 0 >,

olD2. _freq DINT T ™ mequency chO of i-8084WY

%ID2.1 DINT Input O

%ID2.2 DINT Input O

%ID2.3 DINT Input O

%ID2.4 DINT Input O

%ID2.5 DINT Input O

%ID2.6 DINT Input O

%ID2.7 DINT Input [}

<
[« > Main| Variables ~ Newspyl .~

[R93
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"PWM_8088W" Function Block:
Then, using the function block “PWM_8088W” to control the PWM output for each channel, such as the
LD program below.

BOOL, always returns “Ture”

Slot and Chan must

Current State
use constant value. — iS085_State0
14 Zlot State ']
04 Chan Fum

Freq: PWM frequency Init = 100 (Hz)
(Data type: D|NT) i5055_Freq0 {Freg
Duty: PWM duty Il = 0.5 (50%)
(Data type: REAL) iB0&E_DutyD JDuty

State: BOOL, the current working status.
(True: working ; False: stopped)
Num: DINT, it reserved for future usage.

Init = -1 (Continuous mode)
i8035 _Crt0 ot

TRUE: Start , FALSE: Stop

iB088_Run0
[ Run

Cnt: DINT - "-1" (Continuous mode), used to output PWM pulse continuously.

"1~ 65535" (Burst mode), used to output the required pulse count and then stop.
Run: BOOL, used to start (True) or stop (False) the PWM output.

Parameters:
Slot: The used I/0 slot No., and it must be a constant value, not a changeable value.
In this case, the value is "1". (Data type: DINT)
Chan: The used I/O channel No., and it must be a constant value, not a changeable value.

In this case, the value is "0". (Data type: DINT)
Freq: The PWM output frequency. (Data type: DINT ; Unit: Hz)
The value can be from 1 to 500,000 (i.e., 1 Hz to 500 KHz) .
In this case, the initial value is "100" Hz.
Duty: The PWM output. (Data type: REAL)
The value can be from 0.001 to 0.999 (i.e., 0.1 % to 99.9 %).
In this case, the initial value is 0.5 (i.e., 50 %).
Cnt: The output mode (Data type: DINT)
Continuous mode: set it as “-1” (in this case) to output PWM pulse continuously.
Burst mode: it can be from "1" to "65535", to output the required pulse count and then stop.
Run: Using a BOOL variable to trigger the PWM output. (True: Start ; False: Stop)
State: The current working status. (Data type: BOOL). (True: working ; False: stopped)
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Test the program:
Before testing, make sure you have set the PAC's IP address and then compile and download this
program to the PAC. (If not familiar with the operation, refer the Section 2.3.4 and Section 2.3.5.)

When connecting with the PAC, the SPY List (refer the Section 11.3) will show that the I-8088W’s PWM
initial frequency ("i8088_Freq0") is 100 Hz, the initial duty cycle ("i8088_Duty0") is 50%, using the
Continuous mode ("i8088_Cnt0" = -1) and the currently measured frequency of the I-8084W is 0 Hz.

of H !‘y
Workspace 0000 HewSpyt.spl
B _[\ demo_8088w [RUN] [ Name | Value | Description W Mame | Yalue | Type

(1~ Exception programs g i8088_Freqd 100 Init =100 [Hz) = {2} Global variables A
[ Programs i8088_Dutyd 05 Init = 0.5 (50%) i80858_Freqd 100 DINT
: “5] Main g¢  i9088_Cnt0 - Init = -1 (Continuous mode) i8088_Dutyd 0.5 REAL
£ Watch [for debugging) i8088_Run0 ‘ TRUE: Start, FALSE: Stop i8088_Cnt0 -1 DINT

../88 Soft Scope i8088_Statel : Current State i8088_Run0 BOOL
L hritratraing i8084_freqd 0 frequency ch0 of i-3084W iB0B8_Statel BOOL
|=l RETAIN variables
= B %IX1 - i 8088
E B %ID2 - i 8084 _freq

g Global defines

Y Varisbles %ID2.0=i80... O DINT
B Types %ID2.1 0 DINT
%ID2.2 0 DINT
%ID2.3 0 DINT ¥
< < ] 2

[ %] Main| ‘arisbles | NewsSpw1l

Now, set the "i8088 RunQ" as "TRUE" to start the PWM output. At this time, the "i8088 State" will
change from "FALSE" to "TRUE" and output a PWM signal to the I-8084W module, and then the value of
the "i8084 Freq0" will change from 0 Hz to 100 Hz.

Zobd 4 % G @ X S oo 9 o~ E WS AR g (5 % A RUN Paie n e @
Workspace | Cio00 RewSpyt.spl BWEX
[> demo_8088w [RUN] B Mame | Value | Description ¥ Name | Yalue | Type
& [ Exception programs ﬁ i8088_Freqd 100 Init =100 (Hz) E {a} Global variables “~
=4 Programs 8088 Dud 05 Init = 0.5 (50%) i8088_Freqd 100 DINT
“15€] Main B¢  i8088 Cntd -1 Init = -1 (Continuous mode) i8088_Dutyd0 05 REAL
- [ Watch (for debuaging) | i8088_Runl  TRUE TRUE: Start, FALSE: Stop iB085_Cnt0 -1 DINT
48 Soft Scope i8088_Stated  TRUE Current State i8088_Run0d  TRUE BOOL
i =4 Initial values i8084_freqD 100 frequency chi of i-8084\w i8088_Stated TRUE BOOL
-3 NewSpyl ‘ onoo paen [ [l RETAIN variables L
" Bf% Binding Configuration - = B %IX1 - i 8088
29 Global defines [ TRUE W (88 [ B8 %ID2 - i_8084_frey
o 3Y Variables N\ %ID2.0=i80... 100 DINT
BB Types ( FaLSE i) | %021 0 DINT
%ID2.2 0 DINT
%ID2.3 0 DINT ¥
|4 %] Main| ‘ariables | NewSpyl.’ Jrlock [
Build : ' X

If set the "i8088_Cnt0" as 500 (Burst mode), the "i8084_Freq0" value will become 0 after the 1-8088W

outputs 500 PWM pulses. You can try to change the "i8088 Cnt0" value and then set the "i8088_ Run0"
as "TRUE" to view the changes of output.
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Chapter 5 Modbus Master: connecting to Modbus Slave Devices

This chapter lists the way to enable the Win-GRAF PAC as a Modbus Master to connect Modbus
RTU/ASCII Slave or Modbus TCP/UDP Slave devices. If you want to use one XV board in the WP-5xx8-CE7,
refer the Section 5.1.6 to Section 5.1.11.

5.1 Enabling the Win-GRAF PAC as a Modbus RTU/ASCII Master
(1/0 & XV-board)

Application Diagram:

Win-GRAF PAC \(Recommend to connect
(Modbus RTU/ASCII Master) | Max. 32 devices/port)

(Max. 32 Ports) | N
|

B

-8142iW/
i-8144iW
Q.
XPAC XP-8xx8-CEb6

Modbus RTU/ASCII

3 Slave Device
WinPAC ~ WP-9xx8-CE7 tM Series 1/0 Modules

WP-8xx8
WP-5xx8-CE7

=ViewPAC VP-x2x8-CE7

L™
RS-422/485 Modules
i-8142iW (2-ports)

Ki-SlMiW (4-ports) /

Modbus RTU/ASCII
Slave Device

(Refer the P1-1 to view all PAC models)

Follow these steps:
1. Mouse click the “Open Fieldbus Configuration” tool button to open “lO Drivers” window.

Win-GRAF - Test 01

File Edit ¥iew Insert Project Tool: Window Help
Sl g ook oo o falme ARy A
Workspace 10 Orivers | HL o
- Test 0l = T Mame | Type
----- [ Exception programs 5 {2} Global variables
£ [ Programs g [ RETAIN variables
e [H] Main |1 Main
Bl Ej ‘wWatch [for debuggi... || P2 pOnBadindex
8 Soft Scope i P8 pOnDivZero v
------- =4 Initial values ¥ ] b4
------- % Binding Configuration [ Mame | Y alue
------- g Global defines &5
------- ﬁ Yariablesz < | &
....... B Types Build X
W Build,(/ Crass references /I Runtime/l Call stack/l Breakpnints/l Digital zampling trace /I Frampt
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2. Click the “Insert Configuration” button on the left of the “lO Drivers” window, then click the
“MODBUS Master” and “OK” to enable the Modbus Master setting.

? Mame | Type
o} Global variables
|l RETAIM variables

Marne | Walue

~

Add Confignration

ik
Chooze a configuratian
g
N
B £ MODBUS
&b S HODBUS Master
----- MODEBUS Slave

3. Click the “Insert Master/Port” button on the left side to open the setting window. Then, select the
“Serial MODBUS-RTU”, set COM Port (e.g., “COM2:9600,N,8,1”) and Delay time (recommended
value: 10 ms, it can be 0 to 10000), and then click “OK”.

1O Drivers *

? Mame | Type
i} Global variables
4 . RETAIN variables

Mame | Yalue

[] Main
oK
ik (O MODBLS on Ethernet -, ®a pOnBadindex
A Address: [ ‘ | cancel B P2 pOnDivZera v
g | Port: i | l
Mo Pratocol: =)= | Walue

- -

8 F ] &

Com, port: %COMZ:%DD,N,B,I

|

If wish to set it as a Modbus ASCII
Master, change the setting to
“ASCII:COM2:9600,N,8,1”

.

Delay between requests

Delay {ms):

[
110

After receiving the respond, waiting for
10 ms to send the next command

Try to reconnect after communication error
V| Manage diagnostic info for slaves

[ pisabled (da not open and manage this port)

1
%

Select “Disabled” if you do not want
to use this COM Port setting.

4. Click the “Insert Slave/Data Block” button on the left side to create a data block.

E E-Mp t4ODBLS Master MName | Walue

Mode

Addreszs

Part

Reconnect after error

Slaves diagnostics
Delay between requests [mz]
Dizabled

RTU
COMZ2:9600.M.8.1
502
10

[
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This table lists five data blocks, and each data block stands for one Modbus Master Request.

Item | Function Code Modbus Request Description
1 2 Read Input-bits Read DI data
2 5 Write single coil-bit Write DO data
3 4 Read Input Registers Read Al data
4 6 Write single holding register | Write one AO data (16-bit)
5 16 Write Holding Registers Write multiple AO data (16/32 bits)

Note: If you want to disable the Modbus RTU/ASCII Master port while the program is running, refer the
Section 5.1.13 to use the “MBRTU_M_disable” function.

5.1.1 Read DI data
1. Completing all the following settings in the “MODBUS Master Request” window, and then click “OK".

MODBUS Master Request Q

a. Slave/Unit:
Request = : m Enter the Net-ID of the Slave device.
Description: | | = (In this case, the Net-ID is ”1").

SlavefUnit: |1 @ b. MODBUS Request:

Select “<2> Read Input Bits” option.

MODBUS Request
SRR — c. Base address:
| 1= Read Coil Bits ~ e
{ 2> Read Input Bits 5 Start from “1” by default.
(Do hen o Roase M| Nb items:
@ bata Blodk | | The number of DI signals to read.
Bass sddracsr: 11 ' (In this case, the number is “16”).
b items: 16 Note:
@ = = If you want to change the “Base address”,
Activation } , ) right-click the “MODBUS Master” and
® Periodic: | ‘
(‘?Eemdl:c' 2000 Rt | then select the “MODBUS Master
) On call e v »” .
) on change €———— ] ] Addresses” to modify the value.
On change This option can not apply _
Misc. to the "Read" request. 10 Drivers
@ 2 = B ) M ODELS Master
Timeout: |250 ms -
Mb trials: :1 HMODBUS Master addresses
= irst valid dd
First valid MODELUS addresses
d. Activation: The way to send the Modbus request. Input bits: 1
Periodic: Sending the request periodically. ol bits: 1
(In this case, to send once every two seconds.) Input registers: |1
“on error” means the next sending time when Holding recietere:
Holding registers: |1
an exception occurred (e.g., 15 seconds).
On call: The request is activated when a program call
to send it

On change: In case of a write request, means that the request is activated each time any variable
changed.
e. Timeout: Set a timeout value. (When time-out occurred, it will show the defined error code.)
(The recommended value for the Modbus RTU/ASCII device is 200 to 1000 ms. E.g., 250 ms)
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2. Next, open the “Variables” window and then declare variables that are available for the program.

 drivers

=) Test_01 B Mg MODBUS Master Name | Yalue
-1 Exception programs 2 = ;'%; RTL: COM2:9600,N,8.1 Request <2> Read Input Bits
— 1 Programs "E [_ “B <2> Read Input Bits (1) [1..16] || Slave/Unit 1
: T Main ) K Address 1
,‘ 3 Watch [for debuggi... ||~ _. Nb Item 16
- -8 Soft Scope g Tips: _ | Activation Periodic
o B Tritial values Press “F1” key to view the details |peiogmsg 2000
- %i% Binding Configuration 4| on the MODBUS Master settings.  [Ferod on emor 15000
- 3g Global defines és Timeout [ms) 250
| M:F Number of tials 1
Lo BB Types B Description
Double click it to open the window. | Operation | Dffset | Mask | |
< >

Declaring 16 variables to read data (Name: “Boo_01 to Boo_16"; Type: BOOL) and one array variable to
record the state of data access (Name: “Status"; Dim.: 5; Type: DINT). Refer the Sectin 2.3.1 for the
way to declare variables, and the figure below shows defined variables.

Voribles —— ____  EEX
“F | Mame | Type | Dirn. [} Attrib. | Syb. | Initvalue | User.. | Tag | Description
E {2} Global variables ~
Bool_01 BOOL O
Bool_02 BOOL O
Bool_03 BOOL O
Bool_04 BOOL O
Bool 05 BOOL O
Bool_0B BOOL
Bool 07 BOOL E Bool 16 BOOL L]
Boal 08 BOOL O [ Status DINT ] L]
Bool 09 BOOL O 5 A ‘
Bool_10 BOOL O =
Boal_11 BOOL O
Bool_12 BOOL O J L
Bool_13 BOOL O
Bool 4 JBOOL E Bool_15 BOOL H
Bool 16 |BOOL O Status DINT [0..4] L]
T |
4 }_ 10 Driwers Yariablas

3. Inthe "lO Drivers" window like the figure below, drag all required variables in the Variables Area (i.e.,
“Bool_01" to “Bool_16" and “Status”) and drop them to the “Symbol” area in the first data block.
Note: The “Status” is an array variable, so, the Status[0] to Status[4] will show on the “Symbol” area.

Click the “Del” key to delete the Status[1] to Status[4].

4. Next, select “Offset” field from “Boo_01" to “Boo_16" and then click the “Iterate Property” button
on the left side to set the “Offset” value (From: “0” ; By: “1”, refer the Section 3.1 — Step8).
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5.

In the “Operation” field, set the “Status[0]” as “Error report” which means the return value is an

“Error Code” if a read error occurred and the value will be reset to “0” if read successfully.

IO Drivers *

I8 Mg MODBUS Master Name | Value ¥ Name | Type
=i [_ﬂ] RTU: COM2:9600,M,8,1 Request <2> Read Input Bits 2 Bool_01 BOOL &
3 (-8 <2> Read Input Bits (11 [1..16] }Iavea"Unit = Bool_02 BOOL
B beldie Y |Bool 03 BOOL
“F* Symbol | Operation | Dffset | Mask | Storage | Range [L¢ Bool 04 BOOL
E Bool_01 Data exchange 0 FFFF  Default Bool_05 BOOL
B: Bool 02 Data exchange 1 FFFF Default Bool_ﬂ@ 7 BOOL
Bool 03 Data exchange 2 FFFF Default BQgI_jj? BOOL
&5 |Bool 04 Data exchange 3 FFFF  Default === " N Bool 08 BOOL
Bool 05 Data exchange _ _ £l FEFE — Defaut =~ ~ Bool_09 BOOL -
lBooLos € ~Pazerchance [ FFFF  Defaul Boal_10 BOOL
Bool 07 Data exchange 53 FFFF Default Bool_11 BOOL
Sool Data exchange 7 FFFF  Default Bool 12 BOOL
Data exchange 8 FFFF  Default Bool_13 BOOL
LG Data exchange g FFFF  Default Bool_14 BOOL
Bool_11 10 FFFF Default Bool_15 BOOL
Bool 12 11 FFFF Default Bool 16 BOOL
Bool 13 Data excharge 12 FFFF  Default Status DINT v
Bool_14 Data exchange 13 FFFF Default T
Bool 15 Data exchange 14 1 —
Bool 16 Dataeschange [0 FFFF —Data
Status[0] Data exchange 0
p Mame 4 |

6_ 10 Privers

The “Offset” must be “0” when
selecting the“Error report”.

BonViG =

Statuz[0] n | Data exchange
EIILII TEPUN e ur

4 Or-going request

4 | 10 Drivers
Build

‘ariak | SUCCEsE counter
Fail counter

Rety counter
Command [one shat]
Command [enable]
Rezet counters

Frari: By 1 E

Resulk:

[ OF. l [ Cancel

You can also press “F1” in this “10 Drivers” window to see details on Modbus Master Configuration.

Error Code Description Error Code Description
0 The communication is OK. 8 Data Parity Error.
1 MODBUS function not supported. 10 Invalid gateway path.
2 Invalid MODBUS address. 11 Gateway target failed.
3 Invalid MODBUS value. 128 Communication timeout.
4 MODBUS Server failure. 129 Bad CRC16.
6 Server is busy. 130 RS-232 communication error.
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5.1.2 Werite DO Data

1. Using the same way in the Section 5.1 - Step 4 to create the second data block and completing all the
following settings in the “MODBUS Master Request” window, and then click “OK".

MODBUS Master Request m In this example

Eifest = I a. Slave/Unit:
Description: .
RS R - - ‘ Enter the Net-ID of the Slave device.
SlavefUnit: 2 \@ (e.g., the Net-ID is “2”).
MODBUS Request b. MODBUS Requ.est:. o
23> Read Holding Registars =) @ Select “<5> Write single coil bit”.
| <4> Read InEut Reﬁisters )| c. Base address:
Ty T - ”\;‘ Start from “1” by default.
Data block - A (Refer the Section 5.1.1 to change it.)
@ Base address: il ’ d. On call:
R e \ The request is activated when a
E program call to send it
Bk , (Refer the Section 5.1.1 for details)
() Periodic: 1 ’ ms \ J _ I
b= | = ] e. Timeout: Set a timeout value.
@ on cal {on error) . N
©)On change When time-out occurred, it will show
e the defined error code. (The

@ ey 1250 ’ ms recommended value for the Modbus

= = RTU/ASCII device is 200 to 1000 ms.

. % il
bkt ’ In this case the value is 250 ms.)

2. Next, open the “Variables” window and then declare variables that are available for the program.

Workspace 10 Drivers *

= 2 Test_01 E - Mg MODBUS Master Mame | Yalue
w {1 Exception programs a2 -7 RTU: COM2:9600,N.8.1 Request <5> Write single coil bit
-~ Programs s +] <2> Read Input Bits (1] [1..16] Slave/Unit 2
: T Main B =1 <5 Wiite single coill bit [2] [1..1] Address 1
£ Watch (for debuggi.. | = w Nb Item 1
- /&8 Soft Scope q - Activation On Cal

= Initial values m Tips: Period [ms) 0

%4 Binding Configuration Press “F1” key to view the details | peiodoneror 0
- 39 Global defines é5 on the MODBUS Master settings. | Timeout (ms) 250
; ﬂ Variables MNumber of tials 1
el Types \ B Description

Double click it to open the window.

Add two boolean variables in the "Variables" window (refer the Section 2.3.1 for declaring variables).

Variable name Data type | Description

DO O BOOL Used to Write digital output data.

II’

In this case, choose the “On cal
using a variable to call it.

Act O BOOL way to write data that means
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After completing the settings, the defined variables show as below:

Variables B X
o Name | Type | D.5 | Attib. | Syb. | Initvalue | User.. | Tag- | Description
DO_D BOOL ] A
Act D BOOL O v
| 1 >

4 >7| 10 Drivers. | Vhrialrtlers_,s"»

3. Inthe “IO Drivers” window, drag variables - “DO_0", “Act_0” and “Status” (that created in the
Section 5.1.1) from the Variables Area to the Symbol Area in the second data block.
Note: The “Status” is an array variable. When you drag “Status” into the Symbol Area, it will show
“Status[0]” to “Status[4]", simply press “Del” key to delete “Status[0]” and “Status[2] to [4]".

4. Set the “Operation” field of the “Status[1]” as “Error report” (that means this variable will be set to
an error code when a read error occurs, or reset it to “0” when a read request is successful).
Press the “F1” key to see the description of the Modbus Master Configuration and move to the title
“Status and command variables” to know related commands and error codes.

5. Set the “Operation” field of “Act_0" as “Command (one shot)” (that means the request will be sent
only once when “Act_0" is set to “TRUE”. Then, this “Act_0” will auto reset to “FALSE”).
The "Command (Enable)” means the request is sent continuously as long as the “Act_0" is “TRUE".
So, users can set the “Act_0” to “FALSE” to stop sending command.

IO Drivers * WX
B E-Mp MODBUS Master Name | Value 7 Name | Type | Dim. | At
2 -5 RTU: COM2:9600.N,8.1 Request <85> Wiite single coil bit | Bool_11 BOOL 4
y (-8 <2> Read Input Bits (1] [1..16] Slave/Unit 2 ‘ Bool_12 BOOL
B EI = | g b Address 1 Bool_13  BOOL
| Nb Item 1 Bool_14  BOOL
B Activation On Call _ Bool_15 BOOL
m Period (ms) 0 Bool 16 BOOL
Periodoneror 0 Status DINT  [0.4] |
&5 Timeout [ms) 250 » DO D I. BOOL
- Number of trials 1 Act 0, BOOL v
E‘ Description <l <7 %
2 Symbol | Dperation | Offset | Mask | Storage - Fary MName | Yalue
Status[1] Error report 0 _ _ EFEF- —Defaul— ~
po0 € DFsexdhangs 0 FFFF Defaul
[ Act D Command [one shot) |0 FFFF  Default
¢ D ata exchange A 5
Error report =!L

|4 »| 10 Drivers * Varial Errar report [Set anly]
On-going request
Success counter
Fail counter

A ety counter

Command [ane shat]
Command [enable]

Reset counters

Slave: last errar

Slave: last error date stamp
Slave: last emor time stamp

Claua l=eb rasal Asba sb=ram il
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5.1.3 Read Al Data

1. Using the same way in the Section 5.1 - Step 4 to create the third data block and completing all the
following settings in the “MODBUS Master Request” window, and then click “OK".

MODBUS Master Request

In this example

a. Slave/Unit:

Enter the Net-ID of the Slave device.
(e.g., the Net-ID is “3”).

b. MODBUS Request:
Select “<4> Read Input Registers”.

o

d. Base address:
Start from “1” by default.
(Refer the Section 5.1.1 to change it.)
Nb items:
The number of Al signals to write.
(In this case, the number is “10”).

e

d. Periodic: (Refer the Section 5.1.1)

Sending the request periodically.
(In this case, to send once per second.)

“on error” means the next sending

e
Description: ] ‘
—
SlavejUnit: 3 |
MODEBUS Request
f_%ES_Fi;H Input EiEs A
| «3= Read Holding Registers = @
|24 > Read Input Registers &
| B Wik mimale mmil ik )
Data block
-
<€> Base address: ;1 }
Mb items: 1_10 1
e
Activation
(d @ Pperiodic:  |1000 ) ms. 15000 |
800 call {on error)
On change L . .
This option can not apply
2 z ; to the "Read" request.
<e:> Timeout: 1250 ’ ms
Nb trials: ;1 I

e. Timeout: Set a timeout value.

time when an exception occurred
(e.g., 15 seconds).

When time-out occurred, it will show the defined error code. (The recommended value for the
Modbus RTU/ASCII device is 200 to 1000 ms. In this case the value is 250 ms.)

2. Next, open the “Variables” window and then declare variables that are available for the program.

Workspace O Drivers
- Test_01 ‘ E = Mg MODBUS Master MName [ Value

-1 Exception programs 2 g RTU: COM2:9600,M,8.1 Request <4> Read Input Registers

[~ Programs 3 B <2> Read Input Bits (1] [1..16] Slave/Unit 3

T Main E ‘J “B <5> Write single coil bit (2] [1..1] Address 1

[ Watch (for debuggi.. || =1 <4> Read Input Registe Nb Item 10

: B8 Soft Scope a K Activation Periodic

b 2 Initial values i Period [ms) 1000

' %4 Binding Configuration ﬁ Tips: Period on error 15000

... 3g Global defines & Press “F1” key to view the details | Tineout (ms) 250

13} Variables on the MODBUS Master settings. | Number of tials 1

Ll Types \ EJ', | Description

Double-click it to open this window.

Follow the table below to add six Word (16-bit), one Double integer (32-bit) and one Real (32-bit)
variables. (Refer the Section 2.3.1 for declaring variables).
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Variable name Data type | Description
Word_1 to Word_6 WORD Used to Read Al data (16-bit).
Long_1 DINT Used to Read Al data (32-bit).
Real_1 REAL Used to Read Al data (32-bit).

Refer the Appendix A for details on data type and ranges. After completing the settings, the defined
variables show as below:

¥ MName | Type | D.¥ | Attib. | Syb. | Initvalue | User... | Tag | Description
Long_1 DINT ] A
Word_1 WORD ]
Word_2 WORD O
Word_3 WORD |
Word_4 WORD O
Word 5 WORD ] =
Word 6 WORD O
Real_1 REAL O] v
< - 5
(€ ¥ ] l0Drivers | Variables < =

3. Inthe “10 Drivers” window, drag variables - “Word_1 to Word_6", “Long_1", “Real_1" and “Status”
(that created in the Section 5.1.1) from the Variables Area to the Symbol Area in the third data block.
Note: The “Status” is an array variable. When you drag “Status” into the Symbol Area, it will show
“Status[0]” to “Status[4]", simply press “Del” key to delete “Status[0] to [1]” and “Status[3] to [4]".

4. Set the “Operation” field of the “Status[2]” as “Error report” (that means this variable will be set to
an error code when a read error occurs, or reset it to “0” when a read request is successful).

Press the “F1” key to see the description of the Modbus Master Configuration and move to the title
“Status and command variables” to know related commands and error codes.

5. Boththe “Long_1” and the “Real_1” are 32-bit variables and require two Modbus addresses. So, set

their “Storage” column as “DWORD (Low — High)”.

IO Drivers*

B = Mg MODBLUS Master Name | Yalue ¥ MName 4| Tupe | Dim.

a2 - g RTU: COMZ:9600,N,8.1 Request <4> Read Input Reqis... DO 0 BOOL A

A F-*B <2> Read Input Bits (1) [1..16]]| Slave/Unit 3 ‘ Long_1 DINT

8 "B <5> Wiite single coil bit (2] [1..]| Address 1 Real 1 REAL

Q -8 Read Input Reagisters (3] [ | RNRED 10 _ Status DINT [C

ik Activation Periodic ‘ Word_1 WORD

Period [ms) 1000 ‘ Word_2 YWORD

i Period on err... 15000 Word 3 WORD

&b Timeout [ms] 250 _ Word_4 WORD e

' Number of tri... 1 Woard 5/ WORD

E* Description e Waord 5 WORD B

% Symbol | Dperation | Dffset | Mask | Storage - - 3 - ?z# EELAIN variables ¥
Word_4 Data exchange 0 FFFF Defaut  _ - -7 & ¢ <1
Word_5 < Dataexchange _ 0_ _ FEEF- = Brefault : Na ;e — T TE—
Word 6 Data exchange 1] FFFF Default '
Long_1 Data exchange 0 FFFF DWORD [Low - High)
Real 1 Data exchange 0 FFFF DWORD [Low - High]

[ Status[2] Error report ]J FFFF Default ° v
< o e

(4 %] 10 Drivers,” ariables
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6. As the figure below, select the "Word_1" to “Word_6" and then click “Iterate property” to set their
Offset value (From: 0 ; By: 1).

| Dperation | Offset | Mask | Storage |
Data exchange FF :
Data exchange
Data exchange Marme % |

Data exchange

Data exchange

‘'Mm'm M M m

Frarm: Buy: 1 E

B | | Results
(¢ »| 10 Drivers  \ariables

[ Ok K]\[ Cancel ]

7. Next, double click the Offset field of “Long_1" and “Real_1" items and set their values as “6” and “8”,
then press “Enter” key to complete the settings.
Note: One 32-bit data requires two Modbus addresses. For instance, the Offset value of “Long_1"
is “6” and the next Offset value must be set to “8” (i.e., “Real_1").

Symbol | Operation | Dffset | Mask | Storage |
Word_4 Data exchange 3 FFFF Default ~
Word_5 Data exchange 4 FFFF Default

Word_B Data exchange 5 FFFF Default

Long_1 Data exchange 5 EFEF_IBWORD [Low - High)
Real_1 Data exchange g {@—~ % ' WORD [Low - High)
Status[2] Error report 0 EL Diatous v
P ‘ { press “Enter” ¥

4 %] 10 Drivers " Varisbles
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5.1.4 Write AO Data (16-bit)

1. Using the same way in the Section 5.1 - Step 4 to create the 4th data block and completing all the
following settings in the “MODBUS Master Request” window, and then click “OK".

MODBUS Master Request m In this example

Request = 5 m a. Slave/Unit:
D . t : ) .
Lescrpuan \ l Enter the Net-ID of the Slave device.
Slave Unit: ;I (e.g., the Net-ID is “3”).
e b. MODBU? Reguest: Selt‘ect '
24> Read Tnpuk Fegiiers ﬁ—l @ <6> Write single holding register”.

| <5 Write single coil bit = c. Base address:
<6>- Write single holding register Y

|4 En Wit nil i = Start from “1” by default.
Data block (Refer the Section 5.1.1 to change it.)
@Base address: (1 I d. On change: In case of a write request,

Kb e | ] means that the request is activated
- each time any variable changed.
'O'that'?n ; : , (Refer the Section 5.1.1 for derails.)
O Periodic: [ j I ms {0 ‘ i _ )
Ooneal e 2 = e. Timeout: Set a timeout value.
@) on ch;nge e When time-out occurred, it will show
e the defined error code. (The

@Timeout, 250 ‘ ms recommended value for the Modbus

— RTU/ASCII device is 200 to 1000 ms. In

[
b trials: 11 l

L this case the value is 250 ms.)

2. Next, open the “Variables” window and then declare variables that are available for the program.

Workspace 10 Drivers *

=) Test_01 B [ Mg MODBUS Master Name | Value
- Exception programs 2 g RTU: COM2:9600,M.8.1 Request <B> Write single holding ..
[~ Programs 3 -8B <2> Read Input Bits (1) [1..16] Slave/Unit 3
: T Main E & “B <5 Write single coil bit [2] [1..1] Address 1
-4 Watch (for debuggi... o "B <4> Read Input Registers (3 [1..10 Nb Item 1
Pk &8 Soft Scope E <63 \wirite single holding register [3) [1..1] || a0RELT] On Change
w24 Initial values ﬁ Period [ms) 0
- %jd Binding Configuration - ] Period onemor 0
b 3 g Global defines o Tips: Timeout [ms] 250
T Variables Press “F1” key to view the details Nummber of als [1
B Types \ B on the MODBUS Master settings. Description

Double-click it to open this window.

Declaring a "WORD" variable.
(Refer the Appendix A for details on data type and ranges ; refer the Section 2.3.1 for operations).

Variable name Data type | Description
Word_Write_1 WORD Used to write AO data (16-bit).
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After completing the settings, the defined variables show as below:
W MName | Type | D.5 | Attrib. | Syb. | Initvalue | User.. | Tag | Description
Word_Write 1 WORD O]
< \

[ |

3. Inthe “10 Drivers” window, drag variables - “Word_Write_1" and “Status” (that created in the
Section 5.1.1) from the Variables Area to the Symbol Area in the 4th data block.
Note: The “Status” is an array variable. When you drag “Status” into the Symbol Area, it will show
“Status[0]” to “Status[4]", simply press “Del” key to delete “Status[0] to [2]” and “Status[4]".

4. Set the “Operation” field of the “Status[3]” as “Error report” (that means this variable will be set to
an error code when a read error occurs, or reset it to “0” when a read request is successful).
Press the “F1” key to see the description of the Modbus Master Configuration and move to the title
“Status and command variables” to know related commands and error codes.

IO Drivers *

E E}-ﬂm MODBUS Master Name | Walue ¥ Mame T | Type
a - g RTU: COM2:9600,N,8,1 Request <B> Write single holdi... =] ﬁﬁ Global variahles ~
o B <2> Read Input Bits (1] [1..16] SlaveUnit 3 Word Write 1 WORD
E’ fu B <5> Write single coil bit (2] [1..1] Address 1 vvord_b YWYOURD L
= | - *B <4> Read Input Redisters (31[1..10] Nb ltem 1 Word 5 WORD
B e | <6 gle hold Activation On Change Word_4 WORD
e Period(ms] 0 Word_3 WORD
- | Period onerr... 0 ‘ Word_2 WORD
és Timeout [ms) 250 Word 1 WORD
— Number of ti.. 1 | $ Status DINT
B Description -1 Liaal i EAEARE
B —_— e ) L)
= Symbol J_Dpefalion | Offset | Mask | Storage. — — — ~ | Range(Lc Name | Walue l
Word_Write_1 Data exchange” — T~ — FFFF~  Default
Status[3] Error report IU FFFF Default \
< ‘ | %

[€.%] 10 Drivers  Vaimbles
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5.1.5 Write AO Data (32-bit)
1. Using the same way in the Section 5.1 - Step 4 to create the 5th data block and completing all the
following settings in the “MODBUS Master Request” window, and then click “OK".

MODBUS Master Request m In this example

Request = m a. Slave/Unit:

Desciptiaris) | ] Enter the Net-ID of the Slave device.
Fr— Cance . wan

Slave Unit: 1 |@ (e.g., the Net-ID is “4”).

MODBUS Request b. MODBUS Request:
| <63 Write single holding register ~ Select “<16> Write Holding Registers”.
| <152 Write Coil Bits = @

<16:= Write Holding Reaisters c. Base address:

@ ST Start from “1” by default.
ara Ci
Base nddhass il ’ (Refer the Section 5.1.1 to change it.)
S G 1 Nb items:
Mb items: {
B The number of AO signals to write.
Activation . (In this case, the number is “2”
O eriodc: [ [ w1 al because the REAL type requires two
Qon cal {on error) Modbus address).
(*)On change
Misc. d. On change: In case of a write request,
Timeout: 15250 ] ms means that the request is activated
, — each time any variable changed.
Mb trials: il ’

(Refer the Section 5.1.1 for details)

e. Timeout: Set a timeout value.
When time-out occurred, it will show the defined error code. (The recommended value for the
Modbus RTU/ASCII device is 200 to 1000 ms. In this case the value is 250 ms.)

2. Next, open the “Variables” window and then declare variables that are available for the program.

Workspace 10 Drivers *
B @ Test_01 I8 [ Mg MODBUS Master Name | Walue
-1 Exception programs 2 -5y RTU: COM2:9600,N,8,1 Request <16> Wiite Holding R...
-~ Programs J -8 <2> Read Input Bits (1) [1..16] Slave/Unit 4
: T Main E w “B <5> Wiite single coil bit (2) [1..1] Address 1
[ Watch [for debugai... g -8B <4> Read Input Reagisters (3] [1..10] Nb Item 2
j B8 Soft Scope a B <B> Wiite single holding register (3] [1..1]] Activation On Change
p =4 Initial values @ (= I < 165> "w/rite Holding Reaisters [41(1..2] Period [ms] 0
i %4 Binding Configuration 3 K Period onerror [
i 3g Global defines € ] Timeout [ms) 250
T4 Variable Tips: Number of trials 1
BB Types s\ g Press “F1” key to view the details || pescription
on the MODBUS Master settings.

Double-click it to
open this window.
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Declaring a "Real" variable.
(Refer the Appendix A for details on data type and ranges ; refer the Section 2.3.1 for operations).

Variable name Data type | Description
Real_Write_1 REAL Used to write AO data (32-bit).

After completing the setting, the defined variable shows as below:

Variables VX
7 Name | Type [ D.5 | Attrib. | Syb. | Initvalue | User.. | Tag | Description
Real Write_1 REAL ] —
< | 3
|e85 i) 1B Brivers) Variables

3. Inthe “IO Drivers” window, drag variables - “Real_Worite_1” and “Status” (that created in the
Section 5.1.1) from the Variables Area to the Symbol Area in the 5th data block.
Note: The “Status” is an array variable. When you drag “Status” into the Symbol Area, it will show
“Status[0]” to “Status[4]", simply press “Del” key to delete “Status[0] to [3]”.

4. Setthe “Operation” field of the “Status[4]” as “Error report” (that means this variable will be set to
an error code when a read error occurs, or reset it to “0” when a read request is successful).
Press the “F1” key to see the description of the Modbus Master Configuration and move to the title
“Status and command variables” to know related commands and error codes.

5. The “Real_Write_1" is a 32-bit data and required two Modbus addresses. So, set its “Storage” field
as “DWORD (Low — High)”.

IO Drivers *

B - Mp MODBUS Master Name | Yalue ¥ Name 4| Type
2 - RTU: COM2:9500,N,8,1 Request <16> Write Holding R... | Bool_15 BOOL ~
L, -8 <2> Read Input Bits (1] [1..16] Slave/lnit 4 Bool_16 BOOL
8 w8 <5 Wiite single coil bit (2] [1..1] Address 1 DO O BOOL
o - B <4> Read Input Registers (3] [1..10] Nb Item 2 Long_1 DINT
& ("B <B> Wiite single holding register (3] [1..1] | Activation On Change ‘ Real 1 REAL
a EEEY 5> e Hoding Regivte Periodms) 0 ; Real Write 1 REAL |
Periodoner.. 0 Status DINT
és Timeout (ms) 250 } 7 Word_1 YWORD
Number of tri... 1 .7 Word_2 WORD
B Description — -~ . i‘""""{ P MR 3 :
'~ Symbol /| Dperation | Offset | Mask— }—Stﬁra’g; = | Range (Lc MName | Value ]
Real_‘Write_1 < DalF echange 0 FFFF l DWORD [Low - High) l [l
Status(4] Error report l 0 FFFF
< i : %

(4 »| 10 Drivers  Variables
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5.1.6 How to use the XV Board?

The XV board belongs to the Modbus Slave I/0O board. Before using the 1/0 board, users must plug it into
the WP-5xx8-CE7, and then enable the WP-5xx8-CE7 as a Modbus Master (refer the Section 5.1).

Visit the XV board Selection Guide page to get more details:
www.icpdas.com/root/product/solutions/hmi touch monitor/touchpad/xv-board selection.html

All the Win-GRAF demo projects listed in the following table can be found on the CD-ROM. Refer the
Chapter 12, click the Win-GARF menu bar "File" > "Add Existing Project" > "From Zip" to restore the
demo project and to view the details. (CD-ROM:\Napdos\Win-GRAF\demo-project\)

Demo File Name Description
XV107, XV107A | demo_XV107.zip Read 8 DI, Write 8 DO
XV110 demo_XV110.zip Read 16 DI
XV111, XV111A | demo_XV111.zip Read 16 DO, Read 1 DO
XV116 demo_XV116.zip Read 5 DI, Write 6 DO
XVv308_1 demo_XV308_1.zip 1. Read 8 Al, Read 8 DI
XVv308_2 demo_XV308_2.zip 2. Read 8 Al, Write 8 DO
XV308_3 demo_XV308_3.zip 3. Read 8 Al, Write 4 DO, Read 4 DI
XV310 demo_XV310.zip Read 4 Al, Write 4 DO, Read 4 DI, Write 4 AO

Common setting:
1. Mouse click the “Open Fieldbus Configuration” tool button to open the “I/O Drivers” window.

- [B)X]

(78 Win-GRAF - demo_X¥107
File Edit View Insert Project Tools Window Help

S d® 4
Workspace
2 demo_XV107 I8 - Mg MODBUS Master 7 Name | Type
(- [_d Exception programs & SR A RTU: COMO:115200,N.8.1 A107_DILO0  BOOL o
[}~ Programs i #-*B <2> Read Input Bits (1] [1..8] X107 _DIL01 BOOL
: ) Main 8 -8 <155 Wiite Coil Bits (1) [1..6] W7 DI N2 ROOI
(-~ Watch [for debugging) ||~ Mg MODBUS Slave MODBUS Master Port
B8 Soft Scope E !
=4 Initial values Request | Slave/Unit | A - b
‘ %4 Binding Configuration <2> Read Input Bits 1 1 O MODELS on Ethernet oK |
g Global defines @5 <15 write Coil Bits 1 1 A ’ "
{2} Variables = 1L - =)
LB Types §:ES Port: g
Build - If using it as the Modbus {

Frotacol ASCII Master, modify it to
“ASCII:COMO0:115200,N,8,1”

2. Double click on “RTU: COM:115200,N,8,1” to /
open the “MODBUS Master Port” window. o

Note:
Com. port:  [COM0:115200,NM,5,1 ‘

All the demo projects listed in above table
enable the WP-5xx8-CE7 as a Modbus RTU Delay between requests
Master device and set the "Com. Port" as Delay (ms): |0
"COMO0:115200,N,8,1”.
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Configure the AlI/AO channel

If you want to use the Al/AO channel of the XV Board (e.g., XV308, XV310) in the WP-5xx8-CE7. First,
stop the Win-GRAF driver on the PAC and then configure each Al/AO channel by using
"DCON_Utility_Pro_CE_200.exe".

Using the WP-5238-CE7 as an example:
1. Click the "Win_GRAF_WP_5238" (or the small icon on the taskbar) to open the Win-GRAF driver
window, and then click the "End Driver" button.

Win-GRAF-WP-5238 0K

WR-S232 driver Wersion 1.01 , Jul. 16,2014
This product is licensed.

Project name : demo_xXY110 , YMDE size : 303922

Elapsed time : 0. 0: 0:19

Stop the Win-GRAF driver

o) LA TP T _L.H

2. Click "My Device" on the desktop and then get into the path "\System_Disk\Tools\dcon_utility_pro"
to run the "DCON_Utility_Pro_CE_200.exe".

Fle Edit view Go Favorites | || @] ||| x| = -] ||E
-~

I]]ﬂgldrES WSystern_Disk\Toolsvdoon_utility_pro

v auto_config — crnd_config i language
—log_report — rermote_config i system
(CE7_PlatformBase_arm.dl CrdParser. dl Cornmulo.di
P DCOMN_Utility_Pra_CE_200, exe JEESR e B=Re| PACHNET i
latform.d . Protocol.di Utility. ol

3. Click the COM Port button to set the "COM Port" as "COMOQ", set the "Baud Rate" as "115200" and
set the "Format" as "N,8,1", and then click "OK".

DCON Utility Pro 2.0.0.0 for CE7 am{WP5231)

o< e =

[-’jj Erd Address 1 OM Po Optio X

1D |Add. |BaudRate | Cherks.. | Format] oy oM Port Timeout
|COMO[Backplane] Ii 200 ms

[Baud Rate I Protocol IChecksu

@® M3, ONSE,2 OES1 00,81

{1 ‘ 0K *\ ‘ Cancel |
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4. After clicking the Search button, the XV Board (e.g., XV308) will show in the window. Then, double
click this item to get into the setting window.

\

Start Address D End Address |1

13 ! A ! =3 = ! F‘)ncrripfinh

X¥308 1[1h] 115200 Disable  N,8,1 [Modbus RTUJS*AI + 8 Uni ]

Double-click

4 i B
L] ]
COM:O[N,8,1] || Address: 1[01h] || Baud Rate: 115200 || Checksum:Disable

5. Inthe "Configuration" tab, set the "Data Format" as "Engineering Format" (recommended setting),
set the "Fast Mode" as "Fast Mode" and uncheck the "Reverse DI State (INIT*)".

XV308 Firmware[A102]

(| configuration Bat/ar alarm | Dogalarm | HostwoT | o1 | about]

Protocol@IT*)  [odous Ry []

Address 1 E 01H

Baud Rate(IMT*) 115200 =
Parity (INIT*) |8, 1-Mone Parity |2
ChecksurmiINIT*) IDisabIe =
Data Format |Engineering FDrI‘TEI
Fast Made |Fast Mode =]

Response Delay a

[ Reverse DI State (INIT*}:

Set Module Configurations
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6. Inthe "Al/Al Alarm" tab, to configure the proper ranges and values for each Al channel, and
remenmber to select any Al channel (e.g.,"CH:00") you want to use, then click the "Set Alarm"
button.

Xv308 Firmware[A102]

Ofalarm | Host woT | D1 | about |
High Alarm Limit  Low alarm Limit  Alarm Mode
CH:gn 00003 [-000.003]  [fos]+/- 10 v [=][10 | |10 | |pisable [=]
CH:p1 00004 [00.0040] ool +~-5v [+ | |5 | |pisable [+]
cHigz 00052 [-00.0052]  [[os]+~25v []z25 NEE | |pisable [=]
CH:gz 00011 [-00.0011] [mal+-1v [=]1 | |1 | |pisable [+]
CH:D4 -00022 [-000.022] [[0D] +¢- 20 mi[x] 20 | |20 | |pisable [+]
cHips 00005 [-000.005]  ios]+/- 10 v [][10 | |10 | |pisable [+]
CH:p6 00006 [-000.006]  [o&]+~ 10V [w][10 | |10 | |pisable [+]
CH:gy 00001 [000.001]  [foa] +- 10 v []/10 | |10 | |pisable [=]
XVv308:
Type Code Range Data Format Minimum Maximum
Engineering -25000 +25000
05 +/-2.5V _
Hexadecimal 8000h 7FFFh
Engineering -20000 +20000
06 +/-20 mA -
Hexadecimal 8000h 7FFFh
Engineering +4000 +20000
07 +4 mA ~ +20 mA -
Hexadecimal 0000h FFFFh
Engineering -10000 +10000
08 +/-10V -
Hexadecimal 8000h 7FFFh
Engineerin -5000 +5000
09 +/-5V & - &
Hexadecimal 8000h 7FFFh
Engineering -10000 +10000
0A +/-1V -
Hexadecimal 8000h 7FFFh
Engineering -20000 +20000
oD +/-20 mA -
Hexadecimal 8000h 7FFFh
Engineering 0 +20000
1A 0 mA ~ +20 mA -
Hexadecimal 0000h FFFFh
Note:

1. For easy to use, recommended to use the data format - "Engineering”. (E.g., "+/-2.5 V" will show
as "-25000 to +25000" and "+4 mA to +20 mA" will show as "+4000 to +20000“)

2. When using these "Type Code” - 06, 07, 0D, 1A, please check if the position of eight hardware
jumpers on the XW board are correct.
www.icpdas.com/root/product/solutions/datasheet/hmi touch monitor/XV308.pdf
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Note: When using the XV308, you need to click the "Set Power On" and "Set Safe Value" button
(do not choose any DO Status) in the "DO/Alarm" tab.

Xv308 Firmware[A102]

|HostwoT o1 | about |

DO Status
[Jo [Jx [J2 [J3 [J4 [15 [la []7

Set Power On
Set Safe Yalue

@ Read DO

Do not choose any DO Status.
(O Read Power ON Yal.e Then, click the "Set Power On"
(O Read Safe Value and "Set Safe Value" button.

Alarm Status

H:0 Hil H:2 H:3 H:d H:S HiE H:7
[cClear | [clear | [Clear | [Clear | [Clear | [clear | [clear | [ clear |
L:d L:1 L:2 L:3 L:4 L5 L:G L:7
[Clear | [clear | [Clear | [cClear | [Clear | [clear | [clear | [ clear |

7. Finally, back to the "Configuration" tab and click the "Set Module Configuration" button (Step5) to
finish the AI/AO configuration, and then close the "DCON_Utility Pro_CE_200.exe". In addition, click
the "Win_GRAF_WP_5238" on the desktop to run the Win-GRAF driver (like Step 1).

Follow the similar way like the steps above to configure the Al/AO of the XV310.

XV310 - Analog Input:

Type Code Range Data Format Minimum Maximum

Engineering -25000 +25000
05 +/-2.5V .

Hexadecimal 8000h 7FFFh

Engineering -20000 +20000
06 +/-20 mA -

Hexadecimal 8000h 7FFFh

Engineering +4000 +20000
07 +4 mA ~ +20 mA -

Hexadecimal 0000h FFFFh

Engineering -10000 +10000
08 +/-10V -

Hexadecimal 8000h 7FFFh

Engineering -5000 +5000
09 +/-5V -

Hexadecimal 8000h 7FFFh

Engineering -10000 +10000
0A +/-1V -

Hexadecimal 8000h 7FFFh

Engineering -20000 +20000
oD +/-20 mA .

Hexadecimal 8000h 7FFFh

Engineering 0 +20000
1A 0 mA ~ +20 mA -

Hexadecimal 0000h FFFFh
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Note:
1. For easy to use, recommended to use the data format - "Engineering”. (E.g., "+/-2.5 V" will show

as "-25000 to +25000" and "+4 mA to +20 mA" will show as "+4000 to +20000°)

2. When using these "Type Code” - 0, 1, 06, 07, 0D, 1A, please check if the position of eight
hardware jumpers on the XW board are correct.
www.icpdas.com/root/product/solutions/datasheet/hmi_touch monitor/XV310.pdf

XV310 - Analog Output:

Type Code Range Data Format Minimum Maximum

Engineering 0 +20000
0 0 mA ~ +20 mA

Hexadecimal 0000h FFFFh

Engineering +4000 +20000
1 +4 mA ~+20 mA

Hexadecimal 0000h FFFFh

Engineering 0 +10000
2 ov~+10V

Hexadecimal 0000h FFFFh

Engineering -10000 +10000
3 +/-10V -

Hexadecimal 8000h 7FFFh

Engineering 0 +5000
4 OV~+5V -

Hexadecimal 0000h FFFFh

Engineerin -5000 +5000
5 +/-5V = - =

Hexadecimal 8000h 7FFFh
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5.1.7 Connecting the XV107/ XV107A (8 DI, 8 DO)

The XV107/XV107A is an 8-channel digital input and 8-channel digital output board. This section
provides a Win-GRAF demo project - "demo_XV107.zip". First, go to Section 5.1.6 for the information of
the XV Board before using it.

Demo description:
This demo added two data blocks. One is used to read 8 DI data and the other is used to write 8 DO
data.

1. Mouse double click the 1st data block (i.e., <2> Read Input Bits) to open the setting window.

Workspace i 10 Drivers
= demo_X¥107 B C Mg MODBUS Master A7 Name | Type

[}~ Exception programs 2y [~ g RTU: COMO:115200,N.8.1 AV107_DILOD BOOL A

=4 Programs g : 23] ¢2> Read Input Bits (1) [1..8] | X107_DILD1  BOOL

{ %] Main -8 <15> Wiite Coil Bits (1) [1..8] v X107_DIL02 BOOL

-4 Watch [for debugging) ‘—-} ; X107_DI 03 BOOL

i@ Soft Scope 5 Symbaol | Operation | Dffset| Mask | Storage w107 DI04 BOOL
— XV107_DI_00 Data exchange 1] FFFF Default oS =2

=4 Initial values A107_DIL05  BOOL

TR g ; Q X107_DI_ Data exchange 1 FFFF Default o
%3 Binding Configuration 2 X107 DI 0B BOOL
. z .. AV107_DI_02 Data exchange 2 FFFF Default et
39 Global defines @5 X107 DL 07 BOOL
. A X107_DI_03 Data exchange 3 FFFF Default
¥ Variables - Xv107_status  DINT |
B Tunes B¢ X107_D1_D4 Data exchange 4 FFFF Default ] 07—0 5 0 BOOL ¥
i 5107_DI_05 Data exchange 5  |FFFF Defaut 5 5
Y %d107_DI_06 Data exchange B FFFF Def. f Nﬁ val =
X107 DI 07 Data exchange 7 FFFF_~Detaul a0e Sue
[ XV107_status Error report 1] F Default

| S eIk ‘ | [

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value
plus 1 (Base address). Moreover, if you set the “Operation” as "Error report”, the “Offset” value
for the mapping variable (Date Type: DINT) must set to “0”.

MODBUS Master Request @

K
Description; \ J 2
e
'[ : . iqn
Slavefunit: |1 *\ The Net-ID ( fixed to “1”) of the
Slave device (i.e., XV board).
MODBUS Request
| <1> Read Coil Bits x|
| 2> Read Input Bits —
| £3> Read Holding Registers Read DI data
| A Pmad Trm ik Mamickav~ *
Data block
Z :
Base address: |1 ’
: — — Start from addr. 1 and
Mb items: |8 | .
 — read eight data.
&ctivation
@periodic: (50 ms o }
Ooncal
; Read every 50 ms.
() on change Y
Misc,
Timeout: 100 ms . .
‘ An exception occurs if no
Z g
Mb trials: 1 ’ respond for 100 ms.
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2. Mouse double click the 2nd data block (i.e., <15> Write Coil Bits) to open the setting window.

Workspace ’ 10 Drivers
52 demo_Xv107 | B =-Mg MODBUS Master AT Mame | Type |
2 1] Exception programs 2 g% RTU: COMO:115200M,8.1 =l X107 _DIL05 BOOL o
- Programs i -8 <2> Read Input Bits (1) [1..8] 107 _DIL0Os  BOOL
L e 3] Main ;. E’ (EER = B <155 Wite Coil Bits [1)[1..8] 107_DIL0O7  BOOL
= 4 Watch [for debugging) Q { @ +0:Xv107_D0_00 v || 107 _status  DINT
= -8 Soft Scope ‘E Symbol | Operation = | Offset)| Mask | Storage \ X107_DO_00  BOOL
= Inital values *%¥107_DO_00 Data exchange 0 FFFF Default ‘ A107_DO_01  BOOL
g Binding Configuration X107_D0_01 Data exchange 1 | FFFF Defaut AV107_DO_02  BOOL
-39 Global defines (82 %v107_D0_02 Data exchange 2 |FFFF Defaul A¥107_DO_03  BOOL
- fay Variables E: %y107_D0_03 Data exchange 3 FFFF Default X107_DO_04 BOOL 3
& Types = %v107_D0_04 Data exchange 4 | FFFF Defaul A¥107_DO_ D5 BOOL
| Xv107_DO_05 Data exchange 5  |FFFF Defau AV107_ DO 0 BOOL
%v107_DO_08 Data exchange 6 |FFFF  Defaul T R
X107_D0O_07 Data exchange 7 FFFF Default ——— TR —
= || MName | Walue ]

MODBUS Master Request m

Request

Description: [

|

Slave/Unit:

B f

MODEUS Request

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

I <5 Write single coil bit

| <6 Write single holding register
<15 = 'Write Coail Bits

SE e Wik LAl

Write DO data.

Data block

Base address: 1

e fé——l Start from addr. 1 and

= ' 4] write eight data.
Activation

O periodic: ’ ms IU J

O on cal {on error)

.— .

) 0n change Write only when data changed.
Misc,

Timeout: 100 e

{ = An exception occurs if no
b trials: : ‘ respond for 100 ms.
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5.1.8

"demo_XV110.zip". First, go to Section 5.1.6 for the information of the XV Board before using it.

Demo description:

Connecting the XV110 (16 DI)
The XV110 is a 16-channel digital input board. This section provides a Win-GRAF demo project -

This demo added one data block that used to write 16 DI data.
1. Mouse double click "<2>Read Input Bits" to open the setting window.

Workspace

=) demo_XV110
[ Exception programs

-3 Programs
3] Main

- Watch [for debugging)
: &8 Soft Scope
- =4 Initial values
%4 Binding Configuration
39 Global defines

ﬁ Variables
BB Types

10 Drivers

)

B & I"\n MODBUS Master A |57 Name | Type

G & RTU: COMO:115200N,8.1 , Xv110 DI 00 BOOL 4
i G- <2> Read Input Bits (1] [1..16] Xv110_DI_01 BOOL
Symbol | Operation | Offset | Mask | Storage AV110.DL.OZ2  BOOL
®V110_DL_00 Data exchangs 0 [FFFF Defaut Ayl DL oL
/110_DI_01 N T e G XV110 DI 04  BOOL
X110_DI_02 Data exchange 2 |FFFF Defaut AV110_DIOS  BOOL
%/110_D1_03 D s 5 b san Xv110_DI06  BOOL
S110_DI_04 Data exchange 4 FFFE Defaul AV110_DI_07 BOOL
/110_DI_05 trasbanm =5 e G Xv110 DI 08 BOOL
%110_DI_08 Diskaiskchiangs 6  |FFFF Defaut AV110_DIOS  BOOL

“ 1100107 S > B oaan Xv110_DL10  BOOL
®¢110_D1_08 Data exchange a FFFE Default AV110_DI_N BOOL
%/110_D1_03 " - 5 | s X110 Dl 12 BOOL
%/110_DI_10 Distaiéichiangs 10 |FFFF Defaut AV110 DL13 - BOOL
RV110_DL11 Dats exchangs 11 |FFFF Defaut U0DLg OOk
2110 DI_12 Data exchange 12 |FFFF Defaut AN10 D15 BOOL
Y110 DI_13 Data exchange 13 |FFFF Defaut X110 status  DINT_ |
X¥110.DI_14 Data exchange 14 FFFF Defa 2 S > ,
X110 DI 15 Data exchange 15 FFFF efault Name | Value |
K110_status 1] Default

G

Error report

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value

plus 1 (Base address). Moreover, if you set the “Operation” as "Error report”, the “Offset” value

for the mapping variable (Date Type: DINT) must set to “0”.

Request
Description:

SlavejUnit:

MODEBUS Request

|

MODBUS Master Request m

[ il

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

| <1 Read Coil Bits

Il <23 Read Input Bits T
[ ‘23> Read Holding Registers

| A Omad Trem ik 0

Data block

Base address:

b items:
Activation

(%) Periodic:

Ooncal
(O on change

Misc,

Timeout;

b trials:

mmimb v

~

Read DI data.

Start from addr. 1 and

Read every 50 ms.

(R |

i1

L

16 +\

— read 16 data.
I

iso ‘\ 0

'100 K

!1 l

An exception occurs if no
respond for 100 ms.
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5.1.9 Connecting the XV111, XV111A (16 DO)

The XV111/ XV111A is a 16-channel digital output board. This section provides a Win-GRAF demo
project - "demo_XV111.zip". First, go to Section 5.1.6 for the information of the XV Board before using
it.

Demo description:

This demo added two data blocks. One is used to write 16 DO data and the other is used to read the DO
status.

1. Mouse double click the 1st data block (i.e., <15> Write Coil Bits) to open the setting window.

%) Win-GRAF - demo X¥111 D@@

File Edit View Insert Project Tools Window Help
SR BE = D TNEREE D, G SN T - oS /2 30 T et |

Workspace 10 Drivers

E- 2 demo X¥W111 |8 Mg MODBUS Master | Type
[ [3 Ewception programs 2 g5 RTU: COMO:115200,N.8,1 X111_DO 00 BOOL o
[ Programs b SRR = § < 15> Wwiite Coil Bits (1) [1..16] X111_DO_M BOOL
e [ Main ¥ N ®¥111 DO 02  BOOL
)-8 Watch (for debugging) || = _Symbol | Ogersion N, | Ofiegfask [ Stoage || yvi11-pops  BOOL
. L..I2N Soft Scope 7 X¥111_DO_00 Data exchange 0 Default w11 00 04 BOnl
o L %111_D0_01 Data exchange 1 “ ” . .
- £ :Br::zln s;a!l:u::ﬁgwauon B oo iy 3 Note: The “Offset”value is starting
39 Global defines g5 X¥111.00_03 Data exchange 3 from “0” and the Modbus address
o} Variables £021.00.-0 Dby ety $ of a variable is equal to this value
L BB Types B¢ *v111_D0D_05 Data exchange 5
~ Xv111_D0_06 Data exchange 5 plus 1 (Base address = 1).
© x111_D0_07 Data exchange 7 e T BT
*®¥111_D0_08 Data exchange 8 FFFF  Default w111 DO 12 BOOL
*®¥111_D0_09 Data exchange 9 FFFF  Default w111 DO 13 BOOL
*®¥111_D0_10 Data exchange 10 FFFF Default w111 DO 14 BOOL
X¥111_D0_1 Data exchange 1 FFFF Default 11 1_00‘1 5 BOOL
®¥111_D0_12 Data exchange 12 FFFF  Default W11 status DINT 2
X¥111_D0_13 Data exchange 13 FFFF Default <)\ ‘.— R
XV111_D0O_14 Data exchange 14 FFFF Default p Na;e. = i Value — |
XV111_D0_15 Data exchange 15 FFFF Default T
< | ¥

MODBUS Master Request m
Request
Description: | |

Slave Unit: G ?\ The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

MODBUS Request

| <5 Write sin]ile coil bit ~
| <6 Write single holding register
<15 Write Coil Bits

| #1&n Whvikn Unldima D nmickave Write DO data.
Data block
e —
Base address: I1
= —*1 Start from addr. 1 and
L ko | write 16 data.
Activation
(O periodic: ! ‘ ms ‘0 ‘
Concall {on error)
(*)Onchange @ | :
Write only when data changed.
Misc,
Timeout: ,{ 100 ms . .
S An exception occurs if no
Mb trials: il } respond for 100 ms.
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2. Mouse double click the 2nd data block (i.e., <1> Read Coil Bits) to open the setting window.

Workspace I 10 Drivers
B demo_XV111 | |8 Mg MODBUS Master »
¢ [ Exceptionprogriams || @ © iy RTU: COMO:T15200N 21
=+ Programs -8 <15> Wiite Coil Bits (1) [1..16]
i 1] Main SER=] < 1> Read Coil Bits [11[1.1]

W Name | Type
X111_DO_10 BOOL &
X111_DO_11 BOOL
®/111_D0O_12  BOOL

"E
(1[4 Watch (for debugging) || = @ Error report: X111 _status 3 X111_D0O_13  BOOL
A |
- ‘“  — E Symbol | Operation | Dffset | Mask | Storage ARt ] 0 BRLL —
B Inifal values X111 _status Error report 0 FFFF Default e Bl
%3 Binding Configuation || = = R [ xv111_status  DINT |
-3 g Global defines é5 — ? %
fa} Variables E" Name | Value . [
BB Types ‘ < 2|

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value
plus 1 (Base address).

| |

Description:
Slave Unit: ,rl }\ The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

MODBUS Request

-(1 = Read Coil Bits ~ 1\

| ©2=> Read Input Bits

| 23> Read Holding Registers Read DO data.

l_«'.'.‘. = Dmmd Trm ik Dmmickavs

Data block

——
Base address: il
. f— Start from addr. 1 and
b eems; & read one data.
Activation

(%) periodic: ]I 50
{oncal
(O on change

-

Read every 50 ms.

Misc,

imeouE: 100 i i
Timeout: 4& An exception occurs if no

b trials: l1 | respond for 100 ms.

ms
ms

|

Win-GRAF User Manual, V 1.07, Apr. 2018 by ICP DAS 5-25



5.1.10 Connecting the XV116 (5 DI, 6 Relay)

The XV116 is a 5-channel digital input and 6-channel relay output board. This section provides a
Win-GRAF demo project - "demo_XV116.zip". First, go to Section 5.1.6 for the information of the XV
Board before using it.

Demo description:
This demo added two data blocks. One is used to read 5 DI data and the other is used to write 6 DO
data.

1. Mouse double click the 1st data block (i.e., <2> Read Input Bits) to open the setting window.

Workspace 10 Drivers
_)1 demo_XV116 B : M]] MODBUS Master :
[ Exception programs 2 -ﬂ-; RTU: COMD:115200,N,8.1 *116_D1_00 BOOL ad
([ Programs ‘B : BB =] <2> Read Input Bits (1] [1..5] L4 A116_DI_01  BOOL
© e %] Main i Ef: B <15> Wiite Coil Bits (1) [1..6] 0o A116_DI_02 BOOL
=i, ; e \ ‘
- ',W‘ aich for detiioding) Symbaol | Dperation Offset | Mask | Storage #f1s DI.93 1BO0L
&8 Soft Scope & X116 DI 04 BOOL
§ o XV116_DI_00 Data exchange 0 FFFF Default
o B3] Initial values XW116_status DINT |
Tlé Binding Configuatiac B XV116_DI_01 Data exchange 1 FFFF Default VT1E R 00 BOOL
.88 Glohal definss g XKV116_DI_02 Data exchange 2 FFFF Defau s M
- a‘-‘ S % %116_DI_03 Data exchange 3 |FFFF e | SEE : R
B T e Xv116_DI_04 Data exchange 4 FFFE~" Default Name | Yalue |
G - KV116_status Error report 0 F Default
< | 5

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value
plus 1 (Base address). Moreover, if you set the “Operation” as "Error report”, the “Offset” value
for the mapping variable (Date Type: DINT) must set to “0”.

MODBUS Master Request m
Request
Description: { |

———
SlavefUnit: '1 *J The Net-ID ( fixed to “1” ) of the
MODBUS Request Slave device (i.e., XV board).
{_5 = Read'a:'ﬂ'éits ~l
*
1‘,‘?3’ Reaq Holdng Registers ™ Read DI data.
Data block -
Base address: {1 _
Hb tems: . Start from addr. 1 and
- N read five data.
Activation
(%) Periodic: iSD Q 0
O oncal
S omichange Read every 50 ms.
Misc,
Timeout: ElAlUU ‘Q
;;7? An exception occurs if no
Mb trials: {1 J respond for 100 ms.

Win-GRAF User Manual, V 1.07, Apr. 2018 by ICP DAS 5-26



2. Mouse double click the 2nd data block (i.e., <15> Write Coil Bits) to open the setting window.

Workspace

B demo_XV116

(- Exception programs
1 Programs

i 3] Main

&l [ Watch [for debugging) _‘J

: &8 Soft Scope

o B Initial values

%3 Binding Configuration
3 g Global defines

G} Variables

Ll Types

‘ 10 Drivers
(| |8 Mg MODBUS Master A7 Name | Type | D
s -4 RTU: COMO:115200.N.8,1 X116_DI_04 BOOL ~
‘B E-B <2> Read Input Bits (1] [1..5] L4 KW116_status  DINT
el =¥ < 15> Wiite Coil Bits {11 [1..5] A116_RL_00 BOOL
- Symbaol | Operation AN Offset | Mask | Storage xng—gt—gg gggt
E XV116_RL_0D Data exchange 0 FFFF Default bk, e D
X116 _RL 03 BOOL
m XKV116_RL_O Data exchange 1 FFFF Default w11 E—RL—D 4 BOOL
‘ .. Y11BRL_02 Data exchange 2 FFFF Default Wi B_RL_US BOOL @
'S %v116_RL_03 Data exchange 3 |FFFF Defaut il .
1 B¢ X116_RL_04 Data exchange 4 FFFF Default —_— ——..
XV116_RL_05 Data exchange 5  |FFFF Defaut || Name | Value |
| =i ‘ | 2l

MODBUS Master Request

Request
Description: ’
it: i1
SlavefUnit: l ?\
MODBLS Request

The Net-ID ( fixed to “1” ) of the

Slave device (i.e., XV board).

E <5 Write single coil bit
| <6 Write single holding register
| =15 Write Coil Bits

AL Wvika Ualdims N nmick~®

Data block

Write DO data.

Base address:

Start from addr. 1 and

Mb items: . .
write six data.
Activation
Oeeriodic: |1 1 ms ‘U l
L
) on cal {on error)

{*) on change ¢——m+———|

Write only when data changed.

Misc.
Timeout; ': 100 ms
Mb Erials: i1

An exception occurs if no
respond for 100 ms.
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5.1.11 Connecting the XV308 (8 Al, 8 DIO)
The XV308 is a 8-channel analog input and 8-channel digital input/output board. This section provides
three Win-GRAF demo projects - "demo_XV308_1.zip", "demo_XV308_2.zip" and "demo_XV308_3.zip".

First, go to Section 5.1.6 to view the XV Board instructions and then configure each Al channel by using
"DCON_Utility_Pro_CE_200.exe".

Demo description: (demo_XV308_1)
This demo added two data blocks, one is used to read 8 Al data and the other is used to read 8 DI data.

1. Mouse double click the 1st data block (i.e., <4> Read Input Registers) to open the setting window.

Workspace 10 Drivers
=) demo_XV308_1 |8 Mg MODBUS Master | Type
[ Exception programs & ) RTU: COMO:115200,M,8.1 s & fa} Global variables A
[}~ Programs ER =] <4> Read Input Reaisters (11 [1..8] = AV308_AILD INT
: 13]] Main B i#-*B <2> Read Input Bits (1) [33..40) K & X308 A1 INT
"J E h;h f[fcu debugging) || *= Symbaol | Operation S | Dffset | Mask | Storage AV308_ALZ - INT =
il SulStope B w308 210 Data exchange 0 FFFF  Defaul KV30B_AL3 INT
Bl Iniial values B %V308_A1_1 Data exchange 1 FFFF  Defaul A ALY INT
¥ Binding Configuation || == 1308 Al_2 Data exchange 2 FFFF Defaul AY308.ALS  INT
>34 Blohal cemes €2 /308 A3 Data exchange 3 FFFF Default AV308_ALE INT
-G Variables go XVa08_Al_4 Data exchange 4 FFFF  Defaul XV3I08 AL7 _INT
& pe XV308_41_5 Data exchangs 5  |FFFF  Defaut 00 siae DINT B
I XV308_AI_E Data exchange 53 FFFF Dej (Mﬂ Ll 00', —
X308 Al 7 Data exchange 7 FFFE efault f N.a;e = [ Value =
[ X308 _status Error report 0 F Default
- : > < | )

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value
plus 1 (Base address). Moreover, if you set the “Operation” as "Error report”, the “Offset” value
for the mapping variable (Date Type: DINT) must set to “0”.

MODBUS Master Eequest

Ik
Descripkion: | |

1
it 1
Szt The Net-ID ( fixed to “1” ) of the
MODELS Request Slave device (i.e., XV board).

<2 Read Input Bits ~
=3 Read Holding Reqiskers =
<4 Read Input Registers

~C e Wdwibm il il RiE

N Read DI data.

Drata block
Base address;
Mb items: _ Start from addr. 1 and
read eight data.
Ackivation
(%) Perindic: |5|:| L: ||:| |
{on cal
(") on change Read every 50 ms.
Misc,
Timeouk; 100 ms
An exception occurs if no
b trials: respond for 100 ms.
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2. Mouse double click the 2nd data block (i.e., <2> Read Input Bits) to open the setting window.

Workspace 10 Drivers
- demo_X¥308_1 ‘ B E1-Mg MODBUS Master ~| 7 Name | Type
G- [ Exception programs a2 - RTU: COMO:115200.N,8,1 z AV30B_ALL7 INT o
([ Programs - : &8 <4 Read Input Registers (11[1..8] i 308 _status DINT
3] Main { =8 < Xv308_DIL0O BOOL
D :‘; atch for debugging) || S8 Symbol | Operation | Dffset | Mask | Storage 08 DL |BOOL S
. 4% Soft Scope B X308 DI 2 BOOL -
i o XW308_DI_0 Data exchange 0 FFFF Default =
o B8 Initial values X308 D3 BOOL —
A S B %v208.DI_1 Data exchange 1 FFFF Default i
% Binding Configuration =3 X308 DI 4 BOOL
oo ¢ . X308 DI_2 Data exchange 2 FFFF Default e o
i 3g Global defines é5 X308 DS BOOL
: ; N XW308_DI_3 Data exchange 3 FFFF Default Rl
tofaY Wariables 3 X308_DI_6 BOOL
B Tifses = X308_DI_4 Data exchange 4 FFFF Default 08 DI 7 BOOL %
X308_DI_S Data exchange 5 FFFF Default ) S i
] X308 _DI_B Data exchange B FFFF Default S e— <o ——
XV308_DI_7 Data exchange 7 [FFFF Defaut || Meme | Value
P < | N’ > 1 < ‘\ >

Notw: When using the XV308 to read DI data, the address must start from "33".

MODBUS Master Request

Description: ’ ] : S '

Slevejurit: |1 .| The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

MODBLS Request

} <1 Read Coil Bits
| <2 > Read Input Bits
«3> Read Holding Register

#AN Nmnd Tem bk N

-~

Read DI data.

Data black

Base address: ll 33

b items: 5 Start fr:om addr. 33 and

read eight data.

Activation

(&) periodic: i'so E ‘0 ‘

On call l

8 o ch-ange Read every 50 ms.
Misc.

Timeout; !100 ms ] ]

‘ An exception occurs if no
Mb trials: L i respond for 100 ms.
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Demo description: (demo_XV308_2)
This demo added two data blocks, one is used to read 8 Al data and the other is used to write 8 DO data.

1. Mouse double click the 1st data block (i.e., <4> Read Input Registers) to open the setting window.

Workspace 10 Drivers

- demo_X¥308_2 B - Mg MODBUS Master A7 Name | Type
[ Exception programs & - RTU: COMO:115200,M,8,1 = £ fay Global variables A
| Programs - ER =] <4> Read Input Reaisters (11 [1..8] 1 AV30B_AILD INT
i 5] Main 8 @B <15 White Coil Bits (1) [1..8] P XV308_Al1 INT
l“] E t;l;f[:osrcdc:eb:ggmg] ‘Q Symbol | Operation ~ || offset | Mask | Storage | ﬁgg—i:—g :E; m
B it i Bl xva0s 410 Data exchange 0 FFFF Defaul St
‘!1" Iniial yalves || o vevans A1 Data exchange 1 FFFF Defaul M0 AL INT
1 ‘,““ EIIZ::de::gwamn L KVI08_A12 Data exchange 2 FFFF  Defaul mgg—ﬁ:—g :m
a4 A &2 sovana 4l 3 Data exchange 3 FFFF Default et
) Venables go Xva0s_ Al 4 Data exchange 4 |FFFF  Default it 8 ke L1
B e 3308415 Diatisichianos 5  |FFFF  Defaut XV308_status DINT _Js
E X308 41_6 Data exchange B FFFF D {E a3 —;‘ 2
2308 &l 7 Data exchange 7 FFFE efault Name | Value
[ XK308_status Error report 0 F Default
< i >[¢ i | 3

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value
plus 1 (Base address). Moreover, if you set the “Operation” as "Error report”, the “Offset” value
for the mapping variable (Date Type: DINT) must set to “0”.

MODBOE Master Eeqnest
Request
Description: | |
Slave Unit: ! ?\ The Net-ID ( fixed to “1” ) of the

Slave device (i.e., XV board).

MODEUS Requeskt

2= Read Input Bits -
<3 Read Holding Reqiskers =
N Read Al data.
Daka black,
Base address;
b iteme: _ Start from addr. 1 and
read eight data.
Ackivation
(3) Periadic: |5|:| t o
v on cal
O on changs Read every 50 ms.
Misic,
Timeout: 100 ms ] ]
An exception occurs if no
M Erials: respond for 100 ms.
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2. Mouse double click the 2nd data block (i.e., <15> Write Coil Bits) to open the setting window.

Workspace 10 Drivers
- a_.ﬂ demo_XV308_2 ‘ [B E-Mp MODBUS Master A1 ¥ Name | Type
i~ Exception programs a2 - RTU: COMO:115200.N,8,1 = KW308_status DINT A
[ Programs B : -8 <4> Read Input Registers (1] [1..8] 13 Av3068_DO_0 BOOL
i 3] Main : =8 B = Xv308_DO_1 BOOL
£1--[3 Watch (for debugging) Q : 4 Av3068_DO_2 BOOL
. &8 Soft Scope E Symbol | Operation | Dffset | Mask | Storage | 308 DO 3 BOOL
i o X308 DO_0 Data exchange 0 FFFF Default D 3
o B8 Initial values X308 DO 4 BOOL
A . . ﬁ ®308_DO_1 Data exchange 1 FFFF Default S
% Binding Configuration =3 X308 DO 5 BOOL
I ¢ . A308_DOD_2 Data exchange 2 FFFF Default =g
i 3g Global defines é5 Av308_DO B BOOL
E 4 Varisbles |- ®KW308_DO_3 Data exchange 3 FFFF Default X\/‘308—D O_? BOOL
i ‘g; X308_DO_4 Data exchange 4 FFFF Default B D
B Types ‘ £ >
-~ ®Y308_DO_S Data exchange 5 FFFF Default el —
I %y308 DO_B Data exchange B FFFF Default Name | Walue
X308 _DO_7 Data exchange 7 FFFF Default ‘
) F | — G | =
MODBUS Master Request
Request
OK
Description: [ I ;
[ =
. B
SlavefUnit: | +\ The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).
MODBUS Request (i.e., )

! <5 Write single coil bit -~ |
<6 Write single holding register =

Al

21 & Wdvibm Unldimm O mmiskavs
Write DO data.
Data block
—
Base address: il
b items: '3 Start from addr. 1 and
‘ write eight data.
Activation
O periodic: llj« ’ ms lo ’
8 On cal {on error)
On change @————
. Write only when data changed.
Misc.

Timeout: {200 | ms
—— An exception occurs if no

b trials: ] respond for 100 ms.
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Demo description: (demo_XV308_3)

This demo added three data blocks, the 1st one is used to read 8 Al data, the 2nd one is used to write 4
DO data and the 3rd one is used to read only 4 DI data.

1. Mouse double click the 1st data block (i.e., <4> Read Input Registers) to open the setting window.

Workspace 10 Drivers
- demo_X¥308_3 B -5 RTU: COMO:115200,M.8.1 A1 Name | Type
(- [ Exception programs || & G- <4> Read Input Fregisters (1) [1..8] a_ XV308_AL1 INT A
[}~ Programs B -8 <15> Wiite Coil Bits {1 [1..4] X308 A2 INT
j 13]] Main E i "B <2> Read Input Bits (1) [33..40] A308_Al_3 INT
e[ i i
LJ E t(;:f[:t;rcdof:ggmg] Symbol | Dperation | Offset | Mask | Storage mgg-ﬁ:—g :EI 4
- @ X308 4A1_0 Data exchange 0 FFFF Default XV308— AI—E INT
e IERET . ' [3 X308 Al_1 Data exchange 1 FFFF Default =
1+~Y Birving Confiuratice XV308_AI_2 Data exchange 2 [FFFF Defaut i il
i L Data exchange 3 [FFFF Defaul a0 atns | DIN
i g :‘;::I:Ies g 3308 414 Data exchange 4 FFFF Default X}(\\ggg—gg—? gggt ”
- XK308_Al_5 Data exchange 5 FFFF Default R T --
H 308 ALG Data exchange 6 |FFFF Detaut —|—% 2
K308 417 Data exchange 7 FFFF Default ‘ Name | Value
< [ | ¥ |l ‘ | B

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value
plus 1 (Base address).

MODBUS Master Request

Request
Description: | }
L —
B 1
Slevefinty |t & The Net-ID (fixed to “1” ) of the
MODBUS Request Slave device (i.e., XV board).
| <2> Read Input Bits ~

| 23> Read Holding Reqisters 250

| #En ik cimala ~nilbie O\

Read Al data.

Data block

Base address:

Start from addr. 1 and

b items: * .
— read eight data.

Activation

(%) Periodic: §50 | ms ‘0 ‘
oncal 3

Read every 50 ms.

(O on change
Misc.
% :
Timeout: {100 ms . .
— An exception occurs if no
Nb trials: 1L I respond for 100 ms.

2. Asthe figure below, mouse double click the 2nd data block (i.e., <15> Write Coil Bits) to view the
setting window.

3. Asthe figure below, mouse double click the 3rd data block (i.e., <2> Read Input Bits) to view the
setting window.

Win-GRAF User Manual, V 1.07, Apr. 2018 by ICP DAS 5-32



Workspace J 10 Drivers

- demo_X¥308_3 N]] MODBUS Master Al | Type
{4 Exception programs -ﬁ-; =) {f-; RTU: COMO:115200,M,8.1 ° K308 AL INT ~
[ Programs B -8 <4> Read Input Registers (1] [1..8] - X308 _status DINT
i 1] Main 8 ; BB <15 Wwiite Coil Bits (11 [1..4] - ¥v308_DO_0 BOOL
(-1 Watch [for debugging) ‘3 : -8 <2> Read Input Bits (1) [33..40] F x308_DO_1 BOOL =
P u R @ Symbol | Dperation ) | Dffset | Mask | Storage | AV308_DO_2- BOOL
- Inial values %/308_D0_0 Datawichinos 0 [FFFF Defaut X308 DO 3 BOOL
f ¥ Binding Configuration || =2« /208 DO_1 Data exchanae 1 FFFF Defaul AV308 DL4  BOOL
gs:;;::""es S v308.00_2 Data exchange 2 [ e ([N "t T
P B Types E { iNBUS_DD_B | Data ex;:hange 3 FFFF Default ‘ Name | Value
Workspace 10 Drivers
= demo_Xv308_3 Ig Mo MODBUS Master A Mame | Type
----- 3 Exception programs 2 =N ﬁ; RTU: COMD:115200.4.81 AV308_DO_1 BOOL
-~ Programs N -8 <4> Read Input Registers [1][1..8] 308 Do 2 BOOL
- 3] Main C "B <15 Wiite Coil Bits [1][1..4] ° = AVals_Do 3 BOOL
3 Watch [for debugging] || — : -8 ead [nput Bits [1] 40 303 D4 BOOL
m St Seope E I Sembol | Operation | Offzet | Mask | Storage Xv08 DI 5 \BOOL
- Inital vahies SW3A05_DI_4 Dataeschange | 4 FFFF Defaul X308 Dl 6 1BOOL
~¥ Binding Configuiation |/ == a8 D15 Diata exchange 5 FFFF  Defaul *v308_DI 7 |BOOL &8
~ 59 Global defines 5 a8 DlE D ata exchangs 5 FEFE Defeul 0] &
: E :a”ab"“ gu KV308.DI_7 Data exchange 7 |FFFF Defaul Name | Walue
vpes < | — > | [»

MODBUS Master Request _—
2. <15> Write Coil Bits: ASIEL SEpes X
Write 4 DO data. For i ‘
Description: ’ ’

N E— Cancel

=
Slave Unit: 11
MODBUS Request
[ <5 write single coil bit ~
| <63 Write single holding register =
(<15 Write Coil Bits

The Net-ID ( fixed to “1” ) of the T Wrrite DO data.

. . Data black
Slave device (i.e., XV board). —
Base address: il
; r Start from addr. 1 and
fb items: 4 )
——— | write four data.
MODBUS Master Request Activation
= : O periodic: 0 ’ ms ‘u ‘
eques!
" ) oncal .
Reschpon; yd | - Write only when data
Slave Unit: i1 { ance Misc. changed.
MODBLS Request Timeout: %moi | ms
| 1> Read Coil Bits ~ Hb trigls: 1 An exception occurs if no
mm_ respond for 100 ms.
[_f_ > Read Holding Registers Read DI data. p

sA Nmnd Tmm b M-

Data block

Base address:

e Start from addr. 33 and read

Mb items: . X

only four data in this example.

Activation

@ periodic: |50 ms o |

2 Read 50

ead ever ms. .

Clon change y 3. <2> Read Input Bits, read 4 DI data.
Misc, = = Note:

Tmeo: |10 |ms When using the XV308 to read DI data,
Mb trials: 1 [ the address must start from "33".
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5.1.12 Connecting the XV310 (4 Al, 2 AO, 4 DI, 4 DO)

The XV310 is a 4-ch analog input, 2-ch analog output, 4-ch digital input and 4-ch digital ouput board.

This section provides a Win-GRAF demo projects - "demo_XV310.zip".

First, go to Section 5.1.6 to view the XV Board instructions and then configure each Al channel by using

"DCON_Utility_Pro_CE_200.exe".

Demo Description

This demo added four data blocks. The 1st one is used to read 4 Al data, the 2nd is used to write 4 DO

data, the 3rd is used to read 4 DI data and the 4th is used to write 2 AO data.

1. Mouse double click the 1st data block (i.e., <4> Read Input Registers) to open the setting window.

Workspace 10 Drivers
= demo_X¥310 E =] Hm MODBUS Master AT Name | Type
{14 Exception programs ES -3 RTU: COMO:115200.M,8.1 E {2 Global variables A
[}~ Programs B [ER8=§ <4> Read Input Registers (1) [1..4] AW3T0_AILD INT
: 136] Main E i =B <15> Write Coil Bits (1] [1..4] 0 KW3I10_Al1 INT
(-3 Watch (for debugaing) || -8 <2> Read Input Bits (1) [33..36) - 310 ALZ INT
. 4% Soft Scope & #-*B <16> Write Holding Registers (1) [33..34] G IO AL INT
E ln_ma,I values. ) ¥ ISymboI | Operation | Offset | Mask | Storage AV310_AC_D INT
e g‘ln';"‘lgdc;?”"g“'a"°” ., V3040 Data exchange 0 |FFFF Defaul st S R
34 bichaldefiies &2 sv310_A1_1 Data exchange 1 |FFFF Defaut X310 status DINT_|
T3} Variables go K304 Data exchange 2 FFFF Dek AVS10: 0 [BCOL
e XVI10_A1_3 Data exchange 3 JFFFF_~Defaul £ 2
0 Default Narme | Value

[ K310 _status Error report

‘ ' 2%
|4 5] 10 Drivers < Varisbles

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value
plus 1 (Base address). Moreover, if you set the “Operation” as "Error report”, the “Offset” value

for the mapping variable (Date Type: DINT) must be set to “0”.

MODBUS Master Request m

Request
Description: \ ’ - OK
| -
= - S —
slevejuni: |1 | The Net-ID ( fixed to “1” ) of the
MODBUS Request Slave device (i.e., XV board).
| <2 Read Input Bits gl

J 3> Read Holding

|~ Wdvikm mimale ~ail kik

Read Al data.

Data block
[
Base address: i 1

b items: 4 +\

Start from addr. 1 and
read four data.

Activation
® Periodic: S0 Q io ]
{Joncal
&Y change: Read every 50 ms.
Misc,
z :
Timeout: /100 LQ
2 = An exception occurs if no
Mb trials: ! | respond for 100 ms.
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2. Mouse double click the 2nd data block (i.e., <15> Write Coil Bits) to view the setting window.

Workspace I 10 Drivers *
- demo_X¥310 (| |8 E-Mp MODBUS Master A7 Name | Type
[ Exception programs 2 -8 RTU: COMO:115200N,8,1 W30 AD 1T INT A
[ Programs B : -8 <4> Read Input Registers (1) [1..4] AW310_status DINT
: 3] Main R <15 \wiie Coil Bits (1] (1..4] ¥v310_DO_0 BOOL
& L] Watch [for debugging) ‘J 2B <2> Read Input Bits (1) [33..36] 1} ¥310_DO_1 BOOL
- [ Soft Scope ‘ [F-*B <16> Wite Holding Registers (1) [33..M | Av310_ DO 2 BOOL
; E In-ma.l values. . B Symbol | Dperation | Dffset | Mask | Storage AV310.00_3, |BOOL
%3 Binding Configuration | |° X310 DIL0  BOOL
v ¢ . XV310.D0_0 Data exchange i FFFF Default g
i 39 Global defines @5 X310 DI 1 BOOL
¥ e 2 N XV310.D01 Data exchange 1 FFFF Default i v
i & \ariables { WMN Nl A Don
E BT [ B X¥310_D0_2 Data exchange 2 FFFF Default LT kx|
o XV310_D0_3 Data exchange 3 [FFFF Defalt | jame T Value
[#] —/ |
- (1) I | RAIRS |
MODBUS Master Request
OK
Description: l ‘ ;
—
Slavejunit; |1 '¢\ The Net-ID of the Slave
device (i.e., XV board).
MODBUS Request
| <5 Write single cail bit A |

‘ <6 Write single holding reqister
[ <15 Write Coil Bits
AL Wikm Ualdima Damiscbk v~

Write DO data.

Data block
Base address:
b e Start from addr. 1 and
write four data.
Activation
O periodic: § ‘ ms Lu J
O oncal {on error)
On ch o .
®1Onhonge Write only when data changed.
Misc,
e
Timeout: {100 W . .
L. An exception occurs if no
Mb trials: 1 | respond for 100 ms.

3. Mouse double click the 3rd data block (i.e., <2> Read Input Bits) to view the setting window.

Workspace 10 Drivers *
- demo_X¥310 B Mg MODBUS Master A|/5F Name | Type
(- Exception programs S - [ g% RTU: COMO:115200N.8,1 X310 DO 0 BOOL A
[ Programs - B -8 <4> Read Input Registers (1) [1..4] A310_DO_1 BOOL
] Main 8 7B <15 Wiite Cail Bits (1) [1..4] XV310_DO 2 BOOL
£+ [ Watch [for debugging) | = =Y < 2> Read Input Bits [1 ) ¥310_DO_3 BOOL -
. L./3® SoftScope ‘ ; -*B <165 Wiite Holding Registers WY Xv310_DIL0 BOOL —
Q-,j; ;:lgin\;a?::ﬁguration B Symbol | Operation | Offset | Mask | Storage ﬁlg-—g:—; gggt
8o Global defings é"s) X310.DI_0 Data exchange 0 FFFF Default w3 D_D|_3 BOOL
: é&g Variabl | 7 XV310_DI1 Data exchange 1 FFFF Default = ¥
»- T:::s = g XV310DI_2 Data exchange 2 |eFFF Defar | S = £ 8
XK310_DI_3 Data exchange 3 FFFF Default | Name | Value
v < ‘ ] \——/ > | B
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MODBUS Master Request

Request

Description: 1

|

=
Slave/Unit: 1

MODBUS Request

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

[ <13 Read Coil Bits ~
{mw_-

[ <3 d Holding Regi

Bl e bicaly Read DI data.

Note: When using the XV310 | patablock

to read DI data, the base Base address: |33
address must be set to “33”. b items: 4

Start from addr. 33 and
read four data.

Activation

o |

(%) Periodic: 150 | ms
Concal

Read every 50 ms.

(O on change
Misc,
iz :
Timeout: {100 ; ms
e
hb trials: ! |

An exception occurs if no
respond for 100 ms.

4. Mouse double click the 4th data block (i.e., <16> Write Holding Registers)

Workspace I} 10 Drivers *

- demo_X¥310 ‘ [B E-Mp MODBUS Master A| 7 MName | Type
7+ Exception programs % -3 RTU: COM0:115200,M,8.1 AVIT0_AILT INT A
- Programs 1 #-*B <4> Read Input Registers (1] [1..4] K30 A2 INT
1] Main B : 7B <15> Write Coil Bits (1) [1..4] A3T0_ALS INT
£ Watch (for debugaing) || = B <2> Read Input Bits (1) [33..36] - KY310_AO_0  INT
¢ LR SoftScope ﬁ . @=-"B ding Registe 4 G X310 A0 1 INT
-_,;EI Inﬁ:a} valuesA i . Symbol | Dperation K Offset [|Mask | Storage £l statliz |DINT:
i Q}& Binding Cc.mhguratlon . XV310.40_0 Dataexchange 0 CFFF Default &H=) 2
e € 310,401 Dats excharige 1 FFFF Default || Name | Value
o TAY Variables ‘ | —/ j
B Types =10 : _ - | o SR

(% »] 10 Drivers < Varisbles

MODBUS Master Request m

Request

Descripkion: l

[
Slavefunit: |1 \

MODBUS Request

The Net-ID ( fixed to “1” ) of the
Slave device (i.e., XV board).

[ <6> write single holding register ~
| 153 Wwrite Coil Bits ==
-:‘16:- Write Holding Reaisters =
Y N Write AO data.
. arg Dioc
Note: When using the XV310 s '
ite AO data, the base e s
to write
’ o~ b items: 2 Start from addr. 33 and
address must be set to “33”. — .
write two data.
Activation
(O Periodic: ‘ ms ‘0 I
80“ cal {on error)
On change: @m—— R
- Write only when data changed.
ISC,
Timeout: EIUU ms
Mo, h‘ ] An exception occurs if no

respond for 100 ms.
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5.1.13 To Disable/Enable the Modbus RTU/ASCII Master Port

The Modbus RTU/ASCII Master ports which are enabled in the Win-GRAF "Fieldbus Configuration" -
"0 Drivers" setting window, will automatically work after the PAC is powered on. If user wants to
disable one of the Modbus Master ports, use the "MBRTU_M_disable" function (see below).

(* Declare To_disable as BOOL *)
If To_disable then
To_disable := FALSE ;
MBRTU_M_disable (3) ;
End_if;

In the above code, when you set "To_disable" as "TRUE", it will disable the Modbus RTU/ASCII Master
port - COM3. And later, you can enable it again by using the "MBRTU_M_enable" function (see below).

(* Declare To_enable as BOOL
Declare Status_com3 as BOOL *)
If To_enable then
To_enable := FALSE ;
MBRTU_M_enable (3) ;
End_if;
Status_com3 := MBRTU_M_status (3) ;

The "MBRTU_M_status" function listed above is used to get the status of the Modbus RTU/ASCII Master
port, for example, enabled (True) or disabled (False).
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5.2 Enabling the Win-GRAF PAC as a Modbus TCP/UDP Master
(Ethernet 1/0)

Application Diagram:

Win-GRAF PAC
(Modbus TCP/UDP Master)

ET-7000 Series I/O Modules

LAN VP-x208-CE7

W,
XPAC XP-8xx8-CE6

{Support Max. 100 Slave Devices)
WinPAC WP-9xx8-CE7

Win-GRAF PAC
(Modbus TCP Slave)

WP-8xx8
WP‘SXXB'CE7 Other
ViewPAC VP-x2x8-CE7 Modbus TCP Slave
Device

QJppor! Max. 32 Slave Deviceay

The Setting Steps:

(Refer P1-1 to see the PAC model numbers.)

1. Click the tool icon “Open Fieldbus Configuration” to open the “I/O Drivers” window.

Win-GEAF - Test 01

File Edit ¥iew Insert Project Tool: Window Help

Sl @ s vk - o 0o B lalwedE i B

Workspace 10 Orivers | HL o
- Test 0l = T Mame | Type
----- 3 Exception programs 2 {2} Global variables  #
£ [ Programs q [ RETAIN variables
o [9) Main |1 Main
B Ej Wwatch [for debugai.. | ? 2 pOnBadindex
48 Soft Scope g P8 pOnDivZero v
------- EH Initial values ¥ = b4
------- % Binding Configuration [ Mame | Yalue
------- g Global defines g2
------- oy Wariables ! | >
....... B Types Build X
W Build,(/ Crass references /I Runtime/l Call stack/l Breakpnints/l Digital zampling trace /I Frampt

2. Click “Insert Configuration” icon in the left side of the “I/O Drivers” window, and then click
“MODBUS Master”, then click “OK” to enable a Modbus Master.

Note: One “Modbus Master” can set up multiple Ports (see the next step), can set as a Modbus

Master RTU/ASCII Port (Refer Section 5.1) or a Modbus Master TCP/UDP Port or can set up
not to enable the setting.
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10 Drivers

@ Mame | alue I Mame | Type

= {2} Global variables  »

g |al RETAIN variables

X Add Configuration %]
Chooze a configuration

g

- A
B — £ MODEUS
és & MODEUS Master

. MODBUS Slave

3. Click the tool icon “Insert Master/Port” in the left side, open the setting window and select the
“MODBUS on Ethernet”.
Set up the following items, and then click “OK”.
Address: Fill in the IP Address of the Modbus Slave device (e.g., “192.168.1.100").
Port: TCP port Number of the Slave device.
Protocol: If as a Modbus TCP Master, select the “TCP — Open MODBUS”.
If as a Modbus UDP Master, choose the “UDP — Open MODBUS”.
Delay: Fill in the delay time (e.g., 10 ms, can be 0 ~ 10000).

10 Drivers *

----- Mame | Yalue I Mame | Type
= i} Global variables  ~
LEK Al variables
3 dindex
g | fiero v
>
B — Address: |192.168.1.100 | =
Mode = | Value
&g Port: 502
) ‘ o2 | | 3

Protocol: TCP - Open MODBUS
UDP - MODBUS RTU
UDP - Open MODBEUS
{

() Serial MODBUS-RTU

Com. pork; J ’

e After received an answer,
t )

sl wait for 10 ms, and then

Delay (ms): |10 send the next request.

Try to reconnect after communication error

If not need the TCP/UDP Port
setting, check “Disabled”.

Manage gliagnostic info For slaves

[E] Disabled {do not open and manage this port)
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4. Click the icon “Insert Slave/Data Block” in the left side to create a “Data Block”.

1O Drivers *

Mg MODEUS Master tamme | Walue
3 o4 Open MODELS: 192.168.1.100:502 Mode Open MODBUS
= Address 192.168.1.100
[% Port a0z
= Reconnect after emor
E Slaves diagnostics
Delay between requests [mz] 10
g Dizabled |

Read Al Data
5. Inthe “MODBUS Master Request” setting window, set up the following items, and then click “OK".

MODBUS Master Request |

In this example

Request ; m a. Slave/Unit:
Description: - - .
Descriptio L I Fill in the Net-ID of the Slave device
Slave Unit: i1 I @

(Usually is “17).
b. MODBUS Request:
i Select “<4> Read Input Registers”.

l‘e:§>_}i;d Input E:iEs ~
| <3 Read Holding Registers = @ c. Base address:
| 4> Read Input Reqisters 2l

MODBUS Request

| E s Wdvibn mimoln cnil b = Default to start from 1.
@ Data block Nb items:
[ ‘ .
Base address: |1 ‘ The Al numbers to read (here is 4).
tb items: 4 } Note:

If want to change the “Base address”,

Activati . .
c Wat'?" . E— — please use mouse to right-click the
& Periodic: 11000 ’ ms ‘15000 ; “ ”
| l - MODBUS Master”, and then select
{on cal {on error) “ ”
O on change MODBUS Master Addresses” to

¥ It‘s not suitable for “Read” commend. change the value.

Misc,
@ Timeout: 51000 ‘ ms 10 Drivers

Mb trials: {[1 ’
HMODEUS Master addresses gl
d. Activation: the sending way of Modbus Request. First valid FIODBLE adresses [ x|
Periodic: ~ Send request periodically. In this case, it Input bits: ]
sends request every 1 Sec. “on error” ol
means that when an error occurs, the next Input registers:
sending time (in this case, 15 seconds). Holding registers:

On call: It will send the request once when a

program calls it.
On change: It will send the request once when data is changed.

e. Timeout: Set up the max. time to wait for the response. If exceeds it, that means an error.
(For Modbus TCP/UDP, recommended: 1000 ~ 3000 ms; this example is 1000 ms)
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6. Open the “Variables” window, set up the variables want to use.

Workspace 0D
B Test 2 B Mg MODBUS Master Name | Value
T - Exception programs 2 B ; Open MODBUS: 192.168.1.100:502 Request <4> Read Input Registers
£+ Programs g - | ea Reqiste Slave/Unit 1
e 3] Main K Address 1
E &l J Watch (for debuggi... "3 K MNb Item 4
: /&8 Soft Scope ' E , Tips: ) Activation Periodic
= 3 Initial values g press “F1” key to see the setting ||| pesiad (ms) 1000
% Binding Configuration ~ | method for MODBUS Master. Period onerror 15000
- 3 Global defines ) Timeout [ms) 1000
@ Yariables 1= Number of trials 1
BBy Types \ B Description
Double click to open.
Please follow the table to set up 4 WORD (16 bit) variables (refer Section 2.3.1).
Variable Name Data Type Dim. Description
Word_1~ Word_4 WORD -—- Used to read the Al data (16 bit)
Status DINT 5 Used to record the read/write status

Refer the Appendix A to see the data types and range of the variables. After setting up, it is as the

picture below.

Variables
7 MName /| Type | Dim. | Attrib. | Syb. | Initvalue | User.. | Tag | Description
Status DINT [0..4] O
Waord 1 WORD ]
Word_2 WORD O
Word_3 WORD ]
Word 4 WORD ]

[« ;“] 10 Drivers | Variables

In the “I/O Drivers” window, drag the variables (“Word_1 ~ Word_4" and “Status”) from the

Variables area to the “Symbol” area of the Data Block. Notice: This example shows “Status” is an

Array variable. When drag it to the “Symbol” area, it will become “Status[0] ~
press “Delete” key to delete “Status[1] ~ [4]".

IO Drivers *

Status[4]", please

[B E-Mp MODBUS Master Name | Yalue 7 MName 4| Type | Dim.
2 & ﬂ-; Open MODBUS: 192.168.1.100:502 Request <4> Read Input Regis A | Status DINT [0..4]

‘ -8 <4> Read Input Registers (1] [1..4] Slave/Unit 1 = ord 1 WORD
‘.B' —

Address 1 v ,/ Waord 2 WORD

1k ]

- Symbol | Operation | Offset | Mask | Storage ] Hgngeﬂ Ward_3 WORD
@Data exchange 0 FFFF Default _-" - WORD
g' Word_1 Data exchange 0 FFFF _ Defawk =~ = I Tgm me

Word_2 < - Data exchange— — € — — FEFF Default —_— —

€ - Word_3 Data exchange 0 FFFF Default blame ¥ '
B b Word_4 Data exchange 0 FFFF Default

2% ) 2|

[« ﬂ 10 Drivers ~ \ariables
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8. Set the “Operation” of the “Status[0]” to “Error report” (If reading data fails, its value is an “Error
Code”; when reading data OK, it will reset to “0”.). Press “F1” key to view the setting descriptions for
the Modbus Master. In the title of “Status and command variables”, you can find the details about
this commend and “Error Code”.

9. Select "Word_1~ Word_4" and click “Iterate property” to set up the “Offset” value (From: O; By: 1).

10 Drivers *

[g E-Mp MODBUS Master Name | Value
2 El-g Open MODBUS: 192.168.1.100:502 Request <4> Read Input Regist... |
‘ .,E -8 <4> Read Input Registers [1] [1..4] Slave/Unit 1
| 5 Address 1
[l Nb Item 4
a Activation Periodic
g Period [ms) 1000
1 Period on err... 15000
| &5 Timeout [ms) 1000
' MNumber of tri.. 1
‘ Bt Description
r—
El%n:ol Operation | Offset | Mask | Storage T | Range
Status[0] Error report 0 FFFF Default
° Word_1 Data exchange
Ward_2 Data exchange
e Dimee
Wod4  Dataeschange “ |

£ Frarm: B 1 '

[4 5| 10 Drivers < \ariables

Reszults

[ Ok kl\[ Cancel ]

The setting steps of “Modbus Master Request” for both “Modbus Master RTU/ASCII Port (Section 5.1)”
and “Modbus Master TCP/UDP Port” are the same. Now, we have finished the setting to read Al data.
Please click the item number (link to the Section 5.1.1~5.1.5) in the table below for the setting steps to
read/write other data.

Items | Function Code Modbus Request Description
1 2 Read Input Bits Read DI data
2 5 Write single coil bit Write DO data
3 4 Read Input Registers Read Al data
4 6 Write single holding register | Write one AO data (16-bit)
5 16 Write Holding Registers Write multiple AO data (16/32 bits)
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Note: If you want to disable the Modbus TCP/UDP Master port while the program is running. Refer the
Section 5.2.4 to use the "MBTCP_M_disable" function (and use “MBUDP_M_disable” for UDP).

5.2.1 Connecting ET-7000 Series I/O Module

ICP DAS ET-7000 is a series of /O module supporting Modbus TCP Slave protocol. The Win-GRAF PAC
can enable the Modbus TCP Master to connect the ET-7000 modules. The maximum recommend the
amount of the connecting ET-7000 modules depends on the PAC model, such as the WP-5238-CE7 and
XP-8xx8-CE6, recommends a maximum of 200; the WP-8xx8, WP-8xx8-CE7, and VP-x2x8-CE7 is
recommended that no more than 32.

For more information about the ET-7000 series products, please visit the website:
http://www.icpdas.com/root/product/solutions/remote io/ethernet io/ethernet io selection.html

Use Internet Browser to Set the ET-7000 Modules

Before the first time using the ET-7000, you must set up the ET-7000 by using the Internet Browser.
When the ET-7000 shipping from the factory, the settings are: IP address = 192.168.255.1; Mask =
255.255.0.0. Please set the IP of your PC in the same network (e.g., set the IP to 192.168.255.100, Mask
= 255.255.0.0), then open the browser (such as IE), and enter the IP of the ET-7000 to connect it.

Notice: The Dip Switch on the rear of the ET-7000 must stay in the “Normal” position.

fi% I%ET -7018Z AY{EIAREE 192.168.255.1 SEEAERE
M.

& HhiEliR S T A TS  ER B R EB LT RHZA
9iE (EASes 0 FEEHRER) -

B
e
Username: Admin A
Password: Admin

(Case sensitive) EEEEEU. {ﬁ—z—kdmm v/
TEE): 1«*371.:;; '

(V] seiBHAIEIE R)
[ ®e [ ®m# |
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Click “Configuration” > “Module 1/0 Settings” to set up the range of channels as below, and then click
“Submit”.

ﬁ' PET-7000 Web page - Windows Internet Explorer

(1R £ hip /192.168.255.1 (%) [x] [
v BAVRE | @ PET-T000 Web page 0 - B O & #ER- ®3HO- IRQ
————uy -
ICP DAS = SIS -
—— —
http//www.icpdas.com p— ——
—
el R MEn Modbus Settings (Al Basic Setting)
L Overview
=43 Configuration l Reg 404275 E"a‘t,”,eﬁ {00535)
T Network Setmas Cho [05] +/-2.5V v OFFf [on @
) i i Chi [04] +/-1V v OFFF on & \
! Ch2 [OF] T/C K-type, -270°C ~ 1372°C v ore C lon
- L) | ) "
B - = Set as “ON" to
B10 Wb LMl Ch3 [OF] T/C K-type, -270°C ~ 1372°C v off © loN @ ble it
= a0 enable i
~ " . [ +/-2.5 ¢ | I .
{11 Pair Connection aht AN o i OFF ©[oN
~(1 Mare Information Chs | {05] +/-2.5V v oFf " lon
ché [05] +/-2.5V v oFF " lon |
(Ch7 |(05] +/-2.5V v OFF:VF:T ONg @
chs [05] +/-2.5V v OFF:fiI ON;z;f
“ ” e Rl o > oFf | ON;_ (,;.7
Set “Al Data Format
to ”ON" (Engineer)’ Modbus Address Function Action
means: 00629 50/60 Hz rejection for Al ofF © |ON © | 0=50/1=60 Hz (default=1)

Al Data Format OFE: ’ ON;_i Oq4Hex/1=Engineser (default=0)

+2.5:-25000 ~ +25000
+1 :-1000 ~ +1000

258 :25.8 (°C) | submit |

| I=Clear

Users can set the ET-7018Z‘s "Al Data Format" to "ON" (Engineering) for more convenient usage.
For example:

Type Code Range Data Format Minimum Maximum
Engineering -10000 +10000
04 -1~+1V
2’s comp HEX 8000h 7FFFh
Engineering -25000 +25000
05 -25~425V
2’s comp HEX 8000h 7FFFh
Type M Engineering -20000 +10000
18 Thermocouple Y h H
2200 ~ 100°C s comp HEX 8000 4000

Restore/Open the Demo Project:
The Win-GRAF demo projects in the following sections can be found on the shipping CD, please refer

Chapter 12. Click the menu bar "File" > "Add Existing Project" > "From Zip" can restore/open/check the
demo projects. (CD-ROM:\Napdos\Win-GRAF\demo-project\)

Demo Project File Name Description
ET-7060 demo_ET7060.zip Read 6 DlIs, write 6 DOs
ET-7018Z demo_ET7018z.zip Read 10 Als
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1. Click the tool icon “Open Fieldbus Configuration” to open the “I/O Drivers” window.

= A

Workspace

gomo_E17060)
|_1 Exceplion programs

- Programs

© b ) Main

L - Watch (for debugging) ||

48 Soft Scope

=4 Initial values
: %3 Binding Configuration
= §g Global defines
o ﬁ Variables

B Types

E i
g Request | Slave/Unit | Address | Nbltem | Activation | Peric
- <2> Read Input Bits 1 1 B Periodic 50

€5 <155 Wiite Coil Bits 1 1 6 OnChange 0
B ¢ | 3|

5 iH-*B <155 Wite Coil Bits (1) [1..6]
—" ..Mg MODBUS Slave

7 Hame

ET7060_DI_00
ET7060_DI_01

ET7060_DI_02
ET7060_DI_03
ET7060_DI_D4
ET7060_DI_05

ET7060_status
ET7060_RL_00
ET7060_RL_01

2. Double click “Open Modbus: IP:502” to open the “MODBUS Master Port” window.

Notice:

|€

All demo projects in this chapter can enable the Win-GRAF PAC as a Modbus TCP Master. Please fill
in the current IP address of your ET-7000, and set "Port" to "502” and "Protocol" to "TCP - Open

Modbus".

\lOKI
| =1

Address: {192.168,1.128
Port: 502 y
Protocol: TCP - Open MODBUS

UDP - MODEBUS RTU
UDP - Open MODEBUS

\ {

Enter the current IP address
of your ET-7000.

(O serial MODBUS-RTU

Com. pork:

Delay between requests

Delay {ms): }5

Try to reconnect after communication error
Manage diagnostic info For slaves

[ pisabled {do not open and manage this port)

Win-GRAF User Manual, V 1.07, Apr. 2018 by ICP DAS 5-45



5.2.2 Connecting the ET-7060 (6 DI, 6 Relay)

The ET-7060 is a 6 DI and 6 Relay channels Ethernet I/O module. The Win-GRAF demo project for this
section is "demo_ET7060.zip". Please refer Section 5.2.1 to set up the module channels using the
Internet Browser, and restore/open the demo project.

Demo Description:

This demo creates two Data Blocks, one is used to read 6 DI data, the other is used to write 6 DO data.

1. Double click the first Data Block (<2> Read Input Bits) to open the setting.

Workspace 10 Drivers *
=] _13 demo_ET7060 |8 E-Mp MODBUS Master ~| ¥ Name | Type

-1 Exception programs a2y 13 OpenMODBUS: 192.168.1.128:502 ET7060_DI_00 BOOL #

FA [ Programs "E : =1 <2> Read Input Bits (1] [1..6] I ET7060_DI_01 BOOL
© G 3] Main i =8 <15> Wiite Coil Bits (1) [1..6] /| ET7060_DI_02 BOOL

¢ Watch (for debugaing) || = 5 ET7060_DI_03  BOOL
A ‘ Symbol | Dperation | Offset | Mask | Storage S
H 7 i
= ﬁaf:;s;m B er70s0_01_00 Data exchange 0 [FFFF Defaut » Egggg—g:—gg gggt
SRS : o B ET7060_DI_01 Data exchange 1 FFFF Default
%4 Binding Configuration ET7060_status
. ¢ .. ET7060_DI_D2 Data exchange 2 FFFF Default =
i 3g Global defines @5 ET/060 RL 00  BOOL —
: ? “ ET7060_DI_03 Data exchange 3 FFFF Default S
o fay Variables ET7060 RL 01 BOOL
H B¢ ET7060_DI_04 Data exchange 4 FFFF g
-B& Types = ET7060 RL 02 BOOL
= ET7060_DI_05 Data exchange 5 FFFE, Default ET7 DBU_F\’L_U 3 BOOL
3 [ ET7060_status Error report 0 Default> > SRt s R Rl
< | < |

Notice: The value of the “Offset” starts from “0”, but the Modbus address of the variable is the “Offset”
value plus 1 (Base address). If set the “Operation” to "Error report”, the “Offset” value of the
variable (Data Type: DINT) must set to “0”.

MODBUS Master Request m
Description: \ ’ :

|;_ o . .
Slavefunit: |1 _\ The Net-ID of the Slave Unit
MODBUS Reguest (ET-7000) is fixed to "1".
I_<_1 = Read Coil Bits A
|
[_§32§.515'£°lf'!?£§:3{i5i'5 Read DI data
Data block

Base address:

:+\ Start from the address 1

b items: 6 to read 6 items.
Activation
[ @ Pperiodic: |50 (ms |sooo |
T ' Read once every 50 ms.
() On cal {on error) If ;
error occurs, wait 5 s to
() On change
send the next commend.
Misc,
Timeout 500 LQ
) ] If no responds in 500 ms, means error.
b trials: i1 |
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2. Double click the second Data Block (<15> Write Coil Bits) to open the setting window.

Workspace J 10 Drivers *
-l demo_ET7060 \

‘ E E'I"l]n MODBUS Master

A\ F Name | Type

7 4 Exception programs & i B &z Open MODBUS: 192.168.1.128:502 . ET7060_DI_02 BOOL 4
G - Programs ‘B : 1B <2> Read Input Bits (1) [1..8] NE | ET7060_DI_03 BOOL
= 3] Main , B =1 <15 Wwrite Coil Bits (1] [1..6] ET7060_DI 04 BOOL

’ [J "W atch (for debugging) Q Symbol | Operation Offset | Mask | Storage | ET7060_DLOS: BOOL

- & Soft Scope B ET7080_RL_00 Data exchange 0 [FFFF  Deta ||  E1/060_status  DINT

B f In_ma'l values. : m ET7060_RL_01 Data exchange 1 FFFF Default ET7060 RL 00 BOOL

\.& g"”c:“lgdc;’,"“g”'a“°” | ET7080_RL_02 Data exchange 2 FFFF Defaul Egggg—gt—g; gggt |

e Pran el $2 ET7080_RL_D3 Data exchange 3 FFFF Defaul it

-G Vaiables g ET7060RL 04 Data exchange 4 |FFFF Defaut Elalsn sl Buol

05 Tipes ET7060_RL_05 Data exchange 5 FFFF Default EFOEG.RL.OL 1BO9L 3
E FT70RN RI N5 ROOI ¥
' B - | ) | ] >

Request

Description:

’ [4
SlavefUnit: |1 The Net-ID of the Slave Unit

(ET-7000) is fixed to "1".

»

MODBUS Request

| <5 Write single coil bit A |
l <6 Write single holding register =
<15 > Write Coil Bits

AL Wvibkm Unldime O mmisk s Write DO data,
Data block
—
Base address: il
b e 6 Start from.the address
l to write 6 items.
Activation
O periodic: | ’ ms ‘sooo y
Concall {on error)
(%) On change . . .
¢ Write data, if data is changed.
Misc,
—
Timeout: }500 Lm\s
Mb trials: 1 l If no responds in 500 ms, means error.
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5.2.3 Connecting the ET-7018Z (10 Al)

The ET-7018Z is an 10 Al channels Ethernet I/O module. The Win-GRAF demo project for this section is
"demo_ ET7018z.zip". Please refer Section 5.2.1 to set up the module channels using the Internet
Browser, and restore/open the demo project.

Demo Description:
This demo creates one Data Block to read 10 Al data.

1. Double click the first Data Block (<4> Read Input Registers) to open the setting window.

Workspace 10 Drivers
= demo_ET7018z E =] I“ln MODBUS Master AT Name | Type
71+ Exception programs & [l 4%z Open MODBLS: 192.168.255.1:502 : Minute1 DINT ad
TA [ Programs ‘8 <4> Read Input Reaisters (1] [1..10] Second1 DINT
i 2] Main " - ‘ ET7018z_Al 00 INT
T | i fset t =i
£l Watch ffor debigging) || Rzba | Bporstion N || Ot | Mesk, | Slotege ET70182 Al 01  INT
T ET7018z_4Al_00 Data exchange 0 FFFF Default o ey
% Soft Scope g ET7018z_AlI 02 INT
P i ET7018z_al_01 Data exchange 1 FFFF Default bl
o 24 Initial values ET7018z_AlI 03 INT
RN : ' 4 ET70182_41_02 Data exchange 2 FFFF Default REES
% Binding Configuration ET7018z_Al 04 INT
q ¢ .. ET7018z_41_03 Data exchange 3 FFFF Default vt
w39 Global defines és ET7018z_Al_05  INT
i ;  ET7018z_Al_04 Data exchange 4 FFFF Default o ey
onfa} Variables ET7018z_Al 06 INT
i B¢ ET70182_A1_05 Data exchange 5 FFFF Default pafles
B Types ET7018z_AlLO7  INT
- ET7018z_al_0B Data exchange 6 FFFF Default
L ET70182_A1_07 Dat h. 7 FFFF Default ET7016z AL08 INT
V ET7U182_AI_08 Da : e’,(Chang'a 8 FFFF Defaul i o
z Al ata exchange efault T ]
ET70182 4 09 Data exchange 3 JrrFF olelita Sttten iGN
[ET?U182_status Error report 1] Default ] i
Name | Value ]
< ‘ s

Notice: 1. The value of the “Offset” starts from “0”, but the Modbus address of the variable is the
“Offset” value plus 1 (Base address).
2. If set the “Operation” to "Error report”, the “Offset” value of the variable (Data Type: DINT)
must set to “0”.
3. If Alrange is -32768 ~ 32767, please declare the data type as "INT" for the variable.

MODBUS Master Request m
Description: ‘ I ;

= - L !
Slavefunit: |1 . The Net-ID of the Slave Unit
(ET-7000) is fixed to "1".
MODBUS Request
'_<:E>_P:é;d Input Eifs » “
‘ <3> Read Holding Registers %

| <4 >Read Input Reaisters

| AE o Mlvikm mimals ~ail bik Read Dl data
Data block

—
31

Base address: I—L\ Start from the address 1

b items: 10 | to read 10 items.
Activation

. ! l[‘—‘ —

([ ©eeriode: 50 _ms__|s0o0 { Read once every 50 ms.
Con call {on error) If error occurs, wait 5 s to
O on change send the next commend.

Misc.

Tineout: 500 Q
Mb trials: 1 } If no responds in 500 ms, means error.
: R
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5.2.4 To Disable/Enable the Modbus TCP/UDP Master Port

The Modbus TCP/UDP Master ports which are enabled in the Win-GRAF "Fieldbus Configuration" -
"0 Drivers" setting window, will automatically work after the PAC is powered on. If user wants to
disable one of the Modbus TCP Master ports, use the "MBTCP_M_disable" function (and use the
"MBUDP_M_disable" function for UDP), see below:

(* Declare To_disable as BOOL *)
If To_disable then

To_disable := FALSE ;

MBTCP_M_disable ( '192.168.71.9', 502 ) ;
End_if;

In the above code, when you set "To_disable" as "TRUE", it will disable the Modbus TCP Master port
which connects to the slave device with the IP address "192.168.71.9" (TCP Port_No = 502). And later,
you can enable it again by using the "MBTCP_M_enable" function (using the "MBUDP_M_enable"
function for UDP), see below:

(* Declare To_enable as BOOL
Status_tcp as BOOL *)
If To_enable then
To_enable := FALSE ;
MBTCP_M_enable ( '192.168.71.9', 502 ) ;
End_if;
Status_tcp := MBTCP_M_status ( '192.168.71.9',502 ) ;

The "MBTCP_M_status" function (and "MBUDP_M_status" is for UDP) listed above is used to get the
status of the Modbus TCP Master port, for example, enabled (True) or disabled (False).

For easy maintenance, user can declare a STRING variable (set its length as "20"). For example, declare
one "IP_addr2" variable and set its initial value as "192.168.71.9“. Then you can use it as the

following code.

If To_disable then
To_disable := FALSE ;
MBTCP_M_disable ( IP_addr2 ,502);
End_if;
Status_tcp2 := MBTCP_M_status ( IP_addr2,502);
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5.3 Connecting the Modbus TCP Slave device has two IP addresses

The previous section lists the way to enable the Win-GRAF PAC as a Modbus TCP Master device, and lists
the way to read/write Modbus TCP Slave device. This section will list the way to create the redundant

"Modbus Master Request", when one IP of the Modbus TCP Slave devices is disconnected, the other IP
can still normally to be read/written data.

Application Diagram:
Intelligent Remote Redundant
Ethernet1/O Expansion Unit
iDCS-8830 + F-8K Series I/O Modules

Win-GRAF PAC
WP-8xx8

.

RS-408

LAN1 LAN2

Modbus TCP Slave

Modbus TCP Master

Follow The Steps:
1. Click the “Open MODBUS:”, and then click the menu bar “Tools” > “Export”.
2. In the “Export Assistant” window, click “Export some project items (XNL)” and “Next”.

File Edit View Insert Projec Tools Window Help
S HE 4 #
WOrkspaee 10 Drivers *

& % Q= i 05 %A

Name | Walue
Mode Open MODBUS

Address 192.168.1.100
Exgort. @ +0: boo_1 Port 502
Comyert Pro gram @ +1:boo_2 0 Reconnect after error
Avtomation Seript.. LB +2: boo_3 Slaves diagnostics

- B4 Binding Configuration “B <4> Read Irput Registers (1] [1..5] Disabled ]

~-- Eror report: ERROR, STATUS1\ Delay between requests [ms) 10

2g Global defines é% “@ +0.1: DINT_1

Each Modbus TCP Master can only set to

connect one Slave IP address, so here we
Welcome ko the Export Assistant. What do you want to export? will show the way to copy and generate

the second Modbus Master to connect
O Export a complets project (XML) the second Slave IP address. —

01

l (3) Export some project items (XML ] 1000 5000
1000 2000

o ?*

[ Next‘{[ Cancel |
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3. Check the “Configurations” and uncheck all other items, and then click “Next”.

Export Assistant

Select items to be exported:

[] Programs and UDFBs
[0 Main
[ pOnBadIndex
- [] pOnDivZero
[ pShutDown
[ pStartup

Configurations

[CIExport referenced global variables [ Mext ﬂ [ Eancel

4. Browse a suitable path (default in C:\Win-GRAF\Projects) and named for the file (e.g., Master_2.xml),
and then click "Save" button. Finally, click "Finish" to export the settings.

SEE

BEFFRSD: | L Projects v Q2>
() Demall1
[ £ 3 () ICPDAS_template
HBRAAEE  ((OMICP M
= [yother
{F ) Test
£ Test 01
AR test 1
A () Test 2
BRBIF  [test 0528
Export is complete, =
AN
~ F— ___\ :
‘g 1 Q: G/Iasher_lxml ) v feTF
WELAFH el IR T v T
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I”

5. Using the Notepad software to open the file “.xml” that exported in the step 4, and then copy the

content between the <modbus> and </modbus>.

P Master 2 xml - SR A
BEE KEE BA0Q RO N

<types>

</types>

<variables>
<vargroup name="{Global)" kind="GLOBAL">
</vargroup>
<vargroup name="{Retain)" kind="RETAIN">
</vargroup=

</var|ables>

<m|:|dbus>

[

" RangeLo=

="ffff" F'anq»JHl-"" 2,

DII'JT 4"
(mbol="DINT_5"
bol="

«fieldbus=>
«/fieldbus=

&

6. Paste the copied content above the </modbus>, and change the address to the second IP address of
the Modbus Slave device (e.g., “192.168.1.101"), then save and close the file.

P Master 2 xml - R4

ANl REE B0 RRO HEE
Haw Ctil+N A
FARELSQ)... Ctl+0  |master" address="192.168.1.100" port="502" sdiags="1" reconnect="1" disabled="0" reqdelay="10" rtu="0">
BEERG ?="" mode="Read Input Bits" address="0" nbitem="3" slave="1" call="Periodic{1000,8000)" timeout="1000" retry="1">
%ﬁﬁﬁ(_) A pe="Data" offset="0" symbol="boo_1" nbword="1" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
- pe="Data" offset="1" symbol="boo_2" nbword="1" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
SRFEFIEMEFLM)... pe="Data" offset="2" symbol="boo_3" nbword="1" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
FIENE)... Ctl+P  pe="Status" offset="0" symbol="ERROR_STATUS1" nbword="1" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
AR 2="" mode="Read Input Registers" address="0" nbitem="5" slave="1" call="Periodic(1000,8000)" timeout="1000" retry="1">
~ <modbusitem ope="Data" offset="0" symbol="DINT_1" nbword="32770" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>

<modbusitem
<modbusitem
<modbusitem

ope="Data" offset="2"
ope="Data" offset="4"
ope="Data" offset="6"

symbol="DINT_2" nbword="32770" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
symbol="DINT_3" nbword="32770" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
symbol="DINT_4" nbword="32770" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/=>

<modbusitem ope="Data" offset="8" symbol="DINT_S5" nbword="32770" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>

<modbusitem ope="Status" offset="0" symbol="ERROR_STATUS2" nbword="1" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>

</modbusreqg:

/modbusport

<modbusport kind="master" g} port="502" sdiags="1" reconnect="1" disabled="0" reqdelay="10" rtu="0">

<modbusreq name="" mode= Read Input Bits" address="0" nbitem="3" slave="1" call="Periodic{1000,8000)" timeout="1000" retry="1">
<modbusitem ope="Data" offset="0" symbol="boo_1" nbword="1" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
<modbusitem ope="Data" offset="1" symbol="boo_2" nbword="1" mask="ffff" RangeHi="" RangeLo="" SigH SigLo=""/>
<modbusitem ope="Data" offset="2" symbol="boo_3" nbword="1" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
<modbusitem ope="Status" offset="0" symbol="ERROR_STATUS1" nbword="1" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>

</modbusreqg:

<modbusreq name="" mode="Read Input Registers" address="0" nbitem="5" slave="1" call="Periodic(1000,8000)" timeout="1000" retry="1">
<modbusitem ope="Data" offset="0" symbol="DINT_1" nbword="32770" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
<modbusitem ope="Data" offset="2" symbol="DINT_2" nbword="32770" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
<modbusitem ope="Data" offset="4" symbol="DINT_3" nbword="32770" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
<modbusitem ope="Data" offset="6" symbol="DINT_4" nbword="32770" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>
<modbusitem ope="Data" offset="8" symbol="DINT_S5" nbword="32770" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/=> 3
<modbusitem ope="Status" offset="0" symbol="ERROR_STATUS2" nbword="1" mask="ffff" RangeHi="" RangeLo="" SigHi="" SigLo=""/>

</modbusreqg:

</modbusport>
l </modbus> | =
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7. Click the Win-GRAF menu bar “Tools” > “Import”.

File Edit ¥iew Insert Project [BU9N) Window Help

- . 7 - ) -+
S 3k R Optins.. EWE ARG 5RA
Workspace Customize...
= MTCP_M Send 1o Watch T MName /| Type |
G- [ Exception programs T P 58.1.100:502 ERALGlobal vatiables
[ Programs S (1101..3] boo_1 BOOL
[ Main Edit Vaxiables as Text... \ boo_2 BOOL
S | ;A;tch (for debugagin... ée_nzmte Himl Docogent:: | boo_3 BOOL
i Soft Scope $ iss i DINT _1 DINT
£ Inial values LIRS M ROR_STATUST DINT_2 DINT
- B4 Binding Configuration | @ History.. gisters (1) [1..5] DINT 3 DINT =
i 3g Global defines | 8§ Global Binding Editor DINT 4 DINT
; {2} Variables £ Compare Project DINT_5 DINT
Lo BB Types &7| Gensoats HIML Graphic. ERROR_STATUS1 DINT
. ERROR_STATUS2 DINT v
QPC Client < | @
| 4s8 IEC61850 Client A —
i 1 n ROR_STATUS2 [ v J
Goose Client ;
5 T SlavedUnit | Address | |
Communication Parameters. . 1 2
Runtime Parameters 4 ‘ 1 5

| Import.. \
Export... i |

8. In the “Import Assistant” window, click “Import project items (XNL)” and “Next”.
9. Select the file you want to import (e.g., “Master_2.xml”) and click “Open” button.

Import Assistant Eg]

Welcome to the Import Assistant. What do you want to import?

(& Import project items (XML); °
() Import ST file \
O Import project items fromerevious versions

() Import common definitions

B | O Projects (O Import OEM libraries
(O Import Embedded HMI hardware definition

E () Demo01
Laé () ICPDAS_template
HRAE i (OMICEM
[ yother
(F £ Test
RE (0 Test_01 l Mext Q [ Cancel
test_1
A\ [0 Test 2
‘ (£ Test_3
FRBUF |5 test 0528

2 “*Q
S

\%
Bie Lo e Master_2.3aml v )
WRERD: ML files (*aam)) v) [ ®=# |\
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10. Click “Finish” to finish the import action.

Import Assistant

Import is complete,

N\

11. In the “lO Drivers” window, there has added a new “Open MODBUS” setting item that includes two
“Modbus Master Request” for using to read the DI and Al. One “Error report” is used to check the IP

connecting status, so please add two “DINT” variables in the Variable area (e.g.,

“ERROR_STATUS11”, “ERROR_STATUS21”) and double click the “Error report” to assign variables.

IO Drivers *

E & Nm MODEUS Master

a2 P & Open MODBUS: 192.168.1.100:502
]

s -8 <2> Read Input Bits (1) [1..3]
o “B <4> Read Input Registers (1] [1..5

Bl IEET:] O oen MODBUS: 192.168.1.101:502
g B a <2> Read Input Bits (1) [1..3]
@» @ +0: boo_1
= @ +1:boo_2
és +2: boo 3
= : [_g Error report: EHRDR STATUST ]
Fj E <4> Read Input Reglsters (11[1..5]
i “-@ +0.1: DINT_1

co +2.3: DINT_2

@ +4.5 DINT_3

@ +6.7; DINT_4

@ +B.3DINT 5

[_g Error report: ERROR_STATUS21

~-Mg MODBUS Slave

| B % X
7 MName 4| Type |
boo_3 BOOL A~
DINT_1 DINT
DINT 2 DINT
DINT_3 DINT
DINT _4 DINT
DINT 5 DINT
ERROR_STATUS1 DINT =
ERROR_STATUS11
ERROR_STATUS21 v

[ Value ]

MODBUS Yariable

Symbol

’ERROR_STATUSZI

EN

{Eﬁﬁﬁﬂ_smwsm ] v X
(%) Status | Control B DINT4 3
iError report @& DINT_5
& ERROR_STATUS1
& ERROR_STATUS2 2
() Data exchange i % ERROR_STATUST1
: |
Offset: |7 =
2 Variables: (all N v
Maski  [FFFF ~ [[]Local variables only
— [] Hide FB instances
Storage:  Default

Win-GRAF User Manual, V 1.07, Apr. 2018 by ICP DAS 5-54



5.4 Connecting the tGW-700 to Expand Modbus RTU Master Ports

If using the Modbus RTU (RS-232/485/422) device to transmit data in a long-distance application area,
the user will normally choose a lower baud rate for better signal quality. But, using this way will cause
low transmission efficiencies. In order to improve this problem, ICP DAS releases the tGW-700 series
products (tiny Modbus TCP to RTU/ASCII gateway) for converting Ethernet/RS-485 signals so that the
user can reduce the RS-485 cable lengths and solve the issue with inefficient communications.

This section will provide a demo program (demo_tgw725.zip) to describe how the Win-GRAF PAC
communicates with LC-103 modules via the tGW-700 gateway (as the figure below).

Win-GRAF PAC

(Modbus TCP Master) - —
Ethernet * 'Rs-232/485/422 ™M™ i
WinPAC . (OnelP) = B B
: = -~ iy Q&@e
; ort _ -
Qa"  pe.ags D=1 D=3

tGW-700 Series
\ViewPAC

Modbus TCP to RTU/ASCII
Gateway
5.4.1 Using the tGW-700 Series (Modbus TCP to Modbus RTU/ASCII Gateway)
The tGW-700 module is a Modbus TCP to RTU/ASCII gateway that enables a Modbus TCP host (e.g.,
WP-8xx8) to communicate with serial Modbus RTU/ASCII devices through an Ethernet network, and

eliminates the cable length limitation of legacy serial communication devices. Visit the tGW-700 series
webpage for more information on
http://www.icpdas.com/root/product/solutions/industrial communication/pds/tgw-700.html

tGW-700 series User Manual
http://ftp.icpdas.com/pub/cd/tinymodules/napdos/tgw-700/document/ (See the chapter 3 & chapter 4
to know the way of network setting, testing and web function configuration for the tGW-700 module.)

Before using the tGW-700, the user must configure its network and COM Port setting:

® Connect the Power Supply and the Host PC

1. Check that the Init/Run switch is in the “Run” position. #518904 444 )
.‘
o q V.~
o g
S gzn
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2. Connect both the tGW-700 and the Host computer to the same sub-network or the same
Ethernet Switch, and then power on the tGW-700.

Ethernet Cable

+12 to +48 Vpc jack Power Supply (Non-PoE) PoE Power Supply

@ Install the “eSearch Utility”, and then Search and Configure the Network Setting for the tGW-700
http://ftp.icpdas.com/pub/cd/tinymodules/napdos/software/modbus _utility/

. eSearch Utility [ ¥1.1.7, Mar_30, 2015 ] M=
File Server Tools
MName Alias IP Address Sub-net Mask Gateway MA
r tGW-725 I} Tin 10.10.10.100 255.255.255.0 0.0.0.0
D302 ETherO T9Z.T66.T1.9 200200, 10 T9Z.ThE.T.1 [I]I}
DL-302 EtherlQ 192.168.17.25 255.255.0.0 192.168.1.1 oo:
Weh LED NfA 192.168.11.10 255.255.0.0 192.168.1.1 oo:
Weh LED NfA 192.168.17.42 255.255.0.0 192.168.1.1 00
A0 testl 192.168.11.8 255.255.0.0 192.168.1.1 00:
7T186E3 I-7540D 192.168.17.40 255.255.0.0 192.168.17.40 00
ET-F067fPET-706F NA 192.168.17.44 255.255.0.0 192.168.0.1 0o:
svzz201 Compact 2.168.82.100 255.255.0.0 192.168.1.1 8.
< | >
. . f .
M Searct&Sewers CunilguratlunJUDP] | Ie Weh‘J Exit
Statns

Search your tGW-700. Set the tGW-700’s IP / Mask Open the tGW-700 Web Server.

/ Gateway. (Contact your (Note: Both the tGW-700’s and
Network Administrator to PC’s IP addresses must on the
get correct configuration) same sub-network. See chapter 4

of the tGW-700 user manual.)

Please contact your Network Administrator to get the correct IP, Mask and Gateway addresses. After
completing these settings, click the “OK” button and they will take effect within 2 seconds.

Configure Server (TDF) E|

Server Name : tGW-725

DHCP: |u: OFF j Sub-net Mask : |255.255.255.n Alias: |Tiny
IP Address : 10.10.10.100 Gateway : 0.0.0.0 MAC: |
VWarning!!

Contact your Network Administrator to get correct configuration before any changing! Cancel
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® Web Configuration
You can refer the tGW-700 user manual (chapter 4) to view the configuration way for all features. The

following will describe the COM Port setting.

1. Enter the tGW-700’s IP address on the web browser. (Note: It must on the same sub-network with
your PC’s IP).

2. Enter the password (the factory default password is “admin”).

' e Tiny Gatewsay b4

[ 10.10.10.100 [y 1)

0?‘% Tiny Modbus Gateway (tGW-72x)

N Home | Porti | Port2 | Network | Fifter | Monitor | Password | Logout

| »

The system is logged out.
To enter the web configuration, please type password in the following field.

Login password |l Nl A ) Submit

Note: This web configuration requires JavaScript enabled in your browser (Firefox, IE...).
If the web configuration does not work, please check the JavaScript settings first.

When using IE, please disable its cache as follows.
Menu items: Tools / Internet Options... / General / Temporary Internet Files / Settings... /
Every visit to the page

-

Copyright © 2010 ICP DAS Co., Lid. All rights reserved.

3. After logging in, the main page (Home) will display the current port setting. The user can also click
“Portl” or “Port2” tab to modify the settings.

\cv: Tiny Modbus Gateway (tGW-72x)

Home | Port1 | Port2 | Natwork | Filter | Monitor | Password | Logout

Sysiem Timeout

o*r (Network Watchdog, Seconds)

300

Current port settings:

Remote Server IP
RTU Virtual ID
TCP Slave ID
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5.4.2 Connecting the tGW-700 Series and the LC-103 module (1 DI, 3 Relay)

In this section, we provide a demo project (demo_tgw725.zip) to describe how the Win-GRAF PAC
communicates with LC-103 modules via the tGW-725 (the Modbus TCP to Modbus RTU/ASCII gateway
with two RS-285 ports). You can run the Win-GRAF Workbench and click "File = Add Existing Project -
From Zip..." to open this project in the Win-GRAF PAC CD (CD-ROM: \Napdos\Win-GRAF\demo-project).

The LC-103 is an easy-to-use lighting control module that supports the Modbus RTU protocol and
provides 1 channel for digital input and 3 channels for relay output. Before using this module, set its ID
No. depends on your application needs, for example, if the required ID is "1", simply adjust the rotary
switch to “1" at the bottom of the module. Visit the LC-103 webpage for more detailed information:
http://www.icpdas.com/root/product/solutions/remote io/rs-485/lighting control/lc-103.html

i~ oy
- The LC series module user
L o manual:
if::*: ftp://ftp.icpdas.com.tw/pub/
A cd/8000cd/napdos/Ic/
\

Demo Project Description: (Refer the Section 5.2 to know how to create this project.)

1. Click the “Open Fieldbus Configuration” tool button to open the “IO Drivers” window.

S H 4 Qg X o9 = HzIedE i & %A
Work=space 10 Drivers *

2l demo_tgw725 E Mg MODEBUS Master A 5F MName | Type
i YT S DT (B 7Y 0 p=n MODELIS: 10.10.10.100:502 {3} Global variables  ~
[ Programs *B <15 Write Coil Bits [11]1..3] Slave1_DOO BOOL

“HE] Main 8 @ +0: Slavel_DOO Slavel DO1 BOOL
[ watch [for debugging) || — = +1: Slavel DO Slavel DO BOOL
&R Soft Scope ﬁ & +2 Slavel_D0O2 Slavel_DOO BOOL
= Initial walues @ Success counter tmp_counter Slave? DO BOOL
%4 Binding Canfiguration E O Fail counter: Fail_counter Slavel DO2 BOOL
g Global defines 25 “B <15 Write Cail Bits [3)1[1..3] trmp_counter DINT
il Wariables @+ Slaved DOD fail_counter DINT
B Types B+ 2 +1: Slaved_DO1 trmp_counterl  DINT
[ (&l Projects) = +2 Slaved DO2 fail_counter] DINT
O Success counter tmp_counter3 Slaved_DoOO BOOL
& _Fail counter: fail_counterd Slave3_DON BOOL
u; Open MODBUS: 10.10.10.100:503 ] Slaved_DoO2 BOOL
“B <15 ‘Write Cail Bits [21[1..3] trmp_counter3  DINT
: bl Clawad BOO - fail_counter3 DIMNT s
Request | Slave/Unit | Addiess | Mbltem | Activation | Pe ¢ 3
<183 Wwrite Cail Bits 1 1 3 On Chanage
M ame | Yalue
< »
4 » kdain “Wariables 10 Drivers

On the screen, the "Open MODBUS: 10.10.10.100:502 / Open MODBUS: 10.10.10.100:503" means that
the tGW-725’s IP address is "10.10.10.100" and using two COM ports (RS-485) No. - "502“ and "503".
And, there are two LC-103 modules (Slave ID = "1" and "3") connected to its COM1 and one LC-103
connected to the COM2 (Slave ID = 2). The following will describe the configuration way of each Modbus
Master Request one-by-one.
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2. Mouse double-click the first data block under the COM1 (Port = 502) to view this Modbus Master
request. In this example, the Win-GRAF PAC (Modbus TCP Master) send three DO commands to the
LC-103 (Slave ID = 1) via the tGW-725‘s COML1 (Port = 502). As the figure below, the "Operation" is
set to "Success counter" (or "Fail counter") that means this variable value will add 1 if the command

was successfully sent (or failed). Moreover, the “Offset” value of these variables must set as “0”.

10 Drivers * | HEL A
E Mg MODBUS Master A F Mame | Type
o 2 Open MODBUS: 10.10.10.100:502 ﬁ Global variables -~
Slave1_DOO BOOL
g &+ Slawe1_DO0 Slave1_DOT BOOL
3 @ +1: Slavel_DO1 Slavel_DOZ2  BOOL
= & +2: Slavel_DO2 Slavel? _DOO BOOL
g O Success counter: trp_counter Slavel DO BOOL
& Fail counter: fail_courter Slavel DO2 BOOL
25 B <15 “Write Coil Bits [3][1..3] tmp_counter DIMT
& +0: Slave3_DO0 fail_counter DIMT
B = +1: Slave3_DON tmp_counter?  DIMT
= +2 Slave3_DOZ fail_counterl DIMT
I L Surcess counber tmn counberd b S|a\r53_DOI:| BOOL
Syrbal | Dperation | Drfset) Mask | Storage | Rang Slave3_DO1 BOCL
Slawel1_D0O0 Data exchange 1] FFFF  Default ~ Slaved DOZ BOOL
Slawel_DO1 Data exchange 1 FFFF  Default tmp_counterd DINT
Slawvel_DOZ2 Data exchange 2 ) FFFF Defalt fail_counter3 DINT
brnp_counter Success counter 1] FFFF  Defalt F3 3
fail_counter Fail counter 1] FFFF  Default N
~ . e | Walue
4k bezin “Wariables 10 Drivers

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value
plus 1 (Base address).

MODEBDS Master Eequest _

Request _
Description: || | =
——
SlaveUnit: The Net-ID (e.g., “1” ) of the

Slave device (i.e., LC-103).

MODEUS Fequest

<5 Write single coil bik ”
<6 Write single holding reqister

A E e Weiks Ueldim s Fmmicbmie—

Write DO data.

Drata block,
Base address:
Hb erms: Start from addr. 1 and
Mb items: .
write three data.
Ackivation
) Periodic: | ms ||:| |
O on call (on_errar)
on ch  —— .
IR Write only when data changed.
Misc,
Tirneout: -3':":":' ms
An exception occurs if no
Mb brials: respond for 3000 ms.
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3. Mouse double-click the 2nd data block under the COM1 (Port = 502) to view this Modbus Master
request. In this example, the Win-GRAF PAC (Modbus TCP Master) send three DO commands to the
LC-103 (Slave ID = 3) via the tGW-725's COML1 (Port = 502). As the figure below, the "Operation" is
set to "Success counter" (or "Fail counter") that means this variable value will add 1 if the command

was successfully sent (or failed). Moreover, the “Offset” value of these variables must set as “0”.

E *B <15 wiite Coil Bitz (1) [1..3] A 5F Mame | Tupe
= @ +0 Slavel_DODO ot Global variables ~
1 3 +1: Slavel_DOT Slave1_DOO BOOL
8 @ +2 Slavel_DOZ Slavel DO BOOL
= O Success counter: tmp_counter Slawvel DO2 BOOL
B = Fail counter: Fail_counter Slave2_DOO BOOL
F 8=1 15 Wwiite Coil Bits (3] [1..3] Slave?_D07 BOOL
2+ Slaved_DO0O Slavel DO2 BOOL
&5 B2 +1: Slaved D01 tmp_counter  DINT
= +2 Slave3_DO2 fail_counter DIMT
B+ O Success counter: tmp_counter3 tmp_counterl  DINT
1 Fail counter: fail_counter3 fail_counterl DIMT
. 2. (nen MODALS- 1010 1010050 s Slaves DO BOOL
Symbal | Operation TEIff&eq M azk | Storage | Rang Slave3 DO BOOL
Slave3_D0O0 Data exchange 0 FFFF  Default » Slave3d_DO2 BOoOL
Slave3_DOT Data exchange 1 FFFF  Default trmp_counterd  DINT
Slave3_DO2 Data exchange 2 FFFF  Default fail_counter3 DIMT
trip_counterd Success counter 1] FFFF  Default ¢ 5
fail_counter3 Fail counter 1] FFFF  Default N
. $ arne | Walue
4 ¥ | bain,  Marables | 10 Drivers

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value
plus 1 (Base address).

HMODEUE Master Request

Requesk _
Description: | | =
Slave/Unit: 3 *\ The Net-ID (e.g., “3” ) of the

Slave device (i.e., LC-103).

MODELS Request

<5 Write single coil bit
<hz= Wite single holding register

E

<1£5 tideibe Usldine Rosiskoes N \Write DO data.

[raka block.

Base address: -

b e Start from addr. 1 and

- write three data.
Ackivation

() Perindic: | = ||:| |

o cal {on errar)

(®) On change @ Write only when data changed.

Misc.
Timeout: 3000 ms ] -
An exception occurrs if no
Mb trials: |:| respond for 3000 ms.
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4. Mouse double-click the data block under the COM2 (Port = 503) to view this Modbus Master request.
In this example, the Win-GRAF PAC (Modbus TCP Master) send three DO commands to the LC-103
(Slave ID = 2) via the tGW-725‘s COM2 (Port = 503). As the figure below, the "Operation" is set to
"Success counter" (or "Fail counter") that means this variable value will add 1 if the command

was successfully sent (or failed). Moreover, the “Offset” value of these variables must set as “0”.

10 Drivers *
E 2 +1: Slavel_DON
a2 o +2Z Slavel_DO2Z
L, O Success counter tmp_counter
E O Fail counter: fail_counter
= “B <15 Wiite Coil Bitz [3][1..3]
E o +0: Slavez DOO
& +1: Slaved DO
g O +2 Slaved D02
25 O Success caounter bmp_counterd
& Fail counter: fail_counterd
a & Open MODBUS: 10.10.10.100:503
] te 3[2]1..9]

bl

Suymbol | Operation

| Offset | Mask | Storage | Rang
Slave2 _DO0D [Data exchange 0 FFFF  Default
Slave2_D0O1 [ata exchange 1 FFFF  Drefault
Slave2 DOZ2 [ata exchange 2 JFFFF  Default
tmp_counter Success counker 1] FFFF  Default
fail_counterl Fail counter 1] FFFF  Default
£

4 bAzin “Wariables 10 Drivers

M ame

| LI
“F Mame | Type
it Global variables ~
Slave1_DOO BOOL
Slavel DO BOOL
Slave1_DO2 BOOL
SlaveZ_DOO BOOL
SlaveZ DO BOOL
SlaveZ_DO2 BOOL
tmp_counter DIMT
fail_counter DIMT
tmp_counter?  DINT
fail_counter DINT
Slave3_DOO BOOL
Slave3_ DO BOOL
Slaved_DCr2 BOOL
tmp_counterd  DINT
fail_counter3 DINT s
£ >
| Walue

Note: The “Offset” value starts at “0” and the Modbus address of variable is equal to the “Offset” value

plus 1 (Base address).

MODEDSE Master Eequest

Requesk

Description: |

Slave/Unit:

MODELS Request

The Net-ID (e.g., “2” ) of the
Slave device (i.e., LC-103).

<5 Write single coil bit
«<h= Write single halding reqister

)

Write DO data.

[raka block,

Base address:

L
b items:

Start from addr. 1 and
write three data.

Ackivation
() Perindic: | | ms |EI
() on call (o0 Error

{(#) on change @

Write only when data changed.

Misc,

Tirmeouk: 3000 ms

o ¢
b Erials: I:I

An exception occurs if no
respond for 3000 ms.
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5.4.3 Test the Demo Project (demo_tgw725.zip)

Before testing this demo project, download it to your Win-GRAF PAC. (If you're not familiar with it, refer
the Section 2.3.4 and Section 2.3.5.)

The Hardware Wiring:

WP-8xx8 RS-408 tGW-700 Series
(192.168.80.21:502) EthernetSwitch Modbus TCP to RTU/ASCII Gateway el it iy
Ethernet i Y Portl ﬁ‘: ;".‘.‘z‘ —

(10.10.10.100) ~ - (502) | <L L

= gs.ass D=1 ID=3
Lol Pot2 Py LC-103

- (503) | e — e o

(9600,8,n,1) L&

After connecting with the Win-GRAF PAC, double-click on any DO variable and set it as "TRUE" in the
“I/0O Drivers” window. If the write operation is successful, then the "tmp_counter" value will add "1".

AN P o

Workspace

G = L0 O A& W e AR

Qooo [ Drivers]

B [ demo_tgw725 [StaAp... g E-Mg MODBUS Master -
----- |1 Exception programs B [—'_Iﬁ-; Open MODBIS: 10.10.10.100:502
£l Programs 1 E-*B <15 wiite Coil Bitz (1] [1..3]
(- “75] Main B (@ +0: Slavel_DO0O=TRUE
£ Watch [for debugging) || -2 +1: Slavel_DO1 = TRUE
. &% Soft Scope F 1@ +2 Slavel_DO2 =TRUE
B Initial values g B3 Success counter tmp_counter = 4
------- %4 Binding Canfiguration P O Fail counter: fail_counter =10
i 30 Global defines 5 =B <15 Write Cail Bitz (3] [1..3]
Y Variables (=@ +0:5lave3_ DO = TRUE ] =R ]
........ == T_',JFIES EJ' = | TELUE ‘ | (1]
------- [ [&l Projects) | N
[—I:I Success counter tmp_counterd = 2 ] [ FALSE ] (o]
------ 3 Fail counter: fail_counterd =10
Elﬁx Open MODBUS, 101010100503 F [ Eutlack ]
B <15 Write Coil Bitz [2][1..3]
------ o [ ButUnlock, ] B
...... D
...... = v
Sumbol | Operation | Offset | Mask | Storage | Range (Low) | Riange [High) | Signal [Low]
Slawes_DO0=TRUE  Data exchange i] FFFF  Diefault
< J _
4 hazin Wwariables 10 Drivers

Note: When the Win-GRAF PAC boots up, it will send the Modbus request to the Modbus Slave device.
So, you can see the "tmp_counter" value starts at "1" which means this data write is successful.
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Chapter 6 Retain Variable and Data Storage

6.1 Retain Variable

This chapter lists the way to use the "RETAIN_VAR", "RETAIN_ARY", "RETAIN_FLAG_GET",
"RETAIN_FLAG_SET" and "RETAIN_FLAG_CLR” Functions. The Win-GRAF PACs are built-in the Retain
memory for users to store the retain variable data that will not lose due to the PAC shutdown and can
retain the last value at the next time reboot.

In the shipping CD (\Napdos\Win-GRAF\demo-project), you can find the demo project for this chapter
(demo_retain.zip), please refer Chapter 12 to restore this project (Execute File> Add Existing Project >
From Zip) and set the current IP address of your PAC.

Note: Function "Retain_Var()" or Retain_Ary() can only be used in the first PAC Cycle or in the Cycle
that performs the On-line Change. If use them in other Cycle, it will return "FALSE". If the Retain
Variable has not assigned any initial value and the PAC calls the Function, the return value is not
meaningful; users need to assign appropriate initial values to all Retain Variables at least once.

ST Program:
This demo uses Function Retain_Var() and Retain_Ary().

(* "on_line_change_cycle" is declared as DINT
(nonezero means it is in the cycle just after doing on line change).
"retain_done" is declared as BOOL and inited as FALSE.
"tmp_bool" is declared as BOOL.
*)
on_line_change_cycle := GetSysinfo (_SYSINFO_CHANGE_CYCLE) ;
if (retain_done = FALSE) or (on_line_change_cycle <> 0) then
retain_done := TRUE ; (* just do it one time *)
tmp_bool := Retain_Var ( DINT_1, 1) ; (* retain a DINT variable *)
tmp_bool := Retain_Var ( DINT_2, 2) ;
tmp_bool := Retain_Var ( REAL 1, 3); (* retain a REAL variable *)
tmp_bool := Retain_Var (BOOL_1, 4); (* retain a BOOL variable *)
tmp_bool := Retain_Var (BOOL 2, 5);

(* retain 10 elements of an INT array variable at retain addr starting at 6. *)
tmp_bool := Retain_Ary ( INT_ARY, 6, 10);

(* retain 20 elements of a REAL array variable at retain addr starting at 16. *)
tmp_bool := Retain_Ary ( REAL_ARY, 16, 20) ;

tmp_bool := Retain_Var ( DINT_3, 36) ;

(* 64-bit variable can use only addr from 10,001 to 12,000 *)

tmp_bool := Retain_Var ( LINT_1 ,10001); (* retain a LINT variable (64-bit) *)

tmp_bool := Retain_Var ( LREAL_1, 10002) ; (* retain a LREAL variable (64-bit) *)
end_if ;
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You can check/set variables in the "Variables" window, if you are not familiar with the way of the
variable declaration, please refer Section 2.2.2 and Section 2.3.1.

T MName /| Type | Dim. | Attrib. | Syb. | Initvalue | User.. | Tag | De
= fa} Global variables Al
BOOL_1 BOOL ]
BOOL 2 BOOL ]
DINT 1 DINT O |
DINT_2 DINT O |
DINT 3 DINT ]
INT_ARY INT [0..9] ]
LINT_1 LINT ]
LREAL 1 LREAL O £
on_line_change_cycle  DINT ]
REAL 1 REAL ]
REAL_ARY REAL = L]
retain_done BOOL |20 = ]
trp_bool BOOL R O v
b2 1 L

Note: ICP DAS Win-GRAF PAC does not support the "RETAIN variables" Functions in the "Variables"
window, so please refer the five Functions in the following sections to use the Retain Variables.

Variables B ViX
W Name 4| Type | Dim. | Attrib. | Syb. | Initvalue | User.. | Tag | Description

= el RETAIN variables A

Mewh/ar BOOL O v

_(_‘ ; << I z_‘ SEr
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6.1.1 RETAIN_VAR (Retain a Variable)

RETAIN_VAR
[(Name QO Tips:
[1Addr Press “F1” key to see more details.

Name:

A variable name (DO NOT use Array variable or String).

Variable type can be BOOL, SINT, USINT, BYTE, INT, UINT, WORD, DINT, UDINT, DWORD, REAL, TIME,
LINT or LREAL.

Addr:
Data Type: DINT. The address number for retaining the variable, can be 1 to 12,000.

Q:
Data Type: BOOL. TRUE: Ok; FALSE: Error.

Note:

1.

One Addr can accept only one variable (or one element of the array).
DO NOT assign the same Addr to two variables (or more), or the Retain Value will be wrong.

64-bit data type (LINT or LREAL) can use only the Addr No. from 10,001 to 12,000.

Other data type (BOOL, SINT, USINT, BYTE, INT, UINT, WORD, DINT, UDINT, DWORD, REAL or TIME)
can use the Addr No. from 1 to 12,000.

Win-GRAF User Manual, V 1.07, Apr. 2018 by ICP DAS 6-3



6.1.2 RETAIN_ARY (Retain an Array Variable)

RETAIN_ARY
[Name][] Q[
[{Addr Press “F1” key to see more details.
[{Num
Name[]:

An ARRAY variable name (DO NOT use String).
Variable type can be BOOL, SINT, USINT, BYTE, INT, UINT, WORD, DINT, UDINT, DWORD, REAL, TIME,
LINT or LREAL.

Addr:
Data Type: DINT. The starting address number for retaining the array variable; can be 1 to 12,000.

Num:

Data Type: DINT. The amount of elements in the Array variable to be retained.

For example:

If there are 100 elements in an Array variable, set "Num" to "1 to 100" is correct, but if set it more
than 100 that is not correct.

If there are 5 elements in an Array variable, set "Num" to "1 to 5" is correct, but if set it more than 5
that is not correct.

Q:
Data Type: BOOL. TRUE: Ok; FALSE: Error.

Note:
1. One Addr can accept only one variable (or one element of array).
DO NOT assign the same Addr to two variables (or more), or the Retain Value will be wrong.

2. 64-bit data type (LINT or LREAL) can use only the Addr No. from 10,001 to 12,000.

3. Other data type (BOOL, SINT, USINT, BYTE, INT, UINT, WORD, DINT, UDINT, DWORD, REAL or TIME)
can use the Addr No. from 1 to 12,000.
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6.1.3 RETAIN_FLAG_SET/GET/CLR (Set/Get/Clear the Retain Flag)

How to Use:

The "Retain Flag" is a flag (TRUE/FALSE) stored by users in the retain memory. Users can set this retain
flag to indicate "All retain data has been assigned a proper value before". When a PAC starts without
setting a proper value to retain variable before, the data of the retain variable read from the retain
memory is not correct (it is normally a strange value). So users have to assign proper value to all retain
variable at least once to let the application work well. Then after user can call the "Retain_Flag_Set()" to
set the retain flag. It means "All retain data has been assigned a proper value".

To get the state of the Retain Flag, please call "Retain_Flag_Get()".

To clear the state of the Retain Flag, please call "Retain_Flag_Clr()".

ST Program:

(* "on_line_change_cycle" is declared as DINT
(nonezero means it is in the cycle just after doing on line change) .
"retain_done" is declared as BOOL and inited as FALSE .
"tmp_bool", "retain_flag" and "to_set_flag" are declared as BOOL.

*)
on_line_change cycle := GetSysinfo (_SYSINFO_CHANGE_CYCLE) ;

if (retain_done = FALSE) or (on_line_change_cycle <> 0) then
retain_done := TRUE ; (* just do it one time *)
tmp_bool := Retain_Var( DINT_1, 1); (* retain a DINT variable *)
tmp_bool := Retain_Var( DINT_2, 2);
tmp_bool := Retain_Var( REAL_1, 3); (* retain a REAL variable *)
tmp_bool := Retain_Var( BOOL 1, 4); (* retain a BOOL variable *)

(* ... After doing all the Retain Functions ... *)

retain_flag := Retain_Flag_Get();

if (retain_flag = FALSE) then
(*If Retain variable does not set up any proper value, you can do some proper operation here. *)
(*...%)

end_if;
end_if;

(* When all Retain variables are assigned proper values,
remember to set the "to_set_flag" to "TRUE" for calling "Retain_Flag_Set() once,
so that, when next time you use the "Retain_Flag_Get()", it can return "TRUE".
*)
if (to_set flag = TRUE) then
to_set flag := FALSE ;
tmp_bool := Retain_Flag_Set() ;
end_if ;

Win-GRAF User Manual, V 1.07, Apr. 2018 by ICP DAS 6-5



LD Program:
(Press “F1” key to see the detailed setting descriptions.)

RETAIN_FLAG_SET: Set the retain flag.

to_=et_flag
| R [ERETAN FLAG SETG] |
to_zet_flag
| R2 R I ST Program:
if to_set flag then
to_set_flag := FALSE ;
Q: Data Type: BOOL. Always return TRUE. TMP_BOOL := Retain_Flag_Set() :
end_if ;

RETAIN_FLAG_GET: Get the state of the retain flag.

s

retain_flag
r1 |[E RETAIN FLae GET o] |

ST Program:
Q. Data Type BOOL retain_flag = Retain_FIag_Get() ;
“TRUE": flag is set;

“FALSE”: flag is not set.

RETAIN_FLAG_CLR: Clear the retain flag.

to_clr_flag
| R [ERETAIN FLAG CLR ] |
to_clr_flag
R2 R |
B ST Program:
if to_clr_flag then
to_clr_flag := FALSE ;
Q: Data Type: BOOL. Always return TRUE. TMP_BOOL := Retain_Flag_Clr() ;
end_if;
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6.2 Retain Variable (Using files)

You can refer the following demo project (demo_wp5_retain.zip) to use retain variables with files in the
\System_disk\Win-GRAF\ .

In the shipping CD (\Napdos\Win-GRAF\demo-project), you can find the demo project for this section
(demo_wp5_retain.zip), please refer Chapter 12 to restore this project (Execute File> Add Existing

Project > From Zip) and set the current IP address of your PAC.

This project includes an ST main program (Main) and 3 ST sub-programs (load_retain, save_retain and

Go_retain).

:ﬂ Win GEAF - dewo_wpd_retam
Fe Edt Yew Inest Tooxct Jools Window Help
oy 9 ’ 2 H OM&EMNE AR g FeA
Workspace
J demo_wp_telan o The "demo wpS5 retain” project has the following A T Nuw Type Chvtx Al
d Fscechonpogans 3 default valus . Please ==t your own propsr initial value, A
X 3 B an
A Progame 3 Sl . e oy B = (3 Giobal vanables
) Wi fee ;:',':f \A;_rr_:r : 1:”\ .:: srount £or : A HA.., :l.r i Lea) MAX VAR REAL DINT =
. AX A THER : ) (Bax. L " ege 5 R Apestin
°: ioad_relan ("Get satai = ~ - \nd RE 1d | o T MAYX_VAR_OTHER DINT R
3 ave_tetun (Savere. | @ AP (0 REAL VAR now  REAL [0.99]
gl = 2 - A
4 Go_ratan {"molemeant REAL_VAR ald REAL |0 99]
d Walch ffor debuggng| (bt The bigger value of LX VAR REAL and MAX VAR OTHER OTHER_VAR_now DINT D98 o
R 50l Scops the bigger FAC oyc me will be < >
- Y. " . better to d 1 | fine e for the
o [rdial vabaes : : U 2 S5, s A b 3 A1 5
’ c EAL and MAX VAR OTHER .
54 NS 2 VAR >
%4 Binding Conf 4 [Pacject]
%4 Brdng Configuration A
. ol :g ; 2 Thia project decalrss the folloving varisbles for denx a4 Advarced
@ Gicon deines purposs only. Plesase re-deciare your vn vacinbles, d Athmesc
ﬂ Vanable: AL
g 3 Anmys
ypes My BEAL OO 3 ASwiatlace
s 4 BCnst
2= 2 2 ~ 4 Bodlexrs v
< > € 4| Sacks. foodm  Detvw  BMULM
4 F Mae by Stée O
Buila X
O Bung Crone sstetsnoar Bartrre Cad stk rawserer Dxatal ocing 11wee Pompt | HMI
Aeady Cffne 192.168.71.19:502 Z 0,0 132x 18 0,0 100% M

Limitation :

This project is not good at handling Retain variables which value changes frequently. For example, value
changed about every second or every minute. That is because these retain values of this project are
saved within files in the \System_Disk. The file operations in it consume more CPU time, which will slow
down the PAC performance if retain value changed frequently.

The "demo_wp5_retain" project has the following default values. Please set your own proper initial
values.

MAX_VAR_REAL: 100 (Max. amount for retaining REAL variables)

MAX_VAR_OTHER: 100 (Max. amount for retaining integer+Bool+Timer variables)

Dim of REAL_VAR_now and REAL VAR old: 100 ([0..99], the same as the value "MAX_VAR_REAL")
Dim of OTHER_VAR_now and OTHER_VAR_old: 100 ([0..99], the same as the value "MAX_VAR_OTHER")

Note: The bigger the value of the MAX_VAR_REAL and MAX_VAR_OTHER, the larger the PAC cycle time
will be. So it is better to declare just fine value for the MAX_VAR_REAL and MAX_VAR_OTHER.
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This project declares the following variables for demo purpose only. Please re-declare your own
variables.

My REAL 00 ~ My _REAL_07 (Data Type: REAL)

My DINT_00 ~ My_DINT_05 (Data Type: DINT)

My_BOOL_00 ~ My_BOOL_02 (Data Type: BOOL)

My_Timer_00 ~ My_Timer_05 (Data Type: TIME)

You can see more variables in the "Variables" window.

Variables | L4
W Name | Type | Dim. | Attrib. | Syb. | Init value || | Description
=] oba able e
MAX_VAR_REAL DINT Read Only 100 e Max. amount of REAL variables
MAK VAR OTHER  DINT Read O 100 The “Dim.” must Max. amount of (Integer + Bool + Timer) val -
REAL WAR_now REAL [0.99] be the same. Dim must = MAX_VAR_REAL
REAL VAR old REAL [0..99] O Dim must = MAX_VAR_REAL
OTHER_VAR_now  DINT [0-99] O Dim must = MAX_VAR_OTHER
OTHER_VAR_old DINT [0..99] O Dim must = MAX_VAR_OTHER
File_Pathi STRING(64) [0 [ 'System_DiskWvin-GRAF\retain_real txt'
File_Path2 STRING(B4) [ | 'System_Disk\W\in-GRAFiretain_other.txt'
My REAL 00 REAL O
My REAL 01 REAL (|
My REAL 02 REAL d The directory and files for all Retain variables.
My REAL 03 REAL O
My REAL 04 REAL O v
< >

"Go_retain" sub-program is used to do the retain operation. Remember to modify this sub-program.
There are 4 sections should to be modified in it. Please search "Add your REAL variables for retain here"
and "Add your integer, BOOL, Timer variables for retain here", and depend on your re-declared variables
to modify your "Go_retain" sub-program.

(* Add your REAL variables for retain here *)
(* *)
My_REAL_00 := REAL_VAR_now[0] ;
My_REAL_01 := REAL_VAR_now[1] ;
My_REAL_02 := REAL_VAR_now[2] ;
My_REAL_03 := REAL_VAR_now(3];

My REAL 04 := REAL_VAR_now[4];

My REAL 05 := REAL_VAR_now[5] ;

My REAL 06 := REAL_VAR_now[6] ;

My REAL 07 := REAL_VAR_now[7];

(* *)

(* Add your integer, BOOL, Timer variables for retain here *)
(F e *)
My_DINT_00 := OTHER_VAR_now[0] ;
My_DINT_01 := OTHER_VAR_now[1] ;
My_DINT_02 := OTHER_VAR_now[2] ;
My_DINT_03 := OTHER_VAR_now/[3] ;
My_DINT_04 := OTHER_VAR_now[4] ;
My_DINT_05 := OTHER_VAR_now[5] ;
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My_BOOL_00 := Any_to_BOOL( OTHER_VAR_now[6] ) ;
My_BOOL_01 := Any_to_BOOL( OTHER_VAR_now[7] ) ;
My_BOOL_02 := Any_to_BOOL( OTHER_VAR_now[8] ) ;

My_Timer_00 := Any_to_TIME( OTHER_VAR_now[9] ) ;
My_Timer_01 := Any_to_TIME( OTHER_VAR_now[10] ) ;
My _Timer_02 := Any_to_TIME( OTHER_VAR_now[11] ) ;
My _Timer_03 := Any_to_TIME( OTHER_VAR_now[12] );
My _Timer_04 := Any_to_TIME( OTHER_VAR_now[13] ) ;
My _Timer_05 := Any_to_TIME( OTHER_VAR_now[14] ) ;
(¥ ceeeereeerrernnrrreerereeseses e s nnnnnreeees *)

(* Add your REAL variables for retain here *)
(* *)
REAL_VAR_now[0] := My REAL 00;
REAL_VAR_now[1] := My_REAL_01;
REAL_VAR_now[2] := My_REAL_02;
REAL_VAR_now[3] := My REAL 03;
REAL_VAR_now[4] := My REAL 04 ;
REAL_VAR_now[5] := My _REAL 05 ;
REAL_VAR_now[6] := My_REAL_06 ;
REAL_VAR_now[7] := My_REAL 07 ;

(* *)

(* Add your integer, BOOL, Timer variables for retain here *)
(% cererrrrrrrrrrrrreerrereere e e ee e e e e e e e e e e e e e eeene *)

OTHER_VAR_now|[0] := My_DINT_00;

OTHER_VAR_now[1] := My DINT_01;

OTHER_VAR_now[2] := My DINT_02;

OTHER_VAR_now[3] := My_DINT_03;

OTHER_VAR_now[4] := My DINT 04 ;

OTHER_VAR_now[5] := My DINT_05;

OTHER_VAR_now[6] :=Any_to DINT( My BOOL _00);
OTHER_VAR_now[7] := Any_to DINT( My BOOL_01);
OTHER_VAR_now[8] :=Any_to DINT( My BOOL 02);

OTHER_VAR_now[9] := Any_to DINT(My_Timer_00);
OTHER_VAR_now[10] := Any_to DINT( My _Timer_01 ) ;
OTHER_VAR _now[11] := Any_to DINT( My _Timer_02 ) ;
OTHER_VAR _now[12] := Any_to_DINT( My_Timer_03 ) ;
OTHER_VAR _now[13] := Any_to_DINT( My_Timer_04 ) ;
OTHER_VAR_now[14] := Any_to_DINT( My_Timer_05 ) ;
(¥ cereerrrerrerrreerereeeeeee e e ee e e e e e e e e e eeeeenens *)
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Test Project:
Before testing, make sure you have already set up the PAC IP and compile/download the project into the

PAC (refer Section 2.3.4 and Section 2.3.5). When connecting with the PAC, all values in the Spy list
(refer Section 11.3) will be "0" (or "FALSE") at the begging, please enter some values at will. When the
value has changed, it will create a text file on the PAC (\System_disk\Win-GRAF\retain_real.txt and
retain_other.txt) and Write data to the files.

Note: The "Save_file_counter" will show the number of times the file is written, if this value is changing
rapidly (e.g., to write several times every second/minute.), it is not suitable for this application
(Because to write into files frequently in the "\System_disk" will reduce the PAC effectiveness.).

o S M e AR e (5 % A RUN RN~ U W
| Name | Walue | Description | Last=3
Save_file_counter 0 A
SRR M =13
B My_REAL_00 0.0 <m
g¢ My REAL_01 0.0 LAl el
My REAL 02 0.0 Vi4- DIID?QDM 15:59:40
My_REAL_03 0.0 Tg};& alpﬁi-‘;f;?ﬁ?;lc
My_REAL_04 0.0 \(f:llilc Ullsfg'ggﬂﬁlfil 15:59:40
=. 2alc
My_REAL_05 a9 RAM = 507864 bytss
My REAL 08 0.0 Elapsed: 1m3s
My REAL_07 0.0
ky_DINT_00 0 — S
My._DINT_O1 0 ' AR N ig 05 = )§| RUN T
My_DINT_02 0 OO00 HewSpyt.spl Cycle time (ms):
My_DINT_03 0 i Na : | Description ] Last=4
My _DINT_04 0 - Save_file_counter 7 =
| B A =
My_DINT_05 0 =i vy T Lt =22
My BOOL_00 t El My RE
My_BOOL. 01 e It will increase 1, if it writes once. Local application:
My BOOL 02 = V14 - 010%42014 - 15:59:40
M"—T_ o e My_RE&L_03 00 CRC=16#5fThealc
y_Timer_ t#0s My REAL 04 0.0 Target application:
My_Timer_01 tHOs e & W14 - 01/07/2014 - 15:59:40
et e My_REAL_05 235 CRC=16#5{7healc
¥ Imer_ $ My_REAL_OB 0.0 RAM = 507064 hyrtes
My_Timer_03 tH0s My _REAL_07 00 Elapsed: 8mAs
My_Timer_04 Hils My—DINT—UD 16325 —
My_Timer_05 tHos My_DINT_U‘I 0
My DINT_02 0
My DINT_03 2014
My DINT_04 0 ( Force |
My DINT_0D5 0
My BOOL_00 TRLUE
My_BOOL_01
My BOOL_02 Inlock
My_Timer_00 tH0s g7
My Timer_01 tH1h33m50s DDEHEE EHDDDID-
My_Timer_02 tH0s
My_Timer_03 Hi0s o
: DDDDDDDD EIDEIDDDCID
My_Timer_04 tH0s
. My_Timer_05 tH0s
Win-GRAF PAC: e
| BXE) W®BE #®RY) BEQG |
& 2 X4 B~
.ﬁiﬂ:(gﬂ WSystem_DiskWyin-GRAF
= sofgrafy ] License. bin Quicker.dl QuickerMet.dl
g retain_ather, txt B retain_real.txtd’r] CJooft-GRAF-WEF exe! ] t5.cod
[=] t5.C001 [#] UsershareMat, EWin_GRﬂF_WP_BDDD.exe ﬁWin_GRﬂF_WP_BDDD.Ink
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6.3 Save Data to EEPROM

The Win-GRAF PAC has a built-in EEPROM memory for users to read and write data, which will not lose

data when the PAC shut down. Compared to the read and write of the SRAM, EEPROM has the following

disadvantages:

Note: Some PAC have no EEPROM memory (like the WP-5238-CE7). They don't support EEP_Read() and
EEP_Write().

Advantages: Provides another way to save the important data, besides the Retain Variable. (Section 6.1).
Disadvantages: 1. The operation to read/write EEPROM will use much more CPU time (about 5 ~ 50 ms),
but changing to the way of "Retain variable", CPU time is much less than 1 ms.
Therefore, do not use the "EEP_Read" and "EEP_Write" Functions too frequently, or
it will increase the PAC Cycle time.
2. EEPROM has a “write” limitation (depending on the PAC), it is not suitable to write
the same data many times. So, DO NOT call "EEP_Write" Function within each PAC
Cycle to do the “write” operation.

ST Program: (Following will show the safe and dangerous coding ways.)

(* Declare "FIRST_CYCLE" as a “BOOL” variable and has an initial value “TRUE".

Declare "tmp_bool" as a “BOOL” variable °

Declare "New_Val" and "OIld_Val" as “DINT” variables. *)
(* Read the EEPROM once in the first Cycle. *)
if FIRST_CYCLE then

FIRST_CYCLE := FALSE; (* means it is not the first Cycle any more *)
tmp_bool := EEP_Read (1, New_Val);
end_if;
(* Safe Coding Way: write to the EEPROM only when the value is changed. *)
if New_Val <> 0ld_Val then
Old_Val := New_Val;
tmp_bool := EEP_Write (1, New_Val ) ;
end_if;

(* Dangerous Coding Way: EEPROM may be destroyed very soon. *)

(* Declare "FIRST_CYCLE" as “BOOL” variable and has an initial value “TRUE”.
Declare "tmp_bool" as “BOOL” variable.
Declare "New_Val" and "OIld_Val" as “DINT” variables. *)

(* Read the EEPROM once in the first Cycle. *)

if FIRST_CYCLE then
FIRST_CYCLE := FALSE; (* means it is not the first Cycle any more *)
tmp_bool := EEP_Read (1, New_Val);

end_if;

(*Dangerous Coding Way: Write the "New_Val" value to the EEPROM one time in every Cycle. *)
tmp_bool := EEP_Write (1, New_Val);
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6.3.1 EEP_READ (Read a Value from the EEPROM)

EEP_READ
(Addr QP Press “F1” key to see the detailed
[(J@Name setting descriptions.

Addr: (Data Type: “DINT”)

Address, can be 1 to 1200. If the variable type of the "@Name" parameter is a 64-bit data (e.g., LINT
or LREAL), the "Addr" can be 1001 to 1200 only.

@Name:
A variable name to store the value from the EEPROM.

(DO NOT use string variable. Variable type can be BOOL, SINT, USINT, BYTE, INT, UINT, WORD, DINT,
UDINT, DWORD, REAL, TIME, LINT or LREAL.)

Q:

Data Type: BOOL. TRUE: Ok; FALSE: Error.

If the type of the "@Name" parameter is REAL or LREAL, will return "Q" as FALSE if the value is NaN
(Not a Number) or other error happens. In the case of NaN, the REAL/LREAL variable will get the
value "0.0".

6.3.2 EEP_WRITE (Write a Value to the EEPROM)

EEP_WRITE
Addr Qi
Value

—

Addr: (Data Type: “DINT”)
Address, can be 1 to 1200. If the variable type of the "Value" parameter is a 64-bit data (e.g., LINT or
LREAL), the "Addr" can be 1001 to 1200 only.

Value:
The value to write to the EEPROM.

(DO NOT use string variable. The value type can be BOOL, SINT, USINT, BYTE, INT, UINT, WORD,
DINT, UDINT, DWORD, REAL, TIME, LINT or LREAL.)

Q:
Data Type: BOOL. TRUE: Ok; FALSE: Error.
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Chapter 7 Exchange Data between PACs (Data Binding)

"Binding" function is used to exchange data between ICP DAS Win-GRAF PACs, the data transmission is
event triggered. It is much more efficient than polling way. Win-GRAF offers two ways to set up Binding:

® PUBLIC: Publish one PAC’s own data, or for use of VB .net, C#, or C in the same PAC.
® EXTERN: To get data from other PAC.

Application Diagram:

PUBLIC
WP-5xx8-CE7 Note:
The max. number of
, “Binding” (EXTRN) can be
PUBLIC . used by one Win-GRAF
EXTERN PUBLIC/ EXTERN PAC:

EXTERN

XPAC: Max. 32
WinPAC: Max. 16
ViewPAC: Max. 16
(See P1-1 for details.)

VP-2x08-CE7 T VP-4x08-CE7
(7%) Y (107)
EXTERN - PUBLIC

XP-8xx8-CE6
Redundant Binding

"PUBLIC" Setting Steps:

When the PAC sets up the "PUBLIC" area, means to publish its own data.
1. Mouse right-click on the toolbar "Open Binding Configuration" icon to open the "Binding" window.

2. Click "PUBLIC (: 9000)" to configure the data to be published as PUBLIC; "Address" field needs not
tofill in; "Port" field is fixed to "9000", do not change it.

78 Win-GRAF - Test 3
File Edit View Insert Project Tools Window Help
A = W AN N SRE N D, s oo i ElNle A R e 65 % A

Open Binding Configuration

Workspace Binding

B Test 3 =TT o Network Nane | Value Type K
“ [ Exception programs P (-3 FLBLIC [:9000) Name PUBLIC (2} Global variables o
([ Programs Address =l RETAIN variables

€] Main g Port 3000 ] Main 5
£ Watch (for debugging) ?2 pOnBadindex 3
H Z.in # A - = B
| jﬁ_ S Soope , "PUBLIC" area { I Variable =
e nitial values : s . ariaple [
{ A MName | Identifier ster.. | N
“#fg Binding Configuration needs not to fill L,_aﬂe_ area —1
- 3g Global defines in the Address.
13 Variables
B Types
< : | |

[4 5| Binding, \ariables
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3. Before setting the data to become public, first you must create the variables want to become
public in the Variable area. Right-click on "Global variables" and press "Ins" key to add the new
variables. In the following table, the variables are used for this example. You can set up your own.

After finished, the screen is as below.

"W MName | Type | D
Variables Name Data Type —[“—ﬁ Global variables K A
FPublic_BOOL BOOL
Public_BOOL BOOL Public_INT INT
- Fublic WORD WORD
Public_DINT DINT Dithli~c DEAI DE Al T
Public_WORD WORD R ERL g |
— _] Main AN
Public_REAL REAL &5 Press "Enter" key

4. Right-click on the "PUBLIC (: 9000)", and then select the variables that you want to publish, and
drag them to the "Name" area. "ldentifier" field will automatically generate numbers (if other PAC
wants to access the data, need to set the same ID number).

Note: "PUBLIC" can use up to 8192 variables; "lIdentifier" number can only be "1 ~ 8192".

Binding *

Name | Value T MName | Type |
Name  PUBLIC = fay Global variables A
Address Public_BOOL BOOL

Port 3000 Fublic_INT INT &
Public_DINT ,, DINT
Public_WgRD WORD

Pubﬂq‘REAL REAL v

| = = : & | >
Name | Identifier | Positive hysteresis = =~ —
L - ==7"" || Name | Value |
Public_INT 2
Public= DINT 3 If the user want to assign continuous “Identifier”
Public_WORD 4 . s u cre g
iy : number, first click “Identifier” field and select
s those variables wish to be assigned, and then
2% click “Iterate property” to set up numbers.
|4 ¥ Binding " \ariables

Binding *
ke P
P g PUBLIC (:9000)
- @ 101:Public_BOOL Name !z ] |
g+ - @ 102:Public_INT |
[ From: 1m =| By 1 2 ]

(a2 103Pubic_DINT
°= ® )@ 104Public WORD Resuls
’j——‘u 105-Public_REAL 0 °
Iterdte property 1
;W i 103

| Identifier
Public BOOL  RLEY
Public_INT 102

Public_DINT 103
Public_WORD 104

Public_REAL i [ ok ‘{[ Cancel |

£
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"EXTERN" Setting Steps:
When the PAC sets up the "EXTERN" area, means will get the data from other external PAC.
5. Click the "Insert Master/Port" icon in the left side, it will show the "Group" window. Follow the
description below to set up this window, and then click "OK” button.

Binding

. = EHE Metwark,

ez ' E || C [:9000]

M arne | Walue
Marne PLEBLIC
Address

Port

3000

MName m
EXTERN:1 |
g
Hehes PAC1 PAC2
Address {1’65.‘1"6@,'{.1_ 6@6’0’.16@371’63 rnn rn n
Port {9066_]
Name: Can be modified to the desired name.

Address:  Enter the IP address of the PAC which data will be obtained (e.g., "192.168.1.100").
User can enter two IP Addresses (e.g., "192.168.1.100/200.168.1.100"; that PAC must
use two Ethernet Ports), so that when one IP address occurs any problem, it will try to
link the second IP address.

Port: Fixed to use "9000", do not change it.

6. Inthe variable area, set up the data type you want Variables Name 2ELE] VTR
to get. (Refer Step 3 - Right click on "Global PAC1_BOOL BOOL
variables" and press "Ins" key to add the variables). PACL_DINT DINT
The variables that listed in the table are used for
this example. You can set up your own. After PAC1_REAL REAL
finished, the screen is as below. Error_Status DINT

7. Please drag the variables you need into the "Name" area of the "EXTERN:1".
Note: "Identifier" field will automatically generate numbers, please change them to the same as
the opened IDs of the PAC that you want to get data from.

Binding *

& - g, PUBLIC (:9000) || Name | Value T Name | Type |
£ Z @ 1:Public_BOOL Name EXTERN:1 Public REAL  REAL »
@ 2Public_INT Addr.. 192.168.1... PAC1 BOOL BOOL

g - @ 3:Public_DINT Portt 9000 ¢ PACT_DINT DINT
N . .@ 4Public_WORD /) PAC1_REAL  REAL
:Publio—FEdt L,/ | Eror Status  DINT v
- 7 i Variable area
 Name | Identifier | Destination .~ = utéame ML) l
PAC1_BOOL 1 Exchange data. — — = -
PACT_DINT <« 2 e mm—-- ExEhange data
PACT_REAL 3 Exchange data
Error_Status 4 Exchange data

/4 ¥ | Binding,” Varisbles
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8. As the picture below, "Error_Status" variable is used to determine the communication status of the
PAC, please set this ID to "0" and then double-click "Destination" field and set it to "Connection
error status".

= <ﬁ-; PUBLIC (:9000) # (| Name |,Y_§|U_e,____ ¥ MName Y | Type |
1] © @ 1:Public_BOOL Name EXTERN:1 Public_DINT DINT »
@ 2:Public_INT Addr.. 192.168.1.... Public_ BOOL BOOL
g¢ @ 3:Public_DINT Port 8000 PACT REAL REAL
@ 4:Public_W0ORD PACT_DINT DINT
@ 5:Public_REAL PAC1_BOOL BOOL
-5 EXTERN:1(192.168.1.100/200.168.1.100:3000) Error_Status DINT Vv
Name ! |dentifier | Destination < 2 :
PAC1_BOOL Exchange data MName | Walue [

1
PACI_DINT 2
PACT REAL 3
Error_Status 0

Exchange data
Evehanoa dats
| Exchange data

- | Variable error status
|4 ¥ | Binding ~ ‘riables - Variable date stamp

- | Yariable time stamp
Build | .
5 Connection error status X
| > Build /' Crossreferences | Runtime | jital szamplingtrace | Frompt | Hbdl .~

Note:

a. If "EXTERN" set up two IP addresses (step 5), then the "Error_Status" will return two communication
status. As the following table, use 8 bits to indicate the connection status. The bit 0 ~ 3 represents
the first IP connection status (If all bits are 1, the value is 15); the bit 4 ~ 7 represents the second IP
connection status (If all bits are 1, the value is 240). As long as the value is not equal to “0”, it means
that there are connection errors.

IP2 Connection Status

IP1 Connection Status

27 | 22 | 2° | 2°

22 | 22 ] 2] 2

Status Description

0 0 Connection OK
0 #0 (1~ 15) IP1 Connection error
# 0 (16 ~ 240) 0 IP2 Connection error
#0 Z0 IP1 and IP2 Connection error

b. The return value of the "Error_Status" is an integer value. The following division operation provides
a way to determine this value. Dividing this value by 16, the quotient represents the IP2 connection
status, and the remainder represents the IP1 connection status. If the values are not equal to “0”, it

means that there is any connection error. For example: If "Error_Status" = 16, divided by 16, the

quotient =1 (# 0, IP2 Connection error) and the remainder = 0 (IP1 Connection OK); If "Error_Status"
= 3, divided by 16, the quotient = 0 (IP2 Connection OK) and the remainder = 3 (# 0, IP1 Connection

error);

Notice:

Please ignore the description of the "Connection status" and
"Variable status" in the "Networked applications - Dual
binding on redundant ETHERNET" of the "HTML Help" that
opened when press "F1" key. That explanation is wrong and
does not comply with the ICP DAS Win-GRAF PAC. Please

ignore it.

Jlelslalalz]1]n0
-Q[\J}ﬁ CN}&?
. DK
1 Co'ﬁﬁec;i_on 1 fails
2 . Connectigﬁ'zfa_i.ls
3 Both cnnnectinn;'f'a'il...
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Chapter 8 Connecting DCON 1/0 Modules

The Win-GRAF PAC can connect the ICP DAS "I-7000" and "I-87KW" remote DCON I/O modules via the
COM Port (RS-485). Each PAC can enable up to 16 DCON Ports, and each Port can connect up to 50
remote DCON I/O modules (not recommended over 32). If select the "I-87KW" series I/O modules, it
must be used with the RS-485 I/O Expansion Unit (e.g., 1-87K4/5/8/9 or RU-87P4/8). You can view the
detailed product information on the ICP DAS website:
http://www.icpdas.com/root/product/solutions/remote io/remote io products.html

Win-GRAF PAC

1-8142iW/1-8144iW
(2/4, RS-422/RS-485 Ports)

Before connecting "I-7000" or "I-87KW" remote DCON I/O modules, you must use "DCON Utility"
software to configure each module for the Protocol (choose DCON mode), Address (1 ~ 255), Baudrate
(the setting must the same with the Win-GRAF PAC, recommended set to 9600), Checksum (the setting
must the same with the Win-GRAF PAC, recommended set to "enabled" for communications security),
Data format and other Input/Output settings (set according to demand).

Note:
A. When using the Al module of 1-7000 and |-87KW, set the Data format to "2's Complement".

E.g. 1-7005, 1-7013, I-7014D, 1-7015, 1-7016, I-7017R, |-7018Z, I-7019R, 1-7033; [-87005W, 1-87013W,
[-87015W, 1-87015PW, |-87016W, 1-87017W, 1-87017RCW, 1-87017ZW, I-87017DW, 1-87018W,
[-87018RW, [-87018ZW, 1-87019RW, I-87019ZW, and other Analog Input modules.

B. When using the AO module of 1-7000 and |-87KW, set the Data format to "Engineering"

E.g. 1-7021, I-7022, 1-7024, 1-7024R; 1-87024W, 1-87024UW, I-87024CW, 1-87028UW, 1-87028CW,

[-87028VW, 1-87028VW-20V, and other Analog Output modules.

"DCON Utility" is an easy-to-use software toolkit that help user search the network, configure the 1/0
modules and test the I/O status. Please visit the website to get the software program and user manual:
www.icpdas.com/products/dcon/introduction.htm

The following will introduce the setting method in the Win-GRAF Workbench.
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8.1 Setting "DCON" I/O Boards

"DCON" can be used to enable an RS-485 Port to connect remote DCON I/O modules (e.g., I-7000 series
modules, RU-87P8 I/0 Expansion Unit + I-87KW 1/O modules, or I1-87K8 1/0 Expansion Unit + I-87KW 1/0
modules). If want to enable more than one DCON Port, please set up multiple "DCON" 1/O Boards. (One
PAC can enable up to 16 "DCON".)

1. Click "Open I/0s" of the Win-GRAF tool bar to open the “I/O Boards” setting window.

File Edit View Insit FProject Tools Window Help

Sl ok X s 0 %@mmﬁsgg % %% A

2. Double click "Slot8" to add "DCON" I/O Boards (Refer Chapter 4), and then double click "DCON" to
open the “Properties” window.
Note: The Slot 0 to Slot 7 are reserved for real I/O modules that plugged into the PAC, and the slot 8
or above are for other usage.

£E5E 170 Boards a
B

8?5(:0!‘ - Properties

Baud_rate = 9600
Host_watchdog Enabled =0
Watchdog_timeout = 5000

ICOM Checksum_enabled =0
EEHDCON Delay_ms_between_polls=0

b (0 |an (4= [ [ro | = |
A
o)
v
1l
e

2 \ Reserved( =0
10 Reservedl =0
11 M Reserved2 =0
Reserved3 =0
12
13
14
15 Setting Descriptions
16 'DCON 4 8 P Al
17

Enable one serial port [RS-485] to connect remote DCON 1/0s (17000 series modules , RU-87PE

Mate:
1. This "DCON" supports only the communication properties "N,8,1"" .
That is "No-parity* , "'8 character size'' and "1 stop bit" .
So please must configure all DCON /0 modules to "N.8.1" . W
< | 8|

Parameters:
Note: This "DCON" supports only the communication properties "N,8,1". That is "No-parity" , "8
character size" and "1 stop bit" . So please must configure all DCON I/O modules to "N,8,1".

Port: COM port number (1 ~ 37, depends on the PAC.)

Baud_rate: Communication baudrate in bps, can be 1200, 2400, 4800, 9600, 19200,
38400, 57600, 115200 (bps). Set a wrong value will use the default value
9600.

Host_watchdog_Enabled: 1: enable host-watchdog, O: disable it.
Set a nonzero value will use the value 1.

Win-GRAF User Manual, V 1.07, Apr. 2018 by ICP DAS 8-2



Watchdog_timeout: Unit: ms, can be 3000 ~ 25500.

Set larger than 25500 will use 25500 ms (25.5 sec).

Set smaller than 3000 will use 3000 ms (3 sec).

Ignore this setting when "Host_watchdog_Enabled" is 0.
Checksum_enabled: 0: disabled, 1: enabled.

Set a nonzero value will use the value 1. (Recommended set to

"enabled" for communications security.)
Delay_ms_between_polls: Unit: ms, default is 0 ms. Valid range is 0 ~ 1000.

Set smaller than O will use 0 ms.

Set larger than 1000 will use 1000 ms.

If there is no wireless module connected, set a smaller value.

For instance, set as 0~ 10.
If there are wireless modules (e.g., ICP DAS ZigBee Products: ZigBee

Converters or ZigBee 1/0 modules.) connected, set a bigger value.

For instance, set a value between 30 ~ 100 or other values.
Set larger value will get slower polling efficiency.

Double click the item to be set, and then fill in the value.

Key=06

Ref = 16#5

Port=2

Baud_rate = 9600
Host_watchdog_Enabled =1
Watchdog_timeowut = 3000
Checksum_enabled =0

Reserved0 =0
Reservedl =0
Reserved2 =0
Reserved3 =0

3. After setting up the "DCON" in the "I/O Boards" window, it will automatically add a "BOOL" input
variable in the "Variables" window. When the Win-GRAF links to the PAC, it will show the COM Port
communication status (TRUE: OK; FALSE: error.).

Variables WX
7 Mame 4| Type | Dim. | Attrib. | Spb. | Initvalue | User.. | Tag | Description
@ fa} Global variables

=4 RETAIM variahles
=} 08 - DCON
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8.2 Using 1/0 Function Blocks

The Win-GRAF supports many ICP DAS DCON remote I/O modules, you can open the "Library Manager'
(Refer Section 1.2.3) or press "F1" key in the "Function and FBs" to view these 1/O Function Block
descriptions. This section will introduce "D_7065", "D_7018Z", "D_7083", "D_87084_freq",
"D_87084_cnt4","D_87084 cnt8", and "DL_100T485" I/O Function Blocks.

{74 Library Manager - ICP DAS - XP-WP-¥P = |[B]X]
File Wizard Help
Function and FBs D/0s | Profiles | 45 | Types|
& D_7005 (* remote -7005 %)
@D_7011 (*remote 7011, 7011D, 7011F, 7011PD %)
@D_7012 (* remote -7012, 7012D, 7012F, 7012FD %)

Cota il Do LN - LR AN WP PP RS W, & PEPPER R PR Sl [ Ka Wi /uk K F IiLe Tk Ca) elfleTuh Lal e 3003 V_
: Parameter@scriplion
*#% Function Block N
#*% Input parameters
EN : BOOL : TRUE : enable it , FALSE : disable it .
Port : DINT : COM port number , can be 1 to 37 (depends on PAC) .
(*** Must use a constant value, not a changed wvalue *%#)

Addr : DINT : Net-ID address of the module , can be 1 to 255 . N

In the LD Program - Functional Block area, expand the "ICP DAS - XP-WP-VP" folder of the "Blocks" panel.
There are many Functions and Function Blocks. You can select the desired one, and drag it into the
editing area of the program.

A7 Name | Dim.

b Inst_D_7005 1110 i | Tope
- END._7005 0K | =i ] Main
) # fa} Global variables
. drort v ol = RETAIN variables
Ky = = B8 %IX3 - DCON
i o vt %IX8.0 BOOL
o | {rmer vz} AN ) =
B N B [ ICP DAS - XPWPVP ~
il b DO _0 W 3} N N 15 CUUNTER_GET [*Get t...
= N {} COUNTER_RESET [*Re..
» | e oot w4} RN {} COUNTER_START [*Sta...
o N T} COUNTER_STATE [Get...
o i b2 st Ss o T} COUNTER_STOP (‘Stop...
HIOH ~ -
= = e =L EF D_701U{temate 011, ..
| o bes wil T = = FFD7I012 (remote 17012, .
o = = D_7012_V2 [*Get only 1-...
l Il . D_7013 (Fremote i-7013%)
¥ Tips: 2| D_7014 (‘remote i 7014, ..

| Press “F1” to see the setting description. | — . -,

(4 | Main, Wariables
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8.2.1

“D_7065" Function Block

“D_7065”: Connect a remote I-7065, I-7065D (Power Relay Output Module) or I-7065A, I-7065AD,
[-7065B, I1-7065BD (Solid State Relay Output Module).

Note:
All connected DCON 1/0 modules should be configured once by the DCON Utility (see P8-1).
Please use "DCON"(Section 8.1) in the "I/O boards" window and set proper settings (Port, baud_rate,

1.
2.

etc.)onit.

. All values of DI channels are meaningful only when the returned communication state is TRUE (If

"OK" returns "TRUE".).

Referring Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the
demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\DEMO_D_7065.zip) in the shipping CD and
see the program and descriptions.

Supposition: Use PAC‘s COM2 to connect the I-7065 (Addr. = 2) with 4 DI and 5 Relay output channels.

M _________ _________ __________________________KEX

3 s cont A7 MName | Type | Dim. | &
nst_D_7065 ;
i R1 EN 7055 oK S - Dﬁ Glabal vangb[lje(;aL ~
DI =
| o ] I - N L Ho0.
- 5 = If "OK" returns "TRUE". [ 4 BOOL
4 {adar N2 e E
01 BOOL
DO_1 DI_3 ¢
4 . RL_1 IN_3 V- DO 2 BOOL
DO_2 DI_4 DO_3 BOOL
i - MrRL_2 [T S - DO_4 BOOL
DO_3 DO 5 BOOL
» . RL_3 COM BOOL v
o DO_4 ¢ B
= * 750 RL.4 \ Declare 9 BOOL variables D_7063 (remote 17063, .. A
- — RL S (DI & DO of the I-7065). =
fl D_7066 [*remote i-706E, ...
— v 4FE N 2067 (ramnte iZ0R7. Y
2L b4 {4 »| Blocks Sowlist | Define | ENUM

4 »| Main/ '\)_‘ariablgs

Input Parameters:

EN:
Port:

Addr:

RL_1~ RL_5:

Data type: BOOL. TRUE: enable it; FALSE: disable it.

Data type: DINT. COM port number (can be 1 to 37, depends on PAC).

(*** Must use a constant value, cannot be a changed value. ***)

Data type: DINT. The Net-ID address of the module, can be 1 to 255.

(*** Must use a constant value, not a changed value ***)
Data type: BOOL. 5-Ch DO values.

Output Parameters:

OK:

IN_1~IN_4:

Data type: BOOL. TRUE: Communication is Ok. FALSE: Communication failed.
Data type: BOOL. 4-Ch DI values.
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8.2.2 “D_7018Z" Function Block

“D_7018Z”: Connect a remote I-7018Z module that is a 10-channel Thermocouple analog input module
for measuring voltage, current or temperature with features of individual channel
configuration, open-wire detection and over Voltage protection.

Note:

1. All connected DCON I/O modules should be configured once (e.g., Address, Baudrate, etc.) by the
DCON Utility (see P8-1). Please must configure the data format of Al modules to "2’s complement"
by DCON utility, or the Win-GRAF PAC can not read them well.

2. Please use "DCON"(Section 8.1) in the "I/O boards" window and set proper settings (Port, baud_rate,

etc.) on it.

3. All values of Al channels are meaningful only when the returned communication state is TRUE (If

"OK" returns "TRUE".).

4. Referring Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the
demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\DEMO_D_7018z.zip) in the shipping CD and
see the program and descriptions.

Supposition: Use PAC‘s COM2 to connect the I-7018Z (Addr. = 3) to measure the Celsius temperature.

3 e - AT Name ' | Type | Dim. |
nst_D_7018Z ;
& o EN D T0182 D] | g B 5 {a} Global variables A
E \ A1 REAL
| 24Port w_0f-&11 Al_2 REAL
= If "OK" returns "TRUE". | A3 REAL
o 3 sddr ywo1)Al2 Al_4 REAL
AlLS REAL
o | tympF  vo2las Al B REAL
i A7 REAL
=il W_31AIL4 Al_8 REAL
w A9 REAL
g B YRS . Al_10 REAL
5 Declare 10 REAL variables COM BOOL -
£ v sta 6| (Al of the 1-70182). e s
HICH —— , =
) v glaL7 D_70172_20 [remote i.. A
[ D_7018 [Fremote i-701...
3_ v 7|als D_7018Z [“remote -70...
D_7019R [*remote i-70...
| v glals D_7021 [Fremote i-702...
D_7022 (*remote i-702...
| W gl AlL10 o D_7024 [remote i-702...
< ¥ |[€%] Blocks Soviist | Define | ENUM.
[€ » | Main Varisbles. ' - -
Input Parameters:
EN: Data type: BOOL. TRUE: enable it; FALSE: disable it.
Port: Data type: DINT. COM port number (can be 1 to 37, depends on PAC).
(*** Must use a constant value, cannot be a changed value. ***)
Addr: Data type: DINT. The Net-ID address of the module , can be 1 to 255.

(*** Must use a constant value, not a changed value ***)
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Tmp_F:

Data type: DINT. Temperature Format, can be 1 or 2:

1 : temperature unit in Degree Celsius.

2 : temperature unit in Degree Fahrenheit.

Other value: use it as "1:temperature unit in Degree Celsius".

Output Parameters:

OK:
Vo~V_o:

Data type: BOOL. TRUE: Communication is Ok. FALSE: Communication failed.
Data type: REAL. 10-Ch Al value.
If the channel range type is configured as mV or Volt by DCON utility, the unit of the
returned channel value is Volt.
For example, 0.85421 means 0.85421 V or 854.21 mV.
If the channel range type is configured as mA by DCON utility, the unit of the
returned channel value is mA.
For example, 1.5567 means 1.5567 mA .
If the channel range type is configured as temperature, the value unit is degree.
For example, 25.75 means 25.75 degrees.

Open-wire Detection:

If the returned temperature is greater than "9000.0", it means that

1. The temperature sensor may be broken-line.

2. The temperature sensor may be damaged.

3. The DCON module is not configured well to fit the connected temperature sensors.
4. The ohm measured by the connected sensor is not correct.
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8.2.3 “D_7083"” Function Block
“D_7083”: Connect a remote I-7083, I-7083D, I-7083B or I-7083BD module that is a 3-axis, 32 bits

encoder counter.

Note:

1.

To get the Encoder value of the |-7083, |1-7083D, I-7083B and I-7083BD module, first using "D_7083"

Y AT} n u n u

Function Block. Then, using the “Counter_Start”, “Counter_Stop”, “Counter_Get”, “Counter_State”
and “Counter_Reset” Functions (Refer Section 4.9) to operate encoder channels in an I-7083,
[-7083D, 1-7083B and |1-7083BD module.

All connected DCON 1/0 modules should be configured once (e.g., Address, Baudrate, etc.) by the
DCON Utility (see P8-1). Please must configure the data format of Al modules to "2’s complement"
by DCON utility, or the Win-GRAF PAC can not read them well.

Please use "DCON"(Section 8.1) in the "I/O boards" window and set proper settings (Port, baud_rate,
etc.)onit.

All values of Al channels are meaningful only when the returned communication state is TRUE (If
"OK" returns "TRUE".).

Referring Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the
demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\DEMO_D_7083.zip) in the shipping CD and
see the program and descriptions.

Supposition: Use PAC‘’s COM2 to connect the I-7083 (Addr. = 4) with 3 DI channels.

3 AT Name | Type | Dim. | &
i R1 R CON_‘ 1 ~ || E {a} Global variables ~
al 2 - \ DI_1 BOOL -
| 24port 7o} g DI_2 BOOL
= ol 2 If "OK" returns "TRUE". | DI_3 BOOL
| 4 { addr A P o U COM BOOL v
| DI_3 % >
o To read/write/operate Z2 = D_7080_CNT [remote ..  #
% | Encoder, refer Section 4.9. N L7050 FHEQ (remcte (-
il ; .
Sl ) Declare 3 BOOL variables < 3] Blocks " Soviist | Define | ENUM
] M il (Z-index DI of 1-7083).
Input Parameters:
EN: Data type: BOOL. TRUE: enable it; FALSE: disable it.
Port: Data type: DINT. COM port number (can be 1 to 37, depends on PAC).

(*** Must use a constant value, cannot be a changed value. ***)

Addr: Data type: DINT. The Net-ID address of the module, can be 1 to 255.

(*** Must use a constant value, not a changed value ***)

Output Parameters:

OK: Data type: BOOL. TRUE: Communication is Ok. FALSE: Communication failed.
Z0~Z_2: Data type: BOOL. 3-ch Z-index DI value.
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8.2.4 “D_87084_FREQ” Function Block

"D_87084 freq": Connect a remote 1-87084W in an I/O Expansion Unit (e.g., 1-87K4/5/8/9 or RU-87P4 or
RU-87P8.) to measure 8-ch frequency.

Note:

1. Please MUST configure the I-87084W's frequency data format as "Hex format" by DCON utility (see
P8-1) when using the 1-87084W to measure frequency. Or it will not work.
2. Please use "DCON"(Section 8.1) in the "I/O boards" window and set proper settings (Port, baud_rate,

etc.)onit.

3. All values of Al channels are meaningful only when the returned communication state is TRUE (If
"OK" returns "TRUE".).

4. Referring Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the
demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\DEMO_D_87084_FR.zip) in the shipping CD
and see the program and descriptions.

Supposition: Use PAC‘s COM2 to connect the I-87084W (Addr. = 5) to measure 8-ch frequency.

3k
R1

|

(4 > | Main/ Variables

Input Parameters:
EN:
Port:

Addr:

Output Parameters:

OK:

Freq_0 ~ Freq_7:

main S P T g

A7 MName | Type | Dim. | &
comﬁiil ~ || & {a} Global variables ~
\ Al1 DINT
24Part Freg_of-Al_1 Al_2 DINT
If "OK" returns "TRUE". | 43 DINT
5 Addr Freg_1f-&1_2 Al_4 DINT
A5 DINT
Freg 2} A3 Al B DINT
Al7 DINT
Freg 3} &l_4 Al B DINT
COM BOOL v
Freq_4}AILS \ < : 5
# N~
Freq_5p416 | Declare 8 DINT variables g::;g:::g::; {:Z:Z:: B
Freq 5| a17 (frequency inputs of the
. [-87084W) DL_100T485 [remate DL..
Freq 7}-41.8 1} EEP_READ [*Read a val...
1| I} EEP WRITE ["wiite ava. ¥
b 4 | Blocks ” Sowlist | Define | ENUM

Data type: BOOL. TRUE: enable it; FALSE: disable it.

Data type: DINT. COM port number (can be 1 to 37, depends on PAC).
(*** Must use a constant value, cannot be a changed value. ***)
Data type: DINT. The Net-ID address of the module, can be 1 to 255.
(*** Must use a constant value, not a changed value ***)

Data type: BOOL. TRUE: Communication is Ok. FALSE: Communication failed.
Data type: DINT. 8-Ch frequency value, unit is Hz.
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8.2.5

“D_87084_CNT4” Function Block

"D_87084 _CNTA4": Connect a remote I-87084W in an I/O Expansion Unit (e.g., 1-87K4/5/8/9 or RU-87P4
or RU-87P8.) to measure 4-ch counters.

Note:
Please MUST configure the 1-87084W's counter data format as "Hex format" by DCON utility (see
P8-1) when using the 1-87084W to measure counters. Or it will not work.

1.

Please use "DCON"(Section 8.1) in the "I/O boards" window and set proper settings (Port, baud_rate,

etc.)onit.

To get the 4-ch counter value from the remote 1-87084W, first using "D_87084_cnt4" Function Block.
Then, using the "Counter_Start", "Counter_Stop", "Counter_Get", "Counter_State" and
"Counter_Reset" Functions (refer Section 4.9) to operate counter channels.

All values of Al channels are meaningful only when the returned communication state is TRUE (If
"OK" returns "TRUE".).
Referring Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the

demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\DEMO_D_87084_C4.zip) in the shipping CD
and see the program and descriptions.

Supposition: Use PAC‘s COM2 to connect the I-87084W (Addr. = 6) to measure 4-ch counters.

38

y

R1 J-

e
4 > | Main o \Varisbles

Input Parameters:

Output Parameters:

EN:
Port:

Addr:

OK:

| Dim. | &

Inst_D_87084_CNT4 COM e . Jupe
13t D 870584 CNT4
JED_87084 ChT4 .. |- L) 1 AlS DINT
\ Al B DINT
N AT DINT
If "OK" returns "TRUE". A8 DI
6| Addr COM BOOL
- :

To read/write/operate
counter, refer Section 4.9.

bs

Data type: BOOL. TRUE: enable it; FALSE: disable it.

v

>

D_87082_FREQ [remote.. &

D 87084 CNT4 [Fremote ..

D_87034_CNTS [remote ..

< ¥ | Blocks

FFF N A7N24 FRFN [Fremnte
Sovlist |

Define

Data type: DINT. COM port number (can be 1 to 37, depends on PAC).

(*** Must use a constant value, cannot be a changed value. ***)

Data type: DINT. The Net-ID address of the module , can be 1 to 255.
(*** Must use a constant value, not a changed value ***)

v
ENURN

Data type: BOOL. TRUE: Communication is Ok. FALSE: Communication failed.
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8.2.6 “D_87084_CNT8” Function Block
"D_87084 _CNT8": Connect a remote I-87084W in an I/O Expansion Unit (e.g., 1-87K4/5/8/9 or RU-87P4

or RU-87P8) to measure 8-ch counters.

Note:
Please MUST configure the 1-87084W's counter data format as "Hex format" by DCON utility (see
P8-1) when using the 1-87084W to measure counters. Or it will not work.

1.

Please use "DCON"(Section 8.1) in the "I/O boards" window and set proper settings (Port, baud_rate,

etc.)onit.

To get the 8-ch counter value from the remote |1-87084W, first using "D_87084_cnt8" Function Block.
Then, using the "Counter_Start", "Counter_Stop", "Counter_Get", "Counter_State" and
"Counter_Reset" Functions (refer Section 4.9) to operate counter channels.

All values of Al channels are meaningful only when the returned communication state is TRUE (If

"OK" returns "TRUE".) .

Referring Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the
demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\DEMO_D_87084_C8.zip) in the shipping CD

and see the program and descriptions.

Supposition: Use PAC’s COM2 to connect the I-87084W (Addr. = 7) to measure 8-ch counters.

38

y

| Dim. | &

Inst_D_87084_CNTH COM e . Jupe
1= ) a/084 CNTS

i ri| JED_ 87084 CNTS .. |- L) 1 ALS DINT

\ Al B DINT

N AT DINT

| If "OK" returns "TRUE". A8 DI

| - COM BOOL

<

To read/write/operate
counter, refer Section 4.9.

v

>

D_87084_CNT4 (remote . 4

D 87084 CNT8 [Fremote ..

D_87034_FREQD [remote... —

e
ENUM

T bt F7E NI 10NT 495 Framats N
a3 £ b < ¥ | Blocks ” Sovlist | Define
[« »| Main, \arisbles
Input Parameters:
EN: Data type: BOOL. TRUE: enable it; FALSE: disable it.
Port: Data type: DINT. COM port number (can be 1 to 37, depends on PAC).

(*** Must use a constant value, cannot be a changed value. ***)

Addr: Data type: DINT. The Net-ID address of the module , can be 1 to 255.
(*** Must use a constant value, not a changed value ***)

Output Parameters:

OK: Data type: BOOL. TRUE: Communication is Ok. FALSE: Communication failed.
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8.2.7

“DL_100T485"” Function Block

"DL_100T485": Connect a remote DL-100T485 module to get humidity and temperature value.

Product website: http://www.icpdas.com/root/product/solutions/remote io/rs-485/d| series/dI-100t485.html

Note:

1. Please use "DL-100T485 Utility" software in the shipping CD to configure the appropriate parameters
of the module (e.g., Module ID). The TDL-100T485’s default Address (ID) is "1", Baudrate is "9600",
and the Checksum is "Disable".

2. Please use "DCON"(Section 8.1) in the "I/O boards" window and set proper settings (Port, baud_rate,

etc.) on it.

3. All values of Al channels are meaningful only when the returned communication state is TRUE (If
"OK" returns "TRUE".) .

4. Referring Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the
demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\ DEMO_DL_100T485.zip) in the shipping CD
and see the program and descriptions.

Supposition: Use PAC‘s COM2 to connect the DL_100T485 (Addr. = 1) to get humidity and temperature

value.

3k
R1}

[ % | Main < \ariables

Input Parameters:
EN:
Port:

Addr:

Output Parameters:

OK:
RH:

Temp_C:

Temp_F:

| Type

COM

: 4 W Name | Dim.

g 7 § | E G Global variables A
2 y\ COM BOOL
2-{part RH|-RH1 RH1 REAL
If "OK" returns "TRUE". | Temp_t REAR v

1 adar Temp_C|-Temp_1 < 2

\ D_87084_CNTS [rem.. 4

D_87084_FREQ (...
Declare 2 REAL variables v
(humidity and temperature

1} EEP_READ [Reada ..
values of the DL-100T485.)

) TF FEP WRITE (#udrita = —
4 ¥ | Blocks  Spvlist | Define | ENUM

Data type: BOOL. TRUE: enable it; FALSE: disable it.

Data type: DINT. COM port number (can be 1 to 37, depends on PAC).
(*** Must use a constant value, cannot be a changed value. ***)
Data type: DINT. The Net-ID address of the module, can be 1 to 255.
(*** Must use a constant value, not a changed value ***)

Data type: BOOL. TRUE: Communication is Ok. FALSE: Communication failed.
Data type: REAL. The value is "Relative humidity"; unit is 1%.

For example, a value "45.7" means 45.7%.

Data type: REAL. The temperature value is in "Degree Celsius".

For example, a value "25.7" means 25.7 Degree C.

Data type: REAL. The temperature value is in "Degree Fahrenheit".

For example, a value "78.26" means 78.26 Degree F.
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8.2.8 “D_GPS721” Function Block

Using the “D_GPS721” function to link one “GPS-721" remote GPS receiver module (includes one DO
and one PPS outputs) which is used to receive GPS signals, get the precise date, time, longitude and
latitude, and for satellite positioning and time correction. Moreover, “GPS-721" is equipped with a
RS-232 interface, the remote host can request the GPS-721’s GPS information and remotely control the
built-in DO channel by using DCON commands over RS-485. And, the PPS (Pulse Per Second) function
can be used for a simple time synchronization.

Product website:
http://www.icpdas.com/root/product/solutions/industrial wireless communication/wireless solutions
/gps-721 tc.html

Note:

1. One PAC can use only one GPS-721 module.

2. All connected modules should be configured once. First of all, set up parameters of the GPS-721
module (e.g., Address, Baudrate, etc.) by the DCON Utility (see P8-1). (By defaults, the Address (ID) is
"1", Baudrate is "9600", and Checksum is "Disable".)

3. Please add "DCON" (Section 8.1) in the "I/O boards" window and fill in the proper settings (Port,
baud_rate, etc.).

4. Referring Chapter 12, click the menu bar "File" > "Add Existing Project" > "From Zip" to restore the
demo project (CD-ROM: \Napdos\Win-GRAF\demo-project\dmeo_gps721.zip) in the shipping CD and
see the program and descriptions.)

DS T2 ————————————————————— ————————————— ———————————_——— el e T A

3 A [ Mame | Type
o Blopsr2t B
I i EM  D_GPS721  Tok |
i ok Inst_D_GPS721 D_GPS72
| 2 - Time,_ok S, Inst_D_7005  D_7005
N Inst_D_7012_%2 D_7012_Y
12l “ear|vear! Inst_D_7012 D 7012
I syne yearl DINT
a8 | . Syno tarth |-maorth manth1 DiMT
day1 DINT
B amt_hr JGMT_Hr Dy [-chayt hourl DIMT
rrint DINT
>4 | gt _mmin | GhT_htin Haur |-hour sac] oiMT
Eat dd_0 long1 REAL
| . plel] i it lati1 REAL
H sat_num DINT
= Secf sect d0_0 BOOL
:.'_";"_ Sat_Mumf-sat_num (svnc BOOL » ¥
. ok Enumerated Data Twpes
| | Location_ok ']
| | Long|-longi
i Lati| Iati1 v
< > 4 *| Blocks | Sowlizt | Define | ENUM
4 ¥ | aps721 “ariables
Input Parameters:
EN: Data type: BOOL. TRUE: enable it; FALSE: disable it.
Port: Data type: DINT. COM port number (can be 1 to 37, depends on PAC).
(*** Must use a constant value, cannot be a changed value. ***)
Addr: Data type: DINT. The Net-ID address of the module, can be 1 to 255.
(*** Must use a constant value, not a changed value ***)
Sync: Data type: BOOL. Set it as "TRUE" to enable auto time synchronization (note: It will

work only when the "Time_ok" is also set to "TRUE"). If the time gap between the
GPS-721 and the PAC is 5 seconds (or more), it will automatically correct the PAC time.
Set it as "FALSE" to disable this function.

Win-GRAF User Manual, V 1.07, Apr. 2018 by ICP DAS 8-13


http://www.icpdas.com/root/product/solutions/industrial_wireless_communication/wireless_solutions/gps-721_tc.html
http://www.icpdas.com/root/product/solutions/industrial_wireless_communication/wireless_solutions/gps-721_tc.html

GMT_Hr & GMT_Min:
Data type: DINT. The time difference between local time and GMT (Greenwich
Mean Time). For example, Beijing and Taipei are +8 hours (GMT_Hr=8, GMT_Min=0),
United States is -6 hours (GMT_ Hr= -6, GMT_MIin=0), and India is +5.5 hours
(GMT_Hr=5, GMT_Min=30).

DOO: Data type: BOOL. The Digital output channel of the GPS-721 module.

Output Parameters:

Tok: Data type: BOOL. _
2.Port Time_aok ']
TRUE: The communication of GPS-721
. T4 Addr Year |-year! = 2015
is normal.
K S e =41 Mot | mantht =&
FALSE: The communication of GPS-721 o= ewn Day | eyt =15
is failed. And all the following T P el pourt < 18
output values are invalid.
] [alei] tdinfmint = 558
Seclsec! =45

Time_ok: Data type: BOOL.
TRUE: Now, the values of Year, Month,
Day, Hour, Min and Sec are valid. el @ '

Sat_Mum|-sat_num =&

Long|lonai = 25.0116

FALSE: Now, the values of Year, Month,
Day, Hour, Min and Sec are invalid.

Lati|-lati1 = 121.4738

(i.e., an error or non-real-time value.)

Note: Each day from 23:59:00 to 00:00:59 (2 minutes), the "Time_ok" will be set as "FALSE"
automatically and the time synchronization will not be processed.

Year: Data type: DINT. Year ( 2009 ~ ...).
Month: Data type: DINT. Month (1 ~ 12).
Day: Data type: DINT. Day (1 ~ 31).
Hour: Data type: DINT. Hour (0 ~ 23).
Min: Data type: DINT. Minute (0 ~ 59).
Sec: Data type: DINT. Second (0 ~ 59).

Sat_Num: Data type: DINT. The number of used satellites.
(0: no satellites can be found. Or, using 1 ~ 9 satellites)

Location_ok: Data type: BOOL.
FALSE: Now, the values of "Long" and "Lati" are invalid (i.e., an error or non-real-time
value.)
TRUE: The GPS-721 has got the current longitude and latitude location.
(Only when "Location_ok" is set to "TRUE", the values of "Long" and "Lati" are valid. )

Long: Data type: REAL. Longitude (positive value: East ; negative value: West).
(For example, "25.0121" means 25.0121 degrees.)
Lati: Data type: REAL. Latitude (positive value: North ; negative value: South).

(For example, "121.4576" means 121.4576 degrees.)
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Chapter 9 On Line Change

"On Line Change" function allows Win-GRAF PAC change its application to a modified one during the
PAC running time. The modified application must be the same name as the original one that currently
running on the PAC. The "On Line Change" is primarily used for emergency, such as, when the
application is not allowed to be disabled or stopped for a while or cannot find time to replace a new
application (for example, the device needs 24 hours operation and cannot be stopped). Except the
above situations, it is not recommended to use this function! You had better stop the running
application, then download the modified application to the PAC (see Section 2.3.5), which is more safe.

Application 1
(A little modified)

Win-GRAF [

Application 1
(Original)

9.1 Limitations of "On Line Change"

A Please notice the important limitations before enabling the "On Line Change"!

When On Line change is enabled, you can perform on the fly the following kinds of changes:

® Change the code of a program.
® Change the condition of a SFC transition or the actions of a SFC step.

4 )

Step Action

Transitions =f— Transition 1 =t Transition 2 \

Sequential Function
Step Step 9

Chart (SFC)
N J

® Create, rename or delete global and local variables.

® Create, rename or delete global and local function block instances.

Workspace
- Test ! 16 A | g Name 4| Type | Dim. | Attrib.
G [ Exception programs .. ouT1 7 =[] Main
=13 Programs U RUN BLINK @ Inst_BLINK1  blink
- %1€ Main I“J, £ {2} Global variables
L 3 Watch [for debuggin... || —= | T#2s |CYCLE _del_SW1 BOOL Deleted
. LW Soft Scope & ouT1 BOOL
=4 Initial values 1 SW2 BOOL Added
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The following kinds of changes are not allowed:

® C(reate, delete or rename a program. (It will appear a warning message if delete a program.)

2l Test
[ Exception programs
[ Programs
¥ Main

L= [ s |

Change SFC charts.

Change the local parameters and variables of a UDFB.

Change the type or dimension (or string length) of a variable or function block instance.
Change the set of 1/0 boards.

Change the definition of RETAIN variables.

In addition, the following programming features that are not safe during a change should not be used:

® Pulse (P or N) contacts and coils (edge detection).

25 Instead, you must use declared instances of R_TRIG and F_TRIG function blocks.

Rising Pulse Detection

Before Enable After Enable

=R ,
P S Imst_F_TRIG
P CLKRTRG)
(False > True)
QLT OUT1
F | I

Decreased Pulse Detection

’ S Inst_F_TRIG
N [CLEF TRIZ) o)
(True > False)
o™ net F_TRIG OUTH
N I CLKF TRIG 0

® Loops in FBD with no declared variable linked.

25 You need to explicitly insert a variable in the loop.
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9.2 Using "On Line Change"

Enable The "On Line Change" Function:
1. Mouse click "Project > Settings..." from the menu bar, then double click "On Line Change" item to set

it "Enabled".

[ Win-GRAF - Test
File Edit ¥Yiew [Insert B&mEE® Tool: Wmdow Help

& =% & . [ Enild All Projects F7
Workspace Clean Al Projects
B Test = Download All Projects...

""" [J Exception pre Sotiings..

-~ Programs

C:\Win-GRAF\ProjectsiTest

[Gerersl  JIEUT | Yalue |
FC{E?:;;?I.'; # Communication parameters 192.168.71.18:502
Debugging ¥ Cycle time 0

Advanced %n Code Generation Release

(All) Casknlas ranablasii s s an e S o Ko

Indl (11 Line Change Enabled
iy vemon \ T 2074706705 1548 |

Libraries Edit..

Use external objects Edit.

Double click to disable or enable and configure On Line Change
capabilities,

Cancel

2. Click "Project > Build All Projects" from the menu bar. Must compile the program first, then can set

up the following steps.

[/ Win-GRAF - Test
File Edit Yiew Inwe

m Tools Window Help

S e R N ARG @5 RA

N\ ‘ B %X
: ‘ : A\ Name | Type | Dim
— ; - ouT1 | E £} Global variables A
Build 411 Projects Ff RUN BLINK Q| ] ST BOOL
Clean All Projects ouT1 BOOL -
*= Download ATl Projects.. Ti2s Jovee || i) >
gethngs fien ] L;] [A"] 2
\ / # [ [Used)
q - 7 [d (Project)
29 Global defines i l I Y|l m 3 Advanced v
T} Variables =il ¥| |[€¥] Blocks " Soulist | Define | ENUM
B Types [ 4% erisbles | Main,
i Build X
I'f

Building application data... ~
< 9BO0OL/SINT; OINT; 1 DINT/REAL; O LINT/LREAL; 3 TIME; 1 STRING; - CRC = 1102ac76 >
l On Line Change not possible: too many variables

hielocating code... This message can be ignored when just
< Code CRC=a83cc42e6 - File CRC=feal1925 - Size=1832 > .
enable On Line Change.

Mo error detected

Callstack | Breskpoints | Diaital samplinatrace | Prompt | HMI

[« ¥ Buitd/" Crossreferences | Runtime |
OffLine 192.168.71,18:502 A 0,90 692%18 | 0,0

JReady
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Setup the Number of Variables:

When the "On Line Change" is enabled, you have to set up the number of variables reserved for the
declaration of the new variables and Function Blocks for future on-line change usage.

3. The same as the step 1, mouse click "Project > Settings..." from the menu bar, then double click on

the "On Line Change" to show the setting window.

Please set the needed new number in the “Value" or “Margin" fields.

Note: If both “Value" and “Margin" have set values, it will use the larger value. In this example,

"Value" is set as "30" and “Margin" is set as "10", then the displayed value x 10% is smaller

than 30, so it will use the larger value "30".

4. Click the needed Variable Type, then click the "Set” button.

(E.g., Click "BOOL/SINT variables" and "Set" button, then the number become 9 + 30 = 39.)
Note: "STRING buffers (characters)", "FB instance data (bytes — approx.)" and "Complex variables
segment (bytes) " need to set a larger number (This example uses "5000").

5. After setting (as the picture below), click the "X" in the upper right corner to exit the setting.

On Line Change 3]

Current Status

(oo

ENABLED

Number of varables allocated

(BOOL/SINT varisbles I P ]
| oo
| DINT/REAL variables 240
LINT/LREAL variables 140
TIME variables 240
Active timers 0/0
|STRING variables 240
|STRING buffers [characters) 1740
FB instances 340
FB instance data (bytes - approx.] 3240
Published variables 0/0
| Complex variales segment [bytes) 0/0
540

iPDUs

Numbers displayed: Used / Allocated
Displayed "used' numbers are according to the last build

On Line Change

Current Status

ENABLED

Number of varables allocated

&)
4
(e )

BOOL/SINT variables \ 9739
INT variables These 3 Types | 1431
\DINT/REAL variables need larger \ 2432
LINT/LREAL variables \ 1431
TIME variables values. |
Active timers 3 0730
|STRING variables 2732
L STRING buffers [characters) 17 /5017
FB instances 3733
| |FB instance data (bytes - approx.] 32 /5032
Published variables 0730

Il Complex variales seament [bytes] uzs00d ||
5735

iPDUs

Numbers displayed: Used / Allocated
Displayed "used" numbers are according to the last build

Allocate: O Value ‘30 Allocate: O Walue ’ 5000
@ﬁdargin (z |10 1\ %axgin (z |10 ‘
\ S

N

6. Click "Project > Build All Projects" from the menu bar, compile the program again. Then click “On

Line” or click the tool icon Al to link to the PAC. (Refer the Section 2.3.5.)

Tools Window Help
Build 411 Projects

Clean All Projects
Download A1l Projects...
Settings...

Qn Line

Stmulate

RUN BLINK

{CYCLE
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7. After successfully link to the PAC, click the tool icon "Download changes" to download the program
to the PAC.

Note: "On Line Change" is only suitable for the program that just has a little change (Do not need
to stop the application). If the program name is different from the running one on the PAC,
the user has to stop and download the program again (refer the Appendix B).

X il o S % R (Y B S (05 4K @I RN e{Eb v e @
| mm = = [Main] S X
| o ' ! ' A5 Name |Downloa[d$2:‘neges ﬁ;s.}r_-,l:pe
. OUT] = TRUE = & ] Main -~
] R} RUN BLINK Q)] =l {a} Global variables :
SWW1 Al BC
| T#2s JCYCLE QOuUT1 TRUE BCw
Sl 3
g1 ER=TY A

' 3 (Used)

M m CfProlect]
ol > |4 ¥] Blocks  sovlist | Define | ENUM -

[

‘vv“ar'iablgs» | Main

8. Click on the tool icon "Do On Line change" to execute the program.

Note: After executing the "On Line Change", there are some using restrictions for protecting the

system normal operation (refer the Section 9.1). So, make sure the program is correct, then
perform this function.

File Edit View Insrt Project Tools Window Help

ST W I W OE Mk i = Mo Lo I & %R G B Gg (5 % AIRUN Rechieln § @
Workspace I === = [Main] % X
= [ Test [RUN] . : . " A5 Name TVaE T Type
([ Exception programs e OUT1 = TRUE \ =] Main o
. £3 Progams g | R1 RUN BLINK @ O— = {&} Global variables
“5) Main SWi1 BC
=1 [ Watch (for debuggin... ||+ | T#2s |CYCLE ouT1 TRUE BCw
¥ Soft Scope < 1 8
; -_—? Initial values ; 5 —E.] [;“] B A
: -?_!a Binding Configuration B 5 03 (Used) _
39 Global defines s ; Ca (Pojectt ™
G} Variables | , 3| |[€ %] Blocks Soviist | Define | ENUM
B Types {4 2] \arsbles | Main :

| Build in progress... Please Wait...
Mo eror detected
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Chapter 10 Data/Type Conversion and Using the PAC Time

10.1 Al Data Conversion

If you are using Al modules in the PAC's Slot 0 to 7 (for example: I-8017HW), and want to convert the Al
input signal (for example: "4 to 20 mA" or "0 to 10 V") to the user engineering value (for example: 0 to
10000), refer the Section 4.3. However, if you are using the remote Al modules (e.g., through PAC's
RS-485 Port to connect to the 1-87017ZW or I-7017R module), you can refer the following settings:

Win-GRAF PAC
. I-87K4 1/0 Expansion Unit
COMx: RS-485
SE— I-7017R +1-87017ZW
Data - — Data - — Data - —

1. First, connect "i_scale" in the "I/O Boards" window, and double click on "i_scale_x" to open the
Properties window (refer the Section 4.2 for detail steps)
Note: "I/O Boards" supports ONLY ONE "i_scale" (DO NOT connect 2 or more "i_scale").

2. Set up the number and value of the Conversion Function that need to be enabled.
(E.g., Use Function 1 to convert "4 to 20 mA" into "0 to 10000").

Ch01_X0_Min_Physical_Val: “4.0”
Ch01_X1_Max_Physical_Val: “20.0”
Ch01_YO_Engineering_Val_For_X0: “0.0”
Ch01_Y1 Engineering_Val_For_X1: “10000.0”

iéé 10 Boards cale - Properties. _[x]

Ref 16824
{Ch00_X0_reserved =0.0
Ch[l[l " X1 reserved = 00
Ch[l[l Y1 _reserved = 00
ChOl “X0_Min_Physical ¥al=40
|Ch01 X1 Ha.x _Physical_¥al =200
ChOl “YO0_ :4-~ ng ¥al For X0=00
'Ch02_X0_Mi Ph : :alal TR ring ®
in_Physic Ch01_¥1 Engineering ¥al For X1 [X]
|{Ch02 “X1_Max_Physical_Yal= 00 2 ;
'Ch02_Y0 Engmenng_?al For_X0 =00 Y} 10000.0
- 'Ch02 Y1 E ¥al For X1=00
i_scale ChU3_XU_Min_ ym:al Yal =010
Bl scale 0 Ch03_X1_Max_Physical_Val =0.0 v

— 1 i_scale_1 i scale ~
— 2 i_scale 2 ~
10

Jcooowc‘:mhwm—to

Setup the scaling function No. 01 to 29 for scaling /0 variables .

12 Notice:
13 1. If setting both value of Ch_X0 and Ch_X1 to 0.0, it means the relative scaling function No. is d
2. I Ch_X0 is greater than or equal to Ch_X1, the setting is wrong. e

(£ | >

Win-GRAF User Manual, V 1.07, Apr. 2018 by ICP DAS 10-1



3. Edit an ST Program to convert a physical value (e.g., Phy_V[0] to [7]) to an engineering value

(e.g., Eng_V[0] to [7]). (Refer the Section 2.3.3 for detail setting steps.)

45 (% ii is declared as DINT A7 Name 4| Type | Dim. | At
3 Phy ¥V is declared as REAL array with Dim 8 = = ] ST1 (*Data Conversion™) s
i Eng V is declared as REAL array with Dim & ii DINT
IF + -
e " Phy v REAL 0.7]
=  for ii := 0 to 7 do “Eng_V JREAL [0..7]
o B {ay Global variables
;’_;‘ (* Using conversion function 1 to convert a ouT1 BOOL v
bm physical valuean to an engineering value *) < >
Eng V[ii] := Convert to Eng (1, Phy V[ii]]}: ’:,:{.1 F3 A ~
end for: | (*iiis declared as DINT variable :
& Phy_V is declared as REAL array with Dim. =8 —

{4 5| nariables | masj Eng_Vis declared as REAL array with Dim.=8  *)

forii:=0to 7 do

Eng_VI[ii] := Convert_to_Eng (1, Phy_VI[ii]);

end_for;

(* Using conversion function 1 to convert a physical value to an engineering value *)

10.2 AO Data Conversion

If you are using AO modules in the PAC's Slot 0 to 7 (for example: 1-8024W), and want to convert the
engineering value to the AO output signal (e.g., convert "0 to 20000" to "0 to 10 V"), refer the Section
4.4. However, if you are using the DCON remote AO modules (e.g., through PAC's RS-485 Port to

connect to the 1-7024 module), you can refer to the following settings:

1. Connect "i_scale" in the "I/O Boards" window, and double click "i_scale_x" to open the Properties

window (refer the Section 10.1 for detail steps)

Note: "I/O Boards" supports ONLY ONE "i_scale" (DO NOT connect 2 or more "i_scale").

i§E¢ 170 Boards

?

2 H elect

7

g . l Properties ’

7 l::alr:-._I:I
s

i -

14
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2. Set up the number and value of the Conversion Function (e.g., use Function 2 to convert "0 to 20000"

to"Oto 10 V").

9.0: i_scale - Properties X

Key=6

Ref = 16#24
Ch00_X0_reserved =00
ChOO_X1_reserved =0.0
ChO0_YO0_reserved =0.0
ChOD_Y1_reserved =0.0

Ch01_X0_Min_Physical_¥al
Ch01_X1_ Max_Physical ¥Yal

Ch02_XO0_Min_Physical_Val is set as “0.0”.
Ch02_X1_Max_Physical_Val is set as “10.0”.
Ch02_YO0_Engineering_Val_For_XO is set as “0.0”.
Ch02_Y1_Engineering_Val_For_X1 is set as “20000.0".

Chl]l YO Engmeenng_?al or X0=T0

Chl]2 Xl Hax _Physical_Yal=100

Ch02_Y0_Engineering_¥al For X0=00

Ch03_X1_Max_Physical_¥Yal=00

| Ch02_ "~ Y1 Engineering_Yal For X1 =200000

=uu

[€

3. Edit an ST Program to convert an engineering value to a physical value (e.g., Eng_V[0] to [7]).

ST

=R

THEN.

,.A..
-l

|

5 i

<

(Refer the Section 2.3.3 for detail setting steps.)

, WE X
{* ii is declared as DINT A1 MName 4| Type | Dim. | Aty
Phy ¥V is declared as REAL array with Dim & = J ST (*Data Conversian*’) -~
Eng V is declared as REAL array with Dim & ii DINT
*
) Phy v REAL [0.7]
for ii := 0 to 7 do Eng_V REAL .71
= fat Global variables
(* Using conversion function 2 to convert an ouT1 BOOL b
engineering value to a physical value %) | f. i " _)‘
Phy V[ii] := Conwvert_to_ Phy (2, Eng V[ii]): T LJ (&l = e
end for:

end_for;

forii:=0to 7 do

(* ii is declared as DINT variable.
[ Phy_V is declared as REAL array with Dim. =8
“ariables | M4 Eng_V is declared as REAL array with Dim. =8 *)

Phy_VI[ii] := Convert_to_Phy (2, Eng_VIiil);

(* Using conversion function 2 to convert an engineering value to a physical value *)
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10.3 Data Type Conversion

When different types of data want to do "+, -, *, /" calculation or ">, <, =, <=, > =, <> (not equal)"

operation, or when the variable types of the parameters in the function are different, you must first use

the type conversion function (in the following table) to convert them into the same data type, then can

use the data normally.

Data Conversion . L. Data Conversion .
. Descriptions . Descriptions
Functions Functions
ANY_TO_BOOL | Convert to Boolean ANY_TO_REAL Convert to Real
ANY_TO_SINT Convert to Short Integer (8-bit) | ANY_TO_LREAL Convert to Double
ANY_TO_INT Convert to Integer (16-bit) ANY_TO_STRING [Convert to String
Convert to Lone Integer Convert Number to String.
ANY_TO_DINT . g \nteg NUM_TO_STRING |Can set the decimal digital
(32-bit — Default) .
number after converting
ANY_TO_LINT | Convert to Large Integer (64-bit) | ATOH Convert Hexadecimal
String to Integer
. Convert Integer to
ANY_TO_TIME Convert to Timer HTOA . .
Hexadecimal String

For example, the following ST program will convert the DINT variable to a Real first, and then do the
calculation.

REAL_Val_1 := ANY_TO_REAL (DINT Val_1)*3.5+4.8;

You can open the "HTML Help" from the menu bar, and enter the searching key word you want to see
the detail setup instructions.

E? HIML Help

&
&% Topics BERE =Sk -F 7 =HENR BR
Q| Search o [ #80 || smesEo |
Tutorisls ¥ S0 ARIESmT S
% About type conversion ) v _'J
Language.. FIEEEL) ( BrD |
EEEED: ~ B3
#m @ B |
pe conversion functions - 1 i
ANY_TO_BOOL IECE1131-3 2
ANY_TO_DINT AANY_TO_U..\JIEC£1131-3 3
ANY_TO_INT AANY_TO_UINT IECE1131-3 4
ANY_TO_LINT IECE1131-3 5
ANY_TO_LREAL IECE1131-3 6
ANY_TO_REAL IECE1131-3 7
ANY_TO_TIME IECE1131-3 8
ANY_TO_SINT IECE1131-3 9
Programming languages - Refe... IEC 61131-3 10
ANY_TO_STRING IECE1131-3 11
NUM_TO_STRING IECE1131-3 12
BCD_TO_BIN IECE1131-3 13
BIN_TO_BCD IECE1131-3 14 \
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10.4 BCD Conversion

BCD 4-bit code is used to represent decimal numbers from 0 to 9. Suppose there is a decimal value

"132", if converted to BCD code is "000100110010" and if converted to binary is 10000100 (e.g., 2’ + 2*=

128 + 4 =132).
BCD
Decimal T T2 I [ 0 Description
0 0 0 0 0|0
1 0 0] 0] 1]2° NOTE:
2 0 0 1 0 |2'= BCD code can only represent
3 0| 0| 1] 1 |2'+2°=3 numbers from 0 to 9.
4 0 1 0 0 -1 It can not be used for these six
5 0| 11|01 1 |2%2+2°=5 values (1010, 1011, 1100, 1101,
6 0 1 1| 0 |2%2+2'=6 1110, 1111), and will return "0".
7 0| 1|1 |1 |2°+42'+2°=7
8 1|00/ 0 |2=
9 10|01 |22+2°=09

The function table below can be used for BCD (Binary Coded Decimal) value conversion.

Type Conyer5|on Description
Function
BIN _TO_BCD Convert Binary to BCD value
BCD_TO_BIN Convert BCD value to Binary
BIN _TO_BCD: SW2 = TRUE OUT1 = TRUE
19(10)= 0001 1001 gcp) | | EBIN_TC_BCD .
=2'+2°+2°= 16+8+1=25
N1 = 19{in @l =25
BCD_TO_BIN: S = TRUE QLTY = TRUE
33(10)= 0010 0001 ) = 21gcp) | | EBCD_TO_BIN
15(10) =0000 4.—1—].—]:(2) = O(BCD)
M2 =33 I af a2 =21

You can open the "HTML Help" from the
menu bar, and enter the searching key word

H OB < A

you want to see the detail setup EBEEE 2R -8 FEEN =5
instructions. rreld EEQ@) | E‘J%:i‘(l}
SERIRRIEPSANF S (W
@ Topics... v'f :J
. FUH EREL) BTD)
Q| Search.. EREED) B3 3 i
Tutorials [ B = [[5]=4
'? Abont... BCD_TO_EIN IECE1131-3 1
- Type conversion functions IECE1131-3 2
Lansuage... BIN_TO_BCD IEC61131-3 3
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10.5 Pack/Unpack Integer or Boolean

Unpack Integer to Boolean:

If want to unpack one BYTE (or USINT, range: 0 to 255) to 8 Booleans, you can use "UNPACK8" Function
Block.

Inst_UMNPACKS Bool_0 Inst_URPACKS
___________________________________________ ENUNPACKS... | EnUNRACKS . |
Bioal_1
_____________________ DSINT_1 Hin il ' LISINT_1 = 1281 1 '
Bool_2
GZ 1 (:!2 X
Bool_3
Bool_4
o 1 a4 .
Boal_5
5 ] a5 .
Bool_&
(8 ] Q6 .
Bool_7
[T ] arF .

If want to unpack one SINT to 8 Booleans, you must first use the ST program "ANY_TO_BYTE ()" to
convert the SINT to be a BYTE type, as follows:

Iri=t_UMPACHS Bool_0
En URIPACKE @i |
Bioal_1
AR TO BYTE(SINT Wil 1) D o '
Bioal_2
Q2 '
Boal_3
ok '
Raanany Bool_4
ot .
Boal_5
Q15 '
Boal_&
QI '
Boal_7
17 | ]

Pack Boolean Into Integer:

If want to pack 8 Booleans into one BYTE (or USINT, range: 0 to 255), you can use "PACK8" Function.

ST Program:

USINT_1 := PACKS8 (Bool_0, | Bool_1, Bool_2, Bool_3, Bool_4, Bool_5, Bool_6, Bool_7);
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LD Program:

Baal_0 ouT
IND PACHS Eno |
Baaol_1
- [N a|-ushT 1
Bool_2
= N2 Bool_0 = TRUE OUTH = TRUE
11
Boal_3 I1 N0 PACKS Eno
Y I3 Biool_1 = TRUE
Boal_4 ] i @] USINT_1 =15
Y thid Boal_2 = TRUE
Bool_5 O [
e e @ Bool_3 = TRUE
Baal_B ] ]z
— MG
Baal_7 L [
[ M7
v s
g
(e

If want to pack 8 Booleans into one SINT, you must assign a "BYTE" variable to the output(Q) to save the
value temporary, and use a "ANY_TO_SINT" Function to convert BYTE into SINT type, as follows:

Biool_0
0] PACHS Eno N En AMNY_TO_SIMT Eno

Bionl_1 "]
[ e L] G| Temp_BYTE Temp_BYTE I G SIMT WAL 1
Biool_2
[ T —— L
Bool_3
[ T —— L
Bool_4 oo
[ L
Bool_5
[ T — L]
Bool_&
B e INE
Bool _7
B | INT

Note: If the compiling fails, please click "Project" > "Settings" from the menu bar to check if the setting
of "Complex variables in a separate segment” in the "Runtime" is "Yes".

1
Oje P 1L

CWin-GRAFProjectsi Test
General Mame | Walue
L EE Runtime spstem Little endian

Compiler -
Debugging W Cycle time 1]
Advanced &F Code Generation Release
(Al % Exchange 10z while stepping ez

2 Sunnort eariables locking I

[ [il« Comples variables in a separate segment Y'es ]
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10.6 Pack/Unpack BYTE, WORD, DWORD

Pack Two 8-bit Data into One 16-bit Data

If want to pack 2 BYTE (or USINT) into one WORD (or UINT), you can use a "MAKEWORD" Function.

ST Program:

WORD_VAL_1 := MAKEWORD (Hi_byte, Lo_byte);

LD/FBD Program:

En MARENORD Eno En WMAKEAORD Eno
Hi_byte JHi alworRD val 1 |:> Hi_byte = 0|1 G WIORD WAL 1 =128
Lo_byte L Lo_byte =128 R

| MAKEWORD
Hi byte=128 I: ! @ WORD VAL 1= 32768
Lo ByieE=10 =

If want to pack 2 SINT into one INT, you must first use an ST program "ANY_TO_BYTE ()" to convert SINT
into BYTE, and then use an "ANY_TO_INT" Function to convert the packed WORD into INT type.

/\
En MAKBWORD Eno n ARy _TO_MT  E

O+

HI — @ Temp_woRD Temp_woRD {in T Al 1

BN _TO_BY TECSINT _Hi)

M _TO_BYTECSIMT_Lo)-{L

Unpack One 16-bit Data to Two 8-bit Data

If want to unpack one WORD (or UINT) to 2 Byte (or USINT), you can use "HIBYTE", "LOBYTE" Functions.

ST Program:

Hi_byte := HIBYTE (WORD_VAL_1);
Lo_byte := LOBYTE (WORD_VAL_1);
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LD/FBD Program:

En HEVIE  Emo En  HBYIE  Eno

WORD_WaL_1 i o af Hi_byte CWORD_vaL 1 = 32767 JrD e @
En LOBVTE  Emo En LOBYIE  Eno

WORD_VAL 1 i m afLo_pyte WORD_VAL_1 = 32767 JrD o @

HIBYTE
WORD WAL 1 i iy Hi byte

LOBYTE
WORD WAL 1 pid iy Lo byte

If want to unpack one INT to 2 SINT, you must first use an ST program "ANY_TO_WORD()" to convert INT
into WORD, and then use an "ANY_TO_SINT" Function to convert the unpacked BYTE into SINT type.

En HIE TE Eno En BNY_TO_SIMT  Eno
[annnnnsf O+
ANY_TOWORDIMT VAL 17 N ol Temp_BYTE Temp_BvTE al s _Hi
En LOBYTE Eno En BNY_TO_SIMT  Eno
oM O
ANY_TOWORDANT _vaL 131 ol Temp_EvTE Temp_BYTE N o] ST Lo

Pack Two 16-bit Data into One 32-bit Data

If want to pack 2 WORD (or UINT) into a DWORD (or UDINT), you can use a "MAKEDWORD" Functions.

ST Program:

DWORD_VAL_1 := MAKEDWORD (Hi_word, Lo_word);

LD/FBD Program:

En MAKECWMORD Eno

Hi_word JHI o} DWioRD_waL 1

Lo_weord JL

| W&k ECWIOR D
Hi word I: ! o DWORD Wal 1
Lo word =
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If want to pack 2 INT into 1 DINT, you must first use an ST program "ANY_TO_WORD()" to convert INT to
WORD, and then use an "ANY_TO_DINT" Function to convert the unpacked DWORD into DINT type.

En  MAKEDWORD Eno ER_ &MY _TO_DINT _Pno
O—i
ANY_TO_WORDHI_nt1 A - o Temp_mwoRD Temp_DwORD i @ DINT _waL 1

ARl _TOWORDLo_int)

L

Unpack One 32-bit Data to Two 16-bit Data

If want to unpack one DWORD (or UDINT) to 2 WORD (or UINT), you can use "HIWORD", "LOWORD"
Function Blocks.

ST Program:

Hi_word := HIWORD (DWORD_VAL_1);
Lo_word := LOWORD (DWORD_VAL_1);

LD/FBD Program:

En  HMYORD Eno

(AENRRNE|
DWORD_WaL 1 i @ Hi_word

En LOWORD Eno

[nRnnREn|
DDRD Wl 4w Gf-Lo_weord
HIWORD
CWORD WAL 1 i iy Hi word
LOWORD
DWORD WAL 1 vl Gy Lo word

If want to unpack one DINT to 2 INT, you must first use an ST program "ANY_TO_DWORD()" to convert
DINT to DWORD, and then use an "ANY_TO_INT" FB to convert the unpacked WORD into INT type.

En HWCRD Eno Er\___ ANT_TO_NT _Ano
oM O
AR _TO_DWORD(DINT _AL_1) h | Temp_woRD Temp_WoRD {in | Hi_int
En LOWWORD Eno En BEF_TO_INT Eno
annnnni} O—wis
AR _TO_DWWORDDIMT _aLl_13 @ Temp_WoRD Temp_WoRD Jin & Lo_int

Win-GRAF User Manual, V 1.07, Apr. 2018 by ICP DAS 10-10



10.7 Unpack Variable to Byte Array or Pack Byte Array into Variable

"SerializeOut" Function can unpack a Win-GRAF Variable value to a Byte Array (or USINT Array);
"Serializeln" Function can pack a Byte Array (or USINT Array) into a Win-GRAF Variable value.

Note: 1. The Dim. of Array must be set as at least "8".
2. This "Serialize" Function can not use the STRING variable.

You can open the "HTML Help" from the menu bar, and enter the searching key word to see the detail
setup instructions.

E? HTML Help

&% Topics.. E & ﬁ
Q, Search. ISER%E =k Lt-H T-5 EHEE €8
Tuprisls b | mBso [ 220 | smeso | |
% | About. SR AKIESAF S (1) '
Language... sefializeout = v‘ ja
T FREL) BTD)
EATERE (D) B c3tE): 3 Enh
B s IBFE |
Serializeliut IEC 61131-3 1
Advanced operations IECE1131-3 2
Serializeln IECE1131-3 3

If the SerializeOut() and Serializeln() return "0", it means the saving location is wrong or the Array’s
space is not enough.

Note:
(* Declare TMP_DINT as a DINT, Data Type Byte
buf as a BYTE Array, Dim. = 10, BOOL, SINT, USINT, BYTE 1
DINT_Val as a DINT, INT, UINT, WORD 2
Word_Val as a WOREr DINT, UDINT, DWORD, REAL 4
REAL_Val as a REAL *) LINT, LREAL 3

Example 1

(* To unpack one DINT_Val to 4 Bytes, and save them separately to the buf[2], buf[3], buf[4] and buf[5]
from the location 2 of the BYTE Array in the "Little Endian" sequence. *)

TMP_DINT := SerializeOut (buf, DINT_Val, 2, FALSE) ;

Note: The last parameter is "FALSE", that means to use the "Little Endian" sequence (To save the Low
Byte to the starting address).

Win-GRAF User Manual, V 1.07, Apr. 2018 by ICP DAS 10-11



Example 2

(* To unpack one Word_Val to 2 Bytes, and save them separately to the buf[0] and buf[1] from the
location 0 of the BYTE Array in the "Big Endian" sequence. *)

TMP_DINT := SerializeOut (buf, Word_Val, 0, TRUE) ;

Note: The last parameter is "TRUE", that means to use the "Big Endian" sequence (To save the High
Byte to the starting address).
Example 3

(* To pack the buf[0], buf[1] , buf[2] and buf[3] in the BYTE Array into one REAL_Val in the "Little
Endian" sequence. *)

TMP_DINT := Serializeln (buf, REAL_Val, O, FALSE) ;

Note: The last parameter is "FALSE", that means to use the "Little Endian" sequence (To save the Low
Byte to the starting address).

Example 4
(* To map one DINT_Val to one REAL_Val in the "Little Endian" sequence. *)

TMP_DINT :
TMP_DINT :

SerializeOut (buf, DINT _Val, O, FALSE) ;
Serializeln (buf, REAL_Val, O, FALSE) ;
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10.8 Get/Set the PAC Time

If you want to get the current time of a Win-GRAF PAC, you can use a "TIME_GET" Function Block.
(Refer the Section 2.2.1)

:w: |

Currert time of the...
Year |-PAC _Year

orth |-PAC_honth

PAC_Year, PAC_Month,

< PAC_Day, PAC_WeekDay,
PAC_Hour, PAC_Minute,

PAC_Second are declared as

Dy |-PAC_Day

ueDiay |FPAC WieekDay

Hawr |-PAC _Haour DINT

Minute |-PAC_Minute

Second|-FPAC_Second

If want to adjust the Win-GRAF PAC time, you can use "TIME_SET" Function Block. (Refer the Section

2.3.6) First, fill the new time to the variables of "new_Year", "new_Month", "new_Day",

n.n n.n

"new_WeekDay", "new_Hour", "new_Minute" and "new_Second", then set the "Set_new_time" to
"TRUE" one time.

Zet TRUE to zet new time
Set_new_time Inst_TIME_SET
Set  TIME_SET e |

niewy time for the Pac
new_Year | Year

Set_new_time is declared as BOOL

niesy _hornith | darth
new_Year, new_Month, new_Day, - .

new_WeekDay, new_Hour,
nesee_Day JDay

new_Minute, new_Second are
declared as DINT

nesy _Hour JHour

neyy _inute hinute

new _Second 4 Secaond

Set TRUE to =et newy time
Set_new_time
R |

Win-GRAF User Manual, V 1.07, Apr. 2018 by ICP DAS 10-13



Chapter 11 Commonly Used Tools and Useful Tips

11.1 Upgrade Win-GRAF Libraries

Users can download the latest version of Win-GRAF libraries (Win-GRAF Lib, e.g., "win-graf-lib-x.xx.zip")
from http://www.icpdas.com/root/product/solutions/softplc_based on pac/win-graf/download/win-graf-driver.html.

The Win-GRAF Libraries (Including Function, Function Block and I/O Board definitions) are saved in the
folder of “ICP DAS - XP-WP-VP” under the directory of “C:\Win-GRAF\DATA\HWDEF”. In some situations,
you need to upgrade the Win-GRAF Libraries to the new version for supporting more Functions or new

I/O Board. Please follow the steps below:

1. First, close all Win-GRAF Workbench windows. | BRO® WHE WRO BHREW > @
“ » »
W M A I | B
2. You can compress the original “ICP DAS - XP-WP-VP” e ' =
folder and back it up to the other directory (e.g., e = el e I/ ¥
D:\temp\xxx.zip), and then delete the folder. DNEP3 Embedded  Ethemet Files -
HMI Powerlink

3. Copy the new “ICP DAS - XP-WP-VP” folder into the @ /l /}
directory “C:\Win-GRAF\DATA\HWDEF”, and _
A K ICP DAS - ICP DAY - Maths Miscellaneous
execute the Win-GRAF Workbench again. XP-WEP-VP
Note: : ' — .J

Delete the folder after back up. QBF

If you want to know the version number of the

Win-GRAF library. As the figure below, open the ) g ]
"Library Manager" and click "A_Version" in the "I/Os" J /I /l /l
tab, and then click "Description" to see the version Ropers:  Repotgrs  Selectors  Dwnderd: B8

number (e.g., "1.01").

@ Win-GRAF | & Libraries

>| m OEM

rj Google Chrome 4 E’Q Handbook
REEAD) b ™) ICPDAS » | £l History
(%) Outlook Express () Manual
. — ‘ @ Mozilla Firefox £ Re‘adMe Library Manage
paas shd| O Opern 18 Wi Win-GRAF

IS Tool:  Wizard

Save Library !

|ICP DAS - XP-WP-VP Lo K
Counters -~

lera.ry Manager - ICP DAS —ET-WP-YFP

— : . LN DNP3 B
O] E Embedded HMI
=DIP_: S‘I"ltl:]'l (* 3-ChIn from the Dlp zwitch of PAC %) =z 5 Ethermet Powerlink,
I NN AT A T b 21 S0e. T NN ITTIAT T Qe ITTr DA I IAT e = Files
Parameters { Diescription E SEE
The wersion numbe f the Libhray "ICP DAS - XP-WP-¥P™ is| 1.01 . A

The PAC 's Win-GRAF driwer can not recognize it.
DO HOT connect this "4 Version™ in the Win-GRAF project.

Thiz "& Wersion™ is only for identification . Reset Changes

Jul. 25,2014 -
ICPF DAS , Taiwan

| £
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11.2 Upgrade Win-GRAF Driver

For updating add-on functions, I/O boards or other purposes, ICP DAS will release a new version of

Win-GRAF drivers in the future. Users can get the latest driver on the website (http://www.icpdas.com/

root/product/solutions/softplc_based on_pac/win-graf/download/win-graf-driver.html), and follow the steps

below to upgrade the new driver into the PAC.

Note: The Win-GRAF Driver of the XPAC (XP-8xx8-CE6), WinPAC (WP-8xx8, WP-8xx8-CE7, WP-5xx8-CE7)

and ViewPAC (VP-x2x8-CE7) will be placed in the directory "\System_Disk\Win-GRAF\" inside the PAC.

1. On the desktop of a PAC (use WP-8xx8 in this example), double click on the "Win-GRAF_WP_8000"

icon and then click "End Driver" to stop the currently running driver.

S

S

Internet
Explorer

wiordPad

Win-GRAF-WP-8000 @]

WR-xxE driver Wersion 1.01 , Jun.06,2014

This product is icensed.

#7|[V Virtual CE

(/BB £¥ o804 02 B

2. Onthe PC, copy the new driver into the PAC's directory “\Temp\” by using FTP method.
3. Onthe PAC, copy the new driver from “\Temp\” into “\the System_Disk\Win-GRAF\” directory to
replace the old one, and then reboot the PAC.

LD

'Systern_Diskwein-graf

License bin
e in_GRAF _WP_B000.exe
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11.3 Spy List

When a program is running, the Spy List lets users quickly know the variable’s value or status.
Sometimes, a program may declare hundreds or thousands of variables, users do not need to look for
them, just simply switch to the pre-created Spy List window to see the wanted information.

Steps:
1. Right-click on the project name (e.g., "Demo01") and select "Insert New Item".

2. Select "Spy List" of the "Watch", then click "Next" to the next step.
3. Then, key in a list name (e.g., "NewSpy1") and press "OK".

Workspace

Communication Parameters...

] A OnLine
| u " Silste
B
{ ﬁ Monitor {78 Insert New Item
: iFE |‘ i
£ :__j I L4 mssrkhew Fakier Categories: Available Ttems:
3 F b | Insext New Program... (Al Py
i , @43 Graphics
! . Resources
300 | i Embedded HMI % Soft Scope
R Insert New Item...\ Shortcuts
e | Others

a AN

I‘ Mext ! ! I Cancel I

( ENewSpyl 2 ° |
[ 1
| |
L |

I OK%[ Cancel ]

Name

Description
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4. Double click "NewSpy1" on the left side to open the setting window and drag the variables you want
to put into the window.

Workspace | ewspytspte . EEX
=) Demo01 [ | Name | Value | Description |7 _Name | Type | Dim. | &
[ Exception programs g PAC_Year Current time of the PAC o {a} Global variables A
- Programs ~ ' PAC_Month PAC Year DINT
- % PAC_Time (Get/SetP.. | B¢  PAC Day PAC_Month DINT
7€) LD [*Blinking®) PAC_WeekDay WK PAC Day DINT =
T‘ - Watch (for debugaing) PAC_Hour ~ PAC WeekDay  DINT
j 48 Soft Scope PAC_Minute Se PACSHour DINT
i (g NewStucture PAC_Second S~ PAC Minute DINT
o B3 Initial values = INT_Val T ~=——=-="] PAC Second  DINT
- . [ REAL_Val INT_%al INT [0.2]
B NewSpyl w - |_REAL val REAL [0.3]|v
%¢ Binding Configuration AN Sl : M1 | =T -
i 3 Global defines [ %] 01| Pac Tme | Variables | NewSpy1”
5. When the Win-GRAF and the PAC are connected, the "NewSpy1" window will show the variables
information clearly.
File Edit View Insert Project Tools Window Help
Eld 3 G 6 EE X ol g o AU NS GRSl 5 GiAIRUN PgE e n e @
— X
= [ Demo01 [RUN] | Fl Name | Value Description ] W Name | Value | Type | Dim. | Attrib.
T | Exception programs B i PAC_Year 2014 Current time of the PAC = (o} Global variables ]
[ Programs — PAC_Month 6 PAC_Year 2014  DINT
. LB PAC_Time ['Get/SetP.. || B¢| PaC_Day 13 PAC_Month 6 DINT
“5] LD1 (*Blinking?) PAC WeekDay & PAC_Day 13 DINT
(1--[d Watch [for debugging) PAC_Hour 5 PAC WeekDay & DINT
L% SoftScope PAC_Minute 13 PAC_Hour 5 DINT
78] NewStructure PAC_Second 0 PAC_Minute 13 DINT
Fo 2] Initial values ] INT_Val PAC_Second 0 DINT L |
i 28 NewRecipel | INT_Val[0] 55 INT_Wal INT [0..2]
o Eewspt | INT_vall] 36 REAL Val REAL  [0.3]
; %3 Binding Configuration [ INT_Val[2] 100 new_Year 0 DINT
-39 Global defines ] REAL_Val new_haonth 0 DINT
Y Variables REAL Valll] 58 new _Day 0 DINT
BB Types REAL Val[l] 96 new_Hour 0 DINT
REAL_Val[2) 3.2 new_Minute 0 DINT 5
REAL_Val[3] 25 <““‘"‘ °""‘""“= 2 SARE. 5
[€ %] b1 PAC Time | Varisbles | MewsSpyl
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11.4 Backup/Restore a Win-GRAF Project

Back up A Win-GRAF Project:
1. Mouse right-click on the project name (e.g., "Demo01") and select "Save Project" and then "To Disk".

Workspace
Demo01

p Project

8- 1.] F‘rogre Commaﬁon el Insert New Item... ‘
:g Al online | Save Project | |@, obik. %
D B3 Watel M Simulate %l Duplicate Project... ) ToZip.
. I (= Print Project... @ To Zip and Mail...
E] lNew'S U3 InsertNew Folder (D Project Description... To Target...

)E,j Remove Project

2. Click on the "Browser" button to assign a directory you want to save the project (e.g.,
D:\Win-GRAF_demo_backup), fill in the project name (e.g., "Demo01_0613"), and then click "OK" to
back up the project.

Save as
Current Project
C:AWin-GRAFProjectshDemoll

Save as: | Project

Destination: D:AWin-GRAF_demo_backup

Project Name: \DemoD1_0613 » °

Restore A Win-GRAF Project:
1. Copy the previously backed up the project folder (e.g., "Demo01_0613") into
"C:\Win-GRAF\Projects".

- 4B4E DY |9 DAWin-GRAF_demo_backup v

Deynolll 0613

4 D] |2 CAWin-GRAFProjects v

| /l Demo01 =
|

................................... N

Demol] 0613

Retersessnansueneses W vaneannpel

[
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2. Click the menu bar "File" > "Close Project List" to close all opened project windows.

fl Win-GRAF - Demo01

‘Eﬂn:-. dit View Insert Project Tool: Windowe Help
7 Hew Project List...

Cpen Project List k
Zave Project List k
‘57 Closs ProjestList W
N

3. Click the menu bar "File" > "Add Existing Project" > "From Disk", select the project you want (e.g.,
"Demo01_0613") in the "C:\Win-GRAF\" directory, and then click "OK" to restore the project.

[ Win-GRAF

‘ File ieL .lools Window I-_Ielp

ﬂ New Project List... | ’51 {1 2 % WNE
Open Project List 4 [
Select project
o Add New Project...
| i BuiagFopet | @ EonDiky T 5
Print Setup... @) FromZip... l&”l 8 emo =
=R} emol] 06132
1 CAWin-GRAFProjectDemn01 w5l From:Target: ) Default
2 C:AWin-GRAFProjects Test w51 || Prom XbL K - g e
‘ - : ]
& () other
E D) Test
== Tast N1 _v_
5 I
(Euwarme | [ m= W [ B
N\ i

[ Win-GRAF - Demo01_0613

File Edit View Inwert Project Tools Window Help
Gy 4k X i o i ERE ARG 5 RA

il Ho selection!

WCEpNon programs
@ [ Programs

- [ LD1 (Blinking?)
o 3] PAC_Time [‘Get...| W08 X
&[4 Watch (for debuggi... | [ 3
&R Soft Scope

- |r8) NewStucture

o B4 Initial values

< &d NewSpyl

B4 Binding Configuration
- 3q Global defines
{3} Variables

LB Types

[ Build,::'jZ};f:s—teferences A Ru—r:t{@g__,! Callstack | Breakpoints | Digital s3

IReady OffLine 192.168.71.19:502
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11.5 Software Reboot a PAC

Based on some cases, users may want to reboot the PAC in a software way. The Win-GRAF provides a
Function "PAC_Reboot" for users to restart the PAC.

Note: Please DO NOT call this Function in every PAC Cycle, or the PAC will reboot all the time.

Safety Coding:

(* "reset_PAC" is declared as BOOL and has initial "FALSE"
"TMP_BOOL" is declared as BOOL *)
(* ONLY when "reset_PAC" is set to "TRUE", the PAC will reboot *)

if reset_ PAC then
reset PAC o]

reset_PAC := FALSE ; PAC REBOCT I
TMP_BOOL := PAC_Reboot(); reset_PAC
end_if ; R |

Dangerous Coding:

(* "TMP_BOOL" is declared as BOOL *)
(* Dangerous ! This coding method will let the PAC reboot always and cannot stop. *)
TMP_BOOL := PAC_Reboot();

If a mistake to reboot the PAC always, turns the rotary switch of the Win-GRAF PAC to "1" and reset it.
Then it will boot up in safe mode. Then you may rename the Win-GRAF application code on the PAC to
an invalid name. Then when the rotary switch is turned back to "0" and reboot, it will boot up normally
(No application). The Win-GRAF application code in the XP-8xx8-CE6, WP-8xx8, WP-8xx8-CE7,
WP-5xx8-CE7, and VP-x2x8-CE7 is "\System_Disk\Win-GRAF\t5.cod".
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11.6 Using ST Syntax in LD and FBD

The Win-GRAF Workbench allows users using simple ST syntax in Ladder (LD) and Function Block
Diagram (FBD) to facilitate programming. Before use, go to the menu bar "Project"> "Settings" >
"Runtime", and set the "Complex variables in a separate segment" to "Yes" to enable this function.

™ Win GRAF - Test

File Edit ¥iew [nsert B&mEa® Tool: Wmdow Help

S H== S : Euild 41l Projects F?
Workspace Clean A1 Projects
J Test += Download Al Projects ..

[ Exception prg :
" Proorams = \
et sething

CWin-GRAFProjects) Test
General M ame | Walue
L EE Runtime system Little endian
Cormpiler :
Debugging W Cycle time I
Advanced @ Code Generation Release
(Al % Exchange |0z while stepping ez
2 Support varables locking Mo
[ [il. Complex variables in a separate segment Y'es ]

Example:
LD Program:
Using division (REAL_VAL/25.5).
Boal_1
En = [o] I
( REAL_V.&.L.ES.S_@
759 Mz

FBD Program:
Call a function "ANY_TO_BYTE()" to convert the type from "SINT" to "BYTE".

mMAKEWORD
ANY_TO_EIY‘FE{SINLHi} +4-RHI Cr— WORD WAL 1
Lo bwyte L
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11.7 Apply a Recipe on the PAC

Some applications use the pre-defined Recipe and Value for processing different products, and this
Recipe can be mapped to a combination of variables within a Win-GRAF PAC. When one day want to
change the PAC process to produce a different product, you can use the Win-GRAF Workbench to
connect with the PAC and select a new Recipe you want to replace, and then apply it to the PAC.

Steps:
1. Mouse right-click on the project name (e.g., "Test") and select "Insert New Item"; then click on

"Watch" > "Recipe" and "Next" button, fill in the Recipe name (e.g., "NewRecipel") and then click
IIOKII.

Workspace

m Insert New Item

1 Communication Paramet Categories: Available Items:
75 A OnlLine (Al L
: - : Programs =7 cipe
e stk e
PR B Resources B
er-GEy | Monitor Embedded HMI &Y soft Scope
{ o Shartcuts
{ 4 3 [nsert New Folder Others
;g :; (3 Insert New Program...
", w  Insert HMI Device...
-3g G
0 v Shorteuts

BT heienlen

Properties @
( ENewRecipel 2 ° |
1

MName

Description

[ Next%[ Cancel J

[ okw ][ Cancel ]
N\

2. Double click "NewRecipel" on the left side to open the setting window and drag the variables you
want to put into the window.

Worspaee [ RETESI 7 X
= .J Test 53 Name | Value ¥ Name | Type | Dim. | At
(- Exception programs Eﬁ Water ‘ o) {2} Global variahles ~
[ Programs Soft_Flour YWater DINT
2 FEDT =2 Strong. Flow Soft_Flour  DINT 3
] Main E saadol W Strang_Flour  DINT
i |s1] ST1 (*Data Conversi... B Cream S Salad_oil DINT
£l Watch [for debugging) ¥ Eag MPCream DINT
: &8 Soft Scope Cook_time A Egg DINT
Lo 28 Initial values \E-d  Plain_Flour TN _—e =" Cook_time TIME
: ‘ﬁ | Lemon_Juice Plain_Flour ~ DINT
6 NewSpyl | Suger Lemon_Juice DINT
%3 Binding Configuration B¢ Suger DINT v
- g Global defines < - 5

: T3 Variables

[4 5] Vaiables. | NewRecipe1,”
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3. Click on the "Insert Column" icon to add the new Recipe, and then fill in the suitable Values.

HewRecipel.orep *

3| Mame | Value Caramel Pudding | Lemon Pudding Pie D ﬁ? Mame | Type
-  Water 125 o E fa} Global variables A
= Soft_Flour 50 50 Water DINT
E Strang_Flour 50 50 Soft_Flour DINT il
B2 Salad_oil 35 0 Strong_Flour  DINT
3 B Cream 40 40 Salad_oil DINT
' ¥ Eag 180 180 Cream DINT
? Cook_time TH30M TH25M Egy DINT
B4 Plain_Flour 0 0 Cook_time  TIME
E Lemon_Juice 0 5 Plain_Flour — DINT
|== Suger 100 25 Lemon_Juice DINT
g sat 2 1 Suger DINT
Salt DINT v

l-( >l \/aTabEsi NewRecipel, d

4. Click on the "On Line" button to connect the PAC. At first the Values are all "0", please select the
product column and then click the icon "Send Recipe" to apply this Recipe into the PAC.

AN W SN A THEET Oy

Workspace
- [ Test [RUN] . | Value
- [ Exception programs :ﬁ Water 125 | © {3} Global variables ~
s [ Programs = Soft_Flour 50 Water 0 :
. @ FBD1 EEE Strong, Flour Soft_Flour O
i 2] Main ‘ Salad_oil Strong_Flour 0
: s1] 5T1 (*Data Conversi... g Cream Salad_oil 0
) [ Watch (for debugging) g Eagg 180 Cream 0
¢ 8 SoftScope | Cook_time THAO0M Egg 0
24 Initial values = Plain_Flour ] Cook_time t#s
=4 NewRecipel Lemon_Juice 0 Plain_Flour 0
i 6d NewSpyl Oyger 0 RIS 25 Lemon_Juice O =
Bj3 Binding Configuration . B+ e e S ’ <"‘ il = B
b ig Global defines .{:( > | arisbles | NewRecipe1 ” -
OO00 HewRecipel.recp
g3 Mame | Walue | Caramel Pudding | Lemon Pudding Fie
é A ater 125 125 125
- Soft_Flour a0 50 a0 Note: If want to save the Values on
o,  -tong Flourf 50 50 sl the PAC (e.g. Power off and restart
= = alad_oil £ iE L the PAC, the Recipe can still retain
o Lream 40 0 40 the previous Values), please refer
¥ Eag _ 180 180 180 the method of using the retain
Coaok_tirme H30m TH30k TH25M ) . .
= Plain Flour 0 0 a variables in the Section 6.1.
=] Lemon_Juicel 0 1] 5
S Suger 100 100 25
B sak 2 . 1
\_ J

|{ }l \-"ariahIEE,l Hew Recipel
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11.8 Get the Functions and Function Blocks that Supported by the PAC

In the Win-GRAF Workbench window, user can expand the "All" directory in the "Blocks" panel to see
quite a lot of Functions and Function Blocks, however, some are not supported in the Win-GRAF PAC.
The following will show how to quickly get the Functions or Function Blocks that supported by the PAC.

{7 Win-GRAF - DemoO1 EEX

File Edit ¥iew Insert Project Tools Window Help
BB g iilsWme 4B & %A
. (&
Project 2 —4TBoolean AND?)
Name R1: Get current time HEn  TIME_GET  Eno 1% % (Multiply)
58] PAC_] | +{ + (*Addition*
-5 PACI — Expand ( )
7€) LD1 [*Blinking®) = Current time of the PAC n n t{ - (*Subtraction®)
- : LPAC_Vear All 0 SRt
]+ Watch (for debugging) 5l % 7 (*Divide¥)
i @8 Soft Scope 2 i 3£ 1 (*copy (1 gain)*
R p Directory (*copy (1 gain)?)
re] NewStucture 4 %4 < [*Less than™
=) L PAC_Morth ( )
=4 Initial values I — t{ <=["Less or equal®
( qual)
=4 NewRecipel %% <> [*Is not equal*)
6 NewSpyl =i | PAC Day 1% =(*Is equal?)
.- %% Binding Configuration > £{ > (*Greater than™
g a Config ( )
g Global defines ReS PAC. WeekDay t{ >=(*Greater or equal®)
Wariables | - %% >> [LIK] [*Put array item ...
&t [LIKI( y
B Types e 2% >> [1LJ] (*Put array item (2 ...
= | -PAC_Hour %4 >> [I] (*Put array item (1 d...
—oi “ ) 2 [LJ.K]>> (*Get array item ...
= Blocks
= pAC Mindts 2% [1.J1>> (*Get array item (2...
¥ a Panel £ [1]>> [(*Get array item (1 d...
1} ABS (*Absolute value®)
| | PAC_Second "‘v' [} ABSL [*Absolute value [LREALJY)
s idpersss B i — |
&) 3 |
(€2 1] PAC Time” :
Build X
|4 »| Build, Crossreferences | Runtime | Callstack | Breakpoints | Diqital samplinatrace | Prompt | HRI
|Ready OffLine 192.168.71,19:502 Z 0,0 233x 18 0,0 165% 4%

Setting Steps:

1. Make sure the PAC is powered on and connected with a PC via an Ethernet cable.
2. In the Win-GRAF Workbench, right-click on the project name (e.g., "Demo01") and then select
"Configuration", and click on the "Upload" button in the "Select" tab to open the setting window.

Configurations

Workspace 'PAC_Time
= 5 i i

<F Select | Descrintion | Data tyves | Standard | OEM |

“ Right-click z Configurations
=14 Progn pUAMELELS.. T (oot

5 F Al OnLine
B L e Simulae
f:i'f" - Watc| L B

s DR Click "Upload"
K_Ij Eemove Project

wilj Lock Project

@5 Euild Froject
Clean Project [ ®m%= || Ew || A |
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3. Configure/Select the IP address of the PAC and click on "OK" button, the PAC will upload the
configuration file. Next, key in the file name (e.g., "test.cfg") and click "Save" to save the

configuration file.

Communication Settings

Upload the configuration

f_T 5 Runtime

Configunrations

i192.153.?1.19:502 \ E]

192.168.255.1:502
192.168.71.18:502 | Help |

Setup the IP addr. of the PAC ‘

Iploading runtime configuration...

Please wait.

Sy ?X

EETFIS @ | () CONFIG w v &2 = E
> N\
L,.b Save file under C:\Win-GRAF\DATA\CONFIG
FERARIS
G
RE
B
Y Give the file name & save it.
FAVERS
i { SN 1
‘g 84 Q): Gs’t.cfg ) v [ ﬁaﬁ@m
o — ) : N
WS LASH BRI | Configumtion files (*ofg) v A |}

4. Back to the "Configurations" window, the configuration file (test) will show in the list, and then click

"OK" to leave this window.

Select | Deseription | Data types || Standard | OEM |

Configurations

T<Default \ [ |
W‘ Import

Remove

S 2T
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5.

{78 Win-GRAF - Demo01

File Edit View Insrt Project Tools Window Help

In the "Blocks" panel, the red Functions and Function Blocks are not supported by this PAC.

EEX

AN~ B = TN R o % HsEWEe A B @Al
Workspace ll PAC Time X
= Demo01 o I Al T+ DTHOUR (Get hours from time stamp*] A
Bl [ Exception programs 5 _J; T} DTMIN [*Get minutes from time stamp®)
-3 Programs R1: Get current time }En TIME_GET  Eno T} DTMONTH [*Get month from date sta...
L 56] PAC_Time (*Get / Set.. i 1} DTMS [*Get miliseconds from time sta...
“38] LD1 [*Blinking®) = Currert time of the PAC 1} DTSEC [*Get seconds from time stamp...
=~ Watch (for debugging) S E Year| PAC_Year T} DTYEAR [*Get year from date stamp®]
&8 Soft Scope e 11 EEP_READ [*Read a value from the ...
7€) NewStructure 1% Morth|-PAC_Month I+ EEP_WRITE [*whrite a value to the E...
=4 Initial values = |
=5 NewRecipel =) EPLNMT [*Send NMT command®) I
6 NewSpyl =i Day[-PAC_Dal EPLREADARRAY (*Read an aray pa...
%j3 Binding Configuration > Red means PAC EPLREADOBJECT [*Read a simple pa...
g Global defines - whay| PAC_We doeS not su pport EPLREADULINT [*Read a simple 64 b...
£a} Varables 3 EPLWRITEARRBAY [“write an array pa..
B Types HIGg EPLWRITEDBJECT (*write a simple ...
= Hour|-PAC_Hour \_EE EPLWRITEULINT [“wiite a simple 64..,
ﬁ, 1} EXP (*Natural exponent®)
b MindtePAC. Minute T} EXPL [*Natural exponent (LREALJ)
B ” - T} EXPT (*Exponent¥)
Blocks” Panel £} F_ADPEN ("Open fil in append mode”)
) | Second}-PAC_Sec F_CLOSE [*Close file*) 7
4565 | T , 2R ) =i
(€3] Lot] PAC Time - -
| ] Build ' Crossreferences | Runtime | Callstack | Breskpoinis | Diditalsamplinatrace | Prompt | HMI~
JReady test OffLine 192.168.71.19:502 Z 0, -4302 263 x 18 0,0 165%  4&
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11.9 Upload the Win-GRAF Source Code

For some applications, users need to get the source code of the Win-GRAF project from the PAC to the
PC, this is called "Upload". This function can prevent the project source code from missing or incomplete
handover from the previous worker, you can still get the project source code inside the PAC.

Enable/Download The Project Source Code:

1. Click on the menu bar "Project" > "Settings" to open the setting window.

2. Double click on the "Download procedure" of the "Debugging" and select "Send source code for
later project upload", and then click "OK ".

T Win-GRAF - Test

File Edit View Insit BEEiies Tools Window Help

A" B=AR= R Emild 411 Projects 7
Workspace Clean A1 Frojects
S Test ¥ Download All Projects...

----- [ Exception pro -

i Bettings. .

[ Proarams

S =

CWin-GRAF ProjectsiTest

| General | Mame | Yalue |
8 Communication parameters 192.168.71.19:502

| Runitime

l Advanced

(Al

=] Always start simulator in 'cold start’ mode
¥ Cycle time in microseconds during debug
(=] Prompt beforef) faerant bt |

[=] Prompt before,

(=] Prompt beforel  [tems to be downloaded:
[=] Propose to sta

B Loo e 2t <&pplication codes
E’] Show log file..
- Double dicktocond | Note: When the "Upload" is enabled, Add...

download, it means to store the source code on

the PAC. If someone gets this PAC, he
may have the opportunity to get your Move U
source code.

l [VliSend source code for later project upload ]

3. Click on the menu bar "Project" > "Build All Projects" to compile the program, and then click on the

tool icon Al to connect the PAC, and next, download the current project to the PAC. (Refer the
Section 2.3.5 for the detail steps). After downloading, the source code will be stored in the file of the
directory "\Systen_Disk\Win-GRAF\t5.upl" of the PAC. This file will be larger when the project
increases. If the project becomes very large and complex, the file size may reach several hundreds K
Bytes or even more than 1 MB.
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Upload the Porject Source Code:
Please close all opened Win-GRAF windows (Click on the menu bar "File" > "Close Project List").
4. Click on the menu bar "File" > "Add Existing Project" > "From Target", then select the PAC's IP

address and set up the upload file name (e.g., "UPL_project1"), and then click "OK" to upload the
file.

View Tools Window Help
] New ProjectList..

e

SRMESE T R R

Open Project List 4

5| Add New Project..

Add Existing Project | | & FromDisk.
Print Setup.. | B FomZip..

1 CAWin-GRAFProjectsTest wS] | Foom Target..
2 CAWin-

ET'E Open project from target

Select PAC IP

Settings
| T5 Runtime v |[192.168.71.19:502 4{:]
Pathnames

Destination folder : 'C:\Win-GHAF\Pmiects v I Browse... I
e, UPL_proetl ) | get up the upload file name ‘
5. After uploading, click on "OK" button, and then the Win-GRAF will open the project automatically.

Open project from target

From: 192.168.71.19:502/5.upl
To: C:ADOCUME ~1% anicetLOCALS ~15TempZIP103.tmp

[#_-iﬂ‘iﬂiﬂ.iﬂiﬁﬁiﬂ.iﬂiﬂtiﬂﬂH.iﬂtn.iﬂ.hﬂiﬂhiﬂl

100%

Win-GRAF - UPL_projectl

File Edit ¥View Inwsrt Project Tools Window Help
iy Gl i =l g o T2 00 6 MY e S o8 N B

Worksnac= No selec’tion!:‘ | 11 X

Qe I UPL_projectl
g splierrpTograms

B [ Programs
- @ FeD1

3¢] Main

i s7] ST1 [*Data Conversi...
- 1 Watch [for debugging)
Lo EH Initial values
= =4 NewRecipel

B} Binding Configuration e X
-+ 3g Global defines
. fa} Variables
[ o Iy Types [_t[]_l_?‘ullg & Cross referenc.e‘s_k,j Runtime __1_Call staplf‘li Breskpoints l Diqitat 53
IReady my'1 OffLine 192.168,71.19:502
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11.10 Set Up the PAC Password

In order to avoid the important program running on the PAC is changed or stopped by an unfriendly
connecting PC, you can set up a password for the PAC to prevent unauthorized operation.

1. Click on the menu bar "Project" > "Settings" to open the setting window.
2. Double click on the "Runtime password" of the "Compiler", set a password, and then click "OK".

Y Win-GRAF - Test

File Edit ¥iew Insrt BEEES Tools Window Help

S H=H &S L Euild ALl Projects F?
Workspace Clean 11 Frojects

S0 Test *=  Download Al Projects...

Sethngs...

-3 Programs

C:\Win-GRAF\Projectsi Test

‘General Name | Walue |
< i £ r 24 Check array bounds at runtime Yes »
Ca i B Allocate status flags for variables with embedded p... No
Advanced 2 Embed symbols of all variables No
(Al ' Keep case of embedded symbols No
B Check multiple calls to FB instances No
&' Check duplicated profiles No
2 Enable forcing of initial values during debug No
G Update extern POUs before build No
_ 3 Use global definition of extermn POUs No
bR Funtime password
"C" C post compiling

Password

el

Cancel

[ | Cancel

s password:
Set a password ‘

3. Click on the menu bar "Project" > "Build All Projects" to compile the program again, and then

download the current project to the PAC (Refer the Section 2.3.5 for detail steps.). When the next
time to click the "On Line" icon for connection, it will require the password.

% G = 5e 5 6IA

Password:

If click "On Line", it need the password.
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Note: After enabling the password, please remember your password, or you will not connect the PAC.

The Only Solution:

1. Connect the PAC with a USB mouse and screen.
2. On the PAC, execute the Win-GRAF Driver and then click on "End Driver" button.
(Refer the Section 11.2).

Win-GRAF-WP-8000

WP-BxxB8 driver Wersion 1,01, Jun.06,2014

This product is icensed.

3. Rename the file "t5.cod" in the directory "\System_Disk\win-graf" (e.g., "t5.cod1") or delete it. Then
reboot the PAC.

#FBUE(D \Systern_Disk win-graf
License.bin %] Quicker.dl t5.cod
e in_GRAF WP _B000, exe Wiﬂ_GR.&F_WF‘_BDDD."‘Ik

Then, it will become "No application" on the PAC. Now, you can connect and download the
application from the Win-GRAF Workbench again.

% € & E 5 (5 K osriaion D)
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11.11 Using Function Block in the ST Program

It is easy to use the Function in the ST program, just call the Function and assign the corresponding
parameters. The example below will open COM3 at the beginning, and then send a String "Hello’ from

COM3 every 5 seconds.

(* Declare “INIT1” as BOOL and has initial value TRUE,
Declare “TMP_BOQ” as BOOL, “TMR1” as TIME *)

IF INIT1 THEN

INIT1 := FALSE;
TMR1 := TH#Os;
TSTART (TMR1);

END_IF;

IF COM_Status(3) = FALSE THEN
TMP_BOO := COM_open (3, '19200,N,8,1’) ;

END_IF;

IF TMR1 >= TH#5s THEN
TMR1 := THOs ;
COM_send_str (3, "Hello:’) ;

END_IF;

To use a Function Block in the ST, you must first declare an Instance Variable of the Function Block in the
variable region, after that, the using steps are similar to the steps of using the Function, as follows:

The following code can unpack one Byte to become 8 BOOLs:
1. Declare "MyUnpack" variable as "UNPACK8" (FB Instance) and "IN" variable as "BYTE".

Variables | HE /1.4
7 Name . | Type | Dim. | Attrib. | Syb. | Initvalue | U.. 5 | Tag | Description
SBAlGiobal variables ... [
IN BYTE O =
MyUnpack UNPACKS
< ‘ | 2

2. Edit an ST program.

MyUnpack(IN) ;

Q0 := MyUnpack.QO ;
Ql := MyUnpack.Q1;
Q2 := MyUnpack.Q2 ;
Q3 := MyUnpack.Q3;
Q4 := MyUnpack.Q4 ;
Q5 := MyUnpack.Q5 ;
Q6 := MyUnpack.Q6 ;
Q7 := MyUnpack.Q7;
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11.12 How to Protect Your Win-GRAF Program to Avoid Unauthorized
Copied?

When you finish a Win-GRAF application development and prepare for delivery to the customer, please
think about the possibility that your Win-GRAF application on the PAC may will be copied into another
same model PAC?! Be careful! Someone else may steal your hard outcome! The following provides a
simple and easy way to protect your application.

Note: If you give the Win-GRAF application Source Code to the customer, then sorry, the following
method will not protect your program from stolen. Because having the Source Code, anyone can
modify the code and apply into another PAC.

Each ICP DAS Win-GRAF PAC has a Serial Number that has 8 Bytes (also known as 64-Bit), and each PAC
has the different and unique Serial Number. Therefore, you can use this serial number combine with
your own algorithm to generate a password, and pre-store this password on the PAC's file. Then, verify
this password in your application. If not passed, the application will not be allowed to execute.

The steps are as follows:

This example uses two Win-GRAF projects, one is "demo_passwd" used to generate a PAC password and
save it into the PAC's file; the other is "demo_my_ap" application that has been developed and ready to
ship to the customer. Before shipping a PAC to the customer, user needs to download the project
"demo_passwd" into the PAC and runs it once to generate a unique password for that PAC. Then,
downloads the project "demo_my_ap" into the same PAC, and then can ship the PAC to the customer.
After that, if someone copies the Win-GRAF application in this PAC to another same type of PAC and the
operation will fail because of the password validation failure.

There are two example projects (demo_passwd.zip and demo_my_ap.zip) in the shipment CD
(\Napdos\Win-GRAF\demo-project), please refer the Chapter 12 to restore the projects (Execute File >
Add Existing Project > From Zip) and set up the IP address of the current PAC.

Win-GRAF - demo_passwd Q@@
File Edit View Inert Project Tools Window Help
=N 2y o #HOMHEWE AR FBA
Workspace
7 J) demo_passwd P INIT is declareds as BOOL and has initial wvalue TRUE. * A T‘?M_I—UDA
|1 Exception programs . ( L] Main A
- , i [f Dx;;;?tlozs in the first PAC cycle *) B ﬁGlobal variables
5% Fisi THEN i then INIT BOOL
-1l Watch (for dStveging] || 72 INIT := FALSE ; (* No more first cycle *) NO_O DINT
@4 SoftScope o) NO_1 DINT
= Initial values = {(* get the hardware serial nwber *) NO_2 DINT j
i "Bd NewSpyl {bEE PAC_SN{ No 0, No_1, No_2, No_3, No_4, No_5, No_6, No_7) o= =k
s Q!é Binding Configuration .
)Gg Global defines e (* Please use your own algorithrm to generate a password & Varlables Area
$ ﬁ Variables This exawmple generate only one password. You may chaw|| g
B Types A ) - ) > {4 ¥ Blocks  Soulist | Define | E
(£ 5| Main,” Newspyi | Varisbles
Build X
| % ) Build - Crossreferences | Runtj A_ all stack | Breakpa Digital sampling trace Frompt Hbdl
Ready \Oggwe 192,168.71,19:50 £ Lni,Chi 0x1 Lni,Chi 10(
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"demo_passwd" Project:

This program first uses "PAC_SN" Function to read out the Serial Number, and then uses a user-defined
algorithm to generate a password. Finally, save the password to an address within the PAC's file (user
can decide where you want to store).

Variable Declaration:

R  varianies e e v X|
- demo_passwd T Mame | Type | Dim. | Attib. | Syb. | Initvalue | User.. | Tag | Description
&1+ Exception programs ERAlGobal variables ... &
-3 Programs INIT BOOL [J TRUE init as TRUE
Pk &) Main NO_0 DINT J 8-byte hardware serial number
£+ [ Watch (for debugging) NO_1 DINT O
8 Soft Scope NO_2 DINT O
o 28 Initial values NO_3 DINT J
“Bd NewSpyl NO_4 DINT O 4
: NO_5 DINT O
NO B DINT O
NO 7 DINT O
password DINT O v
< I | >

[ €3] Main] Newspyi | Varisbles,

ST Program:

(* This "demo_passwd" example will generate a password by the 8-Byte Serial Number of the PAC
and save it into the EEPROM of the PAC *)

(* Declare "No_0" ~ "No_7" and "password" variables as DINT.
Declare "INIT" variable as BOOL and has Initial value TRUE. *)

(* Operations in the first PAC Cycle *)
if INIT then
INIT := FALSE ; (* No more first cycle *)

(* Get the hardware serial number *)
PAC_SN(No_0,No_1,No_2,No_3,No_4,No_5,No _6,No_7);

(* Please use your own algorithm to generate a password. This example generate only one
password. You may change it to generate some passwords. *)
password := (No_0 * No_1) + (No_2 * 12345) + No_3 + (No_4 * No_5)+No_6+No_7;

(* save the password in a file "my_product.pwd" in the \System_Disk\Win-GRAF *)
file_name := "\System_Disk\Win-GRAF\my_product.pwd';
file_id := f_wopen( file_name ) ;
if file_id =0 then
(* failed , do nothing *)
else
(* open file ok, save the password into it *)
fm_write( file_id , Any_to_String(password) ) ;
f _close( file_id ); (* close file *)
end_if;
end_if ;
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"demo_my_ap" Project:

This project first uses "PAC_SN" Function to read out the Serial Number, then calculates the password,
and then compares the password that read from the PAC's file to check if the password correct.

(orkspace ——————J %X
-2l demo_my_ap Q A MName | Tupe | L
(- Exception programs 3 (* operations in the first PAC cycle #) = £} Global variables »
- Progiams [| e it ~INIT: chen INIT BOOL -
P e THEN -
i ‘”!j LD2 -1__" INIT := FALSE ; (* No more first cycle #) b :g—? g::_TI_
[ﬂ[j Watch [for debuggi... E {* get the hardware serial nuwber ¥) NO_2 DINT G
8 Soft Scope B PAC SN{ No 0, No 1, No 2, No 3, No 4, No 5, No 6, No NOL 3 NINT -
oo B Initial values Ihﬂ‘ = - - - - - - - 5] b
LBy NewSpyl (= {* Please use your own algorithm for the PAC password e I 1) o
i 8% Binding Configurati.. ||~ PAC password:= (No 0O * No 1) + (No_2 * 12345) + No_3 [ [d (Project) y
¥ Global defines (No_4 * No_S) + No_6 + No_7 : o 3 Advanced -
: S @ P Acthnalic ¥
: g\;a"ables Li ] > |[4 %] Blocks” Sovizt | Define | ENUM
i ypes ¢ »| Main 02 NewSowt
(Note: Refer the Section 2.1.2 to arrange the programs in the execution order.)
Variable Declaration:
Workspace S T 2K |
) demo_my_ap T Name - | Type | Dm | Asnby Sy | Ind vabue | User Tag Descsighon
o [ Ewception progranc: A b 3
d Program INIT BOOL L] TRUE It as TRUE
] Man NO O DINT O B-byte hardware senal number
“u] LD2 NO 1 DINT O
2 Walch (1or deboggl NO_2 DINT O
B So Scope NO_3 DINT O]
=5 Indisl vaes NOD 4 DINT O
"Ed NewSpy! NO_5 DINT O
¥4 Bindng Confguaai NO_E DINT |
NO_7 DINT 0
password DINT O
B Tipes PAC_password DINT O
password_ok BOOL () TRUE OK , FALSE: fail
LED BOOL L fee demo purposs only. Il password ok, blink per e2cond
LED2 BOOL Ll el
< ?

[#00 ] Men 1D Newer)  Varebles

ST Program - Main:

(* This "demo_my_ap" example can read the password from the EEPROM of the PAC, and check if
match with the result that calculated from the user’s own algorithm. *)

(* Declare "No_0" ~"No_7", "password" and "PAC_password" variables as DINT.
Declare "INIT" variable as BOOL and has initial value TRUE.
Declare "password_ok" variable as BOOL *)

(* Operations in the first PAC cycle *)
if INIT then
INIT := FALSE ; (* No more first cycle *)

(* get the hardware serial number *)
PAC_SN(No_0,No_1,No_2,No_3,No_4,No_5, No_6,No_7);
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(* Please use your own algorithm for the "PAC_password" value *)
PAC_password:= (No_0 * No_1) + (No_2 * 12345) + No_3+(No_4 * No_5)+No_6+No_7;

(* Read the password value from a file "my_product.pwd" in \System_Disk\Win-GRAF *)
file_name := "\System_disk\Win-GRAF\my_product.pwd';
file_id :=f_ropen( file_name ) ;
if file_id=0 then
(* can not open file, set password to 0 *)
password :=0;
else
(* open file ok, read the password *)
if f_eof(file_id) then
(* reach the end of file *)
else
(* hasn't reached the end of file, read a string form it *)
Tmp_string := fm_read( file_id ) ;
(* Convert a string to a DINT value *)
password := Any_to_DINT(Tmp_string) ;
end_if;
f close(file_id); (* close file *)
end_if;

(* check if the password is correct? *)
password_ok := FALSE ; (* setit as "FALSE" in the beginning *)
if password = PAC_password then

password_ok :=TRUE; (* the password is correct *)
end_if;

end_if;

LD Program — LD2

If the "password_ok" is “FALSE“, it means the password is incorrect, then will exit the program. Only

when the password is correct can the program execute continuously, and then your application can be
protected from the unauthorized access.

IEUE: i Fal SF fai
passward_ok
!

This example uses only one
"LD2" program, if your

RETLRM

for demo purposs onl... application as well as other
LEDT rograms, please add the
RUN  BLINK I programs, p _
"password_ok" checking code
nn LED2 for each program.

T#l=JCYICLE
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Chapter 12

Description of Win-GRAF Demo Projects

There are some demo projects in the Win-GRAF shipping CD (CD-ROM: \Napdos\Win-GRAF\
demo-project) which some of them will be introduced in the following sections.
Before using the demo projects, follow the steps below:

1. Click on the menu bar "File" > "Add Existing Project" > "From Zip" to open a project (e.g.,
"demo_tmrl.zip").
@iew Tools Window Help
tm) New Project List... i *‘; {1 i Uy 7 _:I B
Open Project List 4
_g Add New Project...
Add Existing Project | | @) FomDik..
i_’rintSeth... E_le F:omZip:..
(G tomorpeies
[Jdemo_com_portl zip
Note! = AN

"Close Project List")

Win-GEAF - Demol1

Edit Wiew Insmrt Project

Eml Wew Project List.
Cipen Project List
Save Project List

l T Close Project List l

Please close the current "project List"
before restoring the demo projects in the
CD-ROM. (Click on the menu bar: "File" >

Tool: Window Help

Qdemo_com _port? zip
@demo_com _port3.zip
:Qdemn_com _portd zip
[l demo_filel zip

it CD-ROM:

\Napdos\Win-GRAF\demo-project

CD)demo_tile2 zip

:;gdemn_retamzip
¥ demno_tmrl zip
:Qdem_tmﬂ 2ip
F D) demn_tmr3 zip

B
> EEIOR jdemo_tmrl.zip vi ( EE%@Q
v | [P BRSO [Zpf e 8 LI N
SEAH)
Destination folder : ‘rlf;A‘\-Wiﬁ;Ei-ﬁ:AAF\Proiecls v‘ Browse...
Name: (demo_tmr1 |

2. Double click "Main" to open the ST program, and can view/add variables in the variable area.
3. Mouse right-click on the project name (“demo_tmr1“), and select "Communication Parameters" to
set up the IP Address of your PAC. (Refer Section 2.3.5)

{7 Win-GRAF - demo_tmrl
File Edit ¥iew Insert Project Tools Window Help
D=

1% D N

1k

J g AR 00 Y R G 05 %R Al

Communication Settings

=

i
[ Exception programs 7 (* Set 3T ~
3 | ; | . OK =
£ [ Progan g VSN | g
| (o e | c00L
£ [ WaEnTor debuaging] || T vt 1 ‘192‘188‘?1‘19:502 IQ STOP_tmr BOOL
& SoftScope © = ‘ [P RESET tmr BOOL |
: - = | 192.168.255.1:502 ‘
- 24 Initial values —— i set 11 |192168.71.18:502 ‘ LED1 BOOL
i 6 NewSpyl 'hﬁ; if  STOP_| 1132.168.71.19:502 I ED2 BOOL v
%3 Binding Configuration X STOP_tr [T |
i3 g Global defines tStop (T ERE Y0 n
o fa} Variables EHALE ¥ 5 B3 (Proiect) =
v
BT T BN -
= Types [l < »| Blocks  Soviist | Define | ENUI
| Build X
[4 %] Buitd " Grossisferences | Runtime | Callstack | breakpoints | Dl sampinatrace | Fomet | HMI~
§Ready OffLine 192.168.71.18:502 Z Lni, Chi 0x1 Llni, Cht 100%
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12.1 The List of Demo Programs

The Win-GRAF product package includes a CD-ROM named Win-GRAF-PAC-CD, the user can find out
more information on Win-GRAF demo programs in the path - \Napdos\Win-GRAF\demo-project. Refer

the table below to restore these programs to the Win-GRAF Workbench.

The following table shows the list of the demo programs:

File Name Description
Use the "tStart" and the "tStop" functions to operate the Timer
demo_tmrl .
- (refer section 12.2.1).
demo_tmr2 To do periodic operations for the Timer (refer section 12.2.2).
demo,_tmr3 To do periodic operations more accurately for the Timer

(refer section 12.2.2).

demo_com_portl

Send a string by the COM Port (refer section 12.3.1).

demo_com_port2

Request/Anser the device by the COM Port (refer section 12.3.2).

demo_com_port3

Wait for data coming from the remote device to the COM Port
(refer section 12.3.3).

demo_com_port4

Report data periodically to the remote device by the COM Port
(refer section 12.3.4).

demo_filel

Write data to a file on the PAC (refer section 12.4.1).

demo_file2

Read data from a file on the PAC (refer section 12.4.2).

demo_retain

Use retain variables to save lately values before the PAC power failure
(refer section 6.1).

demo_wp5_retain

Use file to retain variable values (refer section 6.2).

demo_extra_port

Enable a serial port for connecting the Win-GRAF Workbench
(refer appendix E).

demo_my_ap

demo_passwd

Protect your Win-GRAF program and avoid being embezzled
(refer section 11.12).

demo_XV310

demo_XV308 1

demo_XV308 2

demo_XV308 3

demo_XV116

demo_XV111

demo_XV110

demo_XV107

Use an XV-Board in the WP-5xx8-CE7 (refer section 5.1.6 ~ 5.1.12).

demo_vb01

demo_vb02

demo_vb03

demo_vb04

Use VB.net 2008 programs to read/write Win-GRAF variables
(refer Chapter 13).

demo_PID_simple

The PID and regulator applications.

demo_user_C

Develop your own Functions and Function Blocks (refer Chapter 18).
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File Name

Description

demo_rdn_1

demo_rdn_2

demo_rdn_3

Redundant System (refer Chapter 16).

demo_ET7060

Connect the remote ET-7060 Ethernet I/O module (refer section 5.2.2).

demo_ET7018z

Connect the remote ET-7018Z Ethernet I/O module (refer section 5.2.3).

DEMO_DL_100T485

Connect the remote DL-100T485 module to measure temperature and
humidity (refer section 8.2.7).

demo_schedule

Schedule control (refer Chapter 17).

demo_d_7065 Connect the remote I-7065 1I/0 module (refer section 8.2.1).
demo_d_7018z Connect the remote |1-7018Z I/0O module (refer section 8.2.2).
DEMO_D_7083 Connect the remote I-7083 I/0 module (refer section 8.2.3).
demo_8088w PWM Output (refer section 4.11).

DEMO_D_87084_FR

Connect the remote |1-87084W module to measure frequency
(refer section 8.2.4).

DEMO_D_87084_C4

DEMO_D_87084 _C8

Connect the remote [-87084W module to measure Counter
(refer section 8.2.5, 8.2.6 and 4.9).

Use the 2G/3G GSM Modem to send/receive the text message

demo_SMS (refer Chapter 21).
. Send a file via Ethernet or 3G wireless network from a PAC to a remote PC
demo send file
- - (refer Chapter 20).

demo_3G

3G wireless communication.
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12.2 Timer Operations

12.2.1 Start, Stop and Reset the Timer

Refer P12-1 to open the project ("demo_tmrl.zip"), and can view/add variables in the variable area.

ST Program:

(* Declare “START_tmr”, “STOP_tmr”, “RESET_tmr”, “LED1”, “LED2” as BOOL
Declare “TMR1” as TIME *)
(* Set START_tmr as TRUE to start ticking Timer TMR1 *)

IF  START tmr THEN
START tmr := FALSE;
TSTART (TMR1);

END_IF;

(* Set STOP_tmr as TRUE to stop ticking Timer TMIR1 *)
IF STOP_tmr THEN
STOP_tmr := FALSE;
TSTOP (TMR1);
END_IF;

(* Set RESET_tmr as TRUE to reset TMR1 to a value T#0s *)
IF RESET_tmr THEN
RESET_tmr := FALSE;
TMR1 :=THOs ;
END_IF;

(* Let LED1, LED2 ON during TMR1 =3 ~ 10 second *)
LED1 := FALSE;
LED2 := FALSE;
IF (TMR1 >= T#3s)and (TMR1 <= T#10s) THEN

LED1 := TRUE;
LED2 := TRUE;
END_IF;

(* Reset TMR1 as 0 when reachs 15 second *)
IF TMR1 >= T#15s THEN
TMR1 := TH#Os;
END_IF;
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12.2.2 Periodic Operations
Refer P12-1 to open the project ("demo_tmr2.zip"), and can view/add variables in the variable area.

Function "BLINK" plus Function Block "F_TRIG" can produce a Pluse TRUE at regular intervals, so it can
be applied in the periodic operations.

LD Program:
pulze
RUM  BLINK aHolk  F TRIG =] |
nn X
T#2S oy ieLE Type: BOOL
ST Program:

IF plusel THEN
(* do periodic operations here *)

END_IF;

The "BLINK" and "F_TRIG" above will produce a Pluse TRUE every two seconds, but this method has a
drawback:

plusel

v

A

»
P«

2 Sec 2 Sec

If the interval time of the period is shorter (e.g., 100 ms per period or less; or the PAC Cycle Time is
larger, such as 20 ~ 50 ms, generally 3 ~ 15 ms), then the period operations will be inaccurate. For
example, to do a periodic operation every 50 ms, as compared to 250 ms or 2 seconds, the interval time
of 50 ms is very close to the PAC Cycle Time, if using Function Blocks "BLink" plus "F_TRIG", it is easy to
accumulate the output delay time, therefore the final operation time will become inaccurate.

O : Cycle time Delay: 5ms 10 ms .......
(3~ 15 ms) : :

pluse

50ms 50ms Tolerance will increase.
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To improve the situation above, the following coding method will be more accurate:
(Tolerance will not increase.)

Refer P12-1 to open the project ("demo_tmr3.zip"), and can view/add variables in the variable area.

ST Program:

(* Declare “INIT” as BOOL and has initial value TRUE
Declare “TMR1”, “TMR1_next” as TIME *)

IF INIT THEN
INIT := FALSE;
TMR1 := TH#Os;
TMR1_next := TMR1 + T#50 ms;
TSTART (TMR1);
END_IF;

When the timer reach T#23h59m59s999ms,
the value will overflow.
1 Therefore, please reset it automatically to

IF TMR1 >= TMR1_next THEN
IF TMR1 > T#10h THEN

TMR1 := T#O0s; "0" after 10 or 18 hours.
TMR1_next := T#Os;
END_IF;

TMR1_next := TMR1_next + T#50 ms;
(* Do periodic operations here *)

END_IF;
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12.2.3 Detect the Steady ON or Steady OFF Signal
"TON" Function Block can detect the steady "ON" signal. (Keeps "ON" for a minimum period of time.)

oUT_1

IM_1

PT: Programmed Time
ET: Elapsed Time

As the picture above, this function can detect the steady "ON" signal that keep at least 2 seconds.

ON ON

2 sec H H 2 sec
IN_1 < » < B

<

I ON 1 | ON 1

ouT_1

"TOF" Function Block can detect the steady "OFF" signal. (Keeps "OFF" for a minimum period of time.)
that can keep "OFF" for a period of time.

ouT_1

IN_1

Inzt_TOF ’
Il TOF 5]

T#3=PT

PT: Programmed Time
ET: Elapsed Time

As the picture above, this function can detect the steady "OFF" signal that keep at least 3 seconds.

ON ON
2 sec H H 2 sec
IN_1 < > < >
X 1 ON 1 ON 1
:
1
1
OouT_1 .
OFF u OFF ‘ ‘ \ OFF
IN_1 T ' T
I—————p! I—————p!
[ 1 [ 1
1 3sec 1 3sec |
OuT_1
OFF OFF OFF
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12.2.4 Keep Outputting ON for Some Time after Triggering

"TP" Function Block can keep outputting "ON" for some time after triggering (e.g., from OFF to ON).

IM_1 ouT_1

PT: Programmed Time
ET: Elapsed Time

As the picture above, after triggering, it can keep outputting "ON" signal for 10 seconds.

A
A\ 4

A
A\ 4

A
\ 4

10 sec 10 sec

10 sec

ON ON

ouT_1 U
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12.3 Operations of Serial Port Communication

Users can directly operate the serial port (e.g., RS-232, RS-485 or RS-422 Port) to achieve some specific
communication protocol. The following Functions can be used to directly operate the serial port.

Functions Description
COM_open Open a serial COM port.
COM_close Close a serial COM port.
COM_clear Clear the input buffer of a serial COM port.
COM _test Test if any data received in the input buffer of a serial COMM port.
COM_send Command a serial COM port to send 1~500 bytes.
COM_send_str Command a serial COM port to send a String.
COM._ recv Et‘eec;i\;ﬁ :f;:ef;(;g;_he input buffer of a serial COM port and save
COM_status Get the current status of a serial COM port.

Please refer Section 1.2.3 to open the Library Manager and find the detail Function description.

Library Manager - ICP DAS - XP-WP-¥P B E tﬁ
File Wizard Help

Function and FBs | )/0s | Profiles ASI I i’ypes;

COM_clear (* Clear the tput buffer of a COM port ¥ A
#FICOM _close (* Clos a serial COM port *)
#COM_open (* Open a serial COM port. Forex,, TMP_BOO = COM_open{ 2, 9600,N,8,1') ; %)
EICOM _recy (*Receive bytes form the tnput buffer of a serial COM port and save them in a byte acray *)
ECOM_send (* Command a serial COM port to send 1 ~ 500 bytes *)

ECOM_send_str (* Command a serial COM port to send & string )

EICOM _test (* Test if any data received in the input buffer of & serial COMM. port ¥

ol Amesnvd

i imvt o Dharrdaal dnvasd ialain dm e Do cdmmmsmio o inlava ¥

Description ‘

| Parameter
COM_clear : Clear the input buffer of a serial COM port .

*#*% Function

*#*% Input parameters
Port : DINT : serial COMM. port number to open .
can be 1 to 37 (depends on PAC, means COM1 to COM37) .

##%% fJutput parameters
Q0 : BOOL :
TRUE : clear successfully.
FALSE : something wrong (for example, port number is incorrect).

Jun. 18,2014
ICP DAS , Taiwan
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12.3.1 Send a String by the COM Port
Refer P12-1 to open the project ("demo_com_portl.zip"), and view/add variables in the variable area.

ST Program: This program can send a String every 2 seconds by the PAC COM1 (parameters:
'9600,N,8,1°) (e.g., <CNT1=1>o0r<CNT1=25>).

(* Operations in the first PAC cycle *)

if INIT then Declare “INIT” as BOOL and has initial value TRUE;
INIT := FALSE ; (* No more first cycle *) “Port_OK” as BOOL ;
CNT1:=0: CNT1” as DINT ;

“TMR1”, “TMR1_next” as TIME
TMR1 :=T#0s ; “Port_number” as DINT and has initial value “1”
TMR1_next :=TMR1 + TH#2s ;

(* start ticking TMR1 *)
tStart(TMR1) ;
end_if;

(* if the status of COM port becomes FALSE(not open), open it *)
if COM_Status(Port_number) = FALSE then

(* open a serial COM port *)

Port_OK := COM_open(Port_number, '9600,N,8,1' ) ;
end if;

(* when time reached, ... *)
if TMR1 >=TMR1_next then

(* to prevent TMR1 overflow (means reach T#23h59m59s999ms) *)
if TMR1 > T#10h then

TMR1 := THOs ;
TMR1_next := T#Os ;
end_if;

(* Set new TMR1_next *)
TMR1 _next := TMR1_next + T#2s;

(* Send a string from COM port *)
COM_send_str( Port_number, '<CNT1='+ Any_to_STRING(CNT1) +'>');

(* reset CNT1 when reach 100 *)

CNT1:=CNT1+1;

if CNT1>=100 then
CNT1:=0;

end_if;

end_if;
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12.3.2 Request/Answer the Device by the COM Port
If an application needs to use RS-232/485/422 Port to get the data from other devices, the steps are as
the following request and answer:

Win-GRAF PAC @ Device
1. Send a command to request the Device. 2. Check if receive a complete query?
» (If yes, reply an answer to the

3. Check if receive the complete reply? Win-GRAF PAC.)

(If yes, do the proper operations and <

wait for a while, and then return to 4., Wait for the next command,
the step 1 to send the next command.) @ and if receive a command

then go to the step 2.

Refer P12-1 to open the project ("demo_com_port2.zip"), and view/add variables in the variable area.

Note: Double click “Action” will first open a “Notes” window, then click “Action” icon to see the code.

[ Win-GRAF - demo_som_port2

Bls Edit Tiew [set Projest Jook Window Help
¥ 3 4 fh & Nwe s §EA '
Warkspace
) demo_com_poit? - F = ~  Stepi - Action
3 N || e | Astion(P) i
4 Exception programs t (- L It y £
3 Pogans | - I e K | S " \ (3 Global variables
e : | = AN - “ ( 1 o is not open, open it ¥) ¢ M
J‘:;::uatqul 3 - T if CON_status{Port_number) = FALSE ACtion z;’:d-;)‘. g:;‘l#L
S H Port OK := COM_open|Port_nunbet, &
W 5ot Scope . |G| Double click | _ 2% S Gt Byledy  BYIE
=3 nd vaiues e il % Port_rumier  DINT -
95 Birdng Comgumnon ¥ End_Action 7 < >

@ “ — 71 - L3 (A -
—— GEA. T »» T2:50ns — lﬁcw'

- P () ‘ 3 Advarced
l— =1 3 fofrereto

{ [ A Aoy
{30 1 L ASamedace
3 BAChe
- GE5.T > T8ds ; 3 Boclearw
(3 CANbu
- CaNopen
4 Cock

4 Coroesons
> ¢ > 0] mmoks sovkn | Defee  ENUM

-

v »

ertdder

A B
b 4
|}

~

AEEa R
<

Busd Crons sewrernns Purirve Co atank Preshpoees Seatu wwrodng tiace Prorrat MM
R eady OffLne 192.168.71, 18502 [ 0,0 1x1 0,0 1006 A

You can click the “Variables” tag to open the Variables window.
7 Mame | Type | Dimn. | Attrib. | Syb. | Initvalue | User.. | Tag | Description
BRA] Global variables

Part_OK BOOL Ol =
NUM?1 DINT ]

ByteAry BYTE [0..199] ] Byte Array, DINM=200
Port_number DINT E 3 init as 3 v
) iiif >

{4 »| Main| Variables <
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In this example, the Win-GRAF PAC sends a string 'QUESTION?' by COM3 to the device, and then wait for
the reply and does operations. After the operations, waits 2 seconds, and then sends the same
command 'QUESTION?', and repeated.

SFC Program:
( Declare "Port_OK" as BOOL; "NUM1" as DINT ; "ByteAry" asBYTE and Dim.="200";

“Port_number” as DINT and has initial value "3")

Action(P) :

l (* if port is not open, open it *)

1 if COM_status(Port_number) = FALSE then

Port_OK := COM_open(Port_number, '9600,N,8,1') ;
w

end_if;
End_Action;

[~ (Open COM3 as 9600,N,8,1°)

——  Port_ OK ; (If succeeds, do the next.)

2
Action(P) :
(* Clear input buffer *) (In this example, clear input buffer of
3 COM_clear(Port_number) ; COM3 first, and then send a
COM_send_str(Port_number, 'QUESTION?' ) ;
End_Action;
GS3.T >= T#250 (After sending query, wait for 250 ms to allow the device’ reply Bytes
—_ T>= :
4 ms; are safely delivered to the Win-GRAF PAC. Do not set the time too
short, or cannot receive a full reply.)
Action(P) :
(* receive reply from COM3,max. 200 bytes in this example*)
5 NUM1 := COM_recv(Port_number, ByteAry, 0, 200) ;
| (* do operations if protocols is correct *)
if NUM1 =10 then
(*...%)
end_if;
End_action;
. Put the received Byte into ByteAry([]
GS5.T>=TH2 ; (
6 \ and check if the number is correct?
(When done, wait 2 seconds and then If yes, do the operations the

application needed.
1 return to the step 1 to send the next PP )

query command.)
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12.3.3 Wait for Data Coming from the Remote Device to the COM Port

This way is common in the general store or supermarket, such as using the barcode readers. After
reading the barcode of the product, it will send the barcode data to the Win-GRAF PAC's COM Port
(RS-232/485/422), and need not to reply any messages.

Win-GRAF PAC @ Device

2. If receives the complete data from device, < 1. After triggering, send data to
do operations. the Win-GRAF PAC
3. When done, wait for the next data coming.

Refer P12-1 to open the project ("demo_com_port3.zip"), and view/add variables in the variable area.

ST Program:
(* operations in first PAC cycle *) Declare "INIT" as BOOL and has initial value TRUE;
if INIT then "Port_OK" as BOOL ;
INIT := FALSE ; STEP1", "NUM1" as DINT ;
"T1" as TIME ;
T1:=THOs ; "ByteAry" as BYTE and Dim. = "200" ;
STEP1:=0; “Port_number” as DINT and has initial value "3".
end_if;

(* if port is not open, open it *)
if COM_status(Port_number) = FALSE then

Port_OK := COM_open( Port_number, '9600,N,8,1') ;
end_if;

(* If open port fail, exit this ST program *)
if Port_OK = FALSE then

return;
end_if;

CASE STEP1 OF

(* if there is at least 1 byte coming *)
0:
if COM_test(Port_number) then
STEP1:=1;
T1 := THOs ; STEP1 = 0, means waiting, and will test if COM3 has data?
If returns TRUE, means COM3 has data.

Then set STEP1 to "1", T1 to "0" and start timing.

Tstart(T1) ;
end_if;
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(* wait 250 ms, then receive all bytes form COM port *)

L it T1>= T#250ms then STEP = 1 means the data is sendi-ng in, and will wait 250 ms
to receive all data and put them into an array. The waiting
Tstop(T1); time concerns the device specifications and the Baud Rate.
T1 :=THOs ; If set the time too short, may receive data incompleted.
STEP1:=0; Remember to set STEP1 to "0" to wait for the data coming
next time.
(* receive max. 200 bytes *)
NUM1 := COM_recv(Port_number , ByteAry, 0, 200 ) ;
(* do proper operations if protocol is correct,
here assume correct protocols has 25 bytes in this example*)
if NUM1 =25 then
(*... %)
end_if; When receive data, check if data is correct?
If yes, do the operations the application needed.
end_if ;
END_CASE ;
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12.3.4 Report Data Periodically to the Remote Device by the COM Port
If wants to periodically report data to other devices by RS-232/485/422 Port, do as follows.

Win-GRAF PAC

P Device
Every period time (e.g., 5 sec), put the ) )
data to be sent into array (Type: BYTE) —" Check if receive the complete

> ?
and send data by Function COM_send. and correct data: _
oo And then do proper operations.

Refer P12-1 to open the project ("demo_com_port4.zip"), and view/add variables in the variable area.
SFC Program: (Refer Section 12.3.2 to open the "Action" window:.)

(Declare “Port_OK“as BOOL ; "TMP_DINT" as DINT ; "ByteAry" as BYTE and Dim. =100 ;
“Port_number” as DINT and has an initial value "2".)

Action(P) :
' (* if port is not open, open it *)
1 | | if COM_status(Port_number) = FALSE then
Port_OK := COM_open( Port_number, '19200,E,8,2" ) ; (Open COM2 as “19200,E,8,2)
end_if;
End_Action;
R Port OK : (If succeeds, do the next.)
2 — ’
Action(P) : (The sent data concers with
(* prepare ByeAry[] to be sent *) your application, please
3 (*...*) use COM_send to send
(* Send it, here send 20 bytes *) data after the data is
TMP_DINT := COM_send(Port_number, ByteAry, 0, 20) ; ready. Max. 500 Bytes )
End_Action;
\\
4__ GS3.T >= T#5s ; (If wants to send String, can use the Function
COM_send_str(). Max. 255 Bytes, and can not
(After 5 seconds, has "0" in the Byte of the String, because "0"
return to the step 1 to means the end of the String, but it can be the
1 send the next data.) Character "0°.)
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12.4 Read/Write Data from/to a File on the PAC

The Win-GRAF Workbench provides the following Functions to enable sequential read/write operations
in disk files of the Win-GRAF PAC.

Functions Descriptions

Please click the menu bar "Help" > "Topics" and type the

searching key word “File” to see more detail information &g Iopics. \
in the topic of the “File Management functions”. Q| Search...
Tutorials »
@ | About..
Langmage...
F_ROPEN Open/Create a file for reading.
Open/Create a file for writing.
F_WOPEN If the file doesn’t exist, it will be created automatically.
If the file exists, all its content will be removed.
F_AOPEN Create or open a file in append mode.
F_CLOSE Close an open file.
F_EOF Test if the end of file is reached in a file open for read.
FA_READ Read a DINT integer from a binary file.
FA_WRITE Write a DINT integer to a binary file.
FM_READ Read a STRING value from a text file
FM_WRITE Write a STRING value to a text file.
FB_READ Read binary data from a file.
FB_WRITE Write binary data to a file.
F_EXIST Test if a file exists.
F_GETSIZE Get the size of a file.
F_COPY Copy afile.
F_DELETE Remove a file.
F_RENAME Rename a file.
Refer Section 1.2.3 to find the detailed descriptions for the following Functions.
F_dir Create a directory.
F cp._dir Copy all files i_n a dirgctory tq another directory.
(Include subdirectories and files). (Notel)
F del_dir Delete a directory and all files inside it.

(Include subdirectories and files). (Notel)

Note: The Win-GRAF PAC of ICP DAS does not support Functions “F_SAVERETAIN” and
“F_LOADERETAIN”.

Notel: Since the following PAC drivers support the "F_cp_dir" and the "F_del_dir" functions for
operating in sub-directories.

WP-8xx8 : v1.04, VP-x2x8-CE7 : v1.01, XP-8xx8-CE6 :v1.02, WP-5xx8-CE7: Released day.
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12.4.1 Write Data to a File on the PAC

Refer P12-1 to open the project ("demo_filel.zip"), and can view/add variables in the variable area.

ST Program: This program can be used to write 10 "REAL" values to a file on the PAC.

(* This "demo_filel" project will save 10 REAL value to a file
in the \System_Disk\Real_datal.txt.

File Format :
Each row contains one REAL value and ends with <CR><LF> characters. Like:

1.08

2.786

38.45

41.5

59.875

60.76

71.23

80.5

99.8

100.7 *)

Because the size of \System_Disk\ is small,
(* Variables declaration: recommend you may change the directory to
Write_File : BOOL below (Depends on your application):

T tri : String, len=255 . ; i
mp_string ring, len WinPAC, ViewPAC Series:

File_ID : DINT \Micro_SD\ or
REAL_val[0..9] : REAL

ii : DINT XPAC Series:
File_Status :String, len=128 *) \System_Disk2\

(* Set Write_File as TRUE to write data to the file *)
if Write_File then

Write_File := FALSE ;
File_ID := F_Wopen( "\System_Disk\Real_datal.txt');

if File_ID=0 then
(* Can not open file in write mode *)
File_Status := 'Can not open file in write mode !';
else
(* open file in write mode ok, save REAL[0] ~ [9] to file,
each row contains 1 REAL value and end with <CR><LF> *)
File_Status := 'Open file ok.";

forii:=0to9 by 1 do
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Tmp_string := Any_to_string( REAL_vallii] ) ;
FM_write( File_ID , Tmp_string ) ;

end_for; If want to save data to Integer, use the code:

Tmp_string := Any_to_string( DINT_val[ii] ) ;
and declare Variable “DINT_val” as DINT and
Dim. at least "10" for this example.

(* close the file *)
F_close( File_ID ) ;

end_if;
end_if;

Test Program:
In this example, when the "Write_File" is set to "TRUE", the values will be written into the file

\System_Disk\Real _datal.txt on the PAC.

1. Please set up IP configurations (Refer P12-1), compile and download the program to the PAC.
(Click on "Project" > "Build All Projects" / "On Line", if not familiar with the operation, refer to
Section 2.3.4, Section 2.3.5)

2. Click "NewSpy1" to open a Spy List and fill in the values to be written, and then set the "Write_File"
become "TRUE" to Write data. (If OK, "File_Status" will show "Open file ok".)

File Edit ¥iew Inse @ @w Help

DAX K o g o B UHE NS GRS

Workspace D000 HewSpyrt.spl
= > demo_file1 [RUN] ' g Name
[ Exception programs m =1 REAL_val @
=4 Programs 2 REAL_wvallD] | 1.23
%) Main g REAL_valll] | 29
=4 Watch [for debugging) REAL_wall2] | 27
P ﬂ Soft Scope REAL_wval3] | 5.5

REAL vall4] | 9.85

o) NewSpy'l REAL_vall5] | 3.42

g Binding ConfigNgti ‘ REAL_vall6] | 3.0 Lock
REAL_vall7] | 7.83

T Varables REAL_wall8] | 3.69 Uritock
BB Types REAL_wvall9] \2E7__J i i
Wwiite_Fi F&LSE set TRUE to write data to the file

File_Status ‘Open file ok

[4 ¥ Main| MewsSpy1 ” Variables

3. Onthe PAC, open the file "Real_datal.txt", can see the values filled in the step 2.

[#=RE WEE AW BEQ |
@ v ? XU O Taxe #e8E sy B30 TAD| & H

. _ﬁﬂ@te—mpp 1.23

(25 Drivers 30
5 External_device_driver 27
[~ ISAGRAF 55
& took 9 85
I Win-GRAF 347

2] Backup_Real_1.txt 3
[FlGetPacMame.exe
[&penmount ush_touch_v2010052¢ -85

3.89
E] testfl.txt k 2.67
£] woarking_Int.txt

Win-GRAF User Manual, V 1.07, Apr. 2018 by ICP DAS 12-18



12.4.2 Read Data from a File on the PAC

Refer P12-1 to open the project ("demo_file2.zip"), and can view/add variables in the variable area.

ST Program: This program can be used to read 10 "REAL" values from a file on the PAC.

(* this "demo_file2" project will read 10 REAL value from a file
in the \System_Disk\Real_data2.txt .
File format :
Each row contains one REAL value and ends with <CR><LF> characters. Like:
1.08
2.786
38.45
41.5
59.875
60.76
71.23
80.5
99.8
100.7

¥)
(*

Variables Declaration:

Write_File : BOOL
Tmp_string  : String, len=255
File_ID : DINT
REAL_val[0..9] : REAL
ii : DINT
File_path : String, len = 128, initial val = '\System_Disk\Real_data2.txt'
File_Status  :String, len=128
*
) \ Because the size of \System_Disk\

is small, recommend you amy
change the directory to below
(Depends on your application):

(* Set Read_File as TRUE to read data from the file *)
if Read_File then

Read_File := FALSE ; WinPAC, ViewPAC Series:
(* Check if file exists *) \Micro_SD\ or
if F_exist( File_path ) = FALSE then
(* file doesn't exist *) XPAC Series:
File_Status :='File "' + File_path +"" does not exist !'; \System_Disk2\
else

(* file does exist , open it in read mode *)
File_ID := F_Ropen( File_path );

if File_ID=0 then

(* open file in read mode fail *)

File_status := 'Can not open File "' + File_path +'"" I';
else
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(* open file in read mode ok, read REAL[0] ~ [9] from file,

each row contains 1 REAL value and end with <CR><LF> *)
File_status := 'Open File "' + File_path +'" Ok .";
forii:=0to9 by1 do

(* test if the end of file is reached in a file open for read *)
if F_EOF(File_ID) then

(* reach the end of file, exit "for loop" *)

exit ;
end_if;

(* read one row in the file as a string *)
Tmp_string := FM_READ( File_ID ) ;

(* convert the string to become REAL value *)
REAL_vallii] := Any_to_REAL( Tmp_string ) ;

N

end_for;
If want to read Integer, use the code below:

(* close the file *) DINT_vall[ii] := Any_to_DINT( Tmp_string ) ;

F_close( File_ID); and declare Variable “DINT_val” as DINT and
Dim. at least "10" for this example..

end_if ;
end_if;
end_if;

Note: In this example, when the "Read_File" is set to "TRUE", it will read the file on the PAC
"\System_Disk\Real data2.txt", please make sure the file already exists on the PAC.

| BRE) ®BE BRY) BEQ |
¢ % 2 X4 E-
HAHE(D) I \Systerm_Disk

(-7 Drivers = . =

i External_device_driver HE%':E:I wEE) Bl 8L0) IE’EIH =
5 ISAGRAF 1.08

7 tools 4. 756

. Win-GRAF 3845

[ penmount_usb_touch_v20100526, 415
] [EC61131 User and Reference Mani 29875

2] Backup_Real_2.txt 60.76
723
£] Update_History 28120418 txt 80.5
=] working_Real.txt 9%.8
1007
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Test Program:

1. Please set up IP configurations (Refer P12-1), compile and download the program to the PAC.
(Click on "Project" > "Build All Projects" / "On Line", if not familiar with the operation, refer to
Section 2.3.4, Section 2.3.5)

2. Click "NewSpy1" to open a Spy List and set the "Read_File" to "TRUE" to read the data. (If OK,
"File_Status" will show "Open File "\System_Disk\Real_data2.txt" Ok.")

File Edit View Ine @‘ Help @
A = I T = 7 Yo, e s T 898 W8 S = L Al jun Patne nd D

Workspace |l OO0 HewSpyt.spl
£ [ demo_file2 [RUN] ‘ B Name | Yalue | Description
fﬁn L4 Exception programs Eﬂ =] REAL_wal @ -
[ Programs E REAL_wall0] | 1.08
L) Main B REAL_valll] | 2786
(=) [ Watch [for debuggi... REAL_wvall2] | 38.450001 I; TRUE j (1)
. 4% Soft Scope REAL_vall3] | 415 ‘\

- REAL val4) | 53875 ( FALSE J[to)]
| REAL vals) | 60.759338
REAL_vall§] | 71230003 Lock
REAL val7] |s05

REAL valls] | 39.800003

100.693937

T} Variables
BB Types

set TRUE to read data from the file

‘Open File "sSystem_Disk\Real_data2.txt" Ok '

‘ R4
|[EE Fon] vambes | Wewsovi/

I

Note: There is one another file operation example listed in the Section 6.2. It handles many data in the
file, you may refer it.
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12.4.3 Data Logging

Refer P12-1 to open this project ("demo_Datalog.zip") that provides a simple function for data logging.
This program creates a spy list that contains a String variable (write_date), an Integer variable (int_data)
and a Real variable (float_data). These variable values will be recorded to a file per minute and be stored
on the PAC‘s \System_Disk2\. This log file will be named according to the current date (e.g., May 06,
2015, the file name will be "2015-5-6.csv"). Moreover, this log file will be replaced per day and the
existing file will be moved to "\System_Disk2\Current month\" (e.g., May 06, 2015, the file will be
moved to "\System_Disk2\2015-5\").

Note: This example project is used for the XP-8xx8-CE6 PAC. If you want to use the others PAC,
simply change the file path as \Micro_SD\ or other storage location.

The sample of the CSV file format:
Time, int_val, float_val
20:18:30, 1236, 14.56
20:18:40, 3456, 34.56
20:18:50, 8932, 89.32

Description of variables: The user can view/set variables in the Win-GRAF "Variables" window.

Name Data Type | Description
Yearl DINT
Month1 DINT
Dayl DINT
WeekDay1 DINT Used to get the PAC system time in the “PAC_Time” program.
Hourl DINT
Minutel DINT
Secondl DINT
old_day DINT Used to know if the time is changed and then rename the log file
old_hour DINT in the “PAC_Time” program.
log_tmrl TIME )
log_tmr2 TIME Timer.
CSV_Path STRING The storage path of CSV file.
CSV_Dir STRING The storage folder of CSV file.
write_date STRING Used to record the time when writing data to a CSV file.
init BOOL Set it as TRUE to initialize. (Init value = TRUE)
int_data DINT Used to record the data.
float_data REAL Used to record the data.
writecsv BOOL Set it as TRUE to write data.
File_ID DINT Used for the "F_WOPEN" function.
tmp_bval BOOL
The temporary variable.
tmp_msg STRING
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Spy List — “My_List”:
There is a Spy list called “My_list” in this example project. (Refer Section 11.3 for more details)

¥ M arne | Walue | Description

FE! write_date

int_data

B

LD Program — “PAC_Time”:
To get/set the PAC system time.

R1 ME.TIME_GET ...

....................... Yearf eart
Meonth}-Month1
Day|-Day1
wDay|-WeekDay1

Hourj-Hour1

Minute}- Minute1

Sec,. }Secondi

ST Program — “Main”:
To generate random values as the data of the log file (.csv) and to change the file storage path.

(* Declare “init” as "BOOL" ; Declare "log_tmrl" and "log_tmr2" as "TIME" *)
(* Set “init” as TRUE to start ticking "TMR1" *)
IF init THEN
init := FALSE ;
(* Enable the timer of the data logger *)
TSTART (log_tmr1) ;
(* Set the separator and decimal within the csv file *)
SetCsvOpt(’,’, ".");
END_IF;

IF old_day<> dayl THEN

tmp_msg:="\System_Disk2\'+CSV_Dir+'\'+ANY_TO_STRING(yearl)+'-'+
ANY_TO_STRING(month1)+'-'+ANY_TO_STRING(old_day)+'.csv';
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(* Copy the file to \System_Disk2\ *)
tmp_bval:=F_COPY (CSV_Path,tmp_msg);

(* Delete the original file stored at \temp\ *)
tmp_bval:=F_DELETE(CSV_Path);

(* Create the CSV file and its filed name *)
tmp_msg:="\Temp\'+any_to_string(yearl)+'-'+any_to_string(month1)+'-'+
any_to_string(day1)+'.csv';
CSV_Path:=tmp_msg;
File_ID:= F_WOPEN(tmp_msg);

IF File_1D<>0 THEN
tmp_msg:='Time,Int_val,Float_val’;
tmp_bval:=FM_WRITE(File_ID,tmp_msg);
tmp_bval:=F_CLOSE(File_ID);

END_IF;
old_day:=dayl;
END_IF;

(* Create the folder every month, or when the PAC boot up. *)

if old_month<>month1 then
CSV_Dir:=ANY_TO_STRING(year1)+ANY_TO_STRING(month1);
tmp_msg:="\System_Disk2\'+CSV_Dir;

F_DIR(tmp_msg); \
Because the size of \System_Disk\ is small,

old_month:=month1;
we recommend that you save the log file at

\Micro_SD\ (for WinPAC, ViewPAC series) or
\System_Disk2\ (for XPAC series).

end_if;

(* The function for writing data to a CSV file *)
IF log_tmrl>=log_tmr2 THEN
log_tmrl:=t#Os;

(* Generate random values for the "Int_val" and the “Float_val" field *)
int_data:=rand(1000);
float_data:=ANY_TO_REAL(int_data)/100;
(* The time for each data logging *)
write_date:=ANY_TO_STRING(hourl)+":'+ ANY_TO_STRING (Minutel)+"'+
ANY_TO_STRING (Second1l);
(* Delete the previous file *)
tmp_msg:="\System_Disk2\'+CSV_Dir+'\'+ANY_TO_STRING(Yearl) +'-'+
ANY_TO_STRING(month1)+'-'+ANY_TO_STRING(Day1)+'.csv';
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(* Delete the file stored at \System_Disk2\ *)
tmp_bval:=F_DELETE(tmp_msg);
(* Trigging it to write data to a file *)
writecsv:=true;
END_IF;

LD Program — “WriteFile”
Set the "writecsv" as "TRUE" to write one data to the CSV file.

The user can click the following function or function block, and then press “F1” to view the descriptions.

VLID: Get the identifier of an embedded list of variables (i.e., Spy List - My_list.spl).
LogFileCSV: Generate a log file in CSV format for a list of variables.
F_COPY: Copy a file.

writecsy In=t_LOGFILE...

R1 P En WVLID Eng LOGFILECSW I
Falze
"My_list.spl' List D)-File_ID ] RST ERR}-ERR

File_ID{ List

writecsy N wWritecsy

R2 P SF_corv bR

cev_Pathsre

Using “F_COPY” to copy a file from the path “\Temp\”
fmp_msg-| Dt (RAM Disk, which can read/write data quickly) to

“System_Disk2”. (Refer the ST program — “Main”)
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Chapter 13 VB.net 2008 Program Running in WP-8xx8 Access to
Win-GRAF Variables

This chapter lists the procedure for creating the first demo program by Visual Studio .NET 2008
development tool. There are some sample programs in the WP-8xx8 CD-ROM.
VB .NET example:
CD-ROM : \napdos\Win-GRAF\demo-project\vb.net_2008_demo\
demo_vb01: Digital I/O demo with one I1-87055W in slot 0 of the WP-8xx8.
demo_vb02 : Analog /O demo with one I-87024W in slot 1, one I-8017HW in slot 2.
demo_vb03: Read/Write Win-GRAF internal integers, timers & real variables. (No 1/0)
demo_vb04 : Read/Write Win-GRAF internal String variables. (No |/0)

Win-GRAF example:
CD-ROM : \napdos\Win-GRAF\demo-project\
"demo_vb01.zip", "demo_vb02.zip", "demo_vb03.zip", "demo_vb04.zip"

13.1 Add an Existing Win-GRAF Project from a ZIP

Please follow these steps to restore the Win-GRAF project.

First Click “File” -> “Add Existing Project” -> “FromZip...”. Then choose the Win-GRAF project zip file
which you would like to restore. After restoring the project, you have to build the project, and then
download it to the PAC.

View Ioals Window Help
m HWew Project List. . *| [l & %d
Cipen Project List 4

= Add Hew Project...

Add Existing Project ﬂ_l] From Digk....
Print Setup... \ B Fom Zip... \
1 CAWin-GRAFProjectshp_vb01 w51 - iRl 2)X)
2 TN m-GR AR rojectshep_wbl3 w5l ——
3 CAWin-GRAFProjectshp_vh02 w51 EBD: | O Demo-Program ¥ O F e mE
4 CAWin-GRAFRProjectssICPDAS_ temnplate w5 B ()CEharp.net_2008_demo
; () wbonet_2008_demo
El! Bt o etz p s Sl demo_vbU1 zip
@
M|
FEnso
-
g
FeEnEERE
‘l‘:!)] 1 demno_wb01 zip w R ()
e LTS memEANT.  [Zip file (zip) v HiH
SRERH)
Destination falder : | C:Wwin-GRAFYWProjects -
Mame; demo_wb
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13.2 Publishing the Win-GRAF Variable for .NET and Soft-GRAF HMI

If users wish to use .NET program to Read/Write the Win-GRAF variables. Except for String variable all of
the variables need to use the "Open Binding Configuration" function to set an address. The following

demonstrates how to publish Win-GRAF variable:

1. Click “Open Binding Configuration” on the toolbar to open the “Binding” setup window.
2. Click "PUBLIC (:9000)". Keep the "Address" value is blank and "Port" value is fixed to 9000.

[} Win-GRAF - Test 3 — . .
Fie Edit Yiew Insert Project Tools Window Help Open Binding Configuration
A W= AN NI REE W P o { 5 ode & B ig 5 & Al
Workspace —
=) Test 3 = 1 Big Network Nate | Value “ MName
[ Exception programs e (8l FLIELIC [:9000) Name PUBLIC {at Global variables A
[} Programs Address =l RETAIN variables
_ 3] Main g Port 3000 _] Main &
-1 Watch (for debugging) _ ?-8 nOnBadindex =
o iy T M
= & Soft Scope , Keep "Address" value blank. ¢ i |
Iniial values Mame | Identifier  —rusmre nysteress N egaTve TYSERTT Y ame Variable Area _J

“$fd Binding Configuration
i 39 Global defines
: 13 Variables

B Types

<
|4 %] Binding/ ‘riables
3. Before publishing these variables, make sure you have declared them in the Variables Area. Click
“Global variables” and press the “Ins” key to insert a new variable. The following table demonstrates
variables using in the “Test_3” project and you can declare them according to the needs of your

application.
WX
Variable name Type T Name | Type D
Public BOOL BOOL mGlobal vatiables K A
— Public BOOL BOOL
Public_INT INT Public_INT INT
Public_DINT DINT Fablics DAL, EIHE
Public WORD WORD
Public_WORD WORD Dukli~ DEAI  DEAI 5
\Public_REAL ‘
Public_REAL REAL | -l |
_1 Main G
& G| Enter key i

4. As the figure below, click on "PUBLIC(:9000)" and drag all the needed variables to the "Name" area.
The "ldentifier" will generate an address number automatically. If any other VB or .NET program
wants to use these public variables, it must set to the same address number (ID).

NOTE:
The "PUBLIC" allows to use up to 8192 variables, and the "ldentifier" number JUST can be 1 to 8192.
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Binding *

= :j}!-PiB Network Name | Value ¥ Name | Type I
i BRI O IR C (:9000) Name  PUBLIC = {a} Global variables A
Address Public BOOL BOOL
g¢ Port 9000 Fublic_INT ¢ INT &
3 Public_DINT / DINT
FPublic_¥WORD WORD
Public /REAL REAL  |v
Name | Identifier | |Positive hysteresis || i,’ 7 &2
Public_BOOL 1 _ | Mame | Value |
Public_INT 2 __-- ---"
Public_DINT T
Public_WORD 4
Public_REAL 5
£ E Rl

|« | Binding " Varisbles

The following procedure will show you how to use the “pub_string” function to publish the Win-GRAF
String variable in the ST program.

Syntax:

Pub_string(Address, String_val) ;

Address: The public address number, and its range can be 1 to 1024
String_val: The name of String variable.

Variables description:

Name Type Description
Init BOOL Set the initial value as TRUE.
TRUE: Binding succeeds.
Tmp_val BOOL FALSE: Binding fails.
msgl STRING, Length is 100
. String variable for demo purpose.

2 STRING, Length is 32
mse L LENEin 15 NOTE: The String length could be 1 to 255.
msg3 STRING, Length is 60

ST program:
If init then
Init := false;

(*add address 1 for share string val *)
Tmp_val := pub_string(1,msgl);

(*add address 2 for share string val *)
Tmp_val := pub_string(2,msg2);

(*add address 3 for share string val *)
Tmp_val := pub_string(3,msg3);

End_if;
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13.3 Create a new VB.NET project

1. First, run Microsoft Visual Studio .NET 2008 software, and then choose “File” > “New Project”.

[Eile | Edit Wiew Tools Test Window Help

Shift+Alt+N

'] MNewFile...
Microsoft*

7| Oven Project... Ctrl+O d Vlsual StUle 2008

G: Open Web Site...  Shift+Alt+O

2. Click “Smart Device” on the left, and then select “.NET Framework 3.5” and “Smart Device Project”.
Entering a proper project name and click “OK”.

Project types: Tk NET Framework 3.5 =
=) Visusl Basic Yisual Studio installed templates
Windowes -
Web
Srmart Device @ E]VB
Office
Smart Device

Diatabass "
Eeporting Froject

Test

WCF

Watkflow My Templates

Other Languages
Other Project Tyvpes
Test Projects

Hearch Cinline
Templates. ..

(£ [

& project for Smart Device applications. Choose target platform, Framework version, and template in the next dialog box. |

M | projectl] |

[ oK &[ Cancel |

3. Select the "Device Application" and "Windows CE" and “.NET Compact Framework Version 3.5”, then
click “OK”.

Target platform: Windows CE b

HNET Compact Framework version: | §ET Campact Framework Version 3.5 w

NET -:.mam Framework ‘.fersu:un 2 EI

Templates:

Control — Empty Project & project for creating a NET
Library Compact Framework 3.5 forms
application for Windows CE
Platform

Dovenload. additons] emlator dmeages and smart device SDEs. .

UK % Cancel |
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13.3.1 Add Project Reference

The “UserShareNet.dll” library contains all functions of data exchange with Win-GRAF variables. Before
you use the “UserShareNet” keyword in the program, you must add the “UserShareNet.dIl” into the
reference list of your project.

1. Copy the “UserShareNet.DLL” from Win-PAC’s shipment CD (\napdos\Win-GRAF\WP-8xx8\
vb.net_2008_ demo\wp_vb01\vb01\) to your project folder (e.g., “C:\project1\”)

2. Right click on the project name (e.g., “projectl”) in the _ =] x|
“Solution Explorer” window, and then select “Add

Reference ...”.

Solution Explorer - pr.., » I X

8| Build Right click
Rebuild

Deploy
Clean

Add 4

Add Eeference...

Add Web Eeference...

3. Click the “Browse” tab and select the “UserShareNet.dll” from your project location.

NET Projects | Browse | Recent

{Rs{UE D | ) projec w D ¥ . -

S X

[y Mo Project - ] ] ]

=) 0bj The current project is located in "C:\project1".
%) UserShareNet dll

RS\ | 3
TR | Component Files (% Al;* tlh* olb * ocx* exe) w

[ OK‘{[ Cancel |

Note: You may copy the “UserShareNet.dll” from the CD-ROM to your current project path first.
Then add it to the project reference.
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4. When “UserShareNet.dll” is added, please double click on “My Project” to check if the
“UserShareNet.dll” is well added.

Lpplication
Compile
Debug
References
Resources
Figning

Devices

- 1 X

Solution Explorer

2|5 G

-_:,]E projectl

Double click

Unuged References. . I [ Eeference Paths...
References:

Reference Name Twpe  Ver.. CopwLocal Path

S sterL NET 2000 bale (o eram Pilesiblicrosott NE T DEN ompactbrameworkiva I
wten. Data NET 2000 bale o gram Filesibicrosoft NE TWDEV ompactFrameworkiva IV
Swtern. Draveing NET 2000 False WPy gram Filesibicrosoft NE TWDEV ompactFrameworkiva I
Swstern, Windows For.. NET 2000 Fale CProgram Filesticrosoft NE TSDEVCompactFrameorkhy@ I
Sarstern il NET 2000 Fals AP o B i

I MaerSharelet NET 1010 Tme C:Documents sd Setingsmserd EwingradfdocWapdod Win-GR I

{ >

5. Right-click on the “Form1.vb” and select “View Code” from the pop-up. Move cursor to top and
insert the “Option Explicit On” and “Imports UserShareNet” in the first two statements.

solution Explorer

2 2R EE S

-_4]5 projectl

Forml vh

“t4 Form1
Option Explicit On

Imports Tzerfharelet

=d| My Froject
B
Ij’ Qipen
Right Cpen With, .
Click

[Z] Wiew Code \

sPublic Class Forml|

|—End Clazs

Then you can design all required objects and actions inside your VB Forms.
(Refer the Chapter 13.5 for more information about using functions in the “UserS